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INTRODUCTION TO
COMPUTER AND WEB

UNIT - 1
COMPUTER FUNDAMENTAL
Introduction to Computer à
A computer is a general purpose device that can be programmed to carry out a finite set of arithmetic
or logical operations. Or other words you can say Computers are machines that performs tasks or
calculations according to a set of instructions, or programs.
Computer Systemà
Computer System consists of Hardware and Software.
Hardwareà
Hardware, in the computer word, refers to physical components that make up a computer system.
There are many different kinds of hardware that can be installed inside, and connected to the outside,
of a computer.
Here are some common individual computer hardware components that you’ll often find inside a
modern computer.
Here is some common hardware that you might find connected to the outside of a computer:
• Motherboard
• Central Processing Units (CPU)
• Random Access Memory
• Power Supply
• Video Card
• Hard Drive (HDD)
• DVD Drive
• Solid-State Drive (SSD)
• Optical Drive
Input Device à
It is used to input data into a computer system.
• Keyboard
• Mouse
• Scanner
• Analog Modem
• Joysticks
• Webcam
• Microphone
• Tape Drive
• Zip Drive
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Output Deviceà
It is used see the output of your work.
• Monitors
• Printers
• Projectors
• Speakers

Softwareà
Software is generic term for organized collections of computer data and instructions, often broken into
two major categories: System Software and Application Software.
System Softwareà
System software that provides the basic non-task-specific functions of the computer. System Software
is responsible for controlling, integrating and managing the individual hardware Components of a
computer systems so that other software and the users of the system see it as functional unit without
having to be concerned with low-level details such as transferring data from memory to disk, or rendering
text onto a display. Generally System Software consists of an Operating System and some fundamental
utilities such as disk formatters, file manager, display managers, text editors, user authentication (login)
and management tools and networking and device control tools.
Application Softwareà
Application Software which is used by users to accomplish specific tasks. Application Software, on
the other hand, is used to accomplish specific tasks other than just running the computer system.
Application Software may consist of a single program, such as an image viewer, a small collection of
programs that work closely together to accomplish a task, such as a spreadsheet or text processing
system, a large collection of related but independent programs and package that have a common
user interface or shared data format, such as Microsoft Office, which consists of closely integrated
word processor, spreadsheet, database etc. ; or a software systems such as a database management
system, which is a collection of fundamental programs that may provide some service to a variety of
other independent applications.
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UNIT - 2
OPERATING SYSTEM
Introduction à
Modern general-purpose computers, including personal computers and mainframes, have an
operating system to run other programs, such as application software. Examples of operating systems
for personal computers include Microsoft Windows, Mac OS (and Darwin), UNIX, and Linux.
The lowest level of any operating system is its kernel. This is the first layer of software loaded into memory
when a system boots or starts up. The kernel provides access to various common core services to all
other system and application programs. These services include, but are not limited to: disk access,
memory management, task scheduling, and access to other hardware devices.
As well as the kernel, an operating system is often distributed with tools for programs to display and
manage a graphical user interface (although Windows and the Macintosh have these tools built into
the operating system), as well as utility programs for tasks such as managing files and configuring the
operating system. They are also often distributed with application software that does not relate directly
to the operating system’s core function, but which the operating system distributor finds advantageous
to supply with the operating system.
The delineation between the operating system and application software is not precise, and is
occasionally subject to controversy. From commercial or legal points of view, the delineation can
depend on the contexts of the interests involved. For example, one of the key questions in the United
States v. Microsoft antitrust trial was whether Microsoft’s web browser was part of its operating system,
or whether it was a separable piece of application software.
Like the term “operating system” itself, the question of what exactly should form the “kernel” is subject
to some controversy, with debates over whether things like file systems should be included in the kernel.
Various camps advocate microkernels, monolithic kernels, and so on.

Operating systems are used on most, but not all, computer systems. The simplest computers, including the
smallest embedded systems and many of the first computers did not have operating systems. Instead,
they relied on the application programs to manage the minimal hardware themselves, perhaps with
the aid of libraries developed for the purpose. Commercially-supplied operating systems are present
on virtually all modern devices described as computers, from personal computers to mainframes, as
well as mobile computers such as PDAs and mobile phones.
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Histories of Operating Systemsà
An operating system (OS) is a software program that manages the hardware and software resources
of a computer. The OS performs basic tasks, such as controlling and allocating memory, prioritizing the
processing of instructions, controlling input and output devices, facilitating networking, and managing
files.
The first computers did not have operating systems. However, software tools for managing the system
and simplifying the use of hardware appeared very quickly afterwards and gradually expanded
in scope. By the early 1960s, commercial computer vendors were supplying quite extensive tools
for streamlining the development, scheduling, and execution of jobs on batch processing systems.
Examples were produced by UNIVAC and Control Data Corporation, amongst others.
Through the 1960s, several major concepts were developed, driving the development of operating
systems. The development of the IBM System/360 produced a family of mainframe computers available
in widely differing capacities and price points, for which a single operating system OS/360 was planned
(rather than developing ad-hoc programs for every individual model).
This concept of a single OS spanning an entire product line was crucial for the success of System/360
and, in fact, IBM’s current mainframe operating systems are distant descendants of this original system;
applications written for the OS/360 can still be run on modern machines. OS/360 also contained another
important advance: the development of the hard disk permanent storage device (which IBM called
DASD). Another key development was the concept of time-sharing: the idea of sharing the resources
of expensive computers amongst multiple computer users interacting in real time with the system. Time
sharing allowed all of the users to have the illusion of having exclusive access to the machine; the
Multics timesharing system was the most famous of a number of new operating systems developed to
take advantage of the concept.
Multics, particularly, was an inspiration to a number of operating systems developed in the 1970s,
notably UNIX. Another commercially-popular minicomputer operating system was VMS.
The first microcomputers did not have the capacity or need for the elaborate operating systems that
had been developed for mainframes and minis; minimalistic operating systems were developed. One
notable early operating system was CP/M, which was supported on many early microcomputers and
was largely cloned in creating MS-DOS, which became wildly popular as the operating system chosen
for the IBM PC (IBM’s version of it was called IBM-DOS or PC-DOS), its successors making Microsoft
one of the world’s most profitable companies. The major alternative throughout the 1980s in the
microcomputer market was Mac OS, tied intimately to the Apple Macintosh computer.
By the 1990s, the microcomputer had evolved to the point where, as well as extensive GUI facilities,
the robustness and flexibility of operating systems of larger computers became increasingly desirable.
Microsoft’s response to this change was the development of Windows NT, which served as the basis for
Microsoft’s entire operating system line starting in 1999. Apple rebuilt their operating system on top of
a Unix core as Mac OS X, released in 2001. Hobbyist-developed reimplementations of Unix, assembled
with the tools from the GNU project, also became popular; versions based on the Linux kernel are by
far the most popular, with the BSD derived Unix’s holding a small portion of the server market.
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The growing complexity of embedded devices has a growing trend to use embedded operating
systems on them.
Operating System – Overviewà
An operating System (OS) is an intermediary between users and computer hardware. It provides users
an environment in which a user can execute programs conveniently and efficiently.
In technical terms, It is a software which manages hardware. An operating System controls the
allocation of resources and services such as memory, processors, devices and information.
Definitionà
An Operating System is a program that acts as an interface between the user and the computer
hardware and controls the execution of all kinds of programs.

Following are some of important functions of an operating System.
• Memory Management
• Processor Management
• Device Management
• File Management
• Security
• Control over system performance
• Job accounting
• Error detecting aids
• Coordination between other software and users
Memory Management à
Memory management refers to management of Primary Memory or Main Memory. Main memory is a
large array of words or bytes where each word or byte has its own address.
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Main memory provides a fast storage that can be accessed directly by the CPU. So for a program
to be executed, it must be in the main memory. Operating System does the following activities for
memory management.
Keeps tracks of primary memory i.e. which part of it are in use by whom and which parts are not in use.
In multiprogramming, OS decides which process will get memory space when and how much.
Allocates the memory when the process requests it to do so.
De-allocates the memory when the process no longer needs it or has been terminated.
Processor Management à
In multiprogramming environment, OS decides which process gets the processor when and how much
time it needs. This function is called process scheduling. Operating System does the following activities
for processor management.
Keeps tracks of processor and status of processes. Program responsible for this task is known as traffic
controller.
Allocates the processor (CPU) to a process.
De-allocates processor when processor is no longer required.
Device Management à
OS manages device communication via their respective drivers. Operating System does the following
activities for device management:
Keeps tracks of all devices. Program responsible for this task is known as the I/O controller.
Decides which process gets the device when and for how much time.
Allocates the device in an efficient way.
De-allocates devices.
File Management à
A file system is normally organized into directories for easy navigation and usage. These directories may
contain files and other directions. Operating System does the following activities for file management:
Keeps track of information, location, uses, status etc. The collective facilities are often known as file
system.
Decides who gets the resources.
Allocates the resources.
De-allocates the resources.
Other Important Activities à
Following are some of the important activities that Operating System does.
Security – By means of password and similar other techniques, preventing unauthorized access to
programs and data.
Control over system performance -- Recording delays between request for a service and response
from the system.
Job accounting – Keeping track of time and resources used by various jobs and users.
Error detecting aids – Production of dumps, traces, error messages and other debugging and error
detecting aids.
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Coordination between other software’s and users -- Coordination and assignment of compilers,
interpreters, assemblers and other software to the various users of the computer systems.

Windows Operating System à
Introduction à
The Windows XP Operating System is a graphical user interface (GUI) developed by the Microsoft
Corporation. The purpose of this document is to assist the user in learning the basic fundamentals of the
Windows XP Operating System. The Introduction to Windows XP workshop is recommended for people
unfamiliar with computers and will serve as a foundation for the other Windows related workshops.
Basic Terminology à
Monitor: The television-like screen that displays the visual representation of the computer’s contents.
Floppy Disk: Storage device used for storing small programs or data. Most diskettes are 3.5” in size and
can store 1.4 Megabytes (MB) of information. A new kind of diskette, called a Zip Disk, can hold as
much as 250 MB or more.
Hard Disk: Storage device found in the computer which is used for storing instructions and data. Hard
disks are capable of storing gigabytes (GB) of data (thousands of Megabytes).
CD-ROM: Compact Disk Read Only Memory storage media. CD-ROMs have a similar appearance
to audio CDs. Computer programs are often stored on these discs because of their large storage
capacity.
CD-R/RW: A compact disk, similar to a CD-ROM, except it can have information recorded on it. Some
types are capable of being recorded multiple times.
RAM: Random Access Memory. RAM is found inside the computer and is used to temporarily store
instructions and data for processing.
Mouse: A handheld device which controls cursor movements on the screen. A button on the mouse
can be used to select programs/files by clicking once on the program/file icon. It can also be used to
launch programs/files by rapidly clicking twice on the icons (double clicking).
Left-Click: Pressing the left button of the mouse once. (Used for selecting icons and opening programs.)
Right-Click: Pressing the right button of the mouse once. (Used for opening contextual menus.)
Single-Click: Clicking once (with the left mouse button) on the icon to select the icon.
Double-Click: Clicking twice (with the left mouse button) on the icon to activate the icon. Activating
the icon will run the program or open the file that is associated with the icon.
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Drag/Drag-and-Drop: This is used to move files around on the computer. It may also be used to copy
files from hard drive to floppy drive and vice-versa. To drag a file, left-click and hold down the button.
Move the icon to the new location and let go of the mouse button.
Network Login à
To log on to the Network, press the OK button at the Login screen. You now have access to the various
programs that are network accessible.

Desktop
The computer screen that is displayed is called the Desktop. As you move the mouse around with your
hand, you see the mouse pointer move accordingly on the computer desktop. The icons on the desktop
correspond to commonly used programs found in the computer. These icons are actually shortcuts to
the programs themselves and double-clicking the icons will launch the programs automatically.
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You can also use the right mouse button to open up different commands. Right-click on an empty area
of the desktop and arrange the icons by name.

My Computer à
The My Computer icon will show a listing of the computer’s disk drives, network drives, and system files/
folders. Local files or folders are found on the computer’s drives here as remote files or folders are found
on the network drives. Double-clicking on the drive letter will open the contents of that drive.

You can also right-click on the icons to do advanced functions.

Title Bar, Menu Bar, Tool Bar à
The Title Bar shows the name of which window you are viewing.
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Minimize/Maximize/Restore/Close à
Every window in the XP operating system will have a series of buttons on the top right corner of the Title
Bar. Close Maximize Minimize Restore Window.
My Documents à
The My Documents folder is the default folder where most of the Windows XP programs will save your
files.

Taskbar à
Time and date are found on the right-hand side of the Taskbar and can be changed by double
clicking on the numbers that display the time.
Start Menuà
The Start Menu contains shortcuts to the most commonly used programs that are found on your
computer.
Clicking Start -> Programs -> Accessories -> Calculator will launch the calculator program

If you know the name of the program you want to open, go to Start -> Run and type in the program’s
name. For example, if you want to open the calculator program, go to Start -> Run and type in the
name calc. click the OK button.
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New Fileà
Go to Start -> Run and type Explorer. Click the OK button. In the Explorer Window, select File -> New ->
Microsoft Word Document

Name it and click the OK button

Open Fileà
Open the file you just created by double-clicking on it. You can also open the file from the Menu Bar
by selecting File -> Open.
With the new file open, enter your name in the open area of the Microsoft Word document.
Save (As)à
Select File -> Save As
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Enter your name as the File name:
Click on the down arrow where it says to Save as type:.
Select to save the file Rich Text Document.
Click Save and close the file.
Note : By saving the text file as the Rich Text Format, you are able to open this file on any type of
computer and work on it even if they do not have the Microsoft Word software installed on the machine.
Furthermore, saving it this way allowed you to make a backup copy of the file that was created.
Making backup copies of files is one of the best practices a computer user can do. Remember to
make regular backup copies of your important files and keep the backups in a safe place.
Copyà
Another way to make a backup copy of your files would be to:
• Locate the file you want to copy in My Computer or Windows Explorer.
• Select the file you want to copy by clicking once on the file.
• Select Edit from the Tool Bar and click on Copy.
• Select Edit from the Tool Bar and click Paste.
• You now have a copy of the file you selected.
You can also right-click on the file you want to copy and left-click on the Copy command. Now move
to an empty area of the window you are currently in and right-click that spot. Select Paste.
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Unzipà
Note : A zipped file is a compressed file that was created by a program to save disk space. Windows
XP has an automatic unzipping utility that will allow you to open zipped files on disk. Place the floppy
disk that was loaned to you at the beginning of the workshop in the floppy disk drive. In the Explorer
Window, select My Computer and click on 3½ Floppy A: drive. Double click on the file text_zip.zip.
You can drag-n-drop this file to the My Documents folder. Move the mouse pointer over the file, left
click once on the file and while holding your finger down, drag the mouse over so the pointer will be on
top of the My Documents folder and let go of the file by taking your finger off of the mouse.
Printà
Open the new file and select Print from the File Menu.

Close the file.
Note : Each computer lab on campus will have a different Print Dialog box. Press the OK button and a
lab assistant will be available to help you with your print out.
Delete
From the Menu Bar, select File -> Delete
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Click the Yes button.
Recycle Binà
Locate the Recycle Bin icon on the Desktop
Find the file you just deleted and select it by clicking on it once. From the Menu Bar,
Select File -> Restore

The file will have been restored to the directory it was deleted from. If you do not remember which
directory the file was in when it was deleted, you can search for it by using the Search Feature.
Note : University machines will not restore a file after the machine has been restarted.
Searchà
To search for the file that was just restored, Click the
Start Menu button, and select
Search ->For File or Folders
There are various ways to search for files and folders.
You are able to search by file Name or words found
in the file you are looking for. You can search specific
areas.
Of your hard drive or for files that was created or
modified on a certain date.
Test some different ways of searching to see which one
works best for you.
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Also, the most recent files that were opened will be found in Start Menu à Documents

Help
The Help and Support Center can be a vital source of information. Click the Start Menu and select Help
and Support.
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You can type in a word or phrase to search for or select topics that might be useful.
Try typing the word Restore.
Antivirus
Locate the Norton Anti-Virus icon on the right-hand side of the Task Bar and double-click it.
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Insert the disk we loaned you into the floppy drive. Select the option of Scan à Scan a Floppy Disk.
There should be a checkmark next to the Floppy Disk.
Press the

button

The scan will complete and tell you whether or not there is a virus on the disk. If a virus is found, follow
the on screen instructions to disinfect. You may also Contact one of our student lab assistants for help.
When scanning is complete,
Close the open window and Exit the program.

Log Off/Shutdown/Restart
To restart your computer or turn your computer off, click the Start Menu Button and select Shut Down …

You will now have the option to log off the computer, turn your computer off or restart the computer.
Select what you want to do and click the OK button.
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Alternatively, pressing CTRL-ALT-DEL (hold down the Ctrl key, the Alt key, and the Delete key on the
keyboard) simultaneously will bring up these options also.

Pressing the Logoff button will prompt you if you want to end your Windows session.
This will close down all programs you had open and will make the computer available for a new user.
Pressing the Shutdown button will ask if you want to turn off or restart the system.
If you restart the system, the computer will refresh all settings and computer
Memory will be restored for a new user.
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UNIT - 3
CONCEPT ABOUT WEB TECHNOLOGY

Concepts à
Web servers and web browsers are communicating client-server computer programs for distributing
documents and information, generally called web data, over the Internet. Web data are marked up in
the HTML language for presentation and interaction with people in web browsers. Each web server uses
an IP address or domain name as well as a port number for its identification. People use web browsers
to send data requests to web servers with the HTTP protocol, and the web servers running on server
computers either retrieve the requested data from local disks or generate the data on-the-fly, mark
up the data in HTML, and send the resulting HTML files back to the web browsers to render. Apache,
Tomcat and IIS are popular web server programs, and IE and Firefox are popular web browsers.
What is Internet ?

The Internet is essentially a global network of computing resources. You can think about the Internet as
a physical collection of routers and circuits as a set of shared resources or even as an attitude about
interconnecting and intercommunication. Some common definitions given in the past include:
• A network of networks based on the TCP/IP communications protocol.
• A community of people who use and develop those networks.
• A community of people who use and develop those networks.
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Usenet news: A distributed bulletin board that offers a combination news and discussion service on
thousands of topics.
World Wide Web (WWW): A hypertext interface to Internet information resources.
What is WWWà
This stands for World Wide Web. A technical definition of the World Wide Web is : all the resources
and users on the Internet that are using the Hypertext Transfer Protocol (HTTP). A broader definition
comes from the organization that Web inventor Tim Berners-Lee helped found, the World Wide Web
Consortium (W3C):
The World Wide Web is the universe of network-accessible information, an embodiment of human
knowledge. In simple terms, The World Wide Web is a way of exchanging information between computers
on the Internet, tying them together into a vast collection of interactive multimedia resources.
What is HTTPà
This stands for Hypertext Transfer Protocol. This is the protocol being used to transfer hypertext documents
that’s makes the World World Wide possible. A standard web address such as http://www.yahoo.
com/ is called a URL and here the prefix http indicates its protocol.
What is URLà
URL stands for Uniform Resource Locator, and is used to specify addresses on the World Wide Web. A
URL is the fundamental network identification for any resource connected to the web (e.g., hypertext
pages, images, and sound files).
A URL will have the following format:
The protocol specifies how information from the link is transferred. The protocol used for web resources
is Hypertext Transfer Protocol (HTTP). Other protocols compatible with most web browsers include FTP,
telnet, newsgroups, and Gopher. The protocol is followed by a colon, two slashes, and then the domain
name. The domain name is the computer on which the resource is located. Links to particular files or
subdirectories may be further specified after the domain name. The directory names are separated by
single forward slashes.
What is Websiteà
Currently you are on our website http://www.tutorialspoint.com which is a collection of various pages
written in HTML markup language. This is a location on the web where people can find tutorials on
latest technologies. Similar way there is millions of websites available on the web. Each page available
on the Website is called a web page and first page of any web site is called home page for that site.
What is Web Serverà
Every Web site sits on a computer known as a Web server. This server is always connected to the
internet. Every Web server that is connected to the Internet is given a unique address made up of
a series of four numbers between 0 and 256 separated by periods. for example, 68.178.157.132 ro
68.122.35.127. When you register a Web address, also known as a domain name, such as tutorialspoint.
com you have to specify the IP address of the Web server that will host the site. We will see different
type of Web servers in a separate chapter.
What is Web Browserà
Web Browsers are software installed on your PC. To access the Web you need web browsers, such
as Netscape Navigator, Microsoft Internet Explorer or Mozilla Firefox. Currently you must be using any
sort of Web browser while you are naviating through my site tutorialspoint.com. On the Web, when
you navigate through pages of information this is commonly known as browsing or surfing. We will see
different type of Web browsers in a separate chapter.
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What is SMTP Serverà
This stands for Simple Mail Transfer Protocol Server. This server takes care of delivering emails from one
server to another server. When you send an email to an email address, it is delivered to its recipient by
a SMTP Server.
What is ISPà
This stands for Internet Service Provider. They are the companies who provide you service in terms of
internet connection to connect to the internet. You will buy space on a Web Server from any Internet
Service Provider. This space will be used to host your Web site.
What is HTMLà
This stands for Hypertext Markup Language. This is the language in which we write web pages for
any Website. Even the page you are reading right now is written in HTML. This is a subset of Standard
Generalized Mark-Up Language (SGML) for electronic publishing, the specific standard used for the
World Wide Web.
What is Hyperlinkà
A hyperlink or simply a link is a selectable element in an electronic document that serves as an access
point to other electronic resources. Typically, you click the hyperlink to access the linked resource.
Familiar hyperlinks include buttons, icons, image maps, and clickable text links.
What is DNSà
DNS stands for Domain Name System. When someone types in your domain name, www.example.
com, your browser will ask the Domain Name System to find the IP that hosts your site. When you register
your domain name, your IP address should be put in a DNS along with your domain name. Without
doing it your domain name will not be functioning properly.
What is W3Cà
This stands for World Wide Web Consortium which is an international consortium of companies involved
with the Internet and the Web. The W3C was founded in 1994 by Tim Berners-Lee, the original architect
of the World Wide Web. The organization’s purpose is to develop open standards so that the Web
evolves in a single direction rather than being splintered among competing factions. The W3C is the
chief standards body for HTTP and HTML.
Internet Based Servicesà
Some of the basic services available to Internet users are:
Email: A fast, easy, and inexpensive way to communicate with other Internet users around the world.
Telnet: Allows a user to log into a remote computer as though it were a local system.
FTP: Allows a user to transfer virtually every kind of file that can be stored on a computer from one
Internet-connected computer to another.
Programming languages on the internetà
The capabilities of the Internet have been enhanced and extended by using programming languages
with HTML. These languages have been responsible for the dynamic and interactive nature of the
Net. New languages and language extensions are being developed to increase the usability of the
Internet. On this page I’ll provide a brief on some of the important languages that have shape the
Internet over the years.
HTML - Hypertext Markup Languageà
HTML (Hypertext Markup Language) is the lingua franca of the Internet. It is the language used to develop
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web pages. Hypertext means that some text in the HTML document carries a link to a different location,
which can be on the same page or another page. On clicking this ‘hot spot’, the viewer is transferred
to that location. Markup means that specific portions of a document are marked up to indicate how
they should be displayed in the browser.
According to purists, HTML is not a language per se, and they are right in one way. HTML simply consists
of tags that are placed around elements, which then changes the properties of these enclosed
elements. There are hundreds of HTML tags and some of these are proprietary, which means that only
some browsers recognize them.
CGI – Common Gateway Interfaceà
The Common Gateway Interface (CGI) has been around for a long time. It allows the web server
software to communicate with other programs running on the server. These external programs are
called CGI scripts or CGI programs and are usually written in Perl or ‘C’. CGI programs are generally used
to process information submitted by visitors via a form on a web page. For example, you might use
the search form on a web site to look for ‘cars’. When you submit your query, the server receives your
request, passes it to the CGI program. The program then looks up the search query term in a database
and responds with the appropriate result formatted in HTML code.
JavaScript/Jscriptà
JavaScript is a programming language that runs on a web browser. It was developed by the same
folks who gave us Netscape and was first implemented in version 2 of the browser. Jscript is Microsoft’s’
implementation of JavaScript for Internet Explorer. By the by, JavaScript is not a subset of Java, in fact, the
two languages share little in common (yes, they share a few basic concepts but the syntax is different
and so is the application). Naming their language “JavaScript”, was just a clever marketing ploy by
Netscape Communications. It was initially called Live script but when Sun Microsystems released Java
and it became very popular, Netscape renamed their scripting language to JavaScript. JavaScript
runs on the browser (client) and does not require any server software. Thus, it is a client-side scripting
language. Since all execution takes place on the browser, JavaScript is responsible for most of the
interactivity on a web page. Image change or text color change on mouse over, creating mouse trails
are all possible through JavaScript. The language has also been widely used for basic form validation.
This seems logical, as it is better to validate a form on the client side than to make several trips to
the server. JavaScript is commonly embedded inside the HTML page and is thus visible to the visitor.
JavaScript can also be written to run on a server and this is based on the ASP model promoted by
Microsoft.
Javaà
Developed by Sun Microsystems, Java is a very powerful, object-oriented language. A lot many
platform dependency issues have been ironed out with the advent of Java. Thus, Java programs for
UNIX can be made to run on Windows or the Mac system with little or no effort. Much development
is taking place on the Java front with new arrivals like Java Beans, Extended Java Beans, and Java
applications for various databases and XML. Using Java servlets one can also develop dynamic Java
Server Pages (JSP). Java can also be seen on the Internet in the form of applets embedded in an HTML
page. Applets are small Java programs that run on a Java compatible browser.
VBScriptà
VBScript is a client-based language that runs only on the Internet Explorer and quite naturally, has been
developed by Microsoft. Though, the browser market share of Internet Explorer has steadily risen and
overtaken that of Netscape, it is still not advisable to use VBScript as a client side language for web
pages. I would prefer to use JavaScript (or Script, if you like) as it runs on all popular web browsers Netscape, Opera, Mozilla and the Internet Explorer. However, VBScript is very often used for developing
Active Server Pages (discussed below).
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ASP - Active Server Pagesà
Active Server Pages is a technology promoted by Microsoft. The ASP utilizes some special tags, which
can be embedded in the HTML code, to generate dynamic web pages. ASP scripts run on the server,
typically, IIS on Windows NT. ASP pages carry the .asp extension that differentiates them from plain
HTML pages and instructs the web server to pass the pages through the ASP interpreter. You can use
VBScript, JavaScript/Jscript or a combination of the two to write ASP pages. The great advantage in
using ASP is the ease of maintenance of the web site. However, the downside is that you become too
dependent on Microsoft technologies.
PHPà
Open source, great development environment - PHP is a cult. This has been the answer of open source
programmers to Microsoft’s ASP. PHP not only carries all the goodness of ASP but also is more secure
and handles databases more easily. It is a known fact that PHP on Apache Web server runs faster than
ASP. PHP code is embedded inside the HTML page and can link to databases to generate dynamic
HTML content. Furthermore, PHP scripts can be made to run on any operating system with little or no
modification.
XML - extensible Markup Languageà
The extensible Markup Language is a web page developing language that enables programmers
to create customized tags. These customized tags can provide the much-needed functionality not
available with HTML. XML documents can be accessed using JSP, PHP etc.
There are several other languages on the Internet such as Perl, Python, VRML (Virtual Reality modeling
Language), awk etc., which I have not discussed here. You can search for them on your favorite
search engine.

TYPES OF INTERNET CONNECTIONSà
As technology grows, so does our need for bigger, better and faster Internet connections. Over the
years the way content is presented via the Web has also changed drastically. Ten years ago being
able to center, bold, and produce text in different colors on a webpage was something to admire.
Today, Flash, animations, online gaming, streaming HD video, database-driven websites, ecommerce
and mobile applications—to name but a few—are standards.
The need for speed has changed the options available to consumers and businesses alike in terms
of how and how fast we can connect to the Internet. The connection speeds listed below represent
a snapshot of general average to maximum speeds at the time of publication. This is no doubt will
change over time and Internet connection speeds also vary between Internet Service Providers (ISP).
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Analog: Dial-up Internet Accessà
Also called dial-up access, an analog Internet connection is both economical and slow. Using
a modem connected to your PC, users connect to the Internet when the computer dials a phone
number (which is provided by your ISP) and connects to the network. Dial-up is an analog connection
because data is sent over an analog, public-switched telephone network. The modem converts
received analog data to digital and vice versa. Because dial-up access uses normal telephone lines
the quality of the connection is not always good and data rates are limited. Typical Dial-up connection
speeds range from 2400 bps to 56 Kbps. Today, analog has been widely replaced by broadband
(Cable and DSL).
ISDN - Integrated Services Digital Networkà
Integrated services digital network (ISDN) is an international communications standard for sending
voice, video, and data over digital telephone lines or normal telephone wires. Typical ISDN speeds
range from 64 Kbps to 128 Kbps.
B-ISDN - Broadband ISDNà
Broadband ISDN is similar in function to ISDN but it transfers data over fiber optic telephone lines, not
normal telephone wires. SONET is the physical transport backbone of B-ISDN. Broadband ISDN has not
been widely implemented.
DSL – Digital Subscriber Lineà
DSL is frequently referred to as an “always on” connection because it uses existing 2-wire copper
telephone line connected to the premise so service is delivered simultaneously with wired telephone
service -- it will not tie up your phone line as an analog dial-up connection does. The two main
categories of DSL for home subscribers are called ADSL and SDSL. All types of DSL technologies are
collectively referred to as XDSL. XDSL connection speeds range from 128 Kbps to 9 Mbps.
ADSL - Asymmetric Digital Subscriber Lineà
ADSL is the most commonly deployed types of DSL in North America. Short for asymmetric digital
subscriber line ADSL supports data rates of from 1.5 to 9 Mbps when receiving data (known as the
downstream rate) and from 16 to 640 Kbps when sending data (known as the upstream rate). ADSL
requires a special ADSL modem.
ADSL+2 - ADSL Extensionà
An extension to ADSL broadband technology that provides subscribers with significantly faster
download speeds when compared to traditional ADSL connections. ADSL+2 works in the same fashion
as ADSL a special filter is installed on a subscriber’s telephone line to split existing copper telephone
lines (POTS) between regular telephone (voice) and ADSL+2. ADSL2+ service is most commonly offered
in highly-populated metropolitan areas and subscribers must be in close geographical locations to the
provider’s central office to receive ADSL2+ service.
SDSL - Symmetric Digital Subscriber Lineà
Short for symmetric digital subscriber line, SDSL is a technology that allows more data to be sent over
existing copper telephone lines (POTS). SDSL supports data rates up to 3 Mbps. SDSL works by sending
digital pulses in the high-frequency area of telephone wires and cannot operate simultaneously with
voice connections over the same wires. SDSL requires a special SDSL modem. SDSL is called symmetric
because it supports the same data rates for upstream and downstream traffic.
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VDSL - Very High DSL à
Very High DSL (VDSL) is a DSL technology that offers fast data rates over relatively short distances — the
shorter the distance, the faster the connection rate.
Cable - Broadband Internet Connectionà
Through the use of a cable modem you can have a broadband Internet connection that is designed
to operate over cable TV lines. Cable Internet works by using TV channel space for data transmission,
with certain channels used for downstream transmission, and other channels for upstream transmission.
Because the coaxial cable used by cable TV provides much greater bandwidth than telephone lines,
a cable modem can be used to achieve extremely fast access. Cable providers typically implement
a cap to limit capacity and accommodate more customers. Cable speeds range from 512 Kbps to 20
Mbps.
Wireless Internet Connectionsà
Wireless Internet, or wireless broadband is one of the newest Internet connection types. Instead of using
telephone or cable networks for your Internet connection, you use radio frequency bands. Wireless
Internet provides an always-on connection which can be accessed from anywhere — as long as you
geographically within a network coverage area. Wireless access is still considered to be relatively new,
and it may be difficult to find a wireless service provider in some areas. It is typically more expensive
and mainly available in metropolitan areas.
T-1 Lines – Leased Line
T-1 lines are a popular leased line option for businesses connecting to the Internet and for Internet
Service Providers (ISPs) connecting to the Internet backbone. It is a dedicated phone connection
supporting data rates of 1.544Mbps. A T-1 line actually consists of 24 individual channels, each of
which supports 64Kbits per second. Each 64Kbit/second channel can be configured to carry voice or
data traffic. Most telephone companies allow you to buy just one or some of these individual channels.
This is known as fractional T-1access. T-1 Lines support speeds of 1.544 Mbps. Fractional T-1 speeds are
64 Kbps per channel (up to 1.544 Mbps), depending on number of leased channels.
Bonded T-1à
A bonded T-1is two or more T-1 lines that have been joined (bonded) together to increase bandwidth.
Where a single T-1 provides approximately 1.5Mbps, two bonded T1s provide 3Mbps or 46 channels
for voice or data. Two bonded T-1s allow you to use the full bandwidth of 3Mbps where two individual
T-1s can still only use a maximum of 1.5Mbps at one time. To be bonded the T-1 must run into the same
router at the end, meaning they must run to the same ISP. Typical Bonded T-1 (two bonded T-1 lines)
speed is around 3 Mbps.
T-3 Lines – Dedicated Leased Lineà
T-3 lines are dedicated phone connections supporting data rates of about 43 to 45 Mbps. It too is
a popular leased line option. A T-3 line actually consists of 672 individual channels, each of which
supports 64 Kbps. T-3 lines are used mainly by Internet Service Providers (ISPs) connecting to the Internet
backbone and for the backbone itself. Typical T-3 supports speeds ranging from 43 to 45 Mbps.
OC3 - Optical Carrierà
Short for Optical Carrier, level 3 it is used to specify the speed of fiber optic networks conforming to the
SONET standard. OC3 is typically used as a fiber optic backbone for large networks with large voice,
data, video, and traffic needs. Speeds are 155.52 Mbps, or roughly the speed of 100 T1 lines.
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Internet over Satelliteà
Internet over Satellite (IoS) allows a user to access the Internet via a satellite that orbits the earth.
A satellite is placed at a static point above the earth’s surface, in a fixed position. Because of the
enormous distances signals must travel from the earth up to the satellite and back again, IoS is slightly
slower than high-speed terrestrial connections over copper or fiber optic cables. Typical Internet over
satellite connection speeds (standard IP services) average around 492 up to 512 Kbps.

Types of IP address and its requirementsà
IP addresses are basically of two types:
1. Static IP address
2. Shared IP address
An IP Address is a 32-bit number that identifies a computer on the Internet. Every web site on the
internet is found not by its domain name but by its IP address.
When someone types the address: www.xyz.com it is translated into an IP address and then the
computer is directed to that IP address which is the web site.
Now every single website has an IP address specifically allocated to it. If every site assigned a separate
IP address then there could be a problem with running out of IP addresses so a lot of the sites on the
server use a single IP address for multiple sites.
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Thus, using more than one site on an IP address is called a Shared IP address. If a site has its own IP
address, and shares with no one else, it is called a Static IP address.
You can always access a site which has a static IP address by using its IP address alone, but you cannot
access a site using a shared IP address by typing in the IP address alone because when you type in a
shared IP address you arrive at the server but the server does not know which site you are looking for
as you have not told it which domain name you want.
Requirement of static IP address à
1. The main reason to have a static IP address for your site is that, you can use SSL encryption on a
static IP address only. In order to transmit sensitive data over the internet, it must be encrypted to
prevent someone from intercepting the information.
2. In case if the site needed the anonymous ftp access (anyone can download files of the site), the site
needs to have a static IP address.
Other than these two reasons there is no need for a site to have its own IP address.
Types of Internet Protocolà
Internet protocolsà
Several protocols are used on the Internet, including Electronic Mail (e-mail), File Transfer Protocol (FTP),
HTTP (World Wide Web), News (or Usenet), Gopher and Telnet. Each of these has its own standard and
usage.
Electronic Mailà
Included in the email protocol are three distinct protocols. SMTP (Simple Mail Transfer Protocol), IMAP
(Internet Message Access Protocol) and POP3 (Post Office Protocol 3). SMTP is a protocol used for
sending mail, while IMAP and POP3 are used for receiving. Almost all Internet service providers support
all three protocols. However the most popular setup for most providers is to use SMTP for sending mail
while using POP3 for receiving.
File Transfer Protocolà
File Transfer Protocol, or FTP, is a means of transferring a file from one computer to another. FTP is
commonly used for uploading a web page to a web server so that it may be seen on the World Wide
Web. A special program, called a client, is usually needed to use FTP.
HTTP (World Wide Web)à
Hypertext Transfer Protocol, or HTTP, is the protocol used by web server to allow web pages to be shown
in a web browser. If you look up into the address bar of your web browser, the place where you type
in the address that you want to visit, it has the prefix “http://” in front of the address. Because most
web browsers are capable of FTP as well as viewing web pages, the http tells the browser what kind of
information to expect.
News (or Usenet)à
Network News Transfer Protocol (NNTP) is used for serving Usenet posts Usenet is similar to the forums
that many web sites have. Usenet has forums that are dedicated to specific companies as well as
forums that have a wide range of topics. Usenet is divided into several areas. Some of the forums
that are included in Usenet are comp. for discussion of computer-related topics, sci. for discussion of
scientific subjects, rec. for discussion of recreational activities (e.g. games and hobbies) and talk. for
discussion of contentious issues such as religion and politics.
Gopherà
Another tool of the Internet is Gopher, a menu-based program that enables you to browse for
information without knowing where the material is located. It lets you search a list of resources and
then sends the material to you.
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Telnet à
Telnet lets you log in to a remote computer just as you would if you were there. So any commands that
you would be able to run from the remote computer if you were sitting in front of it, you would be able
to run from the computer you logged in from.

Web - Browser Types à
Web Browsers are software installed on your PC. To access the Web you need web browsers, such as
Netscape Navigator, Microsoft Internet Explorer or Mozilla Firefox.
Currently you must be using any sort of Web browser while you are navigating through my site
tutorialspoint.com. On the Web, when you navigate through pages of information this is commonly
known as web browsing or web surfing.
There are four leading web browsers: Explorer, Firefox, Netscape and Safari but there are many others
browsers available. You might be interested in knowing Complete Browser Statistics. Now we will see
these browsers in bit more detail.
While developing a site, we should try to make it compatible to as many browsers as possible. Especially
site should be compatible to major browsers like Explorer, FireFox, Netscape, Opera and Safari.
Internet Explorerà
Internet Explorer (IE) is a product from software giant Microsoft. This is the most commonly used browser
in the universe. This was introduced in 1995 along with Windows 95 launch and it has passed Netscape
popularity in 1998.
Netscapeà
Netscape is one of the original Web browsers. This is what Microsoft designed Internet Explorer to
compete against. Netscape and IE comprise the major portion of the browser market. Netscape was
introduced in 1994.
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Mozillaà
Mozilla is an open-source Web browser, designed for standards compliance, performance and
portability. The development and testing of the browser is coordinated by providing discussion forums,
software engineering tools, releases and bug tracking. Browsers based on Mozilla code is the second
largest browser family on the Internet today, representing about 30% of the Internet community.
Firefoxà
Firefox is a new browser derived from Mozilla. It was released in 2004 and has grown to be the second
most popular browser on the Internet.
Operaà
Opera is smaller and faster than most other browsers, yet it is full- featured. Fast, user-friendly, with
keyboard interface, multiple windows, zoom functions, and more. Java and non Java-enabled versions
available. Ideal for newcomers to the Internet, school children, handicap and as a front-end for CDRom and kiosks.
Difference between Intranet, Extranet and Internetà
Intranet is shared content accessed by members within a single organization.
Extranet is shared content accessed by groups through cross-enterprise boundaries.
Internet is global communication accessed through the Web.
For better comprehension, take a look at this drawing:

Summaryà
The Internet, extranets, and intranets all rely on the same TCP/IP technologies. However, they are
different in terms of the levels of access they allow to various users inside and outside the organization
and the size of the network. An intranet allows for restricted access to only members of an organization;
an extranet expands that access by allowing non-members such as suppliers and customers to use
company resources. The difference between the Internet and extranets is that while the extranet
allows limited access to non-members of an organization, the Internet generally allows everyone to
access all network resources.
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Intranetà
This is a network that is not available to the world outside of the Intranet. If the Intranet network is
connected to the Internet, the Intranet will reside behind a firewall and, if it allows access from the
Internet, will be an Extranet. The firewall helps to control access between the Intranet and Internet to
permit access to the Intranet only to people who are members of the same company or organization.
In its simplest form, an Intranet can be set up on a networked PC without any PC on the network having
access via the Intranet network to the Internet.
For example, consider an office with a few PCs and a few printers all networked together. The network
would not be connected to the outside world. On one of the drives of one of the PCs there would be a
directory of web pages that comprise the Intranet. Other PCs on the network could access this Intranet
by pointing their browser (Netscape or Internet Explorer) to this directory - for example:
U:\inet\index.htm.
From then onwards they would navigate around the Intranet in the same way as they would get
around the Internet.
Extranetà
An Extranet is actually an Intranet that is partially accessible to authorised outsiders. The actual server
(the computer that serves up the web pages) will reside behind a firewall. The firewall helps to control
access between the Intranet and Internet permitting access to the Intranet only to people who are
suitably authorised. The level of access can be set to different levels for individuals or groups of outside
users. The access can be based on a username and password or an IP address (a unique set of numbers
such as 209.33.27.100 that defines the computer that the user is on).
Internetà
This is the world-wide network of computers accessible to anyone who knows their Internet Protocol (IP)
address - the IP address is a unique set of numbers (such as 209.33.27.100) that defines the computer›s
location. Most will have accessed a computer using a name such ashttp://www.hcidata.com. Before
this namedcomputer can be accessed, the name needs to be resolved (translated) into an IP address.
To do this your browser (for example Netscape or Internet Explorer) will access a Domain Name Server
(DNS) computer to lookup the name and return an IP address - or issue an error message to indicate that
the name was not found. Once your browser has the IP address it can access the remote computer.
The actual server (the computer that serves up the web pages) does not reside behind a firewall - if
it did, it would be an Extranet. It may implement security at a directory level so that access is via a
username and password, but otherwise all the information is accessible. To see typical security have
a look at a sample secure directory - the username is Dr and the password is Who (both username and
password are case sensitive).
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MICROSOFT OFFICE

UNIT - 4
MICROSOFT WORD - 2007
Introductions à
Microsoft Word is the world’s leading word processing application. It can be used to work with a wide
range of documents like letters, memos, newsletters, forms and now with blogs too with Word 2007.
Screen Layout à

Microsoft Office
Button

Quick Accesses Toolbar

Ribbon

View Choice

Menusà
When you begin to explore Word 2007 you will notice a new look to the menu bar. There are three
features that you should remember as you work within Word 2007: the Microsoft Office Button, the
Quick Access Toolbar, and the Ribbon. These three features contain many of the functions that were in
the menu of previous versions of Word. The functions of these three features will be more fully explored
below.
The Microsoft Office Buttonà
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The Microsoft Office button performs many of the functions that were located in the File menu of older
versions of Word. This button allows you to create a new document, open an existing document, save
or save as, print, send (through email or fax), publish or close.
The Ribbon à

The Ribbon is the panel at the top portion of the document. It has seven tabs: Home, Insert, Page
Layout, References, Mailings, Review, and View that contain many new and existing features of Word.
Each tab is divided into groups. The groups are logical collections of features designed to perform
functions that you will utilize in developing or editing your Word document. Commonly used features
are displayed on the Ribbon, to view additional features within each group, click on the arrow at the
bottom right of each group.

Each of the tabs contains the following tools:

Home: Clipboard, Fonts, Paragraph, Styles, and Editing.
Insert: Pages, Tables, Illustrations, Links, Header & Footer, Text, and Symbols
Page Layout: Themes, Page Setup, Page Background, Paragraph, Arrange
References: Table of Contents, Footnote, Citation & Bibliography, Captions, Index, and Table of
Authorities
Mailings: Create, Start Mail Merge, Write & Insert Fields, Preview Results, Finish
Review: Proofing, Comments, Tracking, Changes, Compare, Protect
View: Document Views, Show/Hide, Zoom, Window, Macros
Create New Documents à
There are several ways to create new documents, open existing documents, and save documents in
Word:
Click on Microsoft Office Button and Click New or Press CTRL+N (Press the CTRL Key while pressing the
“N”) on the Keyboard
You will notice that when you click on the Microsoft Office Button and Click New, you have many
choices about the types of documents you can create. If you wish to start from a blank document,
click Blank. If you wish to start from a template you can browse through your choices on the left, see
the choices on center screen, and preview the selection on the right screen.
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Opening an Existing Documentsà
Click on Microsoft Office Button and click Open, or
Press CTRL+O on the Keyboard
and click the name of the document in
If you have recently used document you can click the
the Recent Documents section of the window Insert picture of recent docs
Saving a Document à
and click Save or Save As (remember, if you’re sending the document to someone who
Click the
does not have Office 2007, you will need to click the
Click Save As, and click Word 97-2003 document), or
Press CTRL+S on the Keyboard
Renaming a Document à
Click the Microsoft Office Button and find the file you want to rename
Right-Click the document name with the mouse and Select Rename from the Shortcut Menu
Type the new name for the file and press Enter Key.
Working on Multiple Documents à
Several documents can be opened simultaneously if you are typing or editing multiple documents at
once. All open documents will be listed in the View Tab of the Ribbon when you click on switch windows.
The current document has a checkmark beside the file name. Select another open document to view
it.
Document View:
There are many ways to view a document in word:
Print Layout: This is a view of the document as it would appear when printed. It includes all tables, text,
graphics, and images.
Full Screen Reading: This is full view length view of a document. Good for viewing two pages at a time.
Web Layout: this is a view of the document as it would appear in web browser.
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Outline: This is an outline form of the document in the form of bullets.
Draft: This view does not display pictures or layouts, just text.
To view a document in different forms, click the document views shortcuts at the button of the screen:

Or: Click on View Tab on the Ribbon àClick on appropriate document view
Close a Document à
To close a document àClick

àClick Close

Editing a Document à
Formatting Text à
Typing and Inserting Text: To enter text, just start typing! The text will appear where the blinking cursor
is located. Move the cursor by using the arrow buttons on the keyboard or positioning the mouse and
clicking the left button. The keyboard Shortcuts listed below are also helpful when moving through the
text of a document:
Move Action
Beginning of the Line

Keystroke
HOME

End of the Line
Top of the Document

END
CTRL+HOME

End of the Document

CTRL+END

Selecting a Text à
To change any attributes of text it must be highlighted first. Select the text by dragging the mouse over
the desired text while keeping the left mouse button depressed, or hold down the SHIFT key on the
keyboard while using the arrow buttons to highlight the text. The following table contains shortcuts for
selecting a portion of the text:
Selection

Technique

Whole Word

Double click within the word

Whole Paragraph

Triple click within the Paragraph

Several Words or Line

Drag the mouse over the words, or Hold down SHIFT+Arrow Key

Entire Document

ChoseàEditingàSelectàSelect All from Ribbon or Press Ctrl+A

Inserting Additional Text à
Text can be inserted in a document at any pint using of the following methods:
Type Text: Put your cursor where you want to add the text and begin typing
Copy and Paste Text: Highlight the text you want to copy and right click and click Copy, put your cursor
where you want the text in the document and right click and click Paste.
Cut and Paste Text: Highlight the text you wish to copy and right click and click Cut, put your cursor
where you want the text in the document and right click and click Paste.
Drag Text: Highlight the text you wish to move, click on ut and drag it to the place where you want the
text in the document.
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You will notice that you can also use the Clipboard group on the Ribbon.
Cut (CTRL+X)
Copy (CTRL+C)
Paste (CTRL+V)

Rearranging Block of Text à
To rearrange text within a document, you can utilize the Clipboard Group on the Home Tab of the
Ribbon. Insert picture of clipboard group labeled
Move Text: Cut and Paste or Drag as shown above
Copy Text: Copy and Paste as above or use the clipboard group on the Ribbon
Paste Text: Use CTRL+V or use the Clipboard group to Paste, Paste Special, or Paste as Hyperlink
Deleting Block of Text à
Use the Backspace or Delete Keys on the Keyboard to delete text. Backspace will delete text to left of
the cursor and Delete will erase text to the right. To delete a large selection of text, highlight it using any
of the methods outlined above and press the Delete key.
Search and Replace Text à
To find a particular word or phrase in a document:
Click Find on the Editing Group on the Ribbon
To find and replace a word or phrase in the document, click Replace on the Editing Group of the
Ribbon.
You can use CTRL+F for Find and CTRL+H for Replace.

Undo Changes à
Click on the Undo Button (

) of Quick Access Toolbar

You can use CTRL + Z for Undo Changes
Styles à
A style is a format enhancing tool that includes font typefaces, font size, effects (bold, italics, underline
etc.), colors and more. You will notice that on the Home Tab of Ribbon, that you have several areas
that will control the style of your document: Font, Paragraph, and Styles.
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Change Font typeface and Size à
To change Font typeface:
Click the arrow next to the font name and choose a font
To Change the Font Size:
Click on arrow next to the font size and choose the appropriate size, or
Click the increase or decrease font size button.
Font Styles and Effects à
Font styles are predefined formatting options that are used to emphasize text. They include: Bold, Italic,
and Underline. to add these to text:
Select the text and click the Font Styles included on the Font Group of Ribbon or
Select the text and right click to display the font tools
Change Text Color à
To change the text color:
Select the text and click the colors button included on the Font Group of the Ribbon, or
Highlight the text and right click and choose the colors tool.
Select the color by clicking the down arrow next to the font color button.

Highlight Text à
Highlighting text allows you to use emphasize text as you would if you had a maker. To highlight text:
Select the text
Click the Highlight Button on the Font Group of the Ribbon, or
Select the text and right click and select the highlight tool
To change the color of the highlighter click on down arrow next to the highlight button
Copy Formatting à
If you have already formatted text the way you want it and would like another portion of the document
to have the same formatting, you can copy the formatting. To copy the formatting, do the following:
Select the text with the formatting you want to copy
Copy the format of the text selected by clicking the Format Painter button on the Clipboard Group of
the Home Tab
Apply the copied format by selecting the text and clicking on it.
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Formatting Paragraphà
Formatting paragraphs allows you to change the look of the overall document. You can access of the
tools of Paragraph formatting by clicking the Page Layout Tab of the Ribbon or the Paragraph Group
on the Home Tab of the Ribbon.
Change Paragraph Alignmentà
The Paragraph alignment allows you to set how you want text to appear. To change the alignment:
Click the Home TabàSelect Paragraph from Ribbonà Under General Tabà Select Alignment from List
Align Left: The text is aligned with your left margin
Center: The text is centered within your margin
Align Right: Aligns text with the right margin
Justify: Aligns text to both the left and right margins
Indent Paragraphsà
Indenting paragraphs allows you to set text within a paragraph at different margins. To indent
Paragraph, you can do: The Home Tab à Select Paragraph from Ribbon à Indention Tab à Select
Indentation Setting.
There are several options for indenting:
• First Line: Controls the left boundary for the first line of a Paragraph
• Hanging: Controls the left boundary of every line in a Paragraph except the first one
• Left: Controls the left boundary for every line in Paragraph
• Right: Controls the right boundary for every line in Paragraph

Add Borders and Shading à
You can add borders and shading to paragraphs and entire pages. To create a border around a
paragraph or paragraphs:
Select the area of text where you want the border or shading
Click the Borders Button on the Paragraph Group on the Home Tab
Choose the Border and Shading
Choose the appropriate options
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Create a Table à
To create a table:
Place the cursor on the page where you want the new table
Click the Insert Tab of the Ribbonà Click the Tables Button on Table GroupàYou can create a table
one of four ways:
Highlight the number of row and columns
Click Insert Table and enter number of rows and columns
Click the Draw Table, create your table by clicking and entering the rows and columns
Click Quick Tables and choose a table

Enter Data in a Tableà
Place the cursor in the cell where you wish to enter the information, Begin typing.
Modify the Table Structure and Format a Tableà
To modify the structure of table:
Click the table and notice that you have two new table on the Ribbon: Design and Layout. These
pertain to the table design and layout.

4.8 I The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program

On the Design Tab, you can choose:
Table Style Options
Table Styles
Drawn Borders
To Format a table, click the table and then click the Layout Tab on Ribbon. This Layout tab allows you
to:
View Gridlines and Properties (from the Table Group)
Insert Rows and Columns (from the Rows & Columns Group)
Delete the Table, Rows and/or Columns (from the Rows & Columns Group)
Merge or Split Cells (from the Merge Group)
Increase and Decrease cell size (Cell Size Group)
Align text within the cells and change text directions(Alignment Group)

Spelling and Grammar à
To check the spelling and grammar of document
Place the cursor at the beginning of the document or the beginning of the want to check
Click the Review Tab on the Ribbon
Click Spelling & Grammar on the Proofing Group.

Any errors will display a dialog box that allows you to choose a more appropriate spelling or phrasing.
If you wish to check the spelling of an individual word, you can right click any word that has been
underlined by Word and choose a substitution.
Spling

The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program I 4.9

Microsoft Office
Mail Merge in Word à
Mail merge is a tool which allows you to create form letters, mailing labels and envelopes by linking
a main document to a set of data or data source. It is the process of combining a list of data with a
template.
The mail merge process involves the following:
The Main Document - contains the text and graphics that are the same for each version of the merged
document.
Data Source - a file that contains the information to be merged into a document. For example, the
names and addresses of the recipients of a letter.
Mail Merge - Form Letters à
Open Microsoft Word
Type the letter with all needed text and formatting leaving areas for the data source data blank (ex
name, address….)
Click the Mailings tab
Click Start Mail Merge
Click Step by Step Mail Merge Wizard

The Mail Merge task pane appears on the right of your screen. Note there are 6 steps.
Step1à
Click Letters for the document type
Click Next: Starting document
Step2à
Click Use the current document under Select starting document
Click Next: Select recipients
Step3à
The recipients can come from either an existing Excel file, or Access table or you can create a new list.
If Using an Existing List:
Click Use an existing list under Select recipients
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Click Browse
Select the file
Click Open
Mail Merge Recipients opens showing the names and addresses from your file
Click OK

Click Next: Write your letter
To Type a New List:
Click Type a new list under Select recipients
Click Create
Click Customize Columns to modify the list of fields
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• Delete any unnecessary field names and/or add new ones
• Click OK
• Type records here hitting TAB to advance to the next field and to continue adding new records

• Click OK
• Click Save
The recipients list will be saved as a separate file as a Microsoft Access file type. It is saved in the
My Data Sources folder. It is recommended to save the file in this folder.
• Click Next: Write your letter
Step4 à
• Click the location in your document where the data from the mail merge fields need to be inserted
• Click Address block…
• Select the address elements you want included
• Click OK
The field name will look like this: <<AddressBlock>>
The Address block will insert the following fields
including any necessary punctuation: First Name,

Last Name, Company, Address 1, Address 2, City,
State, Postal Code.
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If your fields do not match the ones listed above or
you have additional fields, click More items…
• Click on the field from the list
• Click Insert
• Click Close
The field name will look like this - «First_Name»
• Repeat this step until all fields have been inserted.
Remember to put spaces and punctuation where
needed.
• Click Next: Preview your letters
Step5 à
Here is where you can preview the first page with the fields
filled in.
Click Next: Complete the merge
Step6à
To Complete the Merge:
• Click Print to send directly to the printer
• Click Edit individual letters to create a new file
Remember to save your document as you go. The next time you open your document and click
on Step by Step Mail Merge, the data file will be attached.
Mail Merge- Labels à
• Open a new blank document
• Click the Mailings tab
• Click Start Mail Merge
• Click Step by Step Mail Merge Wizard
Step1à
• Click Labels for the document type
• Click Next: Starting document
Step2 à
• Click Label options under Change document layout
• Choose the label style you are using
• Click OK
• Click Next: Select recipients
Step3 à
• Click Use an existing list under Select
Recipients
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• Click Browse
• Select the file that contains the names and addresses

• Click OK
• Click Next: Arrange your labels
Step4 à
• Click in the first label box and click on either Address block or More items to insert the data fields

• Click Update all labels to include the fields on all labels
• Click Next: Preview your labels
Step5 à
Here is where you can preview the labels:
• Click Next: Complete the merge
Step6 à
Click Print to send directly to the printer
Or
Click Edit individual labels to create a new file
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Tabs à
Tabs allow you to create simple tables of data that line up along a particular vertical position. You
can also use advanced tab settings to create paper forms for print outs, or basic tables of contents.
Generally, these items contain dotted or solid lines for you to sign on or to indicate a page number for
a topic - these lines can be generated with leader tabs.
Basic tabs with alignment à
There are several different kinds of alignments with tabs we will explore some of them here.
• A Left tab stop sets the start position of text that will then run to the right as you type.
• A Center tab stop sets the position of the middle of the text. The text centers on this position as you
type.
• A right tab stop sets the right end of the text. As you type, the text moves to the left.
• A Decimal tab stop aligns numbers around a decimal point. Independent of the number of
digits, the decimal point will be in the same position. (You can align numbers around a decimal
character only; you cannot use the decimal tab to align numbers around a different character,
such as a hyphen or an ampersand symbol.)
• A bar tab stop doesn’t position text. It inserts a vertical bar at the tab position.
To Change Default Tab stop à
• On the PAGE LAYOUT Ribbon, click the PARAGRAPH DIALOG BOX LAUNCHER.
• In the PARAGRAPH dialog box, click TABS.
• In the DEFAULT TAB STOPS box, enter the amount of spacing that you want between the default
tab stops.
Note: When you press the TAB key, your tab will stop across the page at the distance that you specified.
Set manual tab stops with ruler à
You might want to use the ruler to set manual tab stops at the left side, middle, and right side of your
document. If you don’t see the horizontal ruler that runs along the top of the document, click the VIEW
RULER button at the top of the vertical scroll bar.
You can quickly set tabs by clicking the tab selector at the left end of the ruler until it displays the type
of tab that you want and then clicking the ruler at the location you want.
To use the horizontal ruler to set tab stopsà
• By default, there are no tab stops on the ruler when you open a new blank document.
• The final two options on the tab selector are actually for indents. You can click these and then
click the ruler to position the indents, rather than sliding the indent markers along the ruler. Click
FIRST LINE INDENT, and then click the upper half of the horizontal ruler where you want the first line
of a paragraph to begin. Click HANGING INDENT, and then click the lower half of the horizontal
ruler where you want the second and all following lines of a paragraph to begin.
• When you set a BAR TAB STOP, a vertical bar line appears where you set the tab stop (you don’t
need to press the TAB key). A bar tab is similar to strikethrough formatting, but it runs vertically
through your paragraph at the location of the bar tab stop. Like other types of tabs, you can set
a bar tab stop before or after you type the text of your paragraph.
• You can remove a tab stop by dragging it (up or down) off the ruler. When you release the mouse
button, the tab stop disappears.
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• You can also drag existing tab stops left or right along the ruler to a different position. When
multiple paragraphs are selected, only the tabs from the first paragraph show on the ruler. If you
set manual tab stops, the default tab stops are interrupted by the manual tab stops that you set.
Manual tab stops that are set on the ruler override the default tab stop settings.
Set manual tab stops with dialog à
If you want your tab stops at precise positions that you can’t get by clicking the ruler, or if you want
to insert a specific character (leader) before the tab, you can use the TABS dialog box. To display this
dialog box, double-click any tab stop on the ruler.

To set manual tab stopsà
• On the PAGE LAYOUT Ribbon, click the PARAGRAPH DIALOG BOX LAUNCHER.
• In the PARAGRAPH dialog box, click the TABS button. The following dialog appears.
• In the DEFAULT TAB STOPS box, enter the amount of spacing that you want between the default
tab stops.
Note: When you press the TAB key, your tab will stop across the page at the distance that you specified.
Tab stop positionà
Type the position on the ruler where you want to create a new tab stop, or select an existing tab stop
from the list to modify its properties.
Default tab stopsà
Specifies amount of spacing that is applied each time you press the TAB key.
Tab stops to be clearedà
Displays tab stops that have been marked for deletion from the TAB STOP POSITION list. Cleared tabs
are deleted from the list when you click OK.
Alignment à
• LEFT Sets a left start position of text that will then run to the right as you type.
• CENTER sets the position of the middle of the text. The text centers on this position as you type.
• RIGHT Sets a right start position of text that will then run to the left as you type.
• DECIMAL Aligns numbers around a decimal point. Independent of the number of digits, the
decimal point will be in the same position. (You can align numbers around a decimal character
only; you cannot use the decimal tab to align numbers around a different character, such as a
hyphen or an ampersand symbol.)
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• BAR Inserts a vertical bar at the tab position. Not used for positioning text.
Creating Leader Tabs à
Use this feature to fill the empty space before a tab stop with dotted, dashed or solid lines. This effect
is most commonly seen in a table of contents. The right aligned tab for the numbers in the example
below has a dotted leader tab.
Chapter 1

1

Chapter 2

12

Chapter 3

20

TO CREATE A LEADER FROM AN EXISTING TABà
• On the PAGE LAYOUT Ribbon, click the PARAGRAPH DIALOG BOX LAUNCHER.
• In the PARAGRAPH dialog box, click the TABS button. The TABS dialog appears.
• Select the tab stop in the TAB STOP POSITION: list.
• Choose one of the 4 Leader types.
• Click on the SET button to save the tab.
• Click on OK to return to the document.
Note: You can also create the Tab from scratch in the Tab dialog box
To create a new tab and assign a leader à
• On the PAGE LAYOUT Ribbon, click the PARAGRAPH DIALOG BOX LAUNCHER.
• In the PARAGRAPH dialog box, click the TABS button. Type in the new tab position in the TAB STOP
POSITION: field
• Choose the ALIGNMENT and optionally choose the LEADER (the default is None).
• Click on the SET button to save the tab.
• Choose OK.
Note: The Clear button removes the selected tab, whilst Clear All removes all the tabs in the selected
paragraph(s). Note tabs are a paragraph format and as such will display differently when you click in
different paragraphs.
The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program I 4.17

Microsoft Office
Bulleted and numbered lists à
Word has tools for automatically assigning bullets and numbers to lists. You can choose from a variety
of different number formats and select which bullet symbols to use. You can also create multi-level
lists very easily using this feature. With numbered lists, if you move, delete or add items, Word will
automatically renumber the list so that you always have the correct numeric sequence.
Bullets à
Bullets are symbols that can be used to denote list items or headings. They attach themselves to
paragraphs within a document.
To create a bulleted list à

• Type the list one line under the other.
• If you want blank lines of space between list items select the lines and use the SPACE AFTER setting
in the PARAGRAPH dialog.
• Click the BULLETS button in the PARAGRAPH group to apply bullet symbols to your list using the
default bullet style (the button will switch on).
Remove Bulletsà
When you want to add a paragraph underneath your last list item, you may find that the bullets
continue. This is because bullets and numbers are paragraph level formats and Word will copy them
from one paragraph to the next when you press the ENTER key. When you don’t want the bullets
any more, if you press ENTER again, Word will assume that you have finished your list and remove it
accordingly.
To switch bullets offà
• Click the cursor on the paragraph where the bullet is, or if the bullets are on several paragraphs,
select them.
• Click the BULLETS button in the PARAGRAPH group (the button will switch off)
Define A New Bulletà
The bullets menu gives you a small selection of pre-picked bullet symbols for you to choose from. If
none of those is suitable for your list, you can define a new bullet from scratch with a palette that
contains a bigger selection of symbols. You can also change the indent positions of your list items.
(Using the paragraph dialog).
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To define a new bullet à
• Click on drop down arrow to right of
BULLETS and choose DEFINE NEW BULLET
a dialog will appear.
• Click the SYMBOL button to select
a different symbol. This displays the
symbol dialog below:
• Initially Word displays symbols from the
Symbol font. You can choose from a
different font by clicking the drop down
list arrow to the right of the FONT box.

Wingdings, Webdings and Monotype Sorts have a large variety of useful symbols to use for bullet points.
When you alter the bullet symbol Word will use that symbol for all new lists when the Bullets button is
clicked.
• Click on a symbol from the palette to select it then click OK to go back to the previous dialog. The
selected bullet will be displayed in one of the preview panes.

• Click the FONT button to access the FONT dialog if you want to make changes to bullet size and
style.
Numbering à
You can add numbers to paragraphs in a document. Word lets you choose between varieties of
different numbering styles.
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To apply numbers to a list à
• Type the list. And select it.
• If you want blank lines of space between list items select the lines and use the AFTER setting in the
PARAGRAPH dialog.
• Click the NUMBERS button on the PARAGRAPH group to apply numbers to your list (the button will
switch on).
Remove Numbers à
When you want to add a paragraph underneath your last list item, you may find that the numbers
continue. This is because bullets and numbers are paragraph level formats and Word will copy them
from one paragraph to the next when you press the ENTER key.
To switch numbers off à
• Click the cursor on the paragraph where the
number is, or if the numbers are on several
paragraphs, select them.
• Click the NUMBERS button on the PARAGRAPH
group.(Button will switch off).
To change the numbering style à
• Select the numbered list.
• Use the drop down arrow to the right of the
numbering button to see a selection of
numbering styles after making a different
selection click to apply style to highlighted list.
You may wish to create your own style of numbering
for your document this is very easy in 2007:
To create a numbering styleà
• Use the drop down arrow to the right of the NUMBERING button to see a selection of numbering
styles select at the bottom DEFINE A NEW NUMBER FORMAT. The dialog box to the above right is
displayed with the options:
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• Click the drop-down list arrow to the right of the NUMBER STYLE box. Word offers a variety of
different numbering styles for lists, standard Arabic numbers, and Roman numerals and so on.
• Click on the required style from the displayed list.
• Click on the FONT button. The FONT dialog opens allowing you to select font options for the
selected number style.
• After selection click OK to return you to the DEFINE NEW NUMBER FORMAT dialog box.
• Add other characters to the NUMBER FORMAT text box to enhance your number style. Use this
option to add extra digits to numbers (e.g. if you want extra decimal places) or to add prefix and
suffix characters (e.g. the word “Item”, -dash etc.).
• Use the ALIGNMENT drop down box to allow a change in alignment of the numbers to left, right or
centre.
• Click OK to apply all options selected to your list.
To change numbered list indents à
• Select the list.
• Open the PARAGRAPH dialog using the DIALOG BOX LAUNCHER.
• To change the number position, set the left indent to where you want the bullet to appear

• From the SPECIAL drop down box select HANGING.
• In the by box set the measurement where you want the text to start.
• Click OK to apply the new indents to the selected items and close the dialog
To Change Start Number of List à
Some list points can be several paragraphs long. When this is the case, you will need to switch the
numbering off for those paragraphs that “belong” to the previous paragraph’s number. When you are
ready to start numbering again, Word will allow you to continue using the next number in sequence.

To change the start number à
• Click in the numbered paragraph you wish to change the number for.
• Click on the drop down arrow to the right of the NUMBERING button and select, near the bottom
• SET NUMBERING VALUE a dialog will appear.
The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program I 4.21

Microsoft Office
• Enter the desired number value in the SET VALUE TO box and click OK. The paragraph should now
begin with the desired number.

To continue numbering from a previous list à
• Click in the numbered paragraph you wish to change the number for.

• Click on the drop down arrow to the right of the NUMBERING button and select, near the bottom
SET NUMBERING VALUE a dialog will appear.
• 3. Select CONTINUE FROM PREVIOUS list and click OK your list should now continue numbering from
the previous list.
Start A New List à
There may be occasions where you need to end one list and begin a new one straight away. Unless you
tell it otherwise, Word will assume that the numbering should follow on in sequence from the previous
list.
To restart numberingà
• Click in the numbered paragraph you wish to change the number for.
• Click on the drop down arrow to the right of the NUMBERING button and select, near the bottom
SET NUMBERING VALUE a dialog will appear.
• Select START NEW LIST and click OK your list should now start again from 1.
Applying A Multi-Level List à
You can apply lists using Word’s automatic numbering tools that have many different list levels. This is
useful if the list you are creating has sub-points which need to line up properly. Word will initially use the
top level style for all list items. Use the keyboard to demote and promote items to the required levels.
To apply a multi-level list à
• Type the list one line under the other.
• If you want blank lines of space between list items select the lines and use the SPACE AFTER setting
in the PARAGRAPH dialog.
• Use the drop down arrow to the right of the MULTI-LEVEL NUMBERING button to see a selection of
multi-level numbering styles after making a selection click to apply style to highlighted list.
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To promote an item à
Position the cursor somewhere in the paragraph, or if you want to demote several paragraphs, select
them and click the indent button in the paragraph group or press the TAB key.
To demote an item à
Position the cursor somewhere in the paragraph, or if you want to demote several paragraphs, select
them and click the outdent button or hold down the SHIFT and TAB key.
To Define A New Multi Level List à
If none of the multi level lists suit your purposes it is possible to define one of your own with many options
all in one places to set the indents and number styles required for your document:

To define new list à
• Use the drop down arrow to the right of the multi-level numbering button and near the bottom;
choose DEFINE NEW MULTI-LEVEL LIST a dialog (above) will appear.
• Select a level to modify (1-9)
• Click the drop-down list arrow to the right of the NUMBER STYLE box. Word offers a variety of
different numbering styles for lists, standard Arabic numbers, and Roman numerals and so on.
• Click on the required style from the displayed list.
• Click on the FONT button. The FONT dialog opens allowing you to select font options for the
selected number style.
• Add other characters to the ENTER FORMATTING FOR NUMBER text box to enhance your number
style. Use this option to add extra digits to numbers (e.g. if you want extra decimal places) or to
add prefix and suffix characters (e.g. the word “Item”, -dash etc.).
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Position à
• Use the NUMBER ALIGNMENT drop down box to allow a change in alignment of the numbers to
left, right or centre.
• Either enter a number or use the spin buttons to set the indent for the number or character for this
level.
• Either enter a number or use the spin buttons to set the indent for the text you will type at this level
(where you want your text to start).
• If you want the same set of indents for all levels then click the SET FOR ALL LEVELS button the
indents chosen will be applied for all levels within your list.
• You may now work through the levels selecting the alignment, number stle and formatting for as
many levels as you would use.
• Click ok to complete and create your new multi level list
Bullets And Numbering With The Shortcut Menu à
You can apply Bullets and Numbering from the shortcut menu that appears when you click the rightmouse button over a selection.
To use shortcut menu for bullets/numbering à

• Select the items to numbered or bulleted.
• Position the mouse anywhere over the highlighted area and click the right mouse button.
• From the resulting shortcut menu, choose the Bullets or Numbering options you should see the
same options as if you had used the drop down arrow to the right of the buttons on the home
ribbon.
• Click on the style you want to apply that style of bullets or numbering to your selected text.
Apply Bullets And Numbers As You Type à
You can tell Word that you are about to type a numbered or bulleted list by starting the first list item
in a special way. When you press ENTER to start a new line, Word will aut format your current text with
standard bullets and numbers.
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To apply bullets as you typeà
Start the list by typing an asterisk and then press TAB. Type the list text item immediately after and then
press ENTER. Word will change the asterisk to the standard bullet symbol and start the next line with the
bullet, ready for you to type the next item.
To apply numbers as you typeà
Type the first number and press TAB. Type the first list item immediately after and then press ENTER. Word
will continue the numbering on the new line ready for you to type the next item. You can use a soft
return to insert blank (un-numbered or un-bulleted) lines between list items.
Text formatsà
Word divides formatting into two types – Character formats and paragraph formats. Character formats
can be applied to individual characters within a document. They include BOLD, italic and different
font styles and sizes. Paragraph formats affect whole paragraphs and control the layout of text on a
page such as alignment, indents and so on.

Character Formatsà
Word is best suited to applying formats to text that has already been typed. It is often better to get the
raw information in the document without worrying about how it looks and then going back afterwards
and applying the formats.

Formatting Font Group à
The formatting font group on the HOME ribbon contains buttons for applying some of the most
commonly used formats.
Font Styleà
The font style controls what individual characters look like. True
Type fonts will always look the same on screen as in a printed
copy. Some fonts are specified (the characters have “curly”
edges, whilst others are plain (sans serif).

To change the font à
• Select the text to change.
• Click on the drop-down list arrow to the right of the currently displayed font name.
• Select the font to use – the selected text will alter accordingly
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Point Sizeà
This controls the size of the printed characters.
To change the point sizeà
• Select the text to change.
• Click on the drop-down list arrow to the right of the currently displayed point size.
• Pick a new number from the list – the selected text will change size accordingly.
Bold, Italic And Underlineà
Bold, italic and underline can be applied to the selection using buttons on the formatting toolbar or
keyboard shortcuts.
Apply bold, italic or underlineà
• Select the text to change.
• Click on either the B, I or U buttons on the toolbar. The button will “switch on” and the selected text
will display the applied format.
Remove Bold, Italic and Underlineà
• Select the text with the format.
• Click the Bold, Italic or underline button to turn the format off.
Text Highlightsà
Just as you can use a fluorescent marker to highlight the salient points on a printed page, Word allows
you to highlight text on screen. Highlights will show in the printed document in colour if you have a
colour printer, or in grey tones if you have a black and white printer.
To highlight textà
• Click the button to switch the highlight tool on.
• Drag your mouse over the text to highlight.
• When you have finished, click the highlight button once more to switch the tool off.
Font Colourà
This will change the colour of on-screen text. It will also print the text in the chosen colour if you are
connected to a colour printer.
To change font colourà
• Select the text you want to change.
• Click the drop-down list arrow displayed on the right-hand side of the button and choose the
desired colour.
To reset font colourà
• Select the text you want to reset to the default colour.
• Click the drop-down list arrow displayed on the right-hand side of the Font colour button.
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• The Automatic option will reset text back to the default colour (normally black).
Font dialog à

The Formatting group contains the most commonly applied formats; however there are more options
available in the Format Font dialog box.
To access the Font dialog boxà
• Select the text to format.
• Clicking on the DIALOG BOX LAUNCHER in the font group will open the FONT dialog.
• The dialog box contains two tabs – FONT and CHARACTER SPACING which are discussed below.
Font Tabà
Many of the options on the Font tab are the same as those on the formatting toolbar, however, the
UNDERLINE options include some extra underline styles. The dialog box also has more effects than can
be achieved using the formatting toolbar.
To apply underline styles from dialogà
• Select the text to format.
• Access the FONT dialog and click the FONT tab.
• Click the drop-down arrow to the right of the UNDERLINE STYLE box – a list of different underline
options will appear.

• Choose your preferred option by clicking on it. The PREVIEW window at the bottom of the dialog
box displays a preview of how your text will look if you choose to keep the applied formats.
• Click the OK button to keep the format. Clicking CANCEL will abandon any choices you have
made and close the dialog box.
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Effectsà
Most of the effects change the appearance of the characters. SUPERSCRIPT and SUBSCRIPT allow
you to raise and lower characters (e.g. 10m2 or H2o). Some effects have more useful functions – for
example HIDDEN renders text on-screen and in the printed document invisible, particularly useful if
you want to hide references to the source of a document or picture so they don’t get printed. Note
however than Hidden text will show on-screen if the Show/Hide button is clicked on.

To apply effects à
• Select the text to format.
• Access the FONT dialog and click the FONT tab.
• Check the boxes by clicking in them with the mouse next to the relevant options to switch an
effect on. The Preview window will show you what each one looks like.
• Uncheck the boxes to switch an effect off.
Some effects can be switched on in combination, others are mutually exclusive (for example you
cannot have both Small Caps and All Caps applied as switching one on will automatically disable the
other.
Character Spacing Tabà
This tab contains options that allow you to increase or decrease the amount of space between
individual characters in a word, or raise or lower those characters in relation to the other characters
positioned on the same line. The PREVIEW window at the bottom of the dialog will display what the
selected text will look like as you change the settings.

Scaleà
Changes the size and space between the individual characters in the selection.
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To alter the scaleà
• Select the text to format.
• Access the FONT dialog and click the CHARACTER SPACING tab.
• Click the drop down list next to the default Scale setting to list other percentage scales, some
bigger and some smaller than the current figure.
• Choose a larger percentage to increase the space between the characters in the selected
text and make the characters proportionally larger as well. Choose a smaller figure to squash
characters together and also decrease their size in proportion to the scale percentage chosen.
To change spacingà
• Select the text to format.
• Access the Font dialog and click the character spacing tab.
• Click the drop down arrow to the right of the Spacing option.
• Choose “Expanded” (more space between the individual characters) or “Condensed” (less
space between the individual characters).
• Use the By box which has up and down arrows that can be clicked to increase or decrease by
how many points (or tenths of points) the characters are expanded or condensed.
Positionà
“Normal” position places the characters on the same level as the other characters on that line. You
can choose to have text raised or lowered instead.
To change character positionà
• Select the text to format.
• Access the FONT dialog and click the CHARACTER SPACING tab.
• Display the list by clicking the arrow to the right of the Position box.
• Choose “RAISED” or “LOWERED” – the By box then allows you to increase or decrease (again in
tenths of points) by how much your characters should deviate from the base line position.
Kerningà
You need this option because some fonts are proportional and others are not.
PROPORTIONAL fonts will adjust the amount of space between one character and the next depending
on what that character is; for example the letter “l” is a thin character and does not need as much
space as an “e”.
NON-PROPORTIONAL fonts allocate the same amount of space for each character regardless of its
width. The POINTS AND ABOVE box allows you to set a size above which Word will kern the fonts – if
you are using a proportional font and you have used the Spacing option, you may need to switch the
Kerning on to prevent the same amount of spacing being allocated to each character.
To activate kerningà
• Select the text to format.
• Access the FONT dialog and click the CHARACTER SPACING tab.
• Click in the KERNING FOR FONTS check box to switch kerning on.
• Use the POINTS AND ABOVE box to set the size at which Word will begin to kern fonts.
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• When you have set all the options you require on this tab, click OK to apply them. CANCEL will
abandon any changes you may have made.
Paragraph formats à
When you need to control how a paragraph lines up on a page, you apply paragraph formats. As with
character formatting, some of the most commonly used options appear as buttons on the Formatting
toolbar whilst others can only be accessed via the Paragraph dialog box.
Alignment à
You can select from four different alignment options in Word by clicking the relevant button (described
below) :
To change alignment à
• Position the cursor in the paragraph whose alignment you want to change, or if you are aligning
several paragraphs, highlight them.
• Click on the button for the alignment you require (see below).
• Click this button to left-align paragraphs. Left alignment ensures that the left edge of each line in
the paragraph begins at the same place. Because of the word-wrapping, the right-hand edge of
the paragraph won’t line up exactly; this is sometimes called a “ragged” edge. Left alignment is
the default alignment for new Word documents.
• Click this button to centre paragraphs. This will make each line of the paragraph position its centre
point in the middle of the page. Both the left and right edges of the paragraph will be ragged.
• Click this button to right-align paragraphs. Right alignment ensures that the right edge of each line
in the paragraph begins at the same place – the left edge will be ragged.
• Click this button to justify paragraphs. This ensures that both the left-hand and right-hand edges of
the lines in the paragraph begin and end at the same position, eliminating any ragged edges.
Indentsà
Indents allow you to control the white space at the left and right hand side of a paragraph. There are
a variety of different methods for setting indents which are described below.
To indent from the leftà
• Click the cursor inside the paragraph whose alignment you want to change or, if you are aligning
several paragraphs, highlight them.
• Click the increase indent button to indent the selected paragraphs by ½ an inch from the left. You
can click this button again to increase by a further ½ inch and so on.
• If you need to decrease the indent by ½ inch, click the decrease indent button to do this.
Proofing Text à
Spell checker & Thesaurusà
Auto Spelling /Grammar Checkà
The proofing tools in Word are very useful in ensuring that the documents you print and distribute are
as error-free as possible.
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Word 2007 automatically checks spelling and grammar as you type provided the options have
been set in the Word Options. Spelling mistakes are flagged by a wavy red line under the error whilst
grammatical faults show with a wavy green line. You can correct these mistakes as they are flagged
by moving the mouse over the error and clicking the right mouse button – a shortcut menu will appear
offering suggestions.
To correct a flagged mistakeà
• Click the right mouse button over the flagged mistake (e.g. a miss-spelt word).
• Click on a suggestion from the top section of the short cut menu to replace the flagged word or
phrase with the one offered by the spell/grammar checker.
Manual Spelling/Grammar Checkà
You can check the spelling and grammar of your document in one go by launching the spell/grammar
checker. There are several ways you can do this, but as Word will start checking from wherever your
cursor is down the document; it makes sense to first move the cursor to the very beginning (use CTRL
HOME) before you commence the check).
To launch the spelling/grammar checker à
• Click the SPELLING & GRAMMAR button from the REVIEW ribbon in the PROOFING TOOLS group.
• Word will launch the Spelling and Grammar dialog shown below:

• The “error” shows in red in the box marked NOT IN DICTIONARY while any suggestions are listed in
the box below. Down the right-hand side of the dialog are a series of buttons allowing you to carry
out different commands and these are described below:
To ignore the mistakeà
• Click IGNORE to ignore the highlighted word and move on to the next item.
To add a word to the custom dictionaryà
• Clicking ADD TO DICTIONARY appends the highlighted word to your custom dictionary, ensuring
that it will never be flagged as an error again. The spelling/grammar check will move on to the
next item.
To change the mistakeà
• Select the suggestion you want to replace the highlighted item with by clicking it with the mouse.
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• Click the CHANGE button, to substitute the suggestion for the flagged word and move you to the
next item.
If you have made the same mistake throughout a document, when the spell/grammar check hits the
first one you can correct them all by clicking the CHANGE ALL button. The check will move on to the
next item.
To use Autocorrectà
• Click AUTOCORRECT to allow Word to make a decision about the error for you using its AutoCorrect
feature.
To undo a commandà
• If you don’t like the replacement you can click the UNDO button which will become available at
the bottom of the dialog to go back one step.
Pausing The Spell/Grammar Checkà
When a check is launched, you can see the highlighted items that Word considers to be errors behind
the dialog box that it supplies to correct them. If none of the options in the dialog box are suitable you
can follow the instructions below to make changes.
To pause the spelling/grammar checkerà
• Click outside the box, in the document itself and make manual corrections. This will pause the
spell/ grammar check (the dialog box options will appear “dimmed”).
• Once you have finished editing, click the RESUME button to reactivate the spell/grammar check.
End The Checkà
When Word can find no further errors it will display the following dialog box:
• Click OK to complete the check.
Thesaurusà
Word’s Thesaurus can be used to look up alternatives to words you have typed in a document. Whilst
it mainly helps to find synonyms to words, in some instances it will also look up antonyms. You can then
click buttons in the dialog box to replace the looked up word with your chosen synonym.
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To launch the Thesaurusà
• Select the word you want to look up.
• Click the THESAURUS button from the REVIEW ribbon in the
PROOFING TOOLS group.

You may leave the thesaurus TaskPane
open and type other words directly into the
search for text box and pressing enter or
you may elect to close the TaskPane
by clicking on the cross in the top left hand
corner.
Choosing A Meaningà
If the synonyms offered don’t match the context in which you are using the word you are looking up,
you can select a different meaning.
To choose a meaningà
• Move your mouse over the most appropriate word, a drop down arrow will appear.
• Select an option if you choose to look up then the thesaurus will look for other synonyms of that
word.
• Choosing insert will replace selected word in document.
• Choosing copy will allow you to paste the word later in an appropriate place in your document.
Headers And Footersà
Headers and footers are used for items that you want to appear on every page of your document.
The header appears in the top margin and the footer in the bottom margin. Examples of the types of
things you might want as your header would include, a logo the current file name or the current date
and time. The most common footer item is page numbers.

When you are adding header or footer items, Word automatically sets the view to Print Layout as
this is the only working view where you can see the header and footer area. (There is print preview
mentioned later. While you are in the header or footer, the rest of the document appears dimmed
to show that it is currently unavailable for editing. As soon as you close the header or footer, your
document comes back “online”.
To insert headers and footersà
• Go to the HEADER & FOOTER group on the INSERT ribbon and click the HEADER or FOOTER button.
• Select a choice from the displayed selection to apply it to your document.
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Insert Header And Footer Basic Field Codes à
The DESIGN ribbon for Headers and Footers has some buttons that you can use to place the current
DATE & TIME, or the PAGE NUMBER and in the header or footer. The buttons insert these items as field
codes. Field codes are pieces of program code that give Word an instruction to do something in the
document at the point they have been inserted. The main reason they are so useful to use is that they
will update automatically every time the document is saved or printed.
So for example, if you were printing a daily time sheet, you could insert a date field in the header which
would always return the current date, regardless of when you print it out.

To enter page numbers à
• Go to the HEADER & FOOTER group on the INSERT ribbon and click the HEADER or FOOTER button
click on EDIT HEADER or footer.
• Position the cursor where you want the information.
• Click the PAGE NUMBER button from the DESIGN ribbon and make a selection choosing any one
of the first four options opens a side bar allowing you to place the number left, centre or right. If
these are not what you want then click on current position to insert the numbering where your
mouse cursor has been placed.
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To format page numbers à
• Go to the HEADER & FOOTER group on the INSERT ribbon and click the HEADER or FOOTER button
click on EDIT HEADER or footer.

To remove page numbersà
• Go to the HEADER & FOOTER group on the INSERT ribbon and click the HEADER or FOOTER button
click on EDIT HEADER or footer.
Different Odd Even Page Numberingà
Word also gives you an option to allow you to place your page numbering in different locations on odd
and even pages. It is useful if you are going to print our document and bind it you may wish the page
numbers on the outer side of each page.
To apply different numbering for odd/even pagesà
• Open the page layout dialog by clicking on the DIALOG BOX LAUNCHER from PAGE SETUP group
on the PAGE LAYOUT ribbon and go to the LAYOUT tab
• Check the box marked DIFFERENT ODD AND EVEN.
• Click OK to save the settings and close the dialog box.
• You now have a different sections in your header or footer called ODD PAGE HEADER and
EVEN PAGE header where you can employ completely different headers and footers including
numbering in different locations
Converting Word Document to Web Pageà
• Click on office Button
• Then Click on Save As Option
• Then Select Web Page from Save as type option
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• Then click on Save to publish the Word document to Web Page

Converting Word Document to PDF à
• Click on Office Button
• Then click on Save As Option
• Now Select PDF or XPS from the list
• Now click on Publish to Save the word file as PDF file.
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UNIT - 5
MICROSOFT EXCEL - 2007
Introduction à
Excel 2007 is a powerful spreadsheet application that allows users to produce tables containing
calculations and graphs. These can range from simple formulae through to complex functions and
mathematical models

Windows Conceptsà
Excel is an application that runs under the Windows graphical user interface. When launched, Excel
sits in its own window” - the box that surrounds the application elements. The window can be moved,
sized, closed, minimized and maximized using the features common to the Windows environment these are listed below:
Window Borderà
The box that surrounds the Excel screen when it is not maximized is called the window border. When the
mouse is over the border, the pointer changes from a single to a double-headed arrow - clicking and
dragging with this shape allows the window to be resized.
Title Barà
The colored bar that appears at the top of the Excel window. The title bar tells you which application
you are using and if the workbook you are in is maximized, it will also contain the name of the workbook.
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If the Excel window is not maximized, by positioning the mouse over the title bar and clicking and
dragging, you can move the Excel window to a new location on the screen.
Maximize Buttonà
When working in a workbook, the Excel screen contains two windows, an application window and a
workbook window. You can maximize both windows to capitalize on the space you have on-screen.
If you would like the window that your Excel application is in to fill up the whole screen, click the
outermost maximize button. You may find that the workbook you are in can still be bigger - click the
inner maximize button to fill the remaining space within the Excel application window.
Minimize Button à
This button is very useful if you need to temporarily switch from Excel into another application without
closing Excel down completely. Click the minimize button to shrink Excel to an icon on the task bar; you
will then be able to view other icons and applications you may wish to access. When you are finished
and ready to continue, click the Excel icon from the task bar to resume. The innermost minimize button
will minimize the current workbook window.
Restore Button à
This button only appears when a window is maximized. A maximized window has no border and you
cannot see what is behind it. If you want to put the window back inside its border so that you can move
and size it, click the restore button.
Close Buttonà
This button is used to close a window. If you click the close button for a workbook window you close the
document. The last button will close the Excel application.
Dialog Box Launcher à
This button launches dialog boxes specific to the part of the ribbon you see them the category will be
named such as FONT, CLIPBOARD, etc
Ribbonsà
Home Ribbonà
Ribbons are tabs that show different commands with respect to what you wish to do. The Home Ribbon
shows basic formatting options.

Insert Ribbonà
The Insert Ribbon allows the insertion of any object. Just click on the named ribbon to see list of
commands that you can perform by clicking on the appropriate icon.

Name Boxà
The Name Box is the small white box to the left of the Formula Bar. It has a number of useful features
such as navigation, the creation and selection of named cells and ranges. Entering a cell reference
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and pressing return will navigate you to the specific cell entered. Using the drop down arrow to the
right of it will allow you to select any specified names in the workbook. When creating functions the
box will have a different appearance and will allow you to choose the most popular functions used in
that workbook.
Formula Barà
The Formula Bar is the white bar to the right of the Name Box and is used for entering and editing
data, creating and editing functions and formulae. The construction of formulae and functions can be
seen in this bar even when the cell containing the formula is showing a calculated value (Unless cell is
formatted to hidden and the sheet protected). The fx button on the left of the bar is a tool to create
functions and formulae.
Worksheetsà
You use worksheets to list and analyze data. You can enter and edit data on several worksheets
simultaneously and perform calculations based on data from multiple worksheets. When you create
a chart, you can place the chart on the worksheet with its related data or on a separate chart sheet.
The names of the worksheets appear on tabs at the bottom of the workbook window. The name of the
active sheet is bold.

Status Barà
The Status bar, across the bottom of the screen, displays different information at different times. To
the left is an indicator, which will display Ready, Edit etc. depending on the mode in which the user
is currently working. If menus are being accessed, this area will usually give details on the currently
highlighted menu option. If you are in the middle of a task - copying data for example - this area will
often display messages and prompts instructing you on what to do next.
To the right of the Status bar, keyboard status indicators reveal whether the Num Lock etc. are switched
on.
Task Paneà
A task pane is a window that collects commonly used actions in one place. The task pane enables
you to quickly create or modify a file, perform a search, or view the clipboard. It is a Web-style area
that you can either, dock along the right or left edge of the window or float anywhere on the screen.
It displays information, commands and controls for choosing options. Like links on a Web page, the
commands on a task pane are highlighted in blue text, they are underlined when you move the mouse
pointer over them, and you run them with a single click.
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Smart Tagsà
Smart Tags, first introduced in Microsoft Office XP, make it easier for you to complete some of the more
common tasks and provide you with control over automatic features. You do not have to complete
any additional steps to make the Smart Tags appear or disappear in Excel. The Paste Options, AutoFill
Options, Trace Error and Insert smart tags appear automatically to allow you to quickly choose actions
and remain in place until you begin another action. For example, when you complete a paste
operation, the Paste Options button remains in place alongside your text until you begin typing new
text.

This feature alerts you via a smart Tag of a possible error in a cell. You can select a command to resolve
the error, ignore it, or access further Error Checking options. The example above right shows the use of
a smart tag where a formula has been written into a cell with a possible error
i.e. = Sum (A1:A2) may need to read =Sum (A1:A3). If you hover over the tag, the message, the formula
in this cell refers to a range that has additional numbers adjacent to it, appears then the options drop
down.
Moving Around Workbookà
With such a large working area available, you need to be aware of some of the techniques used for
moving around the workbook. It is possible to move using either the keyboard or the mouse.
Mouse à
The mouse is good if you want to move small distances. Click the white plus on any cell that you want
to move to. The cell you clicked on becomes the selected cell. Depending on the position of the
mouse in relation to the active cell, Excel displays different pointer shapes. The shape that must be
displaying when moving to a cell or selecting cells is:
Keyboardà
You can select a cell by moving around with your cursor keys. (Arrow keys on your keyboard). Having
selected a cell, by double clicking the cell it becomes the active cell with a flashing cursor. You can
also make a cell active by clicking in the Formula Bar or by pressing the F2 key:

Please note that while any cell is active various commands will not be available until the cell is no longer
active. You may close the cell by pressing return or cancelling whatever was entered by pressing esc.
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To Scroll

Do This

One row up or down

Click the arrows in the vertical scroll bar.

One column left or right

Click the arrows in the horizontal scroll bar.

One window up or down

Click above or below the scroll box in the vertical scroll bar.

One window left or right

Click to the left or right of the scroll box in the horizontal scroll bar.

Useful Keys for Moving à
The table below lists some useful tips for scrolling:
When dragging the scroll box a scroll tip will display, showing the row or column you will move to when
you release the mouse.
To Move

Do This

One Cell Up, Down, Left or Right

[][][à][]

Up One Screen

[PAGE UP]

Down One Screen

[PAGE DOWN]

Left One Screen

[ALT][PAGE UP]

Right One Screen

[ALT][PAGE DOWN]

To Edge of Worksheet (or current block of [CTRL][Relevant Arrow Key]
data)
To a Particular Cell

[F5] then type the reference for the cell required and
press Return

To column A in the current row

[HOME]

To cell A1

[CTRL][HOME]

Keyboard à
When you need to move further, it is better to use the keyboard. The table below lists useful movement
keys.
Workbook Sheets à
To move between sheets: Each new workbook contains worksheets, named Sheet 1 to Sheet 3. The
sheet name appears on a tab at the bottom of the workbook window.
Mouseà You may click on any sheet tab to go to that sheet
Keyboardà Press [CTRL][PAGE DOWN] to move to the next sheet, or [CTRL][PAGE UP] to move to the
previous sheet.
Moving Around Sheet à
To Move to Specific Cell à
Press [F5] on the keyboard à Type the cell reference that you want to move to in the Reference box
and press Enter Key.
Cancelling and Editing Data Entriesà
To abandon or cancel entry: You may find that you have typed an entry into the wrong cell. Provided
you have not confirmed the entry by pressing [Return] or clicking the green tick from the formula bar,
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you can abandon it by pressing [ESC] key from the keyboard or click the Red Cross from the Formula
Bar.
To edit a confirmed entryà Double click on the cell containing data to be edited or press F2 from the
keyboard.
Select Informationà
To select cells with the mouseà
To Select

Do this

A Single Cell

Click the cell, or press the arrow keys to move to the cell.

A range of cells

Click the first cell of the range, and then drag to the last cell.

All cells on a worksheet

Click the Select all button

Nonadjacent
ranges

cells

or

cell Select the first cell or range of cells, and then hold down [CTRL] and
select the other cells or ranges.

A large range of cells

Click the first cell in the range, and then hold down [SHIFT] and click
the last cell in the range. You can scroll to make the last cell visible.

An entire row

Click the row number. Click

An entire column

the column letter.

Adjacent rows or columns

Drag across the row or column headings. Or select the first row or
column; then hold down [SHIFT] and select the last row or column.

Nonadjacent rows or columns

Select the first row or column, and then hold down [CTRL] and select
the other rows or columns.

More or fewer cells than the Hold down [SHIFT] and click the last cell you want to include in the
active selection
new selection
To select cells with the keyboardà
To Select

Do this

The activate cell plus one Cell up, down, left [SHIFT][↑], [SHIFT][↓], [SHIFT][→], [SHIFT][←]
or right
To edge of Worksheet (or current block of [SHIFT][CTRL][Relevant Arrow Key]
data)
The current Region

[CTRL][*]

Whole column

[CTRL][SPACEBAR]

Whole Row

[SHIFT][SPACEBAR]

Whole Worksheet

[CTRL][A]

Select Multiple Sheetà
Using Mouse: Hold Shift Key and click last worksheet that you want included in your selection. All the
sheets between the first and last will be selected. To select non adjacent worksheets use Ctrl key with
mouse.
Formulaà
In a spreadsheet application, at a very basic level, values often need to be added, subtracted,
multiplied and divided. To allow for the fact that individual values might change, spreadsheet formula
generally refers not to actual values, but to the cells where those values are being held. If values have
been entered into A1 and A2, then A1A2 will return an answer which will automatically recalculate if
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the value of A1 should change. It is this automatic recalculation which makes spreadsheets invaluable.
Excel recognizes formula because they are preceded by an equals sign (=). When entering basic
formula, the mathematical operators defining the operation to be carried out are as follows:
Additions

+

Subtraction

-

Multiplication

*

Division

/

/Exponential

^

Typing Formulaà

You enter formula by typing them in the cell where you want the formula’s result to appear. When you
confirm entry of a formula, Excel will display the result on the worksheet, but the underlying calculation
appears on the Formula bar.
To enter a formulaà
(a) Move to the cell where you want to enter the formula.
(b) Type an equals sign (=).
(c) Type the formula (e.g. d2*e2).
(d) Press [RETURN] to confirm the entry.
(e) Excel automatically recalculates formulae. If you change one of the cells referenced in your
formula, as soon as you press [RETURN] to confirm the changed value, your formula result will
update.
Entering Formula by Pointing à
It is possible to enter formulae without actually typing the equals sign (=) or the cell references. Instead,
you can make use of a pointing technique to indicate which cells are to be included. As with typing
formulae, it is important to start off in the cell where the answer is to be displayed.
Pointing can be quicker and more efficient than typing cell references as it reduces the chances of
errors.
To enter a formula using keyboard AND mouse à
(a) Position the cursor in the cell where you want the formula.
(b) Type an equals sign (=).
(c) Click the first cell whose reference should be included in your formula. A moving dotted line,
known in Excel as a ‘marquee’, will appear around that cell and the cell reference will appear in
the formula bar immediately after the equals sign.
Or
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(d) Use an arrow key to move there. A moving dotted line, known in Excel as a ‘marquee’, will appear
around that cell and the cell reference will appear in the formula bar immediately after the equals
sign.
(e) Type in the mathematical symbol you want to use in your calculation, then click on (or move to)
the next cell to be included in the formula.
(f)

Continue building the formula in this way. g) Press [RETURN] to complete the formula.

Filling Formula à
Having entered an initial formula in the first cell of a column or row, you often find that you want to
generate results for the other cells in that column or row. In the example below, you would probably
want your formula to work out totals for all the orders.

There are several ways that you can get Excel to copy a formula so that it generates results for other
cells in a column or row.
The Fill Handle and Formula à
Using Mouse: Position the mouse pointer on Fill Handle, cursor shapes changes to black plus now drag
the mouse up to your desired location.

Using Keyboard: Copy the cell containing formula, now select the range of cells where you want to
copy it, now, press the Enter key to copy the formula or select the cell containing the formula to fill and
the cells where you want to copy it, now press [CTRL][D] to fill down or [CTRL][R] to fill right.
Functionsà
Sum Functionà
Having mastered how to set up your own custom formulae, you will be able to carry out any calculations
you wish. However, some calculations are complicated or involve referring to lots of cells making entry
tedious and time consuming. For example, you could construct a formula to generate a total at the
bottom of a column (or the end of a row), like this: = D2D3D4D5
The above formula would work, but if there were 400 cells to total and not just 4, you would get bored
with entering the individual cell references and would run out of space (formulae are limited to 1024
characters only). When formula become unwieldy or complex, Excel comes to the rescue with its own
built-in formulae known as functions.
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Functions always follow the same syntax:

The name of the selected function tells Excel what you want to do and the arguments generally tell
Excel where the data is that you want to calculate. Excel has a huge number of functions, not all
of them are relevant to everyone. The functions are categorized according to what they do. In this
manual, we outline some of the functions that can be used at a general level.
Autosum à

(a) Move selected cell to bottom of column or end of row of figures.
(b) Click on the formulas Ribbon, then click on autosum. From the menu select the sum function
(c) A ‘marquee’ will appear around the suggested range to sum and a pre-built function will appear
in selected cell.
(d) If suggested range is correct then press [RETURN]. If not redefine range by selected the figures you
wish to include in the function and press [RETURN].
The Shortcut Key For The Sum Function Is [ALT] [=]
Other Common Functions à
The Sum function is very useful, but the AutoSum icon can also be used to for some other common
functions: Average (of the selected figures), Count (the number of selected figures), Max (the largest
selected figure) and Min (the smallest selected figure).
Average Functionà
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(a) Select the cell immediately below a column of figures (or to the right of a row of figures) to be
totaled.
(b) Click on the drop-down arrow next to the AutoSum icon and select the function that you want to
use from the list.
(c) The selected function will automatically appear in the Formula bar and Excel will make a guess at
which Cells you want to use (you will see a marquee around the cells and their references will be
the function arguments).
(d) Press [RETURN] to accept the cells that Excel proposes.
Function Library à
On the formulas ribbon you will find the function library which is dedicated to functions AUTOSUM
functions are just a few of the most regularly used functions.

The functions are broken down into categories and grouped accordingly to make it easy to access the
specific function you desire to use. In many places you will see the MORE FUNCTIONS command which
allows access to the whole range of functions available to excel. This brings us to the INSERT FUNCTION
utility.
Insert Function à
If after looking through all categories you do not find, or find it difficult to locate a specific function then
we can use the INSERT FUNCTION facility. Which contains all functions available in excel.
Using Mouse:
(a) Click the cell where you want a result
(b) Go to the FORMULAS ribbon and click on the INSERT FUNCTION icon on the far left
(c) The INSERT FUNCTION dialog box appears

(d) Type a description of the function you wish to use in the topmost box and click on go OR select a
category from the drop down box
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(e) Results will appear in the bottom box then select a specific function with a single click of the
mouse
(f)

A description will appear underneath the white box and the syntax of how it is constructed

(g) If further explanation is required on a specific function then click on the blue hyperlink in the
bottom left corner to get more information.
(h) When the function you want is selected (in this case COUNTA) click OK.
(i)

A dialog box appears (below right) with a suggested range for the function. Excel will place the
function on the worksheet in the selected cell. You can see the selected function being built on
the formula bar. If this is incorrect reselect the range and press [RETURN].

(j)

Click the Range selector button. This will collapse the dialog box shown above.

(k)

Drag across the cells to replace Excel’s pre selected guess with your own cell references. Click the
button marked on the picture below to return to the dialog.

Cell Referencesà
In functions, you often need to refer to a range of cells. The way Excel displays cell references in
functions depends on whether the cells you want the function to act upon are together in a block or
in several non-adjacent cells or blocks.
The table below explains how you can use different operators to reference cells:
Operator

Description

Example

Reference operator:
(colon)

Range operator, which produces one reference to all B5:B15
the cells between two references, including the two
references

, (comma)

Union operator, which combines multiple references SUM(B5:B15,D5:D15)
into one reference

(single space)

Intersection operator, which produces one reference SUM(B5:B15 A7:D7)
to cells common to two references - In this example,
cell B7 is common to both ranges

Counting and Totaling Cells Conditionally à
Occasionally you may need to create a total that only includes certain cells, or count only certain cells
in a column or row.
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The example above shows a list of orders. There are two headings in bold at the bottom where you
need to generate a) the total amount of money spent by Viking Supplies and b) the total number of
orders placed by Bloggs & Co. The only way you could do this is by using functions that have conditions
built into them. A condition is simply a test that you can ask Excel to carry out the result of which will
determine the result of the function.
Use Sumif()à
You can use this function to say to Excel, “Only total the numbers in the Total column where the entry
in the Customer column is Viking Supplies”. The syntax of the SUMIF() function is detailed below:
= SUMIF(range,criteria,sum_range)
Range is the range of cells you want to test.
Criteria are the criteria in the form of a number, expression, or text that defines which cells will be
added. For example, criteria can be expressed as 32, “32”, “>32”, “apples”.
Sum range these are the actual cells to sum. The cells in sum range are summed only if their corresponding
cells in range match the criteria. If sum range is omitted, the cells in range are summed.
= SUMIF(B2:B11, “Viking Supplies”, F2:F11)
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With the example above, the SUMIF function that you would use to generate the Viking Supplies Total
would look as above. Using the INSERT FUNCTION tool the dialog would look like this and show any
errors in entering the values or ranges.
Use Countif()à
The COUNTIF function allows you to count those cells that meet a certain condition. The function
syntax is as follows:
=COUNTIF(range,criteria)
Range is the range of cells from which you want to count cells. Criteria are the criteria in the form of
a number, expression, or text that defines which cells will be counted. For example, criteria can be
expressed as 32, “32”, “>32”, “apples”.
With our example (shown above), the COUNTIF function that you could use to determine the number
of orders placed by Bloggs & Co. would look like this: =COUNTIF(B2:B11, “Bloggs & Co.”).
Relative and Absolute Referencesà
Relative Referencesà
When you fill formulae, you tell Excel to base the formulae it creates on the one you have entered by
starting from the cell that contains it.

In the example shown right, the formula being copied says =D2*E2. However, once copied, if you click
on any of the copies, Excel will have updated the references to keep the row numbers current (D3*E3,
D4*E4 and so on).
This is because Excel, by default, uses relative referencing. When you enter a formula, you enter specific
cell references. Behind the scenes, Excel ‘translates’ those references into positions relative to the result
cell. So, in our example shown left, Excel would take the formula:
= D2*E2
Translate it as follows:
= [two cells to the left]*[one cell to the left].
It therefore does not matter which row you copy the formula into, Excel will always use “[two cells to
the left] multiplied by [one cell to the left]” to generate the result. Most of the time, this is what you
would want, but there are occasions where you need to stop Excel updating cell references when you
copy formulae.
Absolute Referencesà
The example below shows a formula being created to work out the amount of discount each order
would receive. The order totals are in column F and the discount rate is in B13. The initial formula has
therefore been set up as:
=F2*B13
The formula will generate a result for the first order. However, when copied, you will get zeros against
the discount amounts for the other orders. This is due to the relative referencing that Excel applies to
all formulae by default.
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Having copied the above formula, if you clicked on any formula in the Discount amount column below
the first one, you would see that Excel has updated the references (=F3*B14, F4*B15). This is where
the problem lies - you want Excel to change the first reference as your formula needs to refer to the
different order totals, but the discount rate should remain constant. You need to make that reference
absolute.
To make a reference absolute à
(a) Move to the cell where you have typed the formula and press [F2] to access Edit mode.
(b) Move the cursor with the arrow keys so that it is next to the reference we want to fix.
(c) Press [F4]. Dollar signs will appear against the column letter and the row number.
(d) Press [RETURN] to confirm the change.
(e) In our example, amending the formula to read: =F2*$B$13
(f)

This would prevent Excel from changing the B13 reference when the formula is copied.

You can get the fill handle to fill formulas down to the same level as the entries in the previous column
by double-clicking on it.
Pressing [F4] repeatedly over a reference allows you to toggle between making both the row and
column absolute ($A$1), just the column absolute ($A1), just the row (A$1), or nothing absolute (A1).
Moving and Copying Data à

Having entered information in a worksheet, you may decide that you need to reposition it or use cell
entries in another worksheet or file that you have created. The good thing about Excel is that once
you have entered something once, you can move or copy it anywhere - to other Excel files and
even to files that belong to other applications. All Microsoft products use the same terminology when
describing moving and copying items - cut, copy and paste. These terms stem from the times when
typesetters would lay out templates by physically cutting an item from its current location, and gluing
or pasting it in to the new location.
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Moving Itemsà
Using Mouse:
(a) Select the cells that you want to move.
(b) Click the CUT button on the hOME Ribbon. The selected cells will display a marquee around them
(c) and Excel will show a prompt on the Status bar to tell you what to do next.
(d) Click the Paste button from the HOME ribbon
(e) Press [ENTER].

Using Keyboard:
(a) Select the cells you want to move.
(b) Press [CTRL][x] to cut the cells out a marquee will appear around the cells, and you will see a
prompt on the status bar.
(c) Move to the cell where you want the cut cells to jump to. If you have cut a block of cells, the cell
you select before you paste is where you want the top left cell in the cut block to move to.
(d) Press [CTRL][V] to paste the cells into their new location.
Copying Itemsà
Using Mouse:
(a) Select the cells that you want to copy.
(b) Click the Copy button on the HOME Ribbon. The selected cells will display a marquee around
them and Excel will show a prompt on the Status bar to tell you what to do next.
(c) Move to the cell where you want to place the cells you cut. If you have cut a block of cells, the
cell you select before you paste is where you want the top left cell in the cut block to move to.
(d) Click the Paste button from the hOME ribbon the copied cells will appear
(f)

Press [ENTER]. The copied cells will appear.

Using Keyboard:
(a) Select the cells you want to copy.
(b) Press [CTRL][C] to make a copy. Excel displays a marquee around the copied cells and a prompt
on the Status bar.
(c) Move to the cell where you want the copy to go. If you have copied a block of cells, the cell you
select before you paste is where you want the top left cell in the copied block to be positioned.
(d) Press [CTRL][V] to paste the copy back in.
(e) Press [ENTER].
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Drag and Dropà
You can move and copy cells by selecting and dragging them with the mouse. When you do this, you
must ensure that you have the correct mouse pointer shape displaying before dragging and dropping.
When you select a cell or a group of cells, Excel outlines them with a heavy border. When the mouse is
moved slowly over this border, it will display a white arrow which points up and to the left - and a four
arrowed cross in black this is your drag and drop pointer and allows you to move and copy cells with
the mouse.
To Moveà
Using Mouse:
(a) Select the cells you want to move or copy.
(b) Point to the border of the selection.
(c) With the drag and drop pointer displaying, drag the selection to the upper-left cell of the paste
area. You’ll see a fuzzy box, the same size as the selected block that will follow your mouse - when
you release the mouse the selected cells will jump to their new location.
To Copy à
Using Mouse:
(a) If you want to copy the selection, repeat steps one and two above but before clicking on to it
hold down the [CTRL] key on the keyboard, then begin clicking and dragging. You will see a plus
sign appear next to the mouse pointer to signal the fact that you are copying rather than moving.
(b) With the fuzzy box positioned where you want the copy, let go of the mouse first and then release
the [CTRL] key.
Paste Specialà
The Paste Special option gives you the ability to choose what should be pasted into the destination
cells. For example, you may want to paste data without its formats, or you might want to convert a
formula to a static value - Paste special gives you the choice. You can also use PASTE SPECIAL to add/
subtract/divide or multiply the copied cells with the destination cell data.
To use Paste Specialà
Using Mouse:
(a) Select the cells you want to copy.
(b) Right click anywhere within the highlighted block and choose Copy from the shortcut menu.
(c) Click the right mouse button over the cell where you want the copied data to appear. If you have
copied a block of cells, the cell you click before you paste is where you want the top left cell in
the copied block to move to.
(d) Choose Paste Special. The following dialog box will appear:
(e) Select an option in the PASTE section of the dialog to choose what will be pasted into the destination
cells
(f)

Select an option from the OPERATION section of the dialog to choose the mathematical operation
you want to perform on the copied data.

(g) Check the SKIP BLANKS box to suppress empty cells being pasted.
(h) Check the TRANSPOSE box to change the arrangement of the copied cells from column to row
and vice versa.
(i)

Click OK to close the dialog and paste the data.
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Formattingà
Having produced a spreadsheet, it may be formatted to achieve a more professional and more
easily readable layout of data for both screen display and printout. There are several different ways
of formatting data in Excel 2007 to produce extremely impressive effects, and many of the tools in the
Formatting groups on the HOME ribbon are used for the most popular formatting tasks. This section
looks at several different approaches to improving the layout of a spreadsheet.
Formatting Groups On Home Ribbon à

The Formatting groups are together on the home ribbon the buttons that create formats most frequently
used to enhance worksheet appearance. Not all the formats that you can apply in Excel are contained
in the Formatting group icons some can only be accessed via the dialog box which is accessed by the
dialog launch button found at the bottom right of a formatting group which is discussed later in this
section.
Font à
By default, Excel 2007 uses Calibri as its base font and all new worksheets will use this font for data
that you enter. However, you can choose different font faces for cells on the worksheet using the
Formatting toolbar.
To change the fontà
Using Mouse:
(a) Select the cells where you want to change the font.
(b) Click the drop-down list arrow to the right of the Font box in the Formatting group on the hOME
ribbon. c) The fonts are listed alphabetically. Use the vertical scroll bar on the right of the list to
move the list items up and down.
(d) Select the desired font by clicking on it. The font face for the selected cells will change to reflect
your choice.

Using Keyboard:
(a) Select the cells to change.
(b) Press [CTRL][ShIFT][F] to highlight the current font on the formatting toolbar.
(c) Use [ALT] [ð] to drop down the list of available fonts, use the up and down arrows to move the
highlight bar up and down the list and [RETURN] to apply the chosen font to the selected cells.
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Font Sizeà
This controls the size of the printed characters.

To change the point sizeà
Using Mouse:
(a) Select the cells with the data to change.
(b) Click on the drop-down list arrow to the right of the currently displayed point size.
(c) Pick a new number from the list - the selected cell data will change size accordingly.
Using Keyboard:
(a) Select the text to change.
(b) Press [CTRL][SHIFT][P] to highlight the current point size on the formatting toolbar.
(c) Either type the point size that you want to use (your typing will replace the currently selected
number) or use [ALT][↓] to display the list of point sizes and move the highlight bar to the selected
size using the up and down arrow keys.
(d) Press [ENTER] to apply the currently highlighted size to the selected cells.
Bold, Italic and Underlineà
Bold, italic and underline can be applied to the selection using buttons on the formatting toolbar or
keyboard shortcuts.

Apply and Remove bold, italic or underlineà
Using Mouse:
(a) Select the cells to change.
(b) Click on either the B, I or U buttons on the toolbar. The button will “switch on” and the selected text
will display the applied format.
(c) Clicking on the underline drop down arrow will give you the option of having double underline
instead of the regular single one. You may still toggle this off by clicking the U again
To Remove:
(a) Select the cells with the format.
(b) Click the Bold, Italic or underline button to turn the format off.
Using Keyboard:
(a) Select the cells to change.
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(b) Press [CTRL][B] to apply bold formatting, [CTRL][I] to apply italic formatting or [CTRL][U] to apply
single underline formatting to the selected cell data.
To Remove:
(a) Select the cells with the format.
(b) Press [CTRL][B], [CTRL][I] or [CTRL][U] to switch the format off.
Font Colorà
This will change the color of on-screen information. It will also print the information in the chosen color
if you are connected to a color printer.
To change font colorà
(a) Select the cells whose font color you want to change.
(b) Click the drop-down list arrow displayed on the right-hand side of the button and chooses the
desired color.
(c) Themes (see later) show complimentary color and shades on the theme that you may have
chosen for your worksheet (those in figure are default)
(d) There is also standard color to choose from
(e) If you still cannot find what you want from the default palette there are more colors to choose
from. click more colors to find any colors you desire.
Background Fill Colorà
If you want to shade the background of cells, use the Fill color button.
To change fill color:
(a) Select the cells whose background color you want to change.
(b) Click the drop-down list arrow displayed on the right-hand side of the
Fill color button.
(c) The NO FILL option will remove any applied fill color.
(d) The fill color palette has the same range of colors and color options
that in the text color drop down list.
Bordersà
When you print a worksheet, Excel allows you to choose whether you want all the cell gridlines to print
or not. Often you want to print some but not all of the lines - this is when you need to apply borders. You
can then tell Excel not to print the gridlines but your borders will be printed.
To apply bordersà
(a) Select the area you want to border.
(b) Click the drop-down list arrow to the right of the Borders
button on the Formatting toolbar.
(c) From the palette, click on the required border option.
To remove borders:
(a) Select the area with the borders you want to remove.
(b) Click the drop-down list arrow to the right of the
Borders button on the Formatting toolbar.
(c) From the palette, click on the first border option.
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Alignment à
You can select from three different cell alignment options in Excel by clicking the relevant button
(described below). The buttons determine how data lines up between the left and right edges of the
selected cell(s).
To change alignment:
(a) Select the cell(s) whose alignment you want to change.
(b) Click on the button for the alignment you require (see below).
(c) Click this button to left-align cell data. Left alignment ensures that the left edge of an entry is flush
with the left edge of the cell. Left alignment is the default alignment for text entries in cells.
(d) Click this button to centre cell data. This will make each cell entry in the selection position itself in
the middle of the cell.
(e) Click this button to right-align cell data. Right alignment ensures that the right edge an entry is flush
with the right edge of the cell. Right alignment is the default for numeric cell entries.
Merge Cells à
If you want to type a heading across the top of a table of data, it can be quite difficult to line it up in
the centre. If the columns in your table are different widths, or the title is a certain length, the chances
of you getting it exactly central along the top of the table are practically nil. Luckily Excel has a solution.
You can merge the cells across which you want the heading, centering it at the same time.

To merge cell:
(a) Select the cells you want to merge.
(b) Click the Merge and Centre button from the Formatting toolbar.

To Unmerge cell:
(a) Select the cells you want to unmerge
(b) Click the Merge and Centre button again and this will unmerge the cells selected
(c) As you can see from the figure right if you click the drop down arrow to the right of the merge cell
button you have options to merge cells with different alignments.
Number Formatsà
Initially, numbers in Excel use a General format. You may find that the results of formulae run to different
numbers of decimal places, or you might want to display numbers as monetary values with a currency
symbol and two decimal places. There is no need for you to enter the numbers in the way you want
them displayed - it is far better to use Excel’s number formatting buttons.
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INCREASE AND DECREASE DECIMAL PLACESà
You can add and remove decimal places from numeric data using the Increase Decimal and
Decrease Decimal buttons. Where you decrease, Excel will round numbers up or down to the nearest
unit. However many places that you may increase or decrease the value to excel will still use the
entered value to calculate not the value that appears in the cell as this is only an appearance not a
true value (check formula bar).
To increase decimals:
(a) Select the cells with the numbers you want to change.
(b) Click the INCREASE DECIMAL button from the ALIGNMENT group on the HOME ribbon
(c) Keep clicking the Increase Decimal button until your numbers display the correct number of
decimal Places.
To decrease decimals:
(a) Select the cells with the numbers you want to change.
(b) Click the DECREASE DECIMAL button from the ALIGNMENT group on the HOME ribbon
(c) Keep clicking the Decrease Decimal button until your numbers display the correct number of
decimal places.
Advanced Formatsà
When you want to apply formats that Excel does not give you buttons for on the Formatting toolbar,
you need to use the Format Cells dialog. This dialog contains all the formatting options (including those
accessible via the Formatting toolbar) that you can use within the Excel application.
Format Painterà
The Format Painter is a tool that you can use to copy all formats from one area of the worksheet to
another. This is particularly useful when you have spent time formatting one group of cells and you
decide that another group of cells should have the same formats - rather than reapplying the formats
again manually, one by one, you can paint them on to the new cells with the Format Painter.
To paint formats:
(a) Click the FORMAT PAINTER button from the HOME ribbon in the CLIPBOARD group. Your mouse
pointer will change to display a paintbrush next to the selection pointer (white plus).
(b) Select all the cells you want to apply the formats to by dragging over them. As soon as you release
the mouse, the formats will appear.
Shortcut Keys for Formattingà
Excel has some shortcut keys that you can use for formatting data. The table below lists those you can
use:
To
Display the Cells command (Format menu)
Apply the General number format
Apply the Currency format with two decimal places
(negative numbers appear in parentheses)
Apply the Percentage format with no decimal places

Press
[CTRL][1]
[CTRL][SHIFT][~]
[CTRL][SHIFT][$]

Apply the Exponential number format with two decimal places

[CTRL][SHIFT][^]

Apply the Date format with the day, month, and year

[CTRL][SHIFT][#]

Apply the Time format with the hour and minute, and indicate A.M. or P.M.

[CTRL][SHIFT][@]

[CTRL][SHIFT][%]
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Apply the Number format with two decimal places, 1000 separator, and - for [CTRL][SHIFT][!]
negative values
Apply the outline border
[CTRL][SHIFT][&]
Remove all borders
[CTRL][SHIFT][_]
Apply or remove bold formatting
[CTRL][B]
Apply or remove italic formatting
[CTRL][I]
Apply or remove an underline
[CTRL][U]
Apply or remove strikethrough formatting
[CTRL][5]
Hide rows
Unhide rows Hide
Hide columns
Unhide columns

[CTRL][9]
[CTRL][SHIFT][9]
[CTRL][0]
[CTRL][SHIFT][+]

Lookup Functionsà
As already mentioned, Excel can produce varying results in a cell, depending on conditions set by you.
For example, if numbers are above or below certain limits, different calculations will be performed and
text messages displayed. The usual method for constructing this sort of analysis is using the IF function.
However, as already demonstrated, this can become large and unwieldy when you want multiple
conditions and many possible outcomes. To begin with, Excel can only nest seven IF clauses in a main
IF statement, whereas you may want more than eight logical tests or “scenarios.” To achieve this, Excel
provides some LOOKUP functions. These functions allow you to create formulae which examine large
amounts of data and find information which matches or approximates to certain conditions. They are
simpler to construct than nested IF’s and can produce many more varied results.
Lookupà
Before you actually start to use the various LOOKUP functions, it is worth learning the terms that you will
come across, what they mean and the syntax of the function arguments.
Vector Lookupà
A vector is a series of data that only occupies one row or column. LOOKUP will look through this row or
column to find a specific value. When the value is found, a corresponding “result” in the adjacent row
or column is returned. For example, column D of a spreadsheet may contain figures, and the adjacent
column E contains corresponding text. LOOKUP will search for the requested figure in column D and
return the corresponding text from column E.
The syntax for LOOKUP is as follows:
= LOOkUP( lookup_value , lookup_vector , result_vector )
The lookup_value represents the number or text entry to look for; the lookup_vector is the area in
which to search for the lookup_value; the result_vector is the adjacent row or column where the
corresponding value or text is to be found.
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Note: It is essential that data in the lookup vector is placed in ascending order, i.e. numbers from lowest
to highest, text from A to Z. If this is not done, the LOOKUP function may return the wrong result.
In the diagram, column D contains varying salaries, against which there is a company car in column
E which corresponds to each salary. For example, a £20030 salary gets a Golf, a £35000 salary gets a
Scorpio. A LOOKUP formula can be used to return whatever car is appropriate to a salary figure that is
entered. In this case, the lookup_value is the cell where the salary is entered (B13), the lookup_vector is
the salary column (D3:D11), and the result_vector is the car column (E3:E11). Hence the formula;
= LOOKUP(B13,D3:D11,E3:E11)
Typing 40000 in cell B13 will set the lookup_value. LOOKUP will search through the lookup_vector to
find the matching salary, and return the appropriate car from the result_vector, which in this case is
Mercedes.
Alternatively, the formula could be simplified and cell references avoided by using Formula, Define
Name to give appropriate range names. Call B13 Salary, D3:D11 Salaries and E3:E11 Cars. The LOOKUP
formula could then be simplified to;
= LOOkUP(Salary,Salaries,Cars)
One of the advantages of the LOOKUP function is that if the exact lookup_value is not found, it will
approximate to the nearest figure below the requested value. For instance, if a user enters a Salary of
23000, there is no figure in the Salaries range which matches this. However, the nearest salary below
23000 is 20030, so the corresponding car is returned, which is a Golf. This technique is very useful when
the lookup_vector indicates grades or “bands.” In this case, anyone in the salary “band” between
20030 and 25000 gets a Golf. Only when their salary meets or exceeds 25000 do they get a Sierra.

There may be occasions where the lookup_value is below the lowest value in the vector. In this case
the #N/A message is displayed.
To insert a lookup functionà

(a) Click the drop down arrow next to the LOOKUP AND REFENCE button in the FUNCTION LIBARY
group on the FORMULAS Ribbon;
(b) A dialog box appears displaying the two versions of LOOKUP. There are two syntax forms; the first
is the “array” and the second the “vector.”
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Hlookupà
The horizontal LOOKUP function (HLOOKUP) can be used not just on a “vector” (single column or row
of data), but on an “array” (multiple rows and columns). HLOOKUP searches for a specified value
horizontally along the top row of an array. When the value is found, HLOOKUP searches down to a
specified row and enters the value of the cell. This is useful when data is arranged in a large tabular
format, and it would be difficult for you to read across columns and then down to the appropriate cell.
HLOOKUP will do this automatically.
The syntax for HLOOKUP is;
= HLOOKUP( lookup_value , table_array , row_index_number)
The lookup_value is, as before, a number, text string or cell reference which is the value to be found
along the top row of the data; the table_array is the cell references (or range name) of the entire
table of data; the row_index_number represents the row from which the result is required. This must be
a number, e.g. 4 instructs HLOOKUP to extract a value from row 4 of the table_array.
It is important to remember that data in the array must be in ascending order. With a simple LOOKUP
function, only one column or row of data, referred to as a vector, is required. HLOOKUP uses an array
(i.e. more than one column or row of data). Therefore, as HLOOKUP searches horizontally (i.e. across
the array), data in the first row must be in ascending order, i.e. numbers from lowest to highest, text from
A to Z. As with LOOKUP, if this rule is ignored, HLOOKUP will return the wrong value.
As an example, a user may have a spreadsheet which displays various different rates of interest for a
range of amounts over different time periods;
Whatever the amount a customer wants to borrow, he may pay up to five different rates of interest
depending on whether the loan is over 10, 15 or more years. The HLOOKUP function will find a specific
amount, then move down the array to find the appropriate interest rate for the required time period.

Designate cell A51 as the cell to hold the amount, i.e. the lookup_value; cells C43:H48 are the table_
array; the row_ index_number will be 2 if a customer wants the loan over 10 years, 3 if he wants the loan
over 15 years, and so on. Cell B51 holds this formula;
=HLOOKUP(A51,C43:h48,3)
The above formula looks along the top row of the array for the value in cell A51 (30000). It then moves
down to row 3 and returns the value 15.00%, which is the correct interest rate for a £30000 loan over 15
years. (Range names could be used here to simplify the formula).
As with the LOOKUP function, the advantage of HLOOOKUP is that it does not necessarily have to
find the exact lookup_value. If, for example, you wanted to find out what interest rate is applicable
to a £28000 loan, the figure 28000 can be entered in the lookup_value cell (A51) and the rate 14.30%
appears. As before, Excel has looked for the value in the array closest to, but lower than, the lookup_
value.
Vlookupà
The VLOOKUP function works on the same principle as HLOOKUP, but instead of searching horizontally,
VLOOKUP searches vertically. VLOOKUP searches for a specified value vertically down the first column
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of an array. When the value is found, VLOOKUP searches across to a specified column and enters the
value of the cell. The syntax for the VLOOKUP function follows the same pattern as HLOOKUP, except
that instead of specifying a row index number, you would specify a column index number to instruct
VLOOKUP to move across to a specific column in the array where the required value is to be found.
= VLOOKUP( lookup_value , table_array , col_index_number )
In the case of VLOOKUP, data in the first column of the array should be in ascending order, as VLOOKUP
searches down this column for the lookup_value. In the same spreadsheet as before, a VLOOKUP
formula could be used to search for a specific time period, then return the appropriate rate for a fixed
amount. In the following example, a time period is entered in cell A54 and in B54 the VLOOKUP formula
is contained;

Cell B54 holds this formula; =VLOOKUP(A54,C43:h48,5)
The cell A54 is the lookup_value (time period), the table_array is as before, and for this example rates
are looked up for a loan of £40000, hence the column_index_number 5. By changing the value of cell
A54, the appropriate rate for that time period is returned. Where the specific lookup_value is not found,
VLOOKUP works in the same way as HLOOKUP. In other words, the nearest value in the array that is less
than the lookup_value will be returned. So, a £40000 loan over 17 years would return an interest rate
of 16.00%.
Nested Lookupsà
One of the limitations of the horizontal and vertical LOOKUP functions is that for every lookup_value
changed, the column or row index number stays constant. Using our example, the HLOOKUP will search
for any amount, but always for the same time period. Conversely, the VLOOKUP will search for any time
period, but always for the same amount. In both cases, if you want to alter the time period and the
amount the formula must be edited to alter the column or row index number.
There is, however, a technique whereby one LOOKUP function is “nested” within another. This looks up
one value, which will then be used in a second LOOKUP formula as a column or row index number.
Using this technique allows you to, say, enter a time period and an amount and see the correct interest
rate.
Because nested LOOKUPs have more than one lookup_value, more than one array is needed. This
second array should consist of the column or row numbers to be used in the LOOKUP formula. The
example shows our main interest rates spreadsheet, with an additional two columns of data;
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Column J contains all the same time periods as column C, but alongside this are numbers 2 to 6,
indicating the row_index_ number to be returned for the appropriate time period. To look up this value,
use a simple vector LOOKUP formula, where K50 is the required time period, J43:J47 is the lookup_
vector and K43:K47 is the result_vector; LOOKUP(k50,J43:J47,k43:k47)
Notice there is no equals sign, because this formula is not being entered in a cell of its own. The formula
will return a value between 2 and 6 which will be used as a row_index_number in a HLOOKUP formula.
This HLOOKUP will look in the main interest rate table for an amount typed in by you, and will respond
to the row_index_number returned from the nested LOOKUP formula. The cells J50 and K50 hold the
amount and time period to be typed in by you, and the entire nested HLOOKUP, typed in J52, is as
follows;
=HLOOKUP(J50,C43:h48,LOOkUP(k50,J43:J47,k43:k47))
In the example, the time period 25 is vertically looked up in column J and the corresponding value 5 is
returned. Also, the amount 40000 is horizontally looked up in the main table, with a row_index_number
of 5. The end result is an interest rate of 18.50%. Simply by changing cells J50 and K50, the correct
interest rate is always returned for the amount and period typed in.
Goal Seeking and Solvingà
Excel has a number of ways of altering conditions on the spreadsheet and making formulae produce
whatever result is requested. Excel can also forecast what conditions on the spreadsheet would be
needed to optimize the result of a formula. For instance, there may be a profits figure that needs to be
kept as high as possible, a costs figure that needs to be kept to a minimum, or a budget constraint that
has to equal a certain figure exactly. Usually, these figures are formulae that depend on a great many
other variables on the spreadsheet. Therefore, you would have to do an awful lot of trial-and-error
analysis to obtain the desired result. Excel can, however, perform this analysis very quickly to obtain
optimum results. The Goal Seek command can be used to make a formula achieve a certain value by
altering just one variable. The Solver can be used for more painstaking analysis where many variables
could be adjusted to reach a desired result. The Solver can be used to not only obtain a specific value,
but also to maximize or minimize the result of a formula (e.g. maximize profits or minimize costs).
Goal Seekà

The Goal Seek command is used to bring one formula to a specific value. It does this by changing
one of the cells that is referenced by the formula. Goal Seek asks for a cell reference that contains a
formula (the Set cell). It also asks for a value, which is the figure you want the cell to equal. Finally, Goal
Seek asks for a cell to alter in order to take the Set cell to the required value.
In the example spreadsheet, cell B8 contains a formula that sums advertising and payroll costs. Cell B10
contains a profits formula based on the revenue figure, minus the total costs.
A user may want to see how a profit of 4000 can be achieved by altering payroll costs.
To launch the goal seekerà
(a) On the DATA ribbon, DATA TOOLS group, click WHAT-IF ANALYSIS and then click GOAL SEEK.
(b) In the Set Cell box, enter the reference for the cell that contains the formula result you wish to set
to a specific figure. (In the example, this is cell B4.)
(c) In the TO Value box, type the result you want. (In the example, this is -4000.)
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(d) In the BY Changing CELL box, enter the reference for the cell that contains the value you want to
adjust. (In the example, this is cell B3.)

The Goal Seek command automatically suggests the active cell as the Set cell. This can be
overtyped with a new cell reference or you may click on the appropriate cell on the spreadsheet.
(e) Click the Ok button and the spreadsheet will alter the cell to a value sufficient for the formula to
reach your goal. Goal Seek also informs you that the goal was achieved;
(f)

You now have the choice of accepting the revised spreadsheet, or returning to the previous
values. Click Ok to keep the changes, or CANCEL to restore previous values.

Goal Seek can be used repeatedly in this way to see how revenue or other costs could be used to
influence the final profits.
Simply repeat the above process and alter the changing cell reference.
The changing cell must contain a value, not a formula. For example, if you tried to alter profits by
changing total costs, this cell contains a formula and Goal Seek will not accept it as a changing cell.
Only the advertising costs or the payroll cells can be used as changing cells. Goal Seek will only accept
one cell reference as the changing cell, but names are acceptable. For instance, if a user had named
either cells B5 or B6 as “Advert_costs” or “Payroll” respectively, these names could be typed in the BY
CHANGING CELL box. For goal-seeking with more than one changing cell, use the Solver.
Sorting Dataà
Although not confined to database information, the sorting facility in Excel is particularly appropriate
for changing the order in which records are listed. Remember to save the file containing the database
information prior to sorting.
If you will need to restore the original record order, it is a good idea to include a column of record
numbers before sorting the database. This can be achieved simply by adding a column with a suitable
heading, and using the fill handle or the data series command to enter consecutive numbers adjacent
to each record.
When using any data handling techniques ensure you have: 1. Selected a cell somewhere in the data list
2. Have NO MORE than one cell selected.
Excel automatically selects the entire list for sorting. It compares the top rows of your list for formatting
differences. If there is a difference in the formatting of the top row, Excel identifies that row as column
labels and excludes it from the sort. This ensures the column labels will not be sorted with the rest of the
data.
To perform a single-level sort: (quick sort)à
(a) Select a cell in the list within the column by which you want to sort.
(b) Click the Sort Ascending or Sort Descending button from the DATA ribbon, SORT & FILTER group
To perform a multi-level sort:à
(a) Click within the data to be sorted.
(b) Choose Sort, button from the DATA ribbon, SORT & FILTER group. The following dialog box will
appear in which from which you may specify the Sort fields and the Sort order.
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(c) From the Sort By drop-down list, select the field you want to use as the main sort order.

(d) Select from the next drop down list what you want to sort on by default this will be the data
(values)
(e) Select the Ascending or Descending from the drop down list depending on which order you wish
the data sorted in.
(f)

Select add level

(g) Specify any sub-sorts using the Then By drop-down lists to pick the subsequent fields to sort by
when duplicates occur in the main sort field.
(h) You may add many levels to your sorting of data. If you wish to reorder your sorting levels use the
reorder buttons by selecting a level and moving it up or down
(i)

If you have an incorrect level in your many sort orders. Select it and click on delete level.

(j)

Click Ok. to apply sort orders

Custom Sorting Optionsà
The ascending and descending sort orders rearrange your list by alphabetical, numerical, reverse
alphabetical or reverse numerical order. For some types of data, such as months, this may not be the
order that you need to use. You can use one of the custom sort orders provided with the Excel program
to rearrange your data in chronological order by day of the week or by month.
To sort by a custom sort orderà
(a) Choose SORT, button from the DATA ribbon, SORT & FILTER group.
(b) From the SORT BY drop-down list, select the column by which you want to sort.
(c) From the SORT ON drop down list select what you want to sort on (Values)

(d) From the ORDER drop down list select CUSTOM LIST
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(e) The following dialog box will appear
(f)

Select a custom list from the left hand box.

(g) Click on Ok to close the list dialog and apply sort order to level and click on Ok again to perform
the sort.
Filtering a Listà
When you filter a list, you display only the sets of data that meet a certain set of search conditions
called criteria. The AutoFilter feature enables you to specify those search conditions from the list.
When you use the Data, Filter, AutoFilter command, drop-down list arrows are displayed next to each
of the column labels in the list. When you open a drop-down list, a list of all the unique entries for that
column is displayed. By selecting one of the entries from the drop-down list, called a filter criterion
you instruct Excel what to search for. Then Excel filters the list so that only the sets of data that contain
the entry you selected will be displayed. When Filter mode is active, arrows for the columns with filter
criterion selected appear in blue on the worksheet, row numbers appear in blue, and the status bar
displays either the number of rows that meet the criteria, or the text “Filter mode.” The sets of data that
do not meet the criteria remain in the list but they are hidden.
If you select a single cell in the list before choosing Filter drop-down list arrows are applied to all of
the column labels in your list. If you select multiple column labels before choosing Filter drop-down list
arrows are displayed only for the selected columns, thus restricting which columns you can apply filters
to. In either case, the entire list is filtered. Also, you can filter only one list at a time on a worksheet.
To filter a list using AutoFilterà
(a) Choose FILTER, button from the DATA ribbon, SORT & FILTER group.
(b) Your list column labels will appear with drop-down list arrows to the right.
(c) When you select the drop down arrow from the top of a particular column you will have (depending
on the data type) a box at the bottom of the menu with all unique values make sure the values
you wish to be seen are ticked. Select the values you are filtering for.(Following Pictures)
(d) When all values you wish to see are ticked (this creates OR conditions for that column) click OK to
apply the filter for that column
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Value to be
Filtered by

Filter options for
Custom filter.
(see next)

Each time you apply criteria to a column you create AND conditions across columns that reduce the
number of records that will be displayed. Using the simple autofilter OR conditions cannot be applied
across columns. (see advanced filter).
More AND conditions = less records
Whilst a filter is active, if you print the worksheet, only visible rows will be output, so you can print out
multiple views of your data from an individual list.
Removing a single column filterà
(a) You can see which columns have filter criteria active because the drop-down list arrows are blue.
Click the drop-down list arrow for the column whose criteria you wish to remove. And choose the
tick box that says select all.
(b) All values will be selected for display again. Either click OK or select new sort order to show all
records.
Removing all column filtersà
(a) Click the Clear option from the SORT & FILTER button on the hOME ribbon in the EDITINg group
When filters are cleared the SELECT ALL tick box is applied to all columns. Make sure that this method is
the one you really want if you have selected complicated criteria in a particular column.
Custom Criteriaà
When you specify a filter criterion for a column from unique entries listed in the AutoFilter drop-down
list, you can only select one filter criterion at a time. The Custom filter criterion enables you to filter a list
to display sets of data that contain This creates an OR condition or complicated options of what text,
dates or numbers you wish to display To meet the filter criteria, a set of data must meet either the first
filter criterion or the second filter criterion or both.
You can also use the Custom criterion choice to find values that fall within a range. When you specify
custom criteria, select a comparison operator from the drop-down list and then either type in a value
or select it from the criteria drop- down list.
When you use custom criteria, you need to understand the comparison operators that Excel offers you.
The table below outlines these:
Operator
=
>
>=
<
<=
<>

Meaning
Equal to
Greater Than
Greater Than or Equal to
Less Than
Less Than or Equal to
Not Equal to
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To specify “either AND/OR” custom criteriaà
(a) Click on the AUTOFILTER drop-down for the desired column.
(b) Depending on the Data type you will have the data type and type of filter name. (picture shows
number filter)

(c) You may select one of the options shown to start your custom filter OR move to the bottom of the
menu and select custom Filter.
(d) The following dialog box will be shown.
(e) In the Custom AutoFilter dialog box from the first criteria drop-down list select one of the filter
criteria.
(The default operator is = “equals”).
(f)

Click on OR or AND. (this is very important)

(g) From the second operator drop-down list, select a comparison operator.
(h) From the second criteria drop-down list select the other filter criterion.
(i)

Click Ok. The filtered list shows the sets of data that meet either the first or the second specified
criterion for the column.

Using custom criteria to find a range of valuesà
(a) Click the drop-down arrow for the column label whose range of values you want to filter by. This
will typically be numbers or dates
(b) Click Custom filter. From the resulting dialog box, select the comparison operator to control the
lower limiting value, for example greater than or greater than or equal to.
(c) From the first criteria drop-down list, select a value or type the value in.
(d) Select AND as the data MUST meet both conditions to display the range
(e) From the second criteria drop-down list select the other filter criterion.
(f)

Click Ok. The filtered list shows the sets of data that meet BOTH the first and the second specified
criterion for the column.

Wildcardsà
You can use wildcards to search for text in common within the unique entries, even though the entire
entry might not match. For example, searching for all of the sets of data that have entries in the lastname column that begin with “M” might display two Moore’s (where the entire entry matches) but
might also display Madding and Martinez (where the entire entry does not match).
Wildcard

Finds

Example

asterisk

Any set of characters that are in the same position *.xls finds Filter.xls and sortdata.xls
as the asterisk

? question Any single character that is in the same position as B?t finds Bat, Bit, But and Bet
mark
the ?
~ tilde

A question mark or an asterisk

Who~? Finds the text “Who?”
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To filter a list using wildcardsà
(a) With Auto Filter active, select the drop-down list arrow to the right of the column you want to use
to filter the data.
Wildcards only work when filtering columns containing text:
(a) Choose CUSTOM.
(b) Ensure that the operator is set to =.
(c) Type the pattern of letters you are filtering by with the asterisks and/or question marks inserted in
the appropriate positions.
(d) Click Ok.
(e) Turning Off Autofilter
When you no longer need to filter your data, you can switch the AutoFilter off in the following way:
To switch off AutoFilterà
(a) Choose FILTER, button from the DATA ribbon, SORT & FILTER group.
Advanced Filteringà
Sometimes, the filter criteria that you specify with AutoFilter will not yield the necessary results. For
example, you cannot use AutoFilter to filter a list to display the more complex criteria of two separate
AND conditions combined with an OR condition. To do this, you must use the Advanced Filter option.
This relies on you setting up and defining a Criteria range on the worksheet where the data to be
matched can be entered.
Set Criteriaà
The Criteria range usually consists of a copied set of the list column names, and a blank row immediately
beneath into which you can type the data to be matched. It is a good idea to copy the column
names from the top of the database into the area to be used as a criteria range, as this reduces the
chance of there being any discrepancy between the two sets of names.
In fact, not all the column labels need to be included in the criteria range. It could be restricted to
only those labels on which you wished to search, and those labels included could be displayed in a
different order. If you wish and criteria to create a range you may need to copy a particular column
label twice.
OR
Condition

AND
Condition

To define the Criteria rangeà
(a) Copy across to a new sheet the column labels you wish to create criteria for.
(b) Create the criteria in the cells under the labels.
(c) If criteria are created in the same row, this would create an AND condition and on different rows
this would create an OR condition.
(d) Select the copied set of column labels and the criteria below and name the cell range if you wish.
(not essential) Type the word Criteria into the name box and press [ENTER].
You do not have to name the cells with the range name Criteria, but it will ensure that Excel automatically
picks the correct group of cells as the criteria carrying cells whenever you use the Advanced Filter.
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To run an advanced filterà
(a) Click within your data list
(b) Choose ADVANCED, button from the DATA ribbon, SORT & FILTER group.
(c) The following dialog will be displayed

(d) You should see that your data list is selected completely. If not (due to empty columns or rows.)
Delete the values in the list range box and either type in the range you wish or select the correct
range with the mouse
(e) In the criteria range box either type criteria (if you named the range) or delete any values present
and select your criteria from your sheet of criteria.
(f)

By default the list will be filtered in place as when using the AutoFilter.

(g) Click Ok. You will be returned to your data list with the filter applied.
(h) Sort if needed
To remove a filterà
Click the Clear option from the SORT & FILTER button on the HOME ribbon in the EDITING group.
Pivot Tablesà
A PivotTable can summarize large amounts of data using specified calculations and formats. It is called
a PivotTable because the headings can be rotated around the data to view or summarize it in different
ways.
• The source data can be:
• An Excel worksheet database/list or any range that has labeled columns.
• A collection of ranges to be consolidated. The ranges must contain both labeled rows and
columns.
• A database file created in an external application such as Access or Dbase.
• The data in a PivotTable cannot be changed as it is the summary of other data. The data itself can
be changed and the PivotTable recalculated. The PivotTable can be reformatted
To create a PivotTable or PivotTable with pivot chart à
(a) Select a cell in a range of cells of data, or put the insertion point inside of an Excel table.
(b) Make sure that the range of cells has column headings.
(c) Do one of the following: To create a PivotTable report, on the Insert ribbon, in the Tables group,
click PivotTable, and from the menu click PivotTable.
(d) The Create PivotTable dialog box is displayed.
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To Select a data source. And choose the data that you want to analyzeà
(a) Click Select a table or range.
(b) Type the range of cells or table name reference, such as =QuarterlyProfits, in the Table/Range
box.
(c) If you selected a cell in a range of cells or if the insertion point was in a table before you started
the wizard, the range of cells or table name reference is displayed in the Table/Range box.
To Enter a locationà
(a) To place the PivotTable report in a new worksheet starting at cell A1, click NEW WORKSHEET.
(b) To place the PivotTable report in an existing worksheet, select EXISTING WORKSHEET, and then type
the first cell in the range of cells where you want to locate the PivotTable report.
An empty PivotTable report is added to the location that you entered with the PivotTable Field List
displayed so that you can start adding fields, creating a layout, and customizing the PivotTable report.
If you are creating a PivotChart report, an associated PivotTable report is created directly underneath
the PivotChart report for the location that you enter. This PivotTable report must be in the same workbook
as the PivotChart report. If you specify a location in another workbook, the PivotChart report will also
be created in that workbook.
To Create A PivotChart Report From An Existing PivotTable Reportà
(a) Click the PivotTable report.
(b) On the INSERT ribbon, in the CHARTS group, click a chart type.
You can use any chart type except xy (scatter), bubble or stock.
Convert a PivotChart report to a static chartà
Find the associated PivotTable report that has the same name as the PivotChart report by doing the
following: (The PivotTable report that supplies the source data to the PivotChart report. It is created
automatically when you create a new PivotChart report. When you change the layout of either report,
they both change.)
(a) Click the PivotChart report to find the associated PivotTable report name, In the DATA group, on
the DESIGN ribbon, click SELECT DATA to display the EDIT DATA SOURCE dialog box, and then note
the associated PivotTable name, which is the text that follows the (!) exclamation point, in the
Chart data range text box and then click Ok.
(b) To identify the associated PivotTable report, click each PivotTable report in the workbook, and
then on the OPTIONS ribbon, in the PIVOTTABLE group, click OPTIONS until you find the same name
in the NAME text box. then Click Ok.
(c) On the OPTIONS ribbon, ACTIONS group, click SELECT, then click ENTIRE PIVOTTABLE. Press DELETE.
(d) The chart is now static and not associated with the PivotTable.
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Create A Static Chart From The Data In A PivotTable Reportà
This procedure creates a regular, non interactive chart rather than a PivotChart report (PivotChart
report: A chart that provides interactive analysis of data, like a PivotTable report. You can change
views of data, see different levels of detail or reorganize the chart layout by dragging fields and by
showing or hiding items in fields.).
To create static chart from dataà
(a) Select the data in the PivotTable report that you want to use in your chart. To include field buttons(A
field button is a Button that identifies a field in a PivotTable or PivotChart report. You can drag the
field buttons to change the layout of the report, or click the arrows next to the buttons to change
the level of detail displayed in the report.) and data in the first row and column of the report, start
dragging from the lower- right corner of the data that you’re selecting.
(b) On the HOME ribbon, in the CLIPBOARD group, click COPY
(c) Click a blank cell outside of the PivotTable report.
(d) On the HOME ribbon, in the CLIPBOARD group, click the arrow next to PASTE, and then click PASTE
SPECIAL.
(e) Click VALUES, and then click Ok.
(f)

On the INSERT ribbon, in the CHARTS group, click a chart type.

Delete A PivotTable Or PivotChart Reportà
To Delete a PivotTable report:
(a) Click the PivotTable report.
(b) On the OPTIONS ribbon, in the ACTIONS group, click SELECT, and then click ENTIRE PIVOTTABLE.
(c) Press DELETE.
Deleting the associated PivotTable report (associated PivotTable report: The PivotTable report that
supplies the source data to the PivotChart report. It is created automatically when you create a
new PivotChart report. When you change the layout of either report, the other also changes.) for a
PivotChart report creates a static chart that you can no longer change.
To Delete a PivotChart report:
(a) Select the PivotChart report.
(b) Press DELETE.
Deleting the PivotChart report does not automatically delete the associated PivotTable report.
Create Layout For PivotTablesà
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Once the PivotTable has been created a layout has to be created to view your data in the empty
PivotTable we do this through the PivotTable Field list which appears in a pane to the right of your
PivotTable.
An Option button will allow you to change the way your PivotTable field list looks.
To create a layoutà
(a) Drag and drop the fields from the fields section at the top to the bottom areas of the Pane
(b) If Month of Hire is used as a row label the PivotTable will look at your data and pick out the unique
values to make up the row headings within your report.
(c) Choose a field for the column labels
(d) Choose a field you wish to use as your values.
Numerical data will use SUM as the default method of calculating your data. If Textual it will use count
as default. You may use more than one field in any area but it is important to place them correctly. You
may drag them around as much as you wish until your report looks as you wish it to look.
You may filter on one or more fields if you wish. To do this drag a field to the report filter box. Any of
these areas can be filtered.
Modifying A PivotTableà
• All of the following are options for modifying your PivotTable
• Adding or deleting fields
• Filtering and sorting
• Format the colour scheme
• Changing how the pivot chart calculates
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To Add or delete fieldsà
(a) Drag and drop the fields between the various areas and the field list section field info will disappear
or appear in different locations.
(b) Dragging a field from one of the areas to the field list will remove that data from the report. This will
not change the data in your Data list merely leave it absent from the report.
Managing Pivot Tablesà
When data is changed in the PivotTable source list, the PivotTable does not automatically recalculate.
Using Another PivotTable Reportà
The PivotTable cache:
Each time that you create a new PivotTable report or PivotChart report, Excel stores a copy of the
data for the report in memory, and saves this storage area as part of the workbook file. Thus, each
new report requires additional memory and disk space. However, when you use an existing PivotTable
report as the source for a new report in the same workbook, both reports share the same copy of the
data. Because you reuse the same storage area, the size of the workbook file is reduced and less data
is kept in memory.
Location requirementsà
To use a PivotTable report as the source for another report, both reports must be in the same workbook.
If the source PivotTable report is in a different workbook, copy the source report to the workbook
location where you want the new report to appear. PivotTable reports and PivotChart reports in
different workbooks are separate, each with its own copy of the data in memory and in the workbook
files.
Changes affect both reportsà
When you refresh the data in the new report, Excel also updates the data in the source report, and
vice versa. When you group or ungroup items in one report, both reports are affected. When you
create calculated fields or calculated items in one report, both reports are affected.
PivotChart reportsà
You can base a new PivotTable report or PivotChart report on another PivotTable report, but you
cannot base it directly on another PivotChart report. However, Excel creates an associated PivotTable
report from the same data whenever you create a PivotChart report, so you can base a new report
on the associated report. Changes to a PivotChart report affect the associated PivotTable report, and
vice versa.
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Changing An Existing Report’s Source Dataà
Changes in the source data can result in different data being available for analysis. For example, you
may want to conveniently switch from a test database to a production database. You can update a
PivotTable report or a PivotChart report with new data that is similar to the original data connection
information by refreshing the report.
To include additional data or different data, you can redefine the source data for the report. If the
data is substantially different with many new or additional fields, it may be easier to create a new
report.
Displaying new data brought in by refreshà
Refreshing a report can also change the data that is available for display. For reports based on
worksheet lists, Excel retrieves new fields within the source range or named range that you specified.
For reports based on external data, Excel retrieves new data that meets the criteria for the underlying
query (query: In Query or Access, a means of finding the records that answer a particular question you
ask about the data stored in a database.) or data that becomes available in an OLAP cube. You can
view any new fields in the Field List and add the fields to the report. (OLAP cube: An OLAP data structure.
A cube contains dimensions, like Country/Region/City, and data fields, like Sales Amount. Dimensions
organize types of data into hierarchies with levels of detail, and data fields measure quantities.)
To refresh a PivotTableà
Click in PivotTable:
(a) Choose REFRESH DATA in the DATA group on the OPTIONS ribbon.
(b) Choose to REFRESH ALL or just REFRESH
(c) The data is is now refreshed and updated new information, field names and changed data is now
displayed
Refresh will refresh just the report you are clicked on. Refresh all will refresh all reports in the workbook.
Macros in Excelà
Increase the usability of your Excel spreadsheets by adding a little programming to them. While Excel’s
formulas and spreadsheet features make it a great tool, mastering the ability to create macros will
make it even greater and faster to work with. Learn how with these steps.
Click on Office Button
à Excel Options àPopular à Click Check option of Show Developer tab
in Ribbon à Click on Trust Center àTrust Center Settings à Macro Settings à Click Check option of
Enable all macros (not recommended; potentially dangerous code can run)
Record New Macroà
To Record a New Macro click on Developer Tab, under these Tab you will find Record Macro Button.
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Now click on Record Macro button, the following dialog box will appear:

(A) Name Your Macro: You can give a name to your macro
(B) Set a shortcut for your macro(optional): Type a letter in the Shortcut Key box. A lowercase letter
will translate to CTRL + letter; an uppercase letter will be CTRL + SHIFT + letter
(C) Choose where to store your macro: In the Store Macro in list, select the workbook where you want
to store the macro. If you want it to be available whenever you run Excel, select Personal Macro
Workbook.
(D) Write Description of your macro: You can write description about the macros you are going to
record.
(E) Now click on ok Button to save the Macro.
(F)

Record your macro: Remember, Record Macro is still on. Carry out the actions that you want Excel
to record as your macro.

(G) Click Stop Recording: You can find this option on the Stop Recording toolbar.

Chartsà
All graphics related to Microsoft in this book is in compliance with Microsoft guidelines and thus
permitted by Microsoft.
Introduction to Chartingà
One of the most impressive aspects of Excel is its charting ability. There are endless variations available,
allowing you to produce a chart, edit and format it, include notes, arrows, titles and various other
extras as desired. This manual will look at many of the issues involved in producing and formatting Excel
charts.
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Charts are based on data contained in Excel Worksheets. It is necessary to understand how Excel picks
up the data to be used in a chart because the way in which the data is laid out will influence how the
chart is presented.
Excel offers a wide range of types and formats from which you can choose when producing charts.
However, the charts themselves can exist in different forms and it is important to understand the
difference between them. The first form is an embedded chart; the second is a separate chart page.
Terminologyà
As a starting point, there are some terms used in charting which should be understood by you. The terms
defined below relate to the example car sales worksheet and column chart which appear beneath
the table:
Data Point

An individual figure on the spreadsheet which is reflected in the chart e.g. Fred’s Orion
sales figure

Data Series

A collection of related data points, e.g. all of Fred’s figures, which will appear on a
chart as markers (bars, for example) of the same colour

Legend

The “key” to the chart, identifying which patterns/colours relate to which data series

Marker

A bar, column, or slice of pie for example, representing a data point

Category

The category axis appears across the bottom of a graph (pie charts excepted) and
the categories are listed here. Points within the different data series are grouped by
category

Embedded Chartsà

An embedded chart appears on the worksheet where it was created. It is an embedded object, which
does not normally appear in its own window, and has no separate existence apart from the worksheet.
The chart is saved only when the worksheet file itself is saved, and will be printed with the worksheet
in which it is embedded. You may choose to have an embedded or separate chart at any time. All
charts whether embedded or separate are created from the INSERT ribbon in the CHARTS group.

Separate Chart Pagesà
A chart sheet, although linked to the worksheet whose figures it represents, exists as a separate page
in a workbook. The
F11 key is very useful for creating a default chart from selected data as a new sheet within the workbook.
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Some chart elements to be aware of.
Chart
Elements

Description

Titles

This is the area where you can specify the titles to have on the chart (i.e. X-axis “1998”,
Z-axis “GBP”.

Axes

Here you specify whether you want a Y/Z axis and whether you are using timescales to
plot your data

Gridlines

The gridline ribbon allows you to switch on and off horizontal and vertical gridlines

Legend

Use this ribbon to switch the legend on and off or reposition it

Data Labels The Data Labels ribbon allows you to display the amount each point represents or
display the label (i.e. in the example above, each cylinder would have Qtr1, Qtr2
displayed as appropriate at the top of each data marker)
Data Table

The Data Table ribbon will display a grid underneath the chart that will show the
information that is being plotted.

To create a chart

(a) Select data for chart.
(b) Go to the CHARTS group on the INSERT ribbon. Select a chart type and click
(c) The menu on the left appears.
(d) Hovering your mouse over a chart type will bring up an explanation of that chart type
(e) When you have chosen click once to select a chart type
(f)

The chart is now created based on the selected data as an embedded chart.

Or
(a) Select data for chart.
(b) Click on the DIALOG BOX LAUNCHER on the CHARTS group on the INSERT ribbon.
(c) The following dialog will appear
(d) Select a type from the left hand section and a sub type from the right hand section.
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(e) Click OK to create the chart.
(f)

This will be created as an embedded chart

Moving And Resizing Embedded Charts à
Once the chart object has been created and stored as an embedded object, you can move and
resize it.
To move an embedded chart à
(a) Move mouse over the chart frame border your mouse cursor
should have a four pointed black arrow
(b) Click on the chart frame border and hold the mouse
button down as you drag. Release the mouse when the
chart is in the desired location.
To resize an embedded chartà
(a) Move your mouse over the dotted handles on the Chart frame border.
(b) The mouse cursor should change to a double arrow. c) Click and Drag up, down, left or right.
Hold down the [ALT] key if you wish the chart to resize by snapping to the cell gridlines.
Data Layout à
Depending on the “shape” of the selected data, Excel will assign categories and data series to either
the rows or columns of information. Usually it will be assumed that there are more categories than data
series, therefore, if there are more rows than columns of selected information, the data series will be
based on columns, with the legend labels being picked up from the row across the top of the selected
area and the category labels being picked up from the leftmost column:
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If there are more columns than rows in the selected area, the data series will be based on rows, with
the legend labels being picked up from the leftmost column and the category labels taken from the
top row of the selected area:

If the number of rows and columns is the same, Excel will opt for data series in rows. It is possible to
override the choice made by Excel in how the data series and categories are decided. Details of this
procedure will be found under the section on manipulating data.

Shortcut Menu (Right Click)à
You may be familiar with the Shortcut menus associated with the selected cell(s) on the Excel worksheet.
When working on a chart - embedded either on a worksheet or in its own window, clicking on the chart
with the secondary mouse button will call up a Charting Shortcut menu.
The Shortcut menu will contain a selection of choices from some of the Standard Menu bar options
mostly relating to the chart as an embedded object - almost like a graphic on the worksheet.

Chart Typesà
There are several different types of chart available within Excel. The type to choose will vary depending
on the data involved and what information the chart is intended to convey or highlight. Practice will
improve your instinct on which type of chart to use in each instance. Initially it may be useful to try
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different types until the result is reasonably close to your requirements, and then add custom formats
and elements as desired. Some chart types are very specialized and may only be of use to particular
business sectors.
Available Types Of Chartà
Selecting any of the types listed will apply a given chart type to the active chart. The most useful types
available and some of their applications have been summarized below:
Areaà
Area charts can be 2 or 3-dimensional. They are used to compare the change in volume of a data
series over time, emphasizing the amount of change rather than the rate of change. Area charts show
clearly how individual data series contribute to make up the whole volume of information represented
in the graph.
Bar à
Bar charts can be 2 or 3-Dimensional. They are used to show individual figures at a specific time or to
compare different items. Categories are listed vertically, so that bars appear on the horizontal, thus
there is less emphasis on time flow. Bars extending to the right represent positive values while those
extending left represent negative values.
Column à
Column charts can be 2 or 3-Dimensional. They are frequently used to show variation of different items
over a period of time. Categories (often days or months for example, representing a progression of
time) are listed horizontally and columns are displayed side by side, making for easy comparisons. Two
variations on the theme of Column charts are represented by further tools on the Chart toolbar. The
Stacked Column chart can be used to show variations over a period of time, but also shows how each
data series contributes to the whole. A further variation on the 3-D column chart produces 3-D columns
in a 3-D plot area, receding away from the viewer.
Lineà
Line charts can be 2 or 3-Dimensional. Line charts are used to compare trends over time. There are
similarities with Area charts, but line charts tend to emphasize the rate of change rather than volume
of change over time. 3-D lines appear as “ribbons” which can be easier to see on the chart.
Pieà
Pie charts can be 2 or 3-Dimensional. They are used to compare the size of the parts with the whole.
Only one data series can be plotted, making up 100%. Pie charts within their own window can be
made to “explode” by dragging one or more pieces of pie away from the centre.
Radarà
Each category in a radar chart has its own axis radiating from the centre point. Data points are plotted
along each spoke, and data points belonging to the same series are connected by lines.
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XY Scatter Chartsà
XY charts are used to compare two different numeric data series, and can be useful in determining
whether one set of figures might be dependent on the other. They are also useful if the data on the X
axis represents uneven intervals of time or increments of measurement.
3-D Surfaceà
3-D Surface charts present information in an almost topographical layout. They can be used to pinpoint
the high and low points resulting from two changing variables. It can be helpful to think of a 3-D surface
chart as a 3-D Column chart which has had a rubber sheet stretched over the tops of the columns.
Combinationà
A combination chart allows you to overlay one 2-Dimensional chart type on top of another. This can
be useful for comparing different types of data, or for charting data requiring two different axis scales.
Once the combination chart has been set up, the actual type of the main or overlay chart can be
changed by you.
To change the chart typeà
(a)
(b)
(c)
(d)
(e)
Or

Click on chart to be changed..
Go to the CHARTS group on the INSERT ribbon. Select a chart type and click
Hovering your mouse over a chart type in the menu will bring up an explanation of that chart type
When you have chosen click once to select a chart type
Your chart will have changed

(a) Click on the DIALOG BOX LAUNCHER on the CHARTS group on the INSERT ribbon. The INSERT CHART
dialog will appear
(b) Select a type from the left hand section and a sub type from the right hand section. Click OK to
change the chart type
Or
(a) Right click on the chart to call up the shortcut menu Click on CHANGE CHART TYPE
(b) The INSERT CHART dialog will appear Select a type from the left hand section and a sub type from
the right hand section. Click OK to change the chart type
Default Chart Typeà
The default graph setting in Excel is set to a simple 2-dimensional column chart, however you can
change the default to any of the types offered within the chart type dialog.
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To set the default chart typeà
(a) Click on the DIALOG BOX LAUNCHER on the CHARTS group on the INSERT ribbon.
(b) The following dialog will appear
(c) Select a type from the left hand section and click on the specific format that you want the chart
to have from the gallery of pictures on the right.
(d) Click the SET AS DEFAULT CHART button.
(e) New charts created from now on will use the default format as defined by you when pressing F11
Formatting Charts à
There are several different ways of formatting the various elements in a chart. Some formats, such as
adding a legend can be applied to a chart using the following sections:
Calling up the Shortcut menu on a Chart will also allow you to access the dialog boxes which can be
used to change formatting on the entire chart.
Design Ribbon à
The DESIGN ribbon is to change some very basic aspects of your chart globally for the chart we have
already looked at changing the chart type. We will look at creating some of our own later on:

To change data source à
(a) Click on Chart.
(b) Click on SELECT DATA in the DATA group the following dialog will appear
(c) In the CHART DATA RANGE box a highlighted range will be seen.
(d) If you need a completely new range then delete the values in this box and select a different
range for your chart.
(e) Click on OK.

Be sure to include the row and column labels in this range. If you wish you may select more than one
range by holding down the [CTRL] key down after you have selected your first range and then select
another range.
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To add or remove a series or category à
(a) Click on Chart.
(b) Click on SELECT DATA in the DATA group the SELECT DATA SOURCE dialog will appear
(c) In the LEGEND ENTRIES (SERIES) box click on ADD the EDIT SERIES dialog will appear.
(d) In the series name box select the cell that holds the series Label
(e) In the series values box select the range of cells that will make up the data for that series.
(f)

Click OK

(g) In the HORIZONTAL (CATEGORY) AXIS LABELS box click on EDIT
(h) The AXIS LABELS dialog will appear
(i)

Reselect the range that will include any new category labels.

(j)

Click OK. and OK again to apply the new data to your chart.

To delete a seriesà
(a) Click on Chart.
(b) Click on SELECT DATA in the DATA group the SELECT DATA SOURCE dialog will appear
(c) Select the series you wish to delete.
(d) Click on DELETE the series will be removed.
To delete a categoryà

(a) Click on Chart.
(b) Click on SELECT DATA in the DATA group the SELECT DATA SOURCE dialog will appear
(c) Click on the SWITCH ROW/COLUMN button. What was a category has now become a series
(d) Now delete series as previously explained.
(e) Click on the SWITCH ROW/COLUMN button on the dialog box. What were series have now become
categories with the category you wished, removed.
Switch Rows and Columnsà
To switch between rows and columns:
(a) Click on Chart.
(b) Click on SELECT DATA in the DATA group the SELECT DATA SOURCE dialog will appear
(c) Click on the SWITCH ROW/COLUMN button. What was a category has now become a series
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Changing The Chart Layout à
As discussed earlier a chart is made up from many elements that can be turned on or off depending
on the type of chart or arranged in different places on the chart. To change the layout swiftly instead
of laboriously changing each element the change layout tool allows some quick global options.
To change the chart layout à
(a) Click on the drop down arrow on the CHART LAYOUT group
(b) Select a chart Layout
(c) The layout is applied
Chart Stylesà
A chart style is mainly a theme of formatting for your chart using the existing elements of your chart
there are some very exciting colour schemes in this feature.
To apply a chart style à

(a) Select chart
(b) Click on the drop down arrow to the right of the CHART STYLES group.
(c) Select a chart style
(d) Your chart should now adopt the style chosen.
If the chart style is not to your liking apply another style following the same method until you have
a style close to what you wish. We will look at formatting the various elements in a later chapter to
achieve exactly what you want.
Formatting Chart Elements à
To select and format a chart element:

(a) Go to the LAYOUT ribbon.
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(b) To select an element of your chart, click on the drop down arrow to the right of top box in the
CURRENT SELECTION group.
(c) Click on a chart element. That element will be selected
(d) Click on FORMAT SELECTION in the CURRENT SELECTION group, the following dialog will appear.
(e) The left hand section of the dialog will give the various categories of how you may format your
selection (These options may vary depending on the selection.)
(f)

The right hand section contains the available formats for that category.

(g) Clicking on each category and setting your format choices will immediately affect you chart.
(h) When you are satisfied with your formatting choices, click CLOSE.
Many of the options displayed in the category options section may involve other drop down boxes to
make a selection. (see picture) if you move your mouse over these possible selections a help tip should
appear to give you a description of that choice BEFORE actually making a selection. Any choice
already applied will already be selected and have a different colour.
Resetting Custom Formatsà
When experimenting with various formats you may find it difficult to remember exactly what settings
were applied to a specific element and therefore you would find it difficult to make it appear as it once
was. Resetting the format of specific chart elements can be very useful.
To reset an element à
(a) Make a selection of element to be reset
(b) Click on RESET TO MATCH STYLE button on the CURRENT SELECTION group.
(c) The selected element will revert back to the original format settings of the applied chart style.

Adding, Removing And Formatting Labelsà
Information labels on your chart are very important on your chart especially if it is on a separate sheet.
The LABELS group offers a selection of labels you may wish to show or hide on your chart. The chart
layout choices previously explained uses a mixture of labels in different locations on your chart but you
may wish to put specific labels on your chart and format them yourself and place them where you
wish.
To add or remove labelsà

(a) Select chart if embedded
(b) Click on drop down arrow of type of label you wish to add or remove from the LABELS group. c)
Make a selection from choices present.
(d) Label will appear or disappear dependant on choice
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(e) Use the Data Labels button on the LABELS to write the values or the labels on the data markers.
(f)

Use the Data Table button on the LABELS to add the plot data so that it is visible on the chart itself.

To format labels à
(a) Select label element from drop down box in the CURRENT SELECTION group as mentioned
previously.
(b) Click on FORMAT SELECTION in the CURRENT SELECTION group as mentioned previously.
To edit label textà
(a) Select label as previously discussed.
(b) Click within the label and delete and retype with the text you require.
(c) Click off label
To move or resize chart elementsà
(a) Make a selection of a chart element. (E.G. a label)
(b) Handles will appear at each corner to show selection.
(c) Moving mouse over label border should show a 4 pointed Black arrow. This appears to indicate
that you are in the right position to click and drag to move the selected element.
(d) Clicking within the label to edit the text the label will automatically resize to the size of the text
entered
Selecting an element like the plot area will allow a double black arrow when moving over a handle.
Clicking and dragging will resize that element.
Axesà

For various types of charts you may not wish to see both axes on the chart you are able to hide or show
these axes dependant on your needs.
To add or remove axes from chart à
(a) Select chart if embedded.
(b) Click on drop down button on AXES button on AXES group
(c) Select PRIMARY HORIZONTAL or PRIMARY VERTICAL AXIS.
(d) Make a selection from choices shown.
Selecting more primary horizontal or vertical options opens the formatting dialog which would appear
if you selected the axis and formatted it. Using the axes menu is best for turning it off or on.
To format the Category (x) Axis à
(a) Under TICK MARK TYPE, you may click on the appropriate option button to specify that tick marks
on the axis will appear on the inside or outside of the axis line, cross the axis line, or not appear at
all. Minor tick marks can also be included (click on the Scale... button to set the intervals for major
and minor tick marks).

5.50 I The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program

(b) The TICK LABELS section allows you to dictate where the Labels associated with the selected axis
will display. This can be at the High Values end of the axis, the low values end of the axis, next to
the axis, or completely suppressed.
(c) Use the SCALE ribbon to specify at where the value axis will appear, which categories are labeled
and how many categories will appear between each pair of tick marks.
(d) A series of boxes [a]use automatic positioning. The default setting is to have this box checked
which produces a Value Axis at the edge of a given category. Putting a value in the next box
down will result in a Value Axis which cuts down the middle of a category. This will also affect the
location of tick marks on the axis. Categories may be displayed in reverse order if desired, and the
Value Axis may be required to cross at the last plotted category on the chart.
(e) Use the ALIGNMENT category to specify the orientation of the category labels.
To format the Value (y) axis à
(a) Follow steps described above for the category axis.
(b) The SCALE ribbon will have different options relating to the values on the axis.
(c) From the SCALE ribbon, you may specify the Minimum and Maximum values to appear on the axis.
The intervals to be used as Major and Minor units on the axis may also be set. You may dictate
the point at which the value and category axes cross, whether or not the axes are plotted on a
Logarithmic Scale, or whether to have the values plotted in Reverse order.
Gridlinesà
Gridlines are the indicator lines that run across your chart to either divide up your categories or give
visual help when deciding on a value for a data point more distant from the value axis. You may need
more, or less of these, dependent upon your needs for accuracy or visual impact.
To change gridline optionsà
(a) Select chart if it is embedded.
(b) Click on drop down arrow on GRIDLINES on the AXES group.
(c) Choose PRIMARY HORIZONTAL or PRIMARY VERTICAL GRIDLINES and make a selection from the
choices given.
Element optionsà
This category varies dependent on what is selected it may show AXIS, CATEGORY Or SERIES OPTIONS.
For SERIES OPTIONS it allows you to change the width of the column or gap between the series. AXIS
OPTIONS allows you to specify widths and separation options where the axis begins and ends (if
available)
Fill à Use the FILL category to specify background colours or designs.
Shapeà Use this category to set the shape for a selected element (series or data point if available)
Bordersà Select the BORDER colour to change the border colour and set a border
Shadowà This option allows you to set the shadow depth , colour and direction for the selected
element.
3-D Formatà If you have a chart that has a 3-D format this category will allow you to change many
aspects of the 3-D appearance such as the material, lighting, contour, depth and bevel.
Depending on the data being displayed, some data markers on a 3-D chart may be obscured. It is
possible to adjust the view so that your data may be seen to its best advantage. You may influence the
degree of elevation, perspective or rotation of your chart. A sample chart within the 3-D view dialog
box reflects the new views as you change these factors. Elevation and Rotation can be adjusted either
by typing values into the appropriate sections within the dialog box, or by clicking on the arrow buttons
displayed around the sample chart. The latter technique is obviously easier.
The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program I 5.51

Microsoft Office
Elevation dictates the height from which you view the data. Ranging from 90°(above the plot area) to
-90°(below the plot area), where 0° represents a view level with the centre of the plot area. With 3-D
Pie Charts, the range varies from 10°, almost level with the edge of the pie, to 80°, looking down on the
surface of the pie.
3-D rotationà Selecting the plot or chart area will allow you to rotate your chart in any direction or
change the perspective of your chart.
Rotationà Rotation allows you to turn the graph on its vertical axis. The range goes from 0°to 360°,
where zero views the chart from the front, 90°would view it from the side, and 180° would allow you to
see it from the back - effectively reversing the order of the data series for the chart display.
Perspectiveà Perspective can be changed to make the data at the back of a 3-D chart appear more
distant. A perspective of zero means that the farthest edge of the chart will appear as equal in width
to the nearest edge. Increasing perspective (up to a maximum of 100) will make the farthest edge
appear proportionally smaller.
You may also affect the height of the graph in relation to its width and whether or not you want the axes
to remain at right angles. This latter setting would preclude the use of perspective in 3-D charts. Autoscaling allows Excel to scale a 3-D chart so that, where possible, it is similar in size to its 2-D equivalent.
Font à The font for any selected textual element can be set on the HOME ribbon from the FONT group
or right clicking on the highlighted text and using the mini toolbar.
Formatting The Legendà The Legend can be selected and formatting like the other chart elements The
legend can be positioned manually simply by pointing and dragging it to a new position on the chart,
but there are some preset positions which can be selected from legend button in the LABEL group.
Note that the legend cannot actually be resized. Changing the font size will cause the size of the
overall legend to adjust, but it cannot be resized by dragging on the selection handles. No chart
element which shows white selection handles (rather than the usual white) can be resized by dragging.
Dragging the legend to a new position on the chart will sometimes affect the shape of the legend and
the size of the chart. The legend may be placed overlapping the chart. Note that the text appearing
in the Legend box is picked up from the worksheet data. Edit the text on the worksheet in order to
change the legend text (The legend may be deleted(hidden) by selecting it and pressing the Delete
key on the keyboard.
Templatesà
Introduction to Templatesà
A template is a file used as a form to create other workbooks, sheets and charts. New workbooks
created from the template contain the same layout, data, formulae, formats and styles as those of the
template. New sheets and charts inserted into a workbook are a copy of the sheet or chart template.
Standard Templatesà
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Excel comes supplied with a selection of templates designed to help in the production of common
business and home financial tasks. These templates can be modified for personal use.
To use a standard templateà
(a) Click on the MICROSOFT OFFICE BUTTON and select the NEW button, the dialog above will appear
(b) Click the INSTALLED TEMPLATES button on the left to see a list of Excel templates in the centre
section of the dialog
(c) Click on the Picture for the template you wish to base the new workbook on to see a preview on
the right.
(d) When you have located the template you wish to use click CREATE.
Custom Templates à
You can create your own workbook and sheet templates.
To create a workbook template à
(a) Open or create the workbook to be used as the basis for the template.

(b) Click on the MICROSOFT OFFICE BUTTON and select the SAVE AS button, click on EXCEL WORKBOOK,
the save as dialog above will appear
(c) Type the template name in the FILE NAME text box.
(d) Select EXCEL TEMPLATE from the SAVE AS TYPE list. An .XLTX extension will be added to the template
name.
(e) The folder where the file will be stored will automatically change to Templates. By storing all .XLTX
files in the same folder Excel recognizes and keeps track of templates.
(f)

Click SAVE to save the template.

To create a worksheet template à
(a) In a new or existing workbook delete all the sheets except the one to be used as the template.
(b) Click on the MICROSOFT OFFICE BUTTON and select the SAVE AS button, click on EXCEL WORKBOOK,
the save as dialog will appear
(c) Type the template name in the FILE NAME text box.
(d) Select EXCEL TEMPLATE from the SAVE AS TYPE list. An .XLTX extension will be added to the template
name.
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(e) The folder where the file will be stored will automatically change to Templates. By storing all .XLTX
files in the same folder Excel recognizes and keeps track of templates.
(f)

Click SAVE to save the template.

To base a new workbook on a template à
(a) Click on the MICROSOFT OFFICE BUTTON and select the NEW button, the NEW WORKBOOK dialog
will appear
(b) Click the My TEMPLATES button on the left a dialog will appear.

(c) Click on the Picture for the template you wish to base the new workbook on to see a preview on
the right.
(d) When you have located the template you wish to use click CREATE.
To add a worksheet based on a sheet template à
(a) Click the right mouse button over a sheet tab and choose INSERT.
(b) Click the icon for the worksheet template you want to base the new sheet on.
(c) Click OK
AutoTemplatesà
An auto template is a workbook saved as a template in the XLSTART folder or alternate Startup folder
using the specific filename Book.xltx, sheet.xltx, dialog.xltx or macro.xltx. AutoTemplates if they exist will
act as the basis for all new items you create in the Excel environment.
The Book.xltx template becomes the default workbook. The Sheet.xltx template becomes the default
worksheet.
Opening And Editing Templatesà
Templates are files just like workbooks. If you need to change a template in any way, simply open, edit
and save in the normal way.
To open a templateà
(a) Click on the MICROSOFT OFFICE BUTTON and select the OPEN button
(b) Change the LOOK In location to the Templates folder.
(c) Select the name of the template you want to open. Click OPEN
To edit a templateà
(a) Make changes in the open template.
(b) Click on the MICROSOFT OFFICE BUTTON and select the SAVE button
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Template Propertiesà
Files have various properties that are saved with them. Some properties, such as date created and last
saved date are included and updated automatically by Excel. Others, such as title and subject must
be entered manually by the user. Properties are helpful when trying to locate files as you can use the
properties to search.

To set template propertiesà
(a) With the template open Click on the MICROSOFT OFFICE BUTTON and select the PREPARE button
and select PROPERTIES.

(b) A section (above) will appear under the formula bar.
(c) Set the properties that apply to the template.
(d) Click x. in right hand corner of this bar to close
(e) If you have further properties to set. Click on document properties on the bar and choose
ADVANCED PROPERTIES the dialog on the right will appear
(f)

The 5 separate tabs allow the input of many more pieces of information.

(g) When complete click on OK
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Templates can contain custom number formats and predefined styles.
Project on Preparation of MIS Report à
MS Excel has many advantages and advance excel has many advanced level advantages to those
who are working with multinational companies using various advanced excel formulas and functions
while preparing MIS reports for their organization excel is widely used to create financial statements, as
well as many other types of financial reports, such as budget, forecast, cash flow, ratio analysis, financial
modeling, business scenario and various other reports that help business to present its performance
in realistic manner. MS Excel users around the world use this program inefficiently by creating too
many workbooks, preparing complicated reports that contain too many links between workbooks
awhile using formulas, MIS reports like balance sheets profit and loss account trial balance. There are
various steps while preparing any MIS report and financial statements these steps are given below:- Trial
Balance Adjusting the trial balance will involve introduction to add update and adjustments to accounts
balances in trial balance and preparing an audit adjusted trial balance reports to be used before
preparing financial statements. Balance Sheet offers step by step instructions for creating balance
sheet which is the major part of the financial statements. Income Statement This part of the excel MIS
reports deals with how to create the income statement using excel worksheet Analyzing Financial
statement and creating Management Financial MIS Reports This part of the MIS reports involves:Balance sheet comparison reports, how to use reports created in previous years chapters to create
balance sheet.
Five year income statement and quarterly comparison reports describing how to use income reports
and quarterly comparison reports.
Analyzing MIS and financial statements using pivotal tables and pivot charts reports to analyze the
company’s financial statements.
Analyzing MIS reports for analyzing ratio analysis and other comparison techniques, and profit centers.
There are many Advance excel MIS training institute which offers advanced excel training all over the
world, those who are interested to upgrade their skills in advances excel should join good computer
training institute. Excel can be used for a wide range of different projects in any office. For example if
you work in the sales or financial divisions of your organization, then you probably already know how
you will be using Advanced Excel. However, because of the simple program and innovative searching
and selection abilities, you found that there are a lot of tips on how to get more efficiency out of
Excel that do not include just precise research. As you understand the methods for using Exceed most
successfully, your efficiency will improve considerably and your management will be satisfied. Having
the abilities to use Excel will also start up new profession alternatives for you, often providing you new
job opportunities and the prospective for an improved wage.
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UNIT - 6
MICROSOFT POWER POINT - 2007
Introduction à
PowerPoint 2007 is a powerful graphics application that allows you to create presentations for printing
or on-line viewing using a variety of different tools. These range from wizards to help you with the
content and look and feel of your presentation to animation tools to create moving images.
All graphics related to Microsoft in this book is in compliance with Microsoft guidelines and thus
permitted by Microsoft.
How To Use This Guideà
This manual should be used as a point of reference following attendance of the introductory level
Word 2007 training course. It covers all the topics taught and aims to act as a support aid for any tasks
carried out by the user after the course.
The manual is divided into sections, each section covering an aspect of the introductory course. The
table of contents lists the page numbers of each section and the table of figures indicates the pages
containing tables and diagrams.
Instructionsà
Those who have already used a spreadsheet before may not need to read explanations on what each
command does, but would rather skip straight to the instructions to find out how to do it. Look out for
the arrow icon which precedes a list of instructions.
Keyboardà
Keys are referred to throughout the manual in the following way:
ENTER – Denotes the return or enter key, DELETE – denotes the Delete key and so on. Where a command
requires two keys to be pressed, the manual displays this as CTRL P – this means press the letter “p” while
holding down the Control key.
Commandsà
When a command is referred to in the manual, the following distinctions have been made:
When Ribbon commands are referred to, the manual will refer you to the Ribbon – E.g. “Choose HOME
from the Ribbons and then B for bold”.
When dialog box options are referred to, the following style has been used for the text – “In the PAGE
RANGE section of the PRINT dialog, click the CURRENT PAGE option”
Dialog box buttons are shaded and boxed – “Click OK to close the PRINT dialog and launch the print.”
Within each section, any items that need further explanation or extra attention devoted to them are
denoted by shading. E.g.:
“Power point will not let you close a file that you have not already saved changes to without prompting
you to save.”
What Is Power point à
PowerPoint is a presentation graphics package that lets you create formatted presentations which
can be used in a number of ways. You can produce projects such as overheads for a team briefing,
slides for a business meeting or interactive on- screen presentations on your company’s products. It
allows you to produce:
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• Animated Presentations shown on a monitor or overhead screen
• Overhead Projector Transparencies
• Paper Printouts of your slides
• Notes for the Speaker
• Handouts for the Audience
• 35 mm slides
• Launching Power point

To Activate a Button on the ribbonà
Click the let mouse button on the required tool.
Dialog Boxà
To open a dialog box use the DIALOG BOX LAUNCHER when the dialog box is open, make a choice
from the various options and click OK at the bottom of the dialog box. If you wish to change your mind
and close the dialog box without making a choice then click on CANCEL. The dialog box will close
without any choice being applied. If you would like help while the dialog box is open then click on the
“? “ in the top right hand corner this will bring up a help window that will display the relevant topics.
Groupsà

Look at a group type on the ribbon such as FONT and in the bottom right hand corner of that group
you may see a small box with an arrow, clicking this is another method to call up a dialog box, this time,
directly from the ribbon. Many dialog boxes may be more familiar if you have used Power Point before.
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Toolbarsà
There are ONLY TWO toolbars within the new version of Office 2007 there is the QUICK ACCESS TOOLBAR
seen here next to the OFFICE BUTTON, and there is the MINI TOOLBAR.

Quick Access Toolbar à
By default there are only three buttons on the QUICK ACCESS TOOLBAR but these can be edited and
other regularly used buttons can be placed there. Using the drop down menu next to the QUICK
ACCESS TOOLBAR will allow the customization of this toolbar adding your most often used commands.
Mini Toolbar à
Whenever text is selected within Word a small formatting toolbar will appear above the highlighted
text it will disappear if the mouse cursor is moved away from the toolbar and will reappear when the
mouse cursor is moved over the highlighted text again.

Status Bar à
The Status bar, across the bottom of the screen, displays different information at different times. To the
left is an indicator, which will display which page you are currently on, which column you are in number
of words in document. If you right click on the empty area of the status bar a menu should appear
showing the various items of information that can be given on the space bar merely click on the info
that you wish displayed and it will appear on the status bar.
To the right of the status bar are firstly, the different views that can be used within PowerPoint, and on
the far right, the zoom control.

Task Pane à

A task pane is a window that collects commonly used actions in one place. The task pane enables you
to quickly create or modify a file, perform a search, or view the clipboard.
It is a Web-style area that you can either, dock along the right or left edge of the window or float
anywhere on the screen. It displays information, commands and controls for choosing options. Like links
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on a Web page, the commands on a task pane are highlighted in blue text, they are underlined when
you move the mouse pointer over them, and you run them with a single click.
A task pane is displayed automatically when you perform certain tasks, for example when you choose
CLIPART from the INSERT, Ribbon, to insert a picture.
About Smart Tags à
Smart Tags, first introduced in Microsoft Office XP, make it easier for you to complete some of the most
common tasks in PowerPoint 2007 and provide you with more control over automatic features.
You do not have to complete any additional steps to make the Smart Tags appear or disappear in
PowerPoint. The PASTE OPTIONS, AUTOCORRECT Options and AUTOFIT smart tags appear automatically
to allow you to quickly choose actions and remain in place until you begin another action. For
example, when you complete a paste operation, the PASTE OPTIONS smart tag (below) remains in
place alongside your text until you begin typing new text.

A “smart tag” is a type of button in Microsoft PowerPoint 2007 that appears after certain actions, such
as an automatic text correction or a copy-and-paste, have taken place. The button has a menu
of options that help you control the result of the action. For instance, if PowerPoint automatically
capitalizes the first letter of a word, but you want the word lowercased in this instance, you can
click the “undo capitalization” option on the button menu to reverse the action.
PowerPoint includes several of these smart tag buttons. They function similarly but their look can vary
and each has a specific purpose.
Autocorrect Options Smart Tag à
The AUTOCORRECT OPTIONS Smart Tag appears after an automatic correction or change, such as a
lowercased letter that’s changed to a capital or a network path that’s converted to a hyperlink. The
Smart Tag shows as a small, blue box when you rest the mouse pointer near text that was changed;
it then becomes a button icon which, when you point to it and click it, displays a menu. If you don’t
want the correction, use the options on the menu to undo it; turn of this type of correction completely;
or connect to the AUTOCORRECT dialog box to adjust settings.
Paste Options Smart Tag à
The PASTE OPTIONS Smart Tag gives you greater control and flexibility in choosing the format for a
pasted item. The Smart Tag appears just below a pasted item, such as text, a table, or a slide, with
options for formatting. For example, if you copy and paste a slide and insert it after a slide that uses a
different design template, you can choose to retain the original design for the slide or let the pasted
slide assume the design of the slide it now follows.
Autofit Options Smart Tag à
The AUTOFIT OPTIONS Smart Tag appears when PowerPoint resizes text you’re typing to make it fit the
current placeholder. If you don’t want the text to be resized, you can select options on the Smart Tag
menu to undo the resizing or to connect to the AUTOCORRECT dialog box to turn AutoFit settings of. Also,
for single-column layouts, you can change to a two-column layout, start a new slide to accommodate
the text, or split the text between two slides.
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Automatic Layout Options Smart Tag à
The AUTOMATIC LAYOUT OPTIONS Smart Tag appears after you insert an item, such as a picture,
diagram, chart, or table that changes the initial layout of the slide. To accommodate the added
item, PowerPoint will automatically adjust the slide layout. If you want, use the options to undo the
automatic layout or turn it off completely.
Creating A Presentationà
Creating Presentationsà
When you launch PowerPoint 2007, you are placed into a blank PowerPoint presentation, with one Title
slide.
To start a new presentationà
Launch PowerPoint. The following screen will automatically be shown, bringing you into a blank
presentation, displaying a blank title slide.

Adding New Slides à
When you start your new presentation, you are automatically placed into a Title slide layout. Whilst
this is the default, you are free to choose any layout listed in the Slide Layout Task pane. There are a
number of methods to add further slides to your presentation.
To add a new slide à
(A) Click on the drop down arrow beneath the NEW SLIDE button in the slides group, on the HOME
ribbon. A menu with the different layout types of slides will appear.
(B) Make a selection by clicking on one of these with the left mouse button
(C) Press CTRL+M
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PowerPoint will create a new slide and this new slide and all subsequent new slides will be based on
the bulleted list layout.
Entering And Editing Text à
Both the Title and Bulleted list layouts are specifically designed so that you can easily enter titles and
bulleted list items.
To Enter text on a Title slideà
To add text to a slide click into the predefined text areas (placeholders) and type.

To create bullets on a Bulleted slide à
(A) Click in the bullets area placeholder to show the lashing cursor.
(B) Type your list item. To begin a new item, press ENTER. The bullet will automatically appear next to
your cursor on the new line.

Multi-Level Bullets à
PowerPoint can create five levels of bullet points. Each has a different bullet point, a smaller text size
and is progressively indented.

Demoting your bulletsà
Use the Increase Indent button on the Formatting Toolbar.
Promoting your bulletsà
Use the Decrease Indent button on the Formatting Toolbar.
Editing Textà
Once text has been entered on a slide it can easily be edited.
To edit text on a slideà
(a) Click on the text item to change – a shaded border will appear around the item and your cursor
will lash somewhere within the text.
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(b) Click with your mouse or use the cursor keys on the keyboard to move the cursor around within the
text, and the BACKSPACE and DELETE keys to remove characters.
(c) When you have finished editing, click outside the text item to exit edit mode.
Adding Free Form Text à
There will be times where you wish to insert text outside of one of the pre-defined text placeholders
or perhaps on a blank slide. The Free Form Text box allows us the freedom to do this. Once you have
added the Free Form text box, you can add it and resize it as you require.

To Insert a text boxà
• On the INSERT ribbon, click TEXT BOX from the text group.
• Click in your slide where you want to insert the text box.
• Type in the text you wish to appear in the text box.
• Resize the text box if necessary using the white resizing circles on each side and corner and format
your text as appropriate.
You can use the options on the FORMAT ribbon to enhance a text box for example, to change the fill
color just as you can with any other drawing object.
Changing The Slide Layout à

LAYOUT refers to the way things are arranged on a slide. A layout contains placeholders, which in turn
hold text such as titles and bulleted lists and slide content such as tables, charts, pictures, shapes, and
clip art.
The default slide that holds bulleted text in 2007 also allows the easy insertion of basic objects you might
wish WITHOUT having to change the slide layout. In the centre of the main bulleted text area are faint
icons that if you move over them will allow you, with one click on them, to insert a range of objects.
(See below)
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Slide layouts where the main placeholder or title placeholder needs to be in different positions can be
selected. All available layouts are displayed in the Slide Layout drop down menu.
To change a slide layout à

• Click on the Slide you wish to change the layout for.
• Click on the LAYOUT button in the SLIDES group on the HOME ribbon.
• Select a layout you wish to apply by clicking on the desired layout from the displayed list with the
let mouse button.
• This will apply the selected slide layout to the current slide
Reapplying a slide layout à
• A layout can be reapplied to a slide by repeating the steps above.
• Select the slide you wish to return to the default content layout for that slide type
• Click on the RESET button on the SLIDES group, HOME ribbon.
• This will reset the layout if you have moved your placeholders or deleted some.
Saving A Presentation à
It is important to save your presentation regularly so that your work is not lost in the event of a system
crash or a power failure.
Name And Save A Presentation Fileà
The first time you save a presentation that you have created, you will need to allocate a file name.
To save and name a presentation fileà
• Click on the OFFICE BUTTON and select, SAVE AS.
• Use the SAVE IN dropdown field to select the drive in which to save the presentation.
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• Double click on a folder to open it. Repeat as necessary until the required folder is displayed in the
SAVE IN ield.
• Type in a FILE NAME.
• Click on SAVE.
Files, by default in 2007 are saved with the SAVE AS TYPE extension PPTX and are not compatible with
earlier versions of power point.
To make compatible with earlier versions à
Save as above but before clicking on the save button change the save as type by using the drop
down arrow to the right of that box and change to save as type of the version you wish (97-2003 file
format).
File Names can contain up to 255 characters and can include characters such as spaces and hyphens.
Subsequent Saves à
Once you have given a presentation a name and specified a location, you should then save that file
regularly as you work.
To save a presentation à
• Select OFFICE BUTTON and SAVE
• Click on the QUICK ACCESS toolbar
• Press CTRL+ S
Saving A Presentation With A New Name à
If you need to copy a presentation then you can save the current presentation under a different name
thus creating a copy of the original.
To save a presentation with a new name à
• Click on the OFFICE BUTTON and select, SAVE AS. The original presentation file name is automatically
selected.
• Delete this and type in a new file name.
• Click on SAVE.
Power point Views à
Different Ways To View Slidesà
When you are creating your presentation you can switch between different views within PowerPoint,
each of which allows you to work in different ways. The views available in Power Point 2007 are:

• Normal (Tri Pane) View
• Slide Sorter View
• Notes Page View
• Slide Show
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To switch between these different presentation views you simply need to select the view from the VIEW
ribbon in the PRESENTATION VIEWS group.

Alternatively, you can click on the required view button at the bottom let of the screen.
However, this option only gives you access to NORMAL. SLIDE SORTER, and SLIDE SHOW views.

The Normal (Tri Pane) View à
In the Normal view you can display the slide, outline and notes views in their own adjustable panes, so
you can see everything at once. NORMAL view is the main editing view, which you use to write and
design your presentation. he view has three working areas: on the left, tabs that alternate between an
outline of your slide text (OUTLINE tab) and your slides displayed as thumbnails (SLIDES tab); on the right,
the SLIDE PANE, which displays a large view of the current slide; and on the bottom, the NOTES PANE.
The notes area allows you to enter notes about the current slide that will not be seen on screen but can
be printed with a picture of the slide to aid a presenter in front of his audience.
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Working With Outline View à
The Outline Tab à
This pane enables you to edit your presentation quickly when it contains a large amount of text. You
can add new slides and text in Outline View. This area is a great place to start writing your content,
planning the logical order you want to present your ideas in, and move slides and text around.
To work in Outline View à
• Click the OUTLINE tab from the NORMAL (Tri Pane) View
• The outline format helps you edit your presentation’s content and move bullet points or slides
around. It allows you to create new slides and add text to slides very quickly.
The Outlining Toolsà
You can increase or decrease text indents, collapse and expand content so that you see slide titles but
no subordinate bullet points, and show or hide text formatting as you work.
To select text in Outline Viewà
• To select all text on a slide, on the OUTLINE tab in normal view, point to the slide icon, and when
the pointer changes to a four-pointed arrow, clicks the icon.
• To select a bulleted item and all its subordinate paragraphs, point to the bullet, and when the
pointer changes to a four-pointed arrow, clicks.
Expand Or Collapse Text à
When you work with text on the OUTLINE tab in normal view, you can collapse text so that you see only
the first outline level (slide titles) as you organize. You can re-expand text at any time. You increase
or decrease text indents, collapse and expand content so that you see slide titles but no subordinate
bullet points, and show or hide text formatting as you work.
To collapse text on one slide à Double-click the SLIDE icon
To Collapse all text in the presentation à Right click and select COLLAPSE ALL
To Expand text on one slide à

Double-click the SLIDE icon

To Expand all text in the presentation à

Right click and select EXPAND ALL

Demote Or Promote Text à
You can increase or decrease text indents, (demote or promote text) using the right click. On the
OUTLINE tab in normal view, click the text whose indent level you want to change.
To decrease an indent àRight click and select PROMOTE
To increase an indent à Right click and select DEMOTE
Creating A Summary Slide à
The ability to create a summary slide and a table of contents slide in your presentation is not available
in Microsoft Office PowerPoint 2007. Instead, to create your own summary or table of contents slide by
copying slide titles onto a new slide, do the following:
To create a summaryà
On the HOME ribbon, in the SLIDES group, click the arrow under NEW SLIDE, and then click a slide layout
that contains a large body text placeholder
Note: If you add a BLANK slide layout, you must then add a text box. To do this, on the INSERT tab, in the
TEXT group, click TEXT BOX, and then drag to draw a large text box on the new slide.
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• In the pane that contains the OUTLINE and SLIDES tabs, click SLIDES.
• For each slide that you want to add to the summary or table of contents, copy the title in the title
placeholder, and then paste it onto the new slide in the order in which the slide appears in your
presentation.
Importing An Outlineà
In some cases, you may prefer to use a Word Processor to create your slide show outline. As long as
that document uses a format that PowerPoint understands (RTF, TXT, DOC, etc), it can create a slide
show outline directly from the document, saving you valuable time.
To Import a pre-existing outlineà
• Create a new presentation.
• On the HOME ribbon, in the SLIDES group, click NEW SLIDE, and then click SLIDES FROM OUTLINE a
dialog appears

• Outlines can be any textual documents that can contain an outline. Locate the file and click on
insert. The textual outline will be inserted within your presentation generating slides as necessary.
Add A Slide From Another Presentation File à
To add one or more slides, from a different presentation file that is located on your computer or on a
network share, do the following:

• Open the presentation that you want to add a slide to.
• In the pane that contains the OUTLINE and SLIDES tabs, click SLIDES, and then click where you
want to add a slide.
• On the HOME ribbon, in the SLIDES group, click NEW SLIDE, and then click REUSE SLIDES
• In the REUSE SLIDES pane, click OPEN A POWERPOINT FILE.
• In the BROWSE dialog box, locate and click the presentation file that contains the slide that you
want, and then click OPEN.

6.12 I The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program

In the REUSE SLIDES pane, Microsoft Office PowerPoint 2007 displays thumbnails of the slides from the
presentation that you selected. Rest the pointer on a thumbnail to see a larger version of the slide’s
contents

• In the REUSE SLIDES pane, do one of the following:
If you want the slide that you are adding to the destination presentation to maintain the formatting of
the original presentation, select the KEEP SOURCE FORMATTING check box before you add the slide to
the destination presentation.
• To add a single slide, click the slide.
• To add all of the slides, right-click any slide, and then click Insert All Slides on the shortcut menu
Slide Sorter Viewà
Slide sorter view is an exclusive view of your slides in thumbnail form. When you are finished creating
and editing your presentation, slide sorter gives you an overall picture of it making it easy to reorder,
add, or delete slides and preview your transition and animation effects.

Working With Slide Sorter Viewà
When you are finished creating and editing your presentation, slide sorter gives you an overall picture
of it - making it easy to reorder, add, or delete slides and preview your transition and animation effects.
To change to Slide Sorter Viewà
Choose SLIDE SORTER view from the VIEW ribbon
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To change the order of your slides à
• Switch to SLIDE SORTER view.
• Click on the slide you wish to move and drag it to the position you require.
• Repeat this process until your slides are in the correct order
Deleting a slide à
• Switch to SLIDE SORTER View
• Select the slides you want to delete. (If you want to select slides in order, press SHIFT as you click;
for slides not in order, press CTRL as you click.)
• Press the DELETE button from the SLIDES group on the HOME ribbon.
Moving & Copying Slides In A Presentationà
To Copy slides within a presentationà
• Select the slides you want to copy. Click to select a single slide, press SHIFT while clicking to select
adjacent slides, or press CTRL while clicking to select non-adjacent slides.
• Then choose COPY from the clipboard group
• Click between the slides you want your copied slide or slides to be, and choose PASTE.
If the slides you pasted use a different design template than the slide you pasted after, and you want
to keep the original formatting, go to the next step. Otherwise, the pasted slides assume the formatting
of the slide they follow, and the paste is complete.
• To retain the slides’ original formatting, click the PASTE OPTIONS smart tag, which appears under
the slides you pasted, and on the button menu, click KEEP SOURCE FORMATTING.
• If you decide you want the current design template styles to apply, click USE DESIGN TEMPLATE
FORMATTING (this is the default).
To Move slides within a presentationà
• Select the slides you want to move. Click to select a single slide, press SHIFT while clicking to select
slides in a row, or press CTRL while clicking to select slides not in a row.
• Then choose CUT. Click the slide you want your cut slides to follow, and choose PASTE.
Note: If the slides you pasted use a different design template than the slide you pasted after, and you
want to keep the original formatting, go to the next step. Otherwise, the pasted slides assume the
formatting of the slide they follow, and the paste is complete.
• To retain the slides’ original formatting, click the PASTE OPTIONS button, which appears under the
slides you pasted, and on the button menu, click KEEP SOURCE FORMATTING.
• If you decide you want the current design template styles to apply, click USE DESIGN TEMPLATE
FORMATTING (this is the default).
Note: To drag the slides, select them, drag them to the new position on the Slides tab, look for the
horizontal line under the slide where you want to paste, then release To copy, you can also press
CTRL+C; to cut, you can press CTRL+X; to paste, you can press CTRL+V.
Moving And Copying Between Presentations à
Moving and copying slides between presentations allows you to easily access slides contained in
different presentations and include them in your current presentation.
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To copy slides between presentationsà
• Ensure that both the PowerPoint files are open i.e. both the source of the PowerPoint slides being
copied and the destination file that the slides are being copied into.
• On the VIEW menu in the WINDOW group, click ARRANGE ALL.
• Select the slides you want to copy (within the source file). Click to select a single slide, press SHIFT
while clicking to select slides in a row, or press CTRL while clicking to select slides not in a row.
• Then choose COPY.
• Click into the slide you want your copied slides to follow (within the destination file), and choose
PASTE.
Note: If the slides you pasted use a different design template than the slide you pasted after, and you
want to keep the original formatting, go to the next step. Otherwise, the pasted slides assume the
formatting of the slide they follow, and the paste is complete.
• To retain the slides’ original formatting, click the PASTE OPTIONS button, which appears under the
slides you pasted, and on the button menu, click KEEP SOURCE FORMATTING.
• If you decide you want the current design template styles to apply, click USE DESIGN TEMPLATE
FORMATTING (this is the default).
To move slides between presentations à
• Ensure that both the PowerPoint files are open ie. Both the source of the PowerPoint slides being
copied and the destination file that the slides are being copied into.
• On the VIEW menu in the WINDOW group, click ARRANGE ALL.
• Select the slides you want to Move (within the source file). Click to select a single slide, press SHIFT
while clicking to select slides in a row, or press CTRL while clicking to select slides not in a row.
• Then choose CUT.
• Click into the slide you want your copied slides to follow (within the destination file), and choose
PASTE.
• If the slides you pasted use a different design template than the slide you pasted after, and you
want to keep the original formatting, go to the next step. Otherwise, the pasted slides assume the
formatting of the slide they follow, and the paste is complete.
• To retain the slides’ original formatting, click the PASTE OPTIONS button, which appears under the
slides you pasted, and on the button menu, click KEEP SOURCE FORMATTING.
• If you decide you want the current design template styles to apply, click USE DESIGN TEMPLATE
FORMATTING (this is the default).
View In Black And White à

To see slides in Black and White or grayscale à
• Select the view ribbon and select the BLACK AND WHITE, COLOUR or GRAYSCALE from the
COLOUR/GRAYSCALE group
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• The presentation slides and the thumbnails will now display in black and white If legibility and
contrast has deteriorated, select each object and you will notice that you have a new ribbon
called grayscale to allow you to fine tune the settings for each object on all of your slides.

To Print Grayscale à
The settings above are purely for onscreen while building your presentation they have nothing to do
with the running of the presentation or the printing of it.
If you want your presentation to print in Black and White, the Colour/grayscale option in the Print dialog
box (File, Print) will convert your presentation to grey scale as it prints. The Pure Black and White option
in the Print dialog box will print all colours as black or white only.
To print grayscale/black and white à
• Click on the OFFICE BUTTON and select PRINT from menu to call up the PRINT dialog box.
• To the bottom let of the dialog select the COLOUR/GRAYSCALE type you wish to print in from the
drop down box.
• Click OK to print in that colour format

Slide Show View à
Viewing A Slideshow à
Instead of having OHP transparencies produced you can show your presentation directly from your
computer, using the electronic slide show. You can show the presentation on the computer monitor or
use an LCD panel and project the show onto an overhead screen.
Slides ill the whole screen and display exactly as formatted. As you click with your mouse or press ENTER
on your keyboard you will automatically be taken through each slide.
Furthermore you can incorporate a range of extra features such as transitions (the way one slide makes
way for the next) and animated build effects (which allow objects such as text and graphics to “fly”
onto the slide in different ways). You can also include movies and sounds in your presentation as well
as buttons which allow the user to branch from one slide to another. Transitions and Animations will be
detailed in later sections.
When choosing the slide show button at the bottom let of your screen, your slide show is started from
the slide you have selected. However, when starting the slide show from View, Slide Show you will
always be started from the first slide in the presentation.
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To view a slideshow presentation à
Go to the view ribbon and select slideshow from the presentation views group
Print Previewà
PowerPoint 2007 gives you the ability to preview the way your slides will look before they are printed
out on paper.

To use print preview à
• From the OFFICE BUTTON choose PRINT then PRINT PREVIEW.
• Use the NEXT PAGE and PREVIOUS PAGE buttons to advance through your slides.
• You can choose other options for what to print e.g. handouts with three slides per page, by
choosing a new option from the PRINT WHAT box by clicking on the drop down arrow.

• You can choose other printing options by clicking on the OPTIONS button on the menu. e.g. to
create a frame around each slide choose FRAME SLIDES. The SCALE TO FIT PAPER option will resize
your slides for printing on A4 paper
• To return to your previous view after working in Print Preview, click on the CLOSE button.
Formatting Slidesà
Selecting Placeholders And Textà
In order to change the appearance of text, it is firstly necessary to select or highlight either the text or
the placeholder that the text sits in. There are a number of different methods used for selecting the text.
Selecting Placeholdersà
Selecting the entire frame or placeholder is a very quick, efficient and consistent method of selecting
text. Any formatting applied to a selected place holder will format all text sitting in the place holder
To select the Placeholderà
• Click into the text to be formatted.
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• Click on the shaded border of the text box. This will change the pattern of the border line to
indicate that all text in it is selected.

Selecting Textà
You may to apply different formatting to different parts of text within the one place holder or frame.
To select some of the text in a box à
• Click into the text to be formatted.
• Click and drag through text to select it.
To select text by paragraph à
• Click into the text to be formatted.
• Triple click in the text to select a paragraph and any second, third, fourth and fifth level paragraphs
below it.

Formatting Text à
Text formatting allows you to change the font, size, colour and style of your text. Using similar formatting
across your Word, Excel and PowerPoint documents helps to present a consistent and professional
corporate image. Don’t forget, in order to format text, it is firstly necessary to select it.
The HOME ribbon contains a variety of different options for formatting text on a slide.
The FORMAT ribbon contains many options for changing the appearance of text radically or of
formatting the whole placeholder.
To format text using the home ribbonà
• Select the text you want to format
• Use the buttons on the home ribbon to change many aspects of the font style
• Set the options for FONT, SIZE, COLOUR and EFFECTS. Choose from Effects such as SUPERSCRIPT
and UNDERLINE.
• Click on OK.
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Note: Colours offered are from your Colour Scheme, to use additional colours choose the More Colour
option.
Text Formatting Using The Format Ribbon à
For more advanced and drastic formats, you can make use of the Format ribbon.

To apply formats using the Format Ribbonà

• Select the placeholder you want to format
• Click on the FORMAT ribbon.
• In 2007 the placeholder text is easily formatted as word art by selecting one of the word art styles
in that group
• The buttons with drop down arrows to the right of the word art group allows the changing of colur,
border colour or style of text. Clicking on the drop down arrow to the right of each button. Allows
a selection to alter your text to your satisfaction.
• The text style button allows dramatic changes to your text for a highly professional look to your
text. You may change the attributes for all aspects of your text
• The shadow
• Reflection
• A glow
• The bevel
• 3-d rotation
• Transformations
• After making choices from all of these options your text may appear as below:

• Further text effects and OPTIONS may be achieved by clicking on the DIALOG BOX LAUNCHER
from the WORDART STYLES group and making further changes to your text options from the FORMAT
TEXT EFFECTS dialog which offers many options that will allow you to refine your initial choices from
the preset menus. Such as:
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•
•
•
•
•
•

Text fill
Text outline
The text outline style
3-d format of the text
It’s rotation
Text box options shown in the following dialog

The Format Painter à
The Format Painter is a tool that you can use to copy all the formats from one area of text to another.
This is particularly useful when you have spent time formatting one placeholder and you decide that
you would like to apply the same formatting to another placeholder – rather than reapplying the
formats again manually, one by one, you can paint them in to the new placeholder or text with the
Format Painter.
To paint formats à
• Select the placeholder or the text that contains the formatting that you want to use.
• Click the FORMAT PAINTER button from the HOME ribbon. Your mouse pointer will change to
display a paintbrush next to the selection pointer
• Select the placeholder you want to apply the formats to by clicking on it. As soon as you release
the mouse, the format will appear
Note: The format painter will paint the formats from your chosen placeholder and will then turn off.
You can keep the format painter turned on to enable the painting of multiple placeholders by double
clicking on the format painter instead of single clicking as above. To turn the format painter off when
finished, press esc or click once on the format painter button.
Changing Caseà
If the case of the letters is wrong, rather than deleting and re-typing in the correct case, you can use
the following formatting option.
To change text caseà
• Select your text
• Select the drop down arrow next to the CHANGE CASE button
in the FONT group on the HOME ribbon
• Choose desired case.
Note: Once your text is selected you can also use SHIFT + f3 to toggle between Upper, Lower and
Sentence case.
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Formatting Slide Backgroundsà
The background colour of all new slides is, by default, white. It is possible to apply a different colour,
graded fill colour, pattern, texture or picture, which will override the default setting. The change applies
to all slides that follow the design template of the currently selected slide.
To change the background formattingà
• On the DESIGN ribbon, click on the BACKGROUND STYLES button from the BACKGROUND group.
Make a choice from one of the preset options displayed.

• Make selections from the FILL category or click on the PICTURE category to select a picture for
your background. When all desired selections have been made click CLOSE.
Note: A picture you use as a slide background will be stretched to fill the slide background area. If it is
not of suitable proportions it will be distorted.
You can insert many popular graphics file formats into your presentation including Enhanced Metafile
(.emf), Joint Photographic Experts Group (.jpg), Portable Network Graphics (.png), Windows Bitmap
(.bmp, .rle, .dib) and Windows Metafile (.wmf) graphics. To insert other file formats you will need to
install additional graphic filters.
Objectsà
Chartsà
Charts in power point 2007 are very different from earlier versions and for the most part it is just like
working in excel. In fact the underlying datasheet IS excel and when you select the data or edit the
data you will be working in the underlying spreadsheet. The charting program is exactly the same
otherwise as you would find in excel.
An embedded chart appears on the worksheet where it was created. It is an embedded object, which
does not normally appear in its own window, and has no separate existence apart from the slide.
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Chart Elements à
Some chart elements to be aware of:
Chart Element

Description

Titles

This is the area where you can specify the titles to have on the chart (i.e. X-axis
“1998”, Z-axis “GBP”

Axes

Here you specify whether you want a Y/Z axis and whether you are using timescales
to plot your data

Gridlines

The gridline ribbon allows you to switch on and off horizontal and vertical gridlines

Legend

Use this ribbon to switch the legend on and off or reposition it

Data Labels

The Data Labels ribbon allows you to display the amount each point represents or
display the label (i.e. in the example above, each cylinder would have Qtr1, Qtr2
displayed as appropriate at the top of each data marker)

Data Table

The Data Table ribbon will display a grid underneath the chart that will show the
information that is being plotted.

Illustrationsà
Drawingà
PowerPoint offers a wide range of drawing tools which allow you to create your own pictures to visually
enhance your presentation. You also have a comprehensive Clip Art gallery of pictures which can be
inserted into your slides.
Creating Regular Shapes à
To draw a shape à

• In the DRAWING group on the HOME ribbon select a shape from the SHAPE gallery
• Go to the ILLUSTRATIONS group on the INSERT ribbon and click on the SHAPES button to open the
Shapes menu.
• To draw a shape, click on the shape to select it, and then click on the slide at the top left corner
where you want to start and drag the outline of the shape diagonally. Release the mouse and the
shape appears on the slide.
Drawing Perfect Squares, Circles And Straight Linesà
If you hold down the SHIFT key while dragging an oval or a rectangle, PowerPoint keeps the object
the same width and height. That way you can make perfect circles and squares. Release the mouse
before you release the SHIFT key.
Holding down the SHIFT key while dragging a line or arrow keeps your line at an angel that’s an exact
multiple of 15 degree increments, which is particularly useful for making exactly horizontal or vertical
lines. Release the mouse before you release the SHIFT key.
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To draw “perfect” objectsà
• Select a SHAPE Tool.
• Hold SHIFT as you click and drag to define the shape on the slide.
• Release the mouse before you release the SHIFT key
Drawing Object from Centre Outwards à
Sometimes, it’s useful to draw a shape by anchoring its centre point and then dragging. This is particularly
useful when trying to position things accurately on a slide.
To draw an object from the centre out à
• Select a Shape Tool.
• Hold CTRL as you click and drag to define the shape on the slide.
• Release the mouse before you release the CTRL key.
You can draw a perfectly regular shape from the centre outwards by holding down SHIFT + ctrl as you
draw the shape.
Quick styles à
Quick Styles are combinations of different formatting options and are displayed in a thumbnail in the
various Quick Style galleries. When you place your pointer over a Quick Style thumbnail, you can see
how the Quick Style affects your Smart Art graphic or shape.
Quick Styles for Smart Art graphics (Smart Art Styles) include edges, shadows, line styles, gradients and
three-dimensional (3-D) perspectives. Try different combinations of Smart Art Styles and colours until
you find one that matches the message that you want to communicate. You can pick a layout, a
Smart Art Style, and a colour variation that you like, and then change the layout again your Smart Art
Style and colours will stay with your Smart Art graphic, so that you do not need to re do them.
Smart Art Styles map the theme effects (theme effects: A set of visual attributes that is applied to
elements in a file. Theme effects, theme colours and theme fonts compose a theme.) of the document
theme to the shapes within the Smart Art graphic. For example, shapes might have thick lines or edges,
while arrows might have a more subtle style applied to them. You can also apply colours from the
theme colours of the document in different ways, such as changing the colour of the shape border. If
you create multiple Smart Art graphics and want them to look alike, you can apply the same colours
and Smart Art Style to achieve a consistent, professional look.
You can have shapes that display with edges, depth, and rotate in 3-D space. To make a Smart Art
graphic three dimensional, apply a 3-D Smart Art Style or manually apply a 3-D rotation to each shape.
If the entire Smart Art graphic is three- dimensional (called scene coherent 3D), you can continue to
edit the text and formatting of each of the individual shapes, but the shapes cannot be repositioned
or resized. You can only reposition or resize shapes in a two-dimensional scene. To switch between 2-D
and 3-D, under SMART ART TOOLS, on the FORMAT ribbon, in the SHAPES group, click EDIT IN 2-D. The
EDIT IN 2-D button temporarily unlocks your Smart Art graphic for editing so that you can move and
resize shapes— but the 3-D Smart Art Style is still applied to your Smart Art graphic and reappears when
you click EDIT IN 2-D again. When you’re Smart Art graphic is displayed in a 3-D scene, you can rotate it
as a whole and position light sources and the “camera” such that the entire Smart Art graphic appears
to pop out of the screen.
Smart Art Styles affect an entire Smart Art graphic, while Quick Styles for Shapes (Shape Styles) affect
only the selected shape. You can manually customize a shape by changing the colour, effects or
border, or by replacing it with another shape. It is recommended that you customize your Smart Art
graphic only after you settle on its content and layout, as some customizations are not transferred
because they might not look good in the new layout. For more information about switching layouts for
Smart Art graphics, see Switch the layout or type of a Smart Art graphic.
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To apply a Quick Style à
• Select the shape or shapes you wish to apply a Quick Style to.
• As you move your mouse over the various options your shape
on the worksheet will temporarily take on that format as a
preview. See below.
• If you prefer to look at the other theme fills option at the bottom you
will be given the above options
• When you locate the style you want click on it to apply it to your
shape.
Slide Types And Layoutsà
Slidesà
Slides are the main articles of use in power point and have been mentioned many times so far in this
manual they are the building blocks of your presentation and as such will form the content of your
presentation showing one slide after another displaying the content you have inserted, formatted and
animated from the first to the last slide. They are not however the best or fastest way to construct a
formatted presentation.
Every slide you have inserted has had placeholders formatted in a default way. A default background
colour. Default positioning on the slide and no animation effects applied whatsoever. If we could
change the defaults for each of the slide layouts you have applied to your presentation then we could
concentrate putting the text in the outline and the slides themselves would be already formatted
for the main part in the way we would like. his is a much faster way of working and enables us to
concentrate on the content rather than having to spend so much time formatting each and every
slide. To do this we use master slides to hold the default formatting or objects that we wish. BUT NOT THE
TEXTUAL CONTENT.
Slide Layoutsà
After inserting a slide you may wish you had chosen a different layout. There is no need to delete a slide
and reinserting one of another type. You may just change the layout this is especially useful if your slide
already has content.
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To change the layout of a slideà
• Make sure that the slide that you wish to change the layout for is in the main window in normal
view.
• Click on the drop down arrow to the right of the LAYOUT button.
• Select a new layout for the chosen slide by clicking with the let mouse button.
• The selected layout is applied.
Slide Formattingà
Before, or instead of, the formatting of all objects on your slide you may wish to make changes to the
slide format globally by either colouring the background of each slide in one go or manually formatting
one slide and applying it to all slides this can save much time when you have many slides within
your presentation. Presentations within power point are based on a theme and the formatting of that
theme determines the placement and colours and styles of all objects within the presentation. he area
where these themes are kept and can be altered is in the slide master view of your presentation and
any change there will apply globally to the whole presentation or to the slides of a particular layout we
will now look at applying those @themes’ and then manually editing them to create one of our own.

Themes à
Themes are used to give your slide presentations a consistent and stylish appearance. They contain
colour schemes, slide and title masters with custom formatting, and some also include background
graphics which have been placed into the masters. When you apply a theme to your presentation,
the Office theme master and its subset of slide layout have the colour scheme of the theme applied
and it will replace the previous office theme master and colour scheme of the presentation. Once you
apply a Design Template, each slide you add, regardless of the layout, has the same custom look to it.
PowerPoint 2007 comes with a variety of professionally designed themes.

Applying A Theme à
• Ensure no object is selected as this may confuse you having two design ribbons. (one for the
object, one for the slide)
• Choose the DESIGN ribbon, go to THEMES.
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• Click on the drop down arrow to the bottom right hand side of the visible themes.
• Move your mouse over a theme to see a preview of how it will look on your slide.
• Click on a template thumbnail. It will be applied to all the slides in the presentation. It is possible to
apply a design template to selected slides, rather than the entire presentation.
To apply a template to selected slides à
• Select the slides and then right click on a template thumbnail.
• Right click on the thumbnail
• Choose APPLY TO SELECTED SLIDES
When you apply a template to your presentation any logos, graphics and extra text you have previously
placed on your Slide Masters will disappear. If you want to use a design template and show your own
logo too, you must apply the template before adding the logo to the Slide master.
The change in Colour Scheme will affect the colour of many of the objects you may have drawn. It will
also cause charts/ graphs to be re-coloured. For these reasons it is better to apply a Design Template
as early on in the creation of your presentation as possible.
Slide Colour Schemeà
Before starting any formatting you should choose an overall colour scheme. A colour scheme is a
set of eight balanced colours. This default palette of colours will automatically be used for text, slide
background, and any graphics you create such as charts, graphs and artwork.
Once you have chosen your colour scheme you will always be offered this palette of eight colours irst
when formatting everything from text to bullets to background to pictures. However you will still have
access to the full PowerPoint colour palette which you can choose from at any time
Slide Backgroundà

You can apply diferent backgrounds to all or to individual slides.
Use this option to colour the background of your slides. Although you could choose to have different
backgrounds for each slide it gives a more professional effect if you use the same background on all
slides of a presentation.
To apply a standard background à
• Select BACKGROUND STYLES from the DESIGN ribbon
• Choose a style from the dropdown list.
• Right Click on the style to show menu so you may APPLY TO ALL OR TO JUST SELECTED SLIDES if you
have several slides using the same layout then you may apply to matching slides.
Headers And Footers à
A header or footer is text or graphics that appears at the top or bottom of every slide in a presentation.
You can add company logos or other pictures, slide numbering and informative text, such as the
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date or author. To add text use the Header and Footer command. To add graphics and to format the
header and footer text uses the Slide Master.

To Add Headers & Footers to Slides à
• Select HEADER AND FOOTER from the INSERT menu in the TEXT group.
• Click on the SLIDE Tab.
• To include Date, Slide Numbering or Footer text click in the small check box by each option to
display a tick-box.
• For Date, choose UPDATE AUTOMATICALLY and select a format or enter date text manually for
FIXED.
• Type in any required FOOTER text.
• Click on APPLY TO ALL to apply to all the slides in the presentation.
Use the Don’t show on title SLIDE check box to hide headers and footers on your title slide.
• Select HEADER AND FOOTER from the INSERT menu in the TEXT group.
• Click on the NOTES AND HANDOUTS Tab.
• To include DATE, SLIDE NUMBERING, HEADER OR FOOTER text click in the small check box by each
option to display a tick -box.
• For Date, choose UPDATE AUTOMATICALLY and select a format or enter date text manually for
FIXED.
• Type in any required FOOTER and HEADER text.
• Click on APPLY TO ALL.
To format the appearance of these headers and footers use the Notes Master and Handouts Master.
Master Slides à
The slide master stores information relating to the underlying formats of the slides in your presentation,
including font styles, placeholder sizes and positions, background design, and colour schemes and
is used to control the appearance of the presentation. Each presentation can have a series of Slide
Masters to match the layouts you choose. When you want to apply consistent formatting through all
slides in your presentation, you change global attributes by editing the Slide Masters. These changes
will be automatically reflected through each slide (apart from the Title Slide). This is done through the
VIEW ribbon, PRESENTATION VIEWS group, SLIDE MASTER Button.
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Accessing the Slide Master à
Click on the VIEW ribbon, PRESENTATION VIEWS group, SLIDE MASTER Button.
Selecting The Correct Master à
The master view appears as on the previous page. On the left hand side in are masters for each of
the layout types that you may choose for your presentation in NORMAL view. They contain the default
formatting and positioning for the place holders and backgrounds. You may select each master and
change the layout or format of each of them and wherever that layout is used in NORMAL view it will
pick up its default formatting from that master.
To select the correct master à
Since the most often used layouts in your presentation would be the title layout (used for the first slide
and possibly each new part within your presentation it contains a title and subtitle placeholder) and
the default text layout (title and bulleted text placeholders) we could start with those.
To select the title master à
• Make sure you are in MASTER view.
• Select from the masters on the let the TITLE MASTER (second in list usually) it contains a TITLE and
SUBTITLE placeholder.
• The appropriate master appears in the main window.
To select the title and text slide master à
• Make sure you are in MASTER view.
• Select from the masters on the let the TITLE AND TEXT SLIDE MASTER (last in list usually) it contains a
TITLE and BULLETED TEXT placeholder.
• T he appropriate master appears in the main window.
Formatting The Mastersà
Formatting the master is much the same as formatting a normal slide as far as formatting the various
elements of the master goes.
Office Theme Masterà
The office theme master (title and content) is the master that oversees all other masters. Any formatting
applied to this master will APPLY TO ALL SLIDE MASTERS. You would then tweak each master with any
separate formats or placeholder positions that you wish.
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To format the Office theme slide masterà
• Select the OFFICE THEME SLIDE MASTER. Usually first in the list. (Title and content)
• In the main window select the MASTER TITLE placeholder.
• Format the text and ill as you would on a normal slide.
• Change its position if you need to.
• Select the BULLETED TEXT placeholder
• Format the placeholders text and ill how you desire and move it if you need to.
• Format the bulleted levels by clicking on each level in turn and format as previously explained text
and bullet or number style
• Place any required graphics, logos and additional headers and footers on the slide master and
format as desired.
• Format the background as described previously
• Any formatting changes made to the OFFICE THEME MASTER can be seen reflected in all of the
masters to the let in the SLIDE MASTER view.
• All slides that you have used the TITLE AND CONTENT SLIDE layout on will now have picked up the
format from the OFFICE THEME SLIDE master and the positioning of placeholders. Bulleted text will
now display the format you have set for each level.
• To change the position of any graphic or box of click and drag the object to a new position.
• Return to NORMAL View. (Click on the CLOSE MASTER VIEW button or on Normal View button).
All your slides will now follow the formatting of the Slide Master. All graphics, logos, headers and footers
on the master will show on all slides.
If you would prefer the text on any individual slide not to follow the Slide Master format the text of that
slides individually.
Create Your Own Master à
One of the brand new features in 2007 is the ability to create your own master slide layout and insert
placeholders and position them in any place you wish. You may even create your own office theme
master (global Master) his means that you are not bound by the inbuilt masters within power point.
These masters will become layout options for your slides as you build your presentation.

To create your own master slide à
• Go to slide master view.
• Click on insert layout in the EDIT MASTER group.
• A new master layout will appear in your let hand panel and be highlighted. It will also appear in
the main window.
• Click on INSERT SLIDE MASTER. (a new office theme master will appear)
• Click on the drop down arrow to INSERT A PLACEHOLDER in the MASTER LAYOUT group.
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• Select the type of content you will want to use for your master layout and place and position the
placeholders on the slide master.
• Format and position the placeholders as previously instructed.
• Click on CLOSE MASTER VIEW.
To rename a master à

• Go to MASTER view
• Select in the left hand pane the master you wish to rename.
• Click on RENAME in the SLIDE MASTER group a dialog will appear.
• Enter a new name for your master.
• Click on RENAME
To delete a master à
• go to MASTER view
• Select in the left hand pane the master you wish to delete.
• Click on the DELETE button in the SLIDE MASTER group.
Multiple Slide Mastersà
In PowerPoint 2007, it is possible to have more than one Slide Master. PowerPoint users can easily
create more than one slide master within one file. This makes it possible for users to combine multiple
presentations in one file or create separate sections within the same presentation.

To Insert a second slide Masterà
• go to MASTER view
• Click on the button to insert new slide master. A new office theme master is inserted
• Format this as described earlier in the way you wish it to be different from the first slide master.
• You may insert then new layouts and format them as you wish.
• You may create and format as many masters as you wish each will be numbered.
Note: To establish the formatting for title text, body text, bullets and footers for all layouts select the
relevant sample text or bullet and format them as previously discussed.
To apply a new slide masterà
In normal view from the design ribbon, apply a new theme to selected slides or to all slides, meaning
the whole presentation, as previously explained.
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Note: warning: if you apply a new master to the entire presentation, the original slide master becomes
unused and will be deleted. You need to preserve the original slide master to avoid it being deleted.
Warning: if you apply a new master to the entire presentation, the original slide master becomes unused
and will be deleted. You need to preserve the original slide master to avoid it being deleted.
Transition And Animation Effectsà
Animation Effectsà
There are many levels of animation effects that can be used within PowerPoint 2007 to create
movement, excitement and impact within a presentation. Obviously, animation effects applied will
not be seen if slides are printed out onto paper or OHP transparency slides, but can be enjoyed when
a slide show is delivered from a computer using electronic projection equipment.
Animation effects can be applied to whole slides to control the way they appear on the screen.
Animation can also be added to text (e.g. to make bullet points build up one by one) and drawn
objects.

Slide Transitionsà
A transition controls the way one slide moves of the screen to make way for the next one during an
electronic slide show. You have a choice of transitions for each slide, including Fade through black,
Dissolve, Cover Let, and Checkerboard Across. You can vary the speed of each one. Transitions can
be applied to individual slides, a number of selected slides or across the whole presentation. Slide
transitions are applied and modified using the Slide Transition task pane.
Setting Slide Transitions à

• Be in either NORMAL view or SLIDE SORTER view.
• Click on the ANIMATIONS ribbon go to the TRANSITION TO THIS SLIDE group.
• Select a transition from the drop down box to apply.
• Select a speed if too fast or slow.
• Select a sound if you wish. This will play as the transition occurs.
• Click on APPLY TO ALL if you wish to set the same transition for all slides.
• The slides which now have a transition applied will have a small star icon next to their slide number
in the thumbnails area. To remove a transition, select the NO TRANSITION option in the transitions
area.
• You can also apply transition effects while working in Slide Sorter view. This may make it easier to
select the slides you wish to apply transitions to.
Slide Timings On Transitionsà
You can set timings for your slides which will result in a PowerPoint show that will automatically run.
Slides will be shown on screen for the amount of time you specify before the show automatically
advances on to the next slide.
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There are two different ways you can set slide timings; setting them manually for each slide or using the
Rehearse tool.
Setting Slide Timings Manuallyà
It is easiest to work in Slide Sorter view whilst setting slide timings although it can be done using the slide
thumbnails in Normal view.
To set slide timingsà
• Select the slide(s) you want to apply timings to.
• You can set the timing for one or more selected slides by entering in seconds the length of time
you want the slides to appear on the screen Timings are shown in Slide Sorter View beneath each
slide.
• Run your presentation in Slide Show view to see the effect of the timings you have added.
• The slides will advance on a mouse click OR after the specified time has elapsed, the trigger is
whichever occurs first.

Animating Text à
You can animate the text in your slide to add emphasis to your topics. On a bulleted list slide, animation
can be applied to both the title area and the bullets area and is most commonly used to get bullet
points to appear one by one. Text animation is applied using the Custom Animation task pane. You
may only apply animation in normal slide view. cc
There are four categories of animation effect to choose from in Power Point 2007:
Entrance Effects change the way that objects arrive onto a slide. Text can be
made to simply appear, or there are more exciting effects such as Crawl In or
Fly In.
Emphasis Effects can be applied to objects that are already on the slide. Emphasis
Effects will bring attention to an item without actually moving its location e.g.
text can be made to spin in position.
Exit Effects change the way that objects leave a slide. The effects applied are
similar to Entrance Effects.
Motion Paths can be used to make objects move along a certain trajectory e.g.
down, up, spiral. Motion paths are not particularly applicable to animating text
and will be looked at in more detail later in this section.
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There are a large number of animation effects within each of the categories above. To help you make
your selection, you will find you are offered five common effects within each category first. Under
More Effects, the animation effects are divided into Basic, Moderate, Subtle and exciting to help you
gauge which might be more appropriate for your needs. You are able to apply more than one type
of animation to an object e.g. you could have an entrance, then an emphasis and finally an exit
effect. However, don’t be tempted to apply too much animation into your slides as it can start to look
unprofessional. A little animation goes a long way!
To apply text animationà
• Select the text object you want to animate
• Open the CUSTOM ANIMATION TASK PANE by choosing custom animation on the animations
ribbon
• Click on the ADD EFFECT button.
• here are 4 types of animation effect to choose from:

• Select the animation effect you require and either choose one of the five common effects, or
select from the More Effects area.
• Choose appropriate options under Start, Direction and Speed.
• The animation effect will be previewed in the slide
To change animation settingsà

• Select the animation to change in the list on the TASK PANE.
• Click on the CHANGE button.
• You can also make changes by clicking on the down arrow next to the animation in the list and
selecting effect options.
• A dialog appears go to the TEXT ANIMATION tab.
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• If you use bulleted lists in your text you set here that they come in by a certain level of paragraph.
In effect bringing in points and sub points individually or as a group.
• On the EFFECT tab you have the choice to bring in the text ALL AT ONCE, BY WORD, or BY LETTER.
• The TIMING tab allows you to set delays on the time between each piece of text appearing.
Note: Be careful to SELECT the animation you wish to modify and then use the CHANGE button, or you
can end up applying a new animation effect by mistake.
Adding another animation effectà
• Select the text object you want to apply an additional effect onto.
• Click on the ADD EFFECT button and select options as required.
• Use the Play button

to run your animation effects in the slide.

• You can change the order in which items on your slide are animated by using the green re-order
arrows

The effects appear in the Custom Animation List, top to bottom, in the order you apply them. The
animated items are noted on the slide by a non-printing numbered tag that correlates to the effects in
the list. This tag does not show up in the slide show view or in Print Preview:
To remove applied animations à
• Select the animation to remove in the list on the Task Pane.
• Click on the REMOVE button.
Preset Animation Schemes à
It can be lots of fun building up your own custom animation for different areas of text in your slides.
However, sometimes you may want to create text animation more quickly. You can achieve a
professional result easily using a preset animation. Animation contains combinations of animation that
apply to the title area, bulleted area or both.
Preset à

PRESET animations are available on the animations ribbon just select the object then choose a preset
from the drop down menu. Some of these animations include sound as well as animations.
Applying A Preset Animation à
• Select the object(s) you wish to apply the animation to.
• Click on the drop down arrow to the right of the “No animation” box
• Select an animation. It is applied to the object(s) you have selected.
Animating Objectsà
Objects that you have drawn (e.g. auto shapes, squares, circles etc), clipart and images can all be
animated to add excitement to a slide.
In PowerPoint 2007 is the ability to apply more than one kind of animation effect to an object, animate
multiple objects simultaneously and use motion paths.
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Adding Animation Effects à
Adding animation effects to objects is very similar to animating text as described earlier in this section.
There are four different categories of animation that can be added: Entrance, Emphasis, Exit and
Motion Paths. Animation is applied using the Custom Animation task pane.
To apply animation à
• Select the item you want to animate.
• Open the CUSTOM ANIMATION task pane as described
• Click on the ADD EFFECT button.
• There are 4 types of animation effect to choose from:

• Select the animation effect you require and either choose one of the five common effects, or
select from the MORE EFFECTS area.
• Choose appropriate options under Start, Direction and Speed.
• The animation effect will be previewed in the slide.
To change animation settingsà

• Select the animation to change in the list on the Task Pane.
• Click on the CHANGE button.
• You can also make changes by clicking on the down arrow next to the animation in the list.
Note: be careful to SELECT the animation you wish to modify and then use the CHANGE button, or you
can end up applying a new animation effect by mistake.
Organize And Deliver Presentationsà
Running A Slide Showà

When you eventually present your PowerPoint slides, you will want to run the slides as a slide show so
the slides occupy the whole of the screen area available and none of the regular PowerPoint toolbars,
menu bars and task panes is shown. It is also necessary to run your slides as a slide show to get the full
effect of any animation effects you may have applied to your slides.
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When presenting a slide show to an audience, you advance your slides by clicking on your mouse or
using the PAGE DOWN or ENTER buttons on your keyboard. PAGE UP can also be used to take you back
to the previous slide if necessary.
Depending on the purpose and audience of your presentation, you can run a slide show in several
ways. One way is to start a slide show from within PowerPoint. Another way is to save a presentation so
that whenever it is opened it always starts as a slide show.
You can also set up a self-running presentation that will run in an ever-repeating loop until you press
ESC. This is useful if the presentation is to run in a kiosk, or on a monitor at an exhibition.
Starting A Slide Show From Within Power point à
Click on the FROM BEGINNING button on the SLIDESHOW ribbon.
Or
Click the SLIDE SHOW button in the lower-right corner of the presentation window. This will start the show
at your currently select slide.
Or
Select VIEW ribbon the PRESENTATION VIEWS group and SLIDE SHOW button
Or
Press F5 on the keyboard. All these options will start the show from the first slide.
To advance slides in the presentation à
Click your mouse. Or Press PAGE DOWN or ENTER on your keyboard.
To move back to previous slidesà
Press PAGE UP on your keyboard. Or Right click with your mouse. From the menu that appears, choose
PREVIOUS.
To end your slide showà
Press ESC on the keyboard. Or Right click with your mouse and choose END SHOW. Or The show will also
end automatically when you have reached the end of all your slides. You will see a black screen and
can click with the mouse or press PAGE DOWN or ENTER to return to PowerPoint.
Rehearsing Timingsà
You can ‘rehearse’ your presentation, talking through the explanation of each slide and PowerPoint
will record the amount of time you spent on each slide. These timings can then be used to run the
presentation in future. They will adjust all of the previously set manual timings you may have entered
within your presentation for transitions.
Rehearsing Timingsà
• Select rehearse timings on the slideshow ribbon.
• Advance the show as you rehearse so that the timings reflect how long you need each slide to be
displayed.
• Use the buttons in the Rehearsal dialog box to pause between slides, restart a slide, and advance
to the next slide. The timer shows you how long the current slide has been on screen.
• If you wish to start timing again for any slide click on the REPEAT button. PowerPoint will record only
the last timing for each slide.
• When you finish PowerPoint will indicate the total timing for the presentation. If this is acceptable
click on YES to save the timings with the show.
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Running A Show Using Timingsà
• Select Slide Show, Set Up Show.
• In the ADVANCE SLIDES area specify that the slide show should be run USING SLIDE TIMINGS, IF
PRESENT.
• Click on OK.

Hiding Slidesà
If you wish not to show a particular slide within a show but don’t wish to delete it because you will use
it again in the future. Then select the slide and use the hide slide button on the slideshow ribbon. Use it
again to unhide the slide(s). It is best to do this in slide sorter view.
Custom Showsà
If there are many slides to be hidden and unhidden every time you go to run your show then custom
shows may be a better option for you to use. Custom Shows allow you to create presentations within
a presentation. Instead of creating multiple, nearly identical presentations for different audiences, you
can create one presentation which includes all the slides for all the audience groups. Custom Shows
then allows you to save different groupings of these slides under different names. By including all slides
in the one presentation you will not need to recreate slides twice but will still be able to offer tailored
shows to both groups.
For example, you might want to give a presentation at induction days for new staff and prefer to
present slightly different information to your new graduate trainees than to your other recruits. Slides
1 to 5 may be identical for both groups, but slides 6 to 7 may be different, with subsequent slides the
same. Once you have created all the slides to be used you can set up two custom shows specifying
which slides to be shown in which order for each group.
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To create A Custom Show à
• Select SLIDE SHOW ribbon, CUSTOM SHOWS button, CUSTOM SHOW to bring up a dialog of all
shows in presentation.

• Click on NEW.
• Type in a name for the show.
• Under SLIDES IN PRESENTATION, select a slide you want to include in the custom show.

• To select multiple slides, hold down CTRL as you click the slides.
• To include the selected slide(s) in the custom show click ADD or double click on the slide name.
• To change the order in which slides appear, select a slide, and then click one of the arrows to
move the slide up or down in the list.
• Click on OK. To see a preview of a custom show, select the name of the show in the Custom
Shows dialog box, and click on SHOW.
Adding Or Removing Slides in A Custom Showà
• Select SLIDE SHOW ribbon, CUSTOM SHOWS button, CUSTOM SHOW to bring up a dialog of all
shows in presentation.
• Select the name of the custom show you want to change.
• Click on EDIT.
• Add or remove the slides you want.
• Click OK.
• To remove an entire custom show, select its name in the CUSTOM SHOWS dialog box, and then
click REMOVE. This removes the custom show, but the actual slides remain in the presentation.
Hyperlinks (Action Buttons)à
You may wish to include slides in your presentation which may or may not be shown depending on the
audience reaction or questions. Action buttons allow you to set up hyperlinks between pages so that
you can jump to a page out of sequence if you wish.

6.38 I The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program

Creating an Action Button Hyperlinkà
• Switch to NORMAL View.

• From the Insert ribbon select the shapes drop down and scroll to the end of the menu of shapes,
ACTION
• BUTTONS, and choose the button tool you require.
• Click and drag to create a button on the slide.
• Press SHIFT to create a symmetrical button.
• When you release the mouse button the Action Settings dialog box is displayed.
• Set ACTION ON CLICK as HYPERLINK TO.
• Pick from available slides in the presentation.
• Click on OK.
• When the slideshow is run clicking on that action button will take you to the slide you specified
• It is best not to use these with timings but more as an interactive show so individuals can navigate
the show at their leisure.
Inserting Hyperlinks (Objects And Text) à

It is not only action buttons that can help you navigate around your presentation ANY object can
become a hyperlink to another slide or presentation, a web address even another program or file.
• Select any object or piece of text that you wish to create a hyperlink from.
• Go to the insert ribbon and notice the two buttons on the Links group.
• If you select the Hyperlink button the dialog below appears
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• On the LINK TO area to the left make a choice of where you wish to link to the default is to a web
page or a file on your system (could be from any application like word or excel)
•

Select the file in the navigation area in the middle part of the dialog

• You may have to navigate to find it but it would be best if it was located where the current
presentation file was saved.
• Enter a screen tip if you wish by clicking on the screen tip button on the top right and enter some
help text that will appear as the mouse hovers over the link when the slideshow is running.

• Click on OK
•

If you choose the action button instead the action dialog will appear which allows you to
determine the action you wish it to do.

•

Follow the steps as for the action button but in the hyperlink to area you have many other options
from the drop down box.

•

Make a selection, Click OK.

Note: These action settings allow anything to behave like an action button or hyperlink.

6.40 I The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program

UNIT - 7
MICROSOFT ACCESS - 2007
MS Access 2007 à
Microsoft Access à
The primary function of Microsoft Office Access 2007 is an information management program. Information
is stored in separate lists called tables, and information in one table may relate to information in one
or more other tables. These groups of information, when considered together as a whole, become a
database.
Access is designed to use the data in these databases to extract the information relevant to your
situation. Access can also generate reports (such as quarterly sales by each employee) based on
the data contained in the database. The Office 2007 package also features a lot of interconnectivity
between the various programs, including a newly designed SharePoint service that lets users in your
organization connect and share information using a special data centre via the Internet.
New Features in Access 2007à
If you are familiar with previous versions of Access, there are a large number of new features and a
completely new interface in Access 2007. If you have never used Access before, don’t worry - you will
quickly become very familiar with these commands as time goes on.
New Interface Designà
Commands hidden in four different menu layers are a thing of the past with Access 2007.). Commands
are now organized using a new action tab scheme. Under each tab are the commands relevant to
the action described on the tab. This command set is referred to as the ‘ribbon.’ Finally, Access 2007
features contextual tabs showing data that is relevant only to the current object you are working on.
We will explore the new interface in more detail later.

New Template Categoriesà
Access 2007 features eleven new templates, each with their own defined tables, forms, reports, queries,
and relationships. They are designed to let you start working right away, but are also completely
customizable.
More Intuitive Sorting and Filteringà
Access 2007 lets you pick from several predefined sorting methods with just a couple of clicks. Access
also features a contextual quick sorting method using plain language. For example, if you have a
column of numbers, Access can sort them smallest to Largest. If you have a column of dates, Access
can sort them from Oldest to Newest.
New Layout Viewà
When working with forms and reports, Access 2007 features an in-between view called Layout View. It
allows you to see a live form or report with real data in it, but also lets you adjust the position of certain
elements in your form or report on the fly. You can also define ‘mini layouts’ that allow you to move
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several controls as a group. Access still features the more in-depth Design view, used to fine tune every
aspect of a control.
Enhanced Tooltipsà
When you hover your mouse above certain command icons, Access 2007 lists the command name, a
short description of the command, and an example (if applicable). (Tooltips in previous Office programs
listed only the command name.)
Automatic Calendarà
When entering information into a Date field, a small icon will appear allowing you to choose a date
from a small calendar. This eliminates the need to enter a date as 03/22/2007 - just open the calendar
and pick the date!
Rich Text in Memo Fieldsà
If a table makes use of a memo field, data can now be stored as something other than plain text. Using
an HTML-based text format, Access lets you automatically add colours, sizes, and formatting to the text
in a memo field.
Quickly Create New objects using the Insert Tabà
In previous versions of Access, you had to move and minimize windows to find the Database window,
pick the category of database object, and then choose to create a new object. With the Insert tab
and ribbon, you can create a form based on a table with only two clicks (versus as many as a dozen
clicks in the past).
If you need a new table at any point, simply click Table on the Insert tab and start entering data.
Access 2007 even lets you paste data directly from a Microsoft Excel spreadsheet. Data types and
formatting will be found and preserved automatically.
Total Row in Datasheet Viewà
Every table in Datasheet view features an automatic Total Row at the bottom. You can find the sum,
count, average, maximum, minimum, standard deviation, or variance using the Total Row.
Field Templatesà
In the past, it was potentially a long and tedious task to mould a number data type into a usable field
for your organization. Now, you can simply click and drag a predefined field from a list right into your
table at any point.
Field List Task Paneà
When creating a query in previous versions of Access, each table had to be inserted into Design view
in order to use various fields. Now, all fields in all tables are visible in a list. Just drag and drop the ones
you need.
Split Formsà
A Split Form is new to Access 2007; it combines Datasheet and Form view together as one. The Datasheet
view can be placed on the top, bottom, left, or right side of the Form.
Multivalued Fieldsà
A single field can contain multiple values in Access 2007. Imagine you have a product that falls into a
few different categories. In previous versions of Access and other database management programs,
this would have required a many- to-many relationship to be defined. Access 2007 handles this
complicated background relationship with only an extra click when designing a field.
Attachment Data Typeà
If you want to e-mail a document to a co-worker or some pictures to family members, the files would
be sent as an attachment to the e-mail. Access 2007 features a similar attachment data type that
can hold documents, charts, sound files, binary files, or any other type of file. Attachments are also
automatically compressed when necessary to reduce the overall size of the database file.
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Alternating Background Colourà
Datasheet view, reports, and long forms now feature the ability to alternate the background colours of
each row. Long lists of data become much easier to read!
Navigation Paneà
The Navigation Pane is an ever-present feature on the left side of the Access window. It contains a
listing of all objects currently contained in the database. The Navigation Pane can also be collapsed
to make more room in the window.
Embedded Macrosà
Though macros go beyond the scope of this manual, macros in Access 2007 are stored inside a
database object instead of being a separate object. This makes these macros much safer to use.
Increased and Enhanced Connectivityà
One of the goals of Office 2007 was to create a centralized location where members of your organization
can meet and share data over the Internet. Though many of these features are more advanced topics
of Access not covered in this manual, Access features a huge variety of SharePoint services. Access
lets you:
• Collect data from Microsoft Outlook
• Store and retrieve data on a SharePoint server
• Integrate with SharePoint Workflow services
• Retrieve data from linked SharePoint lists
• Store a SharePoint list offline for use away from your organization
• Create and save import or export operations if you perform the same online task multiple times
Export Data to PDF or XPSà
You can export a form, report, or datasheet as a PDF (Portable Document Format) or XPS (XML Paper
Specification) to easily print, post, and e-mail regardless of the computer platform your intended
recipient(s) are using.
New Report Viewà
Report view allows you to browse your report without having to print or preview it. You can also sort
and filter records on the fly.
Enhanced Group, Sort, and Total Featureà
You can apply new grouping and sorting levels much easier with Access 2007. Grouping is done
following a natural sentence structure; you simply fill in the blanks along the way.
Additional Security Featuresà
Though many of the security features go beyond the scope of this manual, Access 2007 (and indeed
the entire Office 2007 suite) features a number of security enhancements and SharePoint services. This
functionality includes:
• Enhanced security by disabling macros and code only until needed
• Revision tracking to see who modified what and when
• Permission setting to restrict data modification
• Restore deleted data from the SharePoint Recycle Bin in case of accidental deletion
• Open forms and reports using SharePoint even if Access is not open on your computer
• Keep track of changes made to memo fields
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Basic Terminology à
Let’s take a look at the terminology used in database-speak, starting with the basics. Consider the
following diagram:
Let’s look at each piece of the database.
Fieldà
A field is the smallest piece of a database; that is, one specific piece of information like a number,
a word, a date, a picture, or a reference for some other piece of data. Each column you see in the
diagram would all be the same data type; that is, one column of data would all be numbers.
Recordà
A record is a collection of one or more fields together in a row. (In a real database, you would not
count the word ‘Record’ as depicted in the diagram - this is just to help visualize the concept.)
Tableà
A table is comprised of one or more records. Each table also has a unique name.
Databaseà
A database is comprised of one or more tables. Each database is also given a unique name.
Formà
A form is a tool that is used to easily and accurately enter data into a table. A form presents one record
of a database at a time to a user, or allows a user to enter data into the database one record at a
time.
Queryà
A query is just like a question you ask the database. There are two types of queries: select and action.
A select query will extract and display data based on criteria you provide. An action query will find all
data relevant to your query and perform some sort of operation on it. A query can be performed on
one or more tables in a database.
Reportà
A report presents the data found by a query. A report can be formatted to show summaries, calculations,
charts, and more based on the data returned by a query. Access takes the report one step further
by letting you organize and format a report into a sleek, professional document suitable for printing,
exporting, or e-mailing.
This might seem like a lot to remember, but don’t worry - this terminology will be used heavily throughout
this manual and soon it will be second nature!

7.4 I The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program

Interface Overviewà
In this section, we will learn about the Access starting screen and the view of a typical working database.
We will introduce the views piece by piece in this section of the lesson. There are a large number of
updates to learn about, but with time you will wonder how you ever managed without them!
If you have ever used Access before, the welcome screen for Microsoft Access 2007 has been
completely redesigned.
However, the layout is much easier to use, especially if you have never used Access before:
Exploring the different parts of the Access 2007 Getting Started interfaceà
Template Paneà
On the left-hand side of the Access window is the Template pane: Access has a number of templates
built right into the program. To access the different categories of templates, simply click a category to
see the available template files.
Recent Filesà

The right-hand side of the window lists any recently opened database files, just like the Office Menu:
Click one of the database files to open the file. If you want to open a database file stored somewhere
else on your computer or on another network, click the more link and browse to the file you want to
open, and then click the Open button.
New Blank Databaseà
In the centre of the window is a link to create a new Blank Database. Use this link to make your own
database from scratch.

The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program I 7.5

Microsoft Office
Consider the following diagram showing an open databaseà
The new interface design of Access 2007 makes it easy for novice and expert users alike to get working
right away. Now that we know a little bit more about the Getting Started page, let’s examine the major
pieces of the interface that is visible when a file is opened.

In this diagram, we can see the Office Menu and Quick Access toolbar present in the upper left-hand
corner. At the bottom of the diagram is the Status bar, telling us that we are currently viewing a table
in Datasheet view. Now let’s explore the real power of Access 2007, including the use of tabs and the
ribbon.
Command Tabs à
Along the top of the window are the command tabs:

In the past, the Office package made use of menus that contained a listing of commands. At their
core, the command tabs are essentially the same thing as menus but with a few big changes. For
starters, the grouping of commands in tabs is much more intuitive. The commands listed under each
tab are also the only commands that are applicable to your current view of the database.
Access 2007 takes this one step further with the addition of contextual tabs. The tab labeled Table Tools
- Datasheet appears only when you have selected a table in Datasheet view. This tab will contain even
more specific commands that can be used on a table being viewed in Datasheet view and will only
be visible when a table is being viewed in Datasheet view.
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Ribbons à
Consider the Home ribbon tab that is selected in the diagram above. Beneath the tab is a listing of
all commands that are performed most often on the currently selected object, contained in what
Microsoft refers to as the ‘ribbon’:

The ribbon was designed to allow access to all functionality of a tab at once. Also, the commands in
the ribbon are only the commands that are available for use at the time.
Navigation Paneà
On the right side of the Access window is the Navigation Pane. It is always visible on the left side of the
screen, but can be expanded or shrunk by clicking the double arrows. The Navigation Pane allows
quick and easy access to any of the database objects.
Click the pull-down arrow beside the Navigation Pane title to show a list of all object categories:
Object Tabsà
In previous versions of Access, any open database object was opened in its own window and designed
to ‘float’ inside the Access Screen. When several database objects were open at once, it was difficult
to navigate through all of the windows easily. Access 2007 has solved that problem by using tabs.
Simply click any of the tabs visible on the top to show the database object. Opening many database
objects will create left and right facing arrows; click on the arrow to scroll that direction through the
open database objects. If you want to close an object you are no longer using, click the Close button
located beside the tabs.
Planning a Databaseà
Before you start using Access to create a database, take the time to answer a few questions:
• Why do you need a database? You want to keep track of the expenses made by you and your
employees.
• Who will be using the database? Any employee of Warner Cousins will have access to this
database.
• What kind of data would be extracted from the database? Total expenses of the company, total
expenses by each employee, expenses by each category.
Once you have answered these questions, it is time to decide how to design the tables for your
database. What fields of data do you need? What data types will the fields need to be? What tables
would be important? Which fields will go in which table, and do the placements make sense?
Next comes the planning of relationships between the data. A big list of numbers doesn’t mean much
by itself, but when constructed based on other data, it becomes meaningful. And finally, make sure
that you talk to everyone who will be using the database will be able to get the data they need. Let’s
examine some of the details.
You will obviously need an expense table that contains at least the following: who made the purchase,
what did they purchase, how much was it, and when did they purchase it?
The payroll department already has a listing of the people who work for you:
• SIN (or company ID #)
• Name
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• Address
• Phone Number
• Company Position
The database now should have two tables: an expenses table and an employee table. Now, there
needs to be some sort of link between the two tables. You could use the name of each person, but
that may become confusing, especially if your company grows into the hundreds. There is another
option, however. You can use the SIN (or company ID) of each employee to tie their purchase to their
personal information.
In database design, your most powerful tool is not the computer, but rather a piece of paper and a
pencil (and a big eraser).
Not only can you easily change the information you might need, but you can also visualize the
information.
Creating a Database from a Templateà
If you are just starting out with Access, or if you have a specific application in mind for a database, you
can make use of the templates already provided in Access 2007. The templates are fully functional
tables, reports, queries, and forms that are all related and ready to go - all you have to do is add the
data!

To use a template à
• Choose a category in the left side of the window. For our purposes, let’s start off with something
basic. Access contains a straightforward Contact database under the Personal category.
• Choose Personal from the categories and then double-click the Contacts database to prepare to
open it:
• Details about the template will be shown on the right-hand side of the screen, click the Download
button to download it from Office Online and open it. When the template opens, close the Access
Help window that appears.
• The template automatically opens the Contact List form which allows you to enter your own
contacts one by one into the database. That’s all there is to creating a database from a template!
All of the objects are already established;

All that is required now is for you to enter your data.
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Creating a Blank Database à
Most of the time, the templates provided in Access will be sufficient to use as a base to get started.
However, if you prefer to construct your database from the ground up, doing so is easy with only a few
clicks.
To create a blank database à

• From the Getting Started page, click Blank Database under the New Blank Database heading:

• On the right-hand side of the screen, give the new database a name by typing it into the File
Name box.
• If you want to create the database in a specific location, click the small folder icon ( ) to the
right of the text box. The new file path you select will be shown underneath the File Name text box;
Access will by default use the My Documents folder:
• Finally, click the Create button. The new empty database will open with a single empty table
contained inside:
• Now you know how easy it is to get started with a new database using Access. Later in this manual
we will explore the usage of the different objects contained inside, as well as how to properly
enter data into a database, or more properly, populate a database.
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Tablesà
You should be very familiar with the components of tables by now. We know a table is made up of
several records each containing fields with data. Access also makes it easy to build and modify any
component of a table using Design view, which we will cover later in this manual.

When designing a database, it is critical that you take the time to design your database carefully.
Although it is not a difficult job to make some adjustments to a field, adding or removing fields in a large
established database can be a real headache. It is important to communicate with everyone who will
be using the database to make sure that everyone has the information they will need. Don’t be afraid
to build a database a little bigger than you think it needs to be; if you end up with unused fields they
are much easier to take out than to put new fields in.
Creating a Tableà
Access gives you the ability to create a table in a few different ways: opening an empty table and
inputting values, using a template, or using Design view to construct your table by hand.
Use the Tables section of the Create ribbon to make a table:
Empty Tableà
• Click the Table command to open a new empty table A new tab will open, containing an empty
table in Datasheet view:

• Click inside the Add New Field column and start entering data. Press Enter to keep adding fields
to the record, then press Tab or click the command to make a new record.
Table from Templateà

• Click the small pull-down arrow beside the Table Templates command to see a short list of available
templates:
• Click a template from the list; it will open a new empty table in the main part of the Access
window:
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• Press Enter on the keyboard to advance to the next field, then press Tab once you have reached
the last field or to make a new record.
Table Design Viewà
• Click the Table Design command to open a new blank table. A new section of Access we have
yet to explore will appear: Design view for a table:

• Design view includes its own Design ribbon in a contextual tab. You have the ability to add a
primary key, construct custom formulas, insert or delete different fields, and more.
• Using Design view is more in-depth than simply entering data into fields. You can specify the field
name, its data type, and give the field some sort of description if you like.
• At the bottom of Design view is the Field Properties section. Here you can modify all of the properties
of a particular field.
For example, if you want to have a Price field in your database:

• Give the field a name, choose a data type for the field.
• A data type can be a word, number, currency, date, time, etc.
• The properties of the Price field (once defined as a number) include how large a price it can be,
the number of decimal places, if the field should contain a default value (like $5.99), and more. As
we use tables more we will explore more of the details regarding Field Properties.
Entering Dataà
Using a tableà
Access 2007 provides you with a few ways of entering data. You can enter in the data manually, use
a form, or use the Import commands in the External Data ribbon.
To enter data manuallyà
• Open a table in Datasheet view by double-clicking its name in the Navigation Pane. If you make
an error while entering data, like accidentally entering a word into a number field, Access will
prompt you with an error stating so.
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• if you try to enter non-numeric characters into the SIN field of the Warner Cousins database, you
will see the following appear:

• There may be an instance where it is necessary to have both letters and numbers in the same data
field (such as the Phone field). Luckily, the Text data type allows you type in any characters you
like.
Managing Table Data Entryà
In the final lesson of this section, we will explore some more advanced table data entry techniques.
These methods, combined with all of the controls that can be enforced from previous sections, help
protect your database from bad data entry.
Using the Table Design Ribbonà
Access 2007 features a special contextual tab that deals with Table Design:

Viewsà
This command switches back and forth between the different views of a table:

Primary Keyà
This command toggles the primary key property for a field on and off. Although relatively rare, it is
possible for a table to have more than one primary key.
Builderà
Use this command to activate the expression builder. The expression builder is used to create logical
expressions used to help ensure data is properly entered into a table. We will explore the use of this
command in this lesson.
Test Validation Rulesà
This command will check any logical expressions built with the expression builder as well as other
properties of a table to ensure there are no inconsistencies.
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Insert Rowà
Use this command to insert a new field above the currently selected row in Design view.
Delete Rowsà
This will remove the currently selected field from Design view.
Lookup Columnà
A lookup column is a special type of combo box used to enter data into a table. You can fill the lookup
column with your own data, or use data from another table. Lookup columns are very useful in using
information contained in a different table. We will explore lookup columns in this lesson.
Property Sheetà
In addition to having field properties, each field has another set of properties you can modify that deal
with more advanced properties. Though some are duplicates of the field properties, most of these
properties are beyond the scope of this manual.
Indexesà
This command is used to modify the background properties of an index you can apply to a field.
How to Validate Dataà
In addition to adding protection like required values and input masks, you can also add validation rules
to your database to ensure that data entered makes sense.
For example, consider the Vehicles table used in the last Step-By-Step. The Number of Cylinders field
has a default value of 6 and the Field Size is defined as Integer, which prevents decimal numbers from
being entered. The field Description states that if a vehicle is equipped with a rotary engine (one that
has no cylinders) that 0 should be the value. Therefore, a data entry is valid if it is a whole number
greater than or equal to zero. However, no precautions are in place to prevent someone from entering
a negative number of cylinders, a data entry that does not make sense.

• By clicking in the Validation Rule box, you can enter a simple expression, > = 0.
• This will prevent someone from entering a negative number of cylinders:

• Back in Design view, you can click the button beside the Validation Rule field to launch the
Expression Builder:
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• The Expression Builder lets you create customized validation rules, expressions, logical functions,
and much more. We will explore the basic functionality of the expression builder later in this
manual.
Creating a Lookup Fieldà
The current Vehicles table has been populated with some information. We already established the
relationships with the Countries and Manufacturers tables. However, having a Manufacturer ID of 6
and a Country ID of 3 is not very meaningful when looking just at the Vehicles Table:

Fortunately, Access features something called a lookup field. It allows you to use the actual Manufacturer
name and
Country name to enter data in the field. Creating a lookup field is easy; however you must first delete
the relationship(s) that exist in the field.
• First, open the Vehicles table in Design view. Click in the Data Type cell of the field you want to turn
into a lookup table and click Lookup Wizard.

• The Lookup Wizard will appear. In the first step, select the data source you will use for your lookup
field. In our case, we want to use the data contained in the Manufacturers table:
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• The next step allows you to choose which table (or query) contains the lookup values; in our case
the Manufacturers table:

• The next step lets you choose which field or fields in the source table you want to use for your
lookup field. In our case, we want to show the Manufacturer name instead of just the ID:

• In the next step you have the option to sort the values that will appear in the field in ascending or
descending order. If you do not specify anything in this step, Access will automatically apply an
ascending order on the field that was used to create the filter:
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• The next step allows you to move your mouse to the edges of the column and click and drag to
adjust the size. You can also opt to show the primary key column, which will show the corresponding
primary key for each value in the lookup field:

• The final step of the Wizard will give the lookup field a name. This will replace the column name of
Manufacturer ID. Click Finish:

• Return to Datasheet view once the Wizard completes. If you click in the Manufacturer’s Name
column of data, the field becomes a combo box. If you need to change the value to something
else, click the pull-down arrow to see a list of available values:
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• As part of the lookup field creation process, Access created a basic relationship between the
Vehicles and Manufacturers table:

• However, the relationship is not a strong one. Right-click the black line joining the two tables and
click Edit Relationships:

• Click the Enforce Referential Integrity check box and click OK. The full relationship will be restored:

Modifying a Lookup Field à
Now that you know how to establish a lookup field, you can modify certain characteristics of the
field to suit your database’s needs. If you open a table in Design view, you can view the lookup field
properties by clicking the Lookup tab at the bottom of the window:
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Relationshipsà
Creating and Removing Table Relationshipsà
In this section we will explore the staple that really makes a database work: the relationships that
are established between the different tables of data. When designing a database, this is the most
challenging step and often the place where most of the confusion with databases arises. Fortunately,
databases are nothing more than tables of data that are related.
Consider the following simple database:

Imagine your database has a table of employees, and a table of expenses that have been made
by your employees. As time goes by, the Expenses table will grow to become quite large. You wish to
make a query that will find out the phone number of every employee that submitted an expense. It is
impractical to place the employee phone number in the same table as the expenses. It will create a lot
of extra data that is not really needed if there is another table containing employee data elsewhere.
The relationship between the two tables is created because of the two common fields, EmployeeID-. In
particular, the Employees table and the Expenses table are in a “one-to-many” relationship, meaning
that one entry in the Employees table can relate to many entries in the Expenses table.
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Knowing this, we can add two relationships to our expanded Vehicles Database. You can view the
relationships by clicking the Relationships command in the Database Tools ribbon:
Consider the following tables:

Instead of naming every country and manufacturer in the Vehicles table, we can lighten the size of the
Vehicles table by taking those two pieces of information and storing them in a separate location. In a
database of this size this may not seem like that big of a deal, but as we proceed through this manual,
the reasoning will become clearer.
Make and Country in the previous Vehicles table are replaced by Manufacturer ID and Country ID. The
Manufacturers and Countries tables listed above contain only the respective ID and name for each
record. However, Access does not automatically recognize the relationships by itself; we must tell it
which fields relate in these tables.
• Click on the database tools ribbon, Show hide group, relationships button to show relationships
window.
• The contextual design ribbon appears click on the show table button in the relationships group.
• Add tables you wish to relate click on close.
• To establish a relationship between the Vehicles and Manufacturers tables, simply click and drag
the Manufacturer ID field from one table to another:

• When you release the mouse button, you will see the Edit Relationships dialogue box:
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• Access has determined that the style of this relationship is One-To-Many, based on the data that
was collected from the drag and drop operation. Before clicking the Create button, you should
click the Enforce Referential Integrity check box.
• Referential Integrity is a set of rules and conditions that make data entry into databases safer. You
should try to enforce referential integrity whenever possible. It insures that all related fields are valid
when considered together in a database, and prevents you from accidentally deleting related
data. To make referential integrity work, the following three conditions must be satisfied:
• The matching field from one table is a primary key or has a unique index. (True: Manufacturer ID is
the primary key)
• The fields in the relationship have the same data type. (True: both fields are numerical)
• Both tables are stored in the same database. (True: both tables are in the same database file, not
a linked table.)
• Since all of the necessary conditions have been satisfied, click Create to establish the relationship:

• You can see the one-to-many relationship in the diagram above. One Manufacturer ID from
Manufacturers may correspond to many Manufacturer IDs from Vehicles.
• Now let’s examine the relationships in the Northwind sample database. As you can see in the
diagram below, there is a lot of action happening in this database!
• Let’s examine the Products table in this database:

Each product record contains many attributes describing the nature of the product that Northwind
sells, one of which is an ID field. In fact, each relationship in the Product table is based on the ID
field. There are four relationships denoted by black lines coming from the ID field, relating to Inventory
Transactions, Purchase Order Details, Inventory Restocking Details, and Order Details. Consider the
relationship with the Order Details table. One product that Northwind sells has the potential to be sold
many times, therefore each sale of each product is logged in the Order Details table. The Products
table is in a one-to-many relationship with the Order Details table.
Creating the relationships is very simple if the fields in your tables have been well planned; simply drag
and drop fields.
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When deleting a relationship, remember that doing so can have a big impact on how the database
works. Make sure you actually do need to remove the relationship!
Deleting relationships à
• Deleting a relationship in the Relationships window is easy, just right-click on the relationship you
want to remove and click Delete:

• Access confirms that you want to delete the relationship, click -Yes- to confirm.
Understanding Field Properties à
Every field in every table in every database has properties. In fact, you will learn that nearly everything
in the entire Access program has properties of some type to modify! To see the field properties of
a certain field, you must first open a table in Design view. Consider the Employees table from the
Northwind sample database:
Field properties are visible in the bottom half of Design view. Each field name has an associated data
type. Each data type will have different properties that you can define to make the table contain
exactly the data you need. We will explore Field Properties in depth later in this manual.
Adding a Primary Key to a Tableà
If you are just starting with Access, chances are you have been using the Table Wizard to help construct
tables. One of the nice things about the Wizard is that it can automatically define a primary key for
you. The Wizard is great for getting going, but once you become more comfortable with databases in
general, you will likely build all of your tables using Design view.
In previous versions of Access, a primary key was not automatically defined when creating a table in
Design view. You were prompted when you were ready to close and save the table. When constructing
a table in Design view using Access 2007, a generic primary key is already assigned:

• However, consider the following table which does not contain a primary key:
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• Currently this table does not have a primary key. If you recall, a primary key is used as some sort
of unique identifier that separates every row in the table from every other. Vehicle ID is a good
candidate for a primary key because every one of the IDs is different. To make it the primary key,
click the light blue box beside the Vehicle ID cell to select the row:

• Now click the Primary Key command in the Table Tools - Design ribbon:

• Primary keys in tables are denoted by a small key in the blue box beside the cell name:

Inserting, Deleting, and Moving Fields à
Let’s continue with our vehicle database example. Access lets you easily insert new fields, delete
useless/unused fields or fields that are not relevant to the data, and move the order of fields in a table.
The easiest way to perform these tasks is by using the table Design view.
In this example, we will add two more rows to the vehicle table: Engine type and Colour.
• To insert a new field, either click in the empty cell beneath the last row in Design view and enter
the data or insert a row between two existing rows. To demonstrate this, we will right-click the
Manufacture Date field and click Insert Rows:

• This will create a new row between Model and Manufacture Date:
• Type Engine Type for the field name and Text as the Data Type
• To insert the Colour field beneath Manufacture Date, simply click in the next empty cell in the Field
Name column and type Colour as the name; and Text as the data type:
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• In order to delete a row, first make sure that you remove any dependencies or relationships that
may exist with other database objects. Access can help you with this task, but to be on the safe
side, you should first make a backup copy of the database or the table by using the Save As
command. Once you’re ready, simply right-click on the blue box beside the field name and click
Delete Rows:

• To move a field, click the blue box beside the field you want to move to highlight the row. Click
the field again, hold down the left mouse button and then drag the field up or down through the
rows of Design view.
• You will see a bold black line between the various fields as you move:
• When the black line is in the location you want to move the row, release the mouse button.

Formatting Tablesà
We have entered all kinds of information into a table in Access, but so far we have only typed in raw
data. In this lesson we will learn how to make tables in Access easier to use and more robust.
Formatting Number Fieldsà
There are three types of number fields in Access: AutoNumber, Number, and Currency. To apply this
new format, first open a table in Design view to adjust its field properties.
AutoNumberà
The AutoNumber data type is used by Access to automatically count up by one or assign a random
number each time a new record is added to a table. Auto Numbers are usually used as primary keys
to ensure uniqueness in data. If values 1, 2, and 3 were used as an AutoNumber type, and you delete
record 2, the number 2 is not reused as an AutoNumber.
Numberà
The Number data type is a more general number that can be used and formatted in many ways. Field
Size indicates what data type the number it will be: either Integer for whole numbers, or Double for
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decimal values or very large positive/ negative values and/or decimal values. You can also assign an
input mask, a default value, and validation rules to a number (we will cover these topics later).
The only limitation on a number field is that the values inputted can only be numbers! If you try to enter
any letters of the alphabet, Access will warn you that you are attempting to enter an invalid data type
into the field.
Currencyà
The Currency data type is very similar to the Number data type; the only difference is that a currency
is permanently defined as a Double data type.
Textà
The Text data type is probably the most overall used data type in a database. Its properties are similar
in nature to the
Number data type, meaning it can have an input mask, validation rules, and a default value. The
IME Sentence Mode, IME Mode, and Unicode Compression all deal with translation properties when
converting a database in one language to another, like from Japanese to English. (These features
are beyond the scope of this manual.) Text fields can contain essentially every letter, character, and
number. Text fields can also be set for a certain number of characters; 255 characters is the maximum
size. Text fields in Access 2007 feature a new property, the ability to align text inside a field. This field is
found at the very bottom of the list:
Memoà
The Memo data type is very similar to the Text data type. The only real differences between the two
are that a memo field can be much larger, up to 65,636 characters (roughly 35 pages of solid text!)
Memo fields in Access 2007 also let you only append data to a memo field. That is, when you attempt
to add data to a memo field, it will only be added to the end. You cannot overwrite any previous
memo information.
Queriesà
Creating Queriesà
We now have come far enough to get to the real functionality of a database: using a query. Having
large amounts of data is fine, and having nice looking and well-designed forms is great, but if you can’t
pose a question to the database and find a result, there is not much use for a large list of data. In this
lesson we will learn about queries and how they work.
What is a Queryà
A query is a question that is asked of a database control program about the data it contains. We
specify what particular fields we are interested in finding out, tell the database where to look for those
fields, and specify any conditions under which to search.
Queries are primarily built from tables, but Access gives you the ability to construct a query based on
the results of another query. Such ‘nested queries’ may require more computer memory and resources
in order to execute but if constructed with care, can save a lot of time, especially when dealing with
very large databases. For the purposes of this manual, we will keep things simple and stick to small and
simple queries. Plus, the great thing about queries is that they are only questions asked about data
that is already there. If you get query results that are completely off the mark, no problem! The data is
untouched, so provided there is no design flaw in your database, only the query needs to be adjusted.
Creating a Query with the Wizardà
• To create a query using the Wizard, click the Query Wizard command in the Create ribbon:
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• The Wizard launches, allowing you to select which type of query to build:

• For the purposes of this manual, we will demonstrate a simply query that will retrieve the product
ID, product name, and price of every product in the Northwind sample database. This type of
query is defined as a select query, one that is used solely to retrieve information.
• The next step of the Wizard is selecting which fields you want to use in your query. This step of the
Wizard should look familiar: it’s just like selecting fields to use in a form.
• In the Tables/Queries combo box, select Table: Products. Highlight ID and click > to move the
field to the Selected Fields list. Repeat for Product Name and Standard Cost:

• The next page of the Wizard gives you the option to apply a few summary calculations to the
field like the maximum value, minimum value, and the average. However, we want to see all
products, so leave the Detail radio button selected:
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• The final page of the Wizard lets you name the query. A long and meaningful name is
recommended. Just like in the creation of a form, you have the option to open the query right
away or modify the design in Design view:

• Click Finish to view the results of the query:

As you can see by the diagram, the query results are shown in what is essentially Datasheet view.
The result of a query is essentially a table complete with its own rows. Though more advanced query
functionality is beyond the scope of this manual, you can actually use the results of a query to
construct a table.
Using Design View to Modify a Query à
As you gain more proficiency with Access, you will reach a point where using just the Query Wizard
will not be sufficient to get the results you are looking for. Therefore, you can use query Design view to
modify any attribute of a query you like.
• To access Design view after using a wizard, select the “Modify the query” design radio button:
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• If you wish to modify a query that already exists, double-click the query object in the Navigation
Pane to open it in Datasheet view. Then use the View menu to select query Design view:

• Either way, you will be shown the following view:

• The table or tables that were used in the query are present at the top of the window, while the
various attributes that were specified during the design of a query are listed at the bottom. Note
that the primary key is shown in the table as a small key icon. You will also see six different row
listings at the bottom of the window.
• The Field row will let you will see all of the fields that are available for use in the query (in this
case the attributes of the Products table). The second row down is the Table row, where you can
specify which table you want to use fields from. The Sort row lets you sort the results of the query
in ascending or descending order (or no order at all, but rather the order in which the query
happened to find data first).
• The Show checkbox will determine if the field will actually be shown in the query results. (If an item
is present in a query but does not have the Show checkbox marked off, it will still be considered in
the query but the data that was used to satisfy the query will not be shown.) The Criteria row lets
you enter a logical operator and a condition that any displayed data must satisfy.
• We have seen the results of finding all products in the Products table. If we want to show only the
items that are more than $50 to purchase, we can enter the criteria ‘> 50.’ This expression contains
a logical operator (greater than). Other operators include less than (<), equal to (=), and not (!).
Query Design view also contains its own contextual tab. Though much of the functionality is beyond
the scope of this manual, let’s take a quick look at what each section of commands does:
Resultsà
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The Results section of the query Design ribbon lets you switch between views using the View menu and
execute the query.

Query Type à
This section of the ribbon allows you to modify properties of the query itself. Use these commands to
make action queries that will perform some operation on the data in your database.

Query Setupà
Use these commands to modify attributes of a query as well as construct more elaborate search criteria.
Show/Hideà
The Show/Hide commands are used to view and modify different background attributes about the
query and the data it will display.
Using Queriesà
To execute a query, you simply have to double-click the query name in the Navigation Pane. The
results will be displayed in a new tab in Datasheet view. Since a query is not a bound object, you can
delete a query without fear of deleting any data in your tables. But be careful if you do delete a query,
because there might be another query, form, or report that uses the query to retrieve data for display
to a user. If you eliminate the source query, the dependent object will not function properly.
Basic Queriesà
In the last section of this manual we will deal with queries. Queries are really the second most important
objects in a database (next to tables) because they have the ability to find information for you.
Using AND OR Operators à
If you recall the Filter by Form section of this lesson, we went searching for all products costing $7.50.

Before you entered the $7.50 filter criteria, you might have noticed at the bottom of the Filter by Form
window that there are two tabs active: Look For and Or. If we wanted to search for products that cost
$7.50 and products costing more than $12.75 (or both), simply click the OR tab and enter more search
criteria. As you add more OR searches, more OR tabs will appear to make your search as specific or
vague as you require.
When dealing with AND and OR operations, it is important to understand how they work on a logical
level. These operators require two pieces of input and produce one output, either true or false.
The AND operation is perhaps the easier to understand. Both conditions of AND must be satisfied in
order to produce a true result. For example, if you are making a cake, you need to have wet and dry
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ingredients mixed together. If you have wet and no dry, or dry and no wet, or neither, you cannot
make a cake.
The OR operation is true as long as one condition is true. Let’s say you want to go and see a movie, but
you will only go if you have at least one friend to go with. You ask Alice and Bob if they want to come.
If Alice and Bob can both come, then you will go to the movies. If Alice can make it but Bob can’t, you
will go, and vice versa. If neither Alice nor Bob can go to the movies, you are not going to go either.
The best place to apply AND/OR operators directly is using Design view of a query (or query results).
Let’s take a look at the Design view for the simple products query we have been using:

We would like to see the products that cost either $7.50 or greater than $12.75. To calculate this, specify
the criteria in the Standard Cost field of the Products Query:

Each successive condition you enter in the column is called a where clause; you can add several
where clauses to help find more specific values. For example, if you own a company and lost the
paper copy of an invoice, and you knew that the total was $960, entering the =960 criteria will consider
only those records that match. When designing queries or filtering criteria that use AND operations, you
essentially add more fields to a query and give each one a specific criteria. For example, if you know
that the missing invoice was $960 and sold by Salesperson A; enter the exact criteria into Design view.
Should you not get the results you were looking for, don’t resort to merely trying different criteria that
don’t make sense to your situation. Think it out and ask why it isn’t working or giving you the results you
thought you should be getting. Another option for troubleshooting queries is to clear all of the criteria in
your query and add it back one condition at a time. Make sure that before adding another field, the
results of the previous query are accurate for your purposes.
Use of IIF Functionsà
The IIF function is used in the background of Access with VBA (Visual Basic for Applications, a
programming language).
Though we will not directly cover its use in this manual, its use should be familiar to you, as it works like
the OR operation. If you recall the example of the OR operator, you know that you will go to the movies
as long as you have someone to go with. The IIF function takes this a step further by saying if you have
no friends available to come to the movies with you, you instead will go to the gym. If you get more
involved with database work in the future, this is a very commonly used function.
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The syntax of the IIF function is IIF (expression, do This If True, do This If False). The trick with this function
is that no matter which value is returned by the function, the true and false portions of the equation
are always evaluated. Care should be taken when making the true and false portions of an IIF function
such that the database code won’t reach an error like dividing a number by zero.
Formsà
What is a Formà
Simply put, a form is an easy way to input data into a database. It contains fields that let you type the
information for each field in, it can have an input mask which will make the field look like an empty
phone number field, and it can contain required field that you must enter in order for the database
entry to be valid.
We have seen a few examples of forms along the way, such as those featured in the Northwind sample
database template included with Access:

Forms can also include functionality not directly related to a table. For example, the Login window that
appears when you open the Northwind sample database is actually a special type of form.
Creating a Form with the Wizard à
Access features a wizard that allows you to specify how you would like a form to look
and what table it should be based upon. Access then does the hard work for you
and creates a usable form in only a few clicks. To create a form using the Wizard,
click the Create command tab and then click the More Forms command:
• Form Wizard is the first option; click it to start the Wizard.
• The first page allows you to select which table or query Access should link to
the form:
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• You can also specify which field or fields you want to use in the form. Click > to move the currently
highlighted field from the Available Fields list to the Selected Fields list. Click >> to move all fields
from one list to the other. Click Next to proceed.

• The next step of the Wizard lets you choose the layout for your form. Select one of the layouts by
clicking the appropriate radio button and then click -Next :

• The next page allows you to style your form to make it catch the attention of the user. Click one
of the styles from the list of those available; you will see a preview of each on the left side of the
window:
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Select a style you like and click -Next-. The final page of the Wizard lets you name the form:

• By default, when you click Finish, the form will open so you can start using it right away. The second
radio button option allows you to open the form in Design view where you can modify every
aspect of a form. (We will discuss the basics of Design view in the next section of this lesson.)
• If you leave the first radio button selected, clicking Finish will open the form right away:

Using Design View to Modify Your Form à
You may recall Design view from one of the Step-By-Step exercises in this manual. Design view allows
you complete control over how a form should look. To enter Design view after using a Wizard to create
a form, make sure you highlight the “Modify the form’s design” radio button in the final step of the
wizard:

• If you want to modify the design of an existing form, double-click the form object in the Navigation
Pane and then select Design View from the View command in the Home ribbon:
• Let’s take a look at what’s going on in form Design view:
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• At the top of the window you will see two new contextual tabs appear: Form Tools - Design and
Form Tools Layout. In the centre of the window is the current working space (called a canvas).

•

On the right-hand side you will see a special pane that lists the fields that are available for use in
Design view:

•

The “Fields available for this view” section shows you all fields associated with the table(s) from
which the form was directly constructed. (In the example above, Shippers is the main table.) The
“Fields available in related tables” list shows the fields and table(s) that the main table shares a
relationship with. (In the example above, the Shippers and Orders tables share a relationship.)
Lastly, the “Fields available in other tables” list shows all the tables in the current database file and
the fields you can use from each.

•

Though much of the use of Design view is beyond the scope of this manual, let’s take a look at
the different groups of commands you can use to work on a form.

•

The following chart lists the overlying functionality of the Design Ribbon:
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Using Formsà
To make use of a form, first double-click its name in the Navigation Pane to open it. Then it is simply a
matter of clicking the new command in the Home ribbon ( ) and entering data into the fields:

Any fields that reference an AutoNumber field (such as a primary key) will advance to a new value. At
the bottom of the form you may recognize the navigation buttons:
Report à
What is a Report à
A report is a formal way of displaying data that has been retrieved from a query. Reports, like forms,
are completely customizable and easy to create by using a Wizard. If the Wizard is not specific enough,
you can change the colour, layout, style, and more, to suit your tastes.
If the data in your database has changed, you don’t need to design a whole new report. Simply
reissue the report and when Access runs the background query again, the data changes will be taken
into account automatically.
Creating a Report with the Wizardà
Many of the reports you create will simply be an exercise in displaying the data in a certain way. Since
reports are made from queries, and most of the queries will have already been built, creating reports
using the Wizard is easy.
• The Report Wizard command can be found in the Create ribbon:
• The first page of the Report Wizard should be pretty familiar to you
by now; it was used to create a form and a query:

• For this example, we will make a report based on the full results from the Customers Extended
query. The next screen of the Report Wizard allows you to apply levels of grouping to the report:
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• Grouping levels are useful in certain queries to help categorize the data returned from a query.
For example, if you ran a query to list all the different times that a product was ordered, you could
group based on the product. Each date the product was sold would then be categorized under
each product name. For the purpose of this example, no grouping will be used. The next page of
the Wizard lets you organize fields in the report in ascending or descending order:

• Select a field from the combo box. If you want to sort based on descending order, click the
Ascending button to change the nature of the sort order.
• The Wizard then asks how you want to organize the items in your report:

• Click the different layout radio buttons to see a preview of how each field will look in the report.
The checkbox at the bottom of the window will help to squeeze all of the data into the same
page. This may not always be the best course of action if some fields contain large entries. Should
the Wizard not produce the results you want, you can always delete the report and start again or
use Design view to modify the layout.
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• At the next screen, you can choose a style for your report to make it more appealing if you are
going to print it:

• Finally, the last screen allows you to give the report a name and either view it right away or modify
its properties in Design view:

• Click Finish to view the report:

Using Design View to Modify a Report à
Like forms and queries, you can enter report Design view by using one of two methods
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• Click the “Modify the report’s design” radio button before closing the wizard.

• Report Design view lets you drag and drop the various fields from the Field List pane. Reports use
headers and footers like the Design view of a form. Reports also have three of their own contextual
tabs:
• The Design and Layout tabs contain the same commands as the Design view of forms. In addition
to listing only query results, you can add interactivity to the report to do things like show charts and
calculate data values from user input.

• Design view for reports also features a Page Setup ribbon to customize how the report will look on
a printed page:
• This section of the ribbon also contains a Page Layout button (the arrow in the bottom right hand
corner). This button opens a dialogue that can be used to precisely modify page settings:
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Using Reports à

To view a report, simply double-click its object name in the Navigation Pane. The report will open in the
main part of the Access window:
This Report View will let you scroll through all the details of the report. We will discuss how to print and
further view a report later in this manual.
Common Report Tasksà
As all the pieces of your report begin to come together, you can apply the formatting and ensure that
the report gives you the information you need to know. Then your report will be ready to publish and
print as handouts or catalogues. In the final lesson of this section, we will discuss how to give a report
some extra flair to effectively present your product or data.
Adding a Photoà
Adding a photo to a report is just like adding any other control to a report. To add a photo, click
the Image command in the Report Tools - Design ribbon and then click and drag somewhere in the
appropriate section you want the photo to appear:

Navigate your computer to find the picture file you want to insert into the report, and then click OK. The
image will be inserted as a best fit into the area you specified.
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TALLY.ERP9

UNIT - 8
TALLY.ERP9 - BASIC
Introduction à
Tally.ERP9 has been developed by Tally Solutions Pvt. Ltd., a Bangalore based Company in India.
It’s very user friendly and popular Accounting Software that runs on Microsoft Windows. It can even
maintain your Accounts, Inventory and Statutory Compliances. A few key features listed below:
• Cordless Accounting System
• Unlimited Accounting Period
• Simultaneous Operation of multiple companies
• Accounting for the Complete Group of Companies
• Top-level security for each company
Facilities with Tallyà
• Data Import and Export Facility
• Audit Facility
• Budgeting
• Scenario Management
• Bank Reconciliation, etc
Tall.ERP9 Start-Up à
Main Area

Close Button

Button Area

Info Area

Calculator Pane
Button Area
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In Tally if you want to maintain data then you have to open a Company.
The Company Info.(Information)• Select Company: Allows you Select or open a Company
• Connect Company: Allows you to Connect Company on Tally.Net
• Disconnect Company: Allows you to Disconnect Company from
• Shut Company: Allows you to close a Company
• Create Company: Allows you to Create a Company
• Alter: Allows you to alter a Company
• Security Control: Allows you to create Security Levels and users & passwords
• Change Tally Vault: Allows you to secure the data by providing a encrypted password
• Split Company Data: Allows you to Split Company data across multiple period
• Backup: Allows you to take a backup of the Company
• Restore: Allows you to restore a data backup
Creating a Companyà involves providing basic information about the company whose books of
accounts are to be maintained in Tally.ERP 9.
Go to Gateway of Tally > (Alt+F3) Company Info. > Create Company
The Company Creation screen appears as shown:

A detailed explanation on each field is given:
Directory: The data path where you want the company to be created is specified in the Directory field.
Name: Enter the name of the company whose books are being opened. If you are a professional
accountant and are maintaining the books of your clients, give the Client Company’s name.
Mailing Name and Address: In addition to the Company Name, Tally.ERP 9 provides the facility to enter
the Mailing Name field. It displays the Company Name by default. You may change it as required, if
the mailing name is different from the Company Name. The mailing name and address details are
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picked up for inclusion in any report that needs the company name and address as heading. For
example: Balance Sheets, Statement of Accounts, and so on.
Statutory compliance for: Select the Country from the List of Countries. The Statutory Features and Base
Currency Symbol are enabled in accordance with the country selected. For example, if the accounts
belong to a company in India, the base currency would be Indian Rupees. The Base Currency will
appear with respect to the Country selected. Selecting India from the List of Countries brings up a
State, Pin Code and Telephone No. field.
State: You can select the appropriate state from the predefined list.
PIN Code: Specify the PIN Code (Postal Index Number) of the specified address.
Telephone: Enter the Telephone number.
Mobile No: Enter the mobile number of the company.
E-mail Address: Enter the E-mail address that will be used to e-mail documents, reports and data from
Tally.
Enable Auto Backup: Set this to Yes, if you want to enable the automatic backup of Tally data (per
company). Else, set this to No. The data backup is stored in the data folder of the respective company.
The auto backup data can be restored by pressing Ctrl+Alt+K from Company Info menu or Gateway
of Tally.
Currency: Currency symbol is the symbol of the base currency, that is, the currency that will be used to
maintain the books of account.
Maintain: Tally.ERP 9 displays a drop down for the Type of Company with two options Accounts only and
Accounts with Inventory. Select Accounts only if you do not have any inventory transactions (suitable
for professionals and corporate offices). However, at a later date (if required) you can choose to alter
the information as Accounts-with-Inventory. Select Accounts-with-Inventory, to maintain both financial
accounts and inventory.
Financial Year From: In most countries, the books of accounts of a company are maintained for a
stipulated period like, 12 months, 15 months, and so on. This stipulated period is referred to as the
Financial Year. The stipulated period of the financial year is 12 months in most countries. Tally.ERP 9
automatically considers 12 months from the date you give here as the Financial Year. Tally.ERP 9
allows you to maintain data for multiple years by changing the period (Alt+F2) at the Gateway of
Tally. In addition, you can also specify the date of actual establishment of the company (date of
incorporation).
Books Beginning From: Tally.ERP 9 presumes that you wish to maintain books from the beginning of the
financial year. Hence, Tally.ERP 9 displays the date given in Financial Year from field automatically. The
date for Books beginning from can be changed, in case of companies, which are incorporated in the
middle of the year. If your company is new, you can opt to start the books of accounts from the date
of actual establishment of the company (date of incorporation) but close books according to the
Financial Year as specified by you.
Tally Vault Password: Tally Vault is an enhanced security system, which allows for encryption of the
company data. Encryption involves converting normally accessible Tally information into unrecognizable
information, which can only be reconverted by authorized persons.
Use Security Control: Set this to Yes, if you want to initiate a password-protected system to control access
to Tally.ERP 9 data. Else, set this to No. If you opt for security control, Tally.ERP 9 offers a comprehensive
password based access control to different features of Tally.ERP 9 based on authority lists created by
the Administrator. For more information refer Data Management in Tally.ERP 9.
Use Tally Audit Features: Tally Audit allows the administrator or an auditor profile user to track changes
in accounting information. If you wish to use this facility, select yes. Tally Audit will be available only to
the administrator/auditor, through Display of Statements of Accounts. For more information refer Data
Management in Tally.ERP 9.
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Loading a Company à
In order to load a company using the Select Company option. You can use the Select Company
option in two ways, from the Company Info. Menu OR by using the button F1: Select Cmp (available
on the Gateway of Tally screen).
Gateway of Tally à
Gateway of Tally is the screen that appears on selecting a company. The Gateway of Tally menu
differs based on the type of company selected. An Accounts Only Company has a different Gateway
of Tally menu from that of an Accounts-with-Inventory Company.
• Gateway of Tally Screen (Accounts-Only)
• Gateway of Tally (Accts with Inventory)
• Gateway of Tally (with Payroll option enabled)
• Gateway of Tally (for Auditors’ edition with Security Control)
Gateway of Tally Screen (Accounts-Only)à
The Gateway of Tally menu of an Accounts Only company appears as shown below:

The Gateway of Tally screen is separated into 2 sections – Main Area (Ctrl+M) and the Button Bar.
Main Area: The left side of the Main Area gives information on:
• Current Period: This is the currently loaded company’s accounting period.
• Current Date: This is the date of the last Voucher Entry for the selected company.
• List of Selected Companies: This displays the name of the loaded company.
The Main Area gives information on:
• Creation of Accounting Masters and Importing Master information
• Creation of Accounting Vouchers and Importing transaction information
• Viewing and printing financial reports using the information given in Masters and Transactions.
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Button Bar:
The Button Bar Contains two sections:
• Top Button Bar
• Right Side Button Bar
Top Button Bar Contains:
Buttons

Shortcut Key

Usability

Print

Alt + P

Navigate to Print Menu

Export

Alt + E

E-Mail

Alt + M

As it is not used from Main Screen, these buttons
are disabled

Upload

Alt + O

Language

Alt + G

To change the Language

Keyboard

Alt + K

To change the Keyboard Language

Control Centre

Ctrl + K

Login to Control Centre

Support Centre

Ctrl + H

To post the queries of the product.

Right Side Button Bar Contains:
Buttons

Shortcut Key

Usability

Select Cmp

F1

To select a company

Shut Cmp

Alt + F1

To shut or close the company

Date

F2

To change the current date

Period

Alt + F2

To change the period

Company

F3

To select a different company which is already loaded. (If one
company is Loaded in Gateway of Tally, this button is disabled)

Company Info

Alt + F3

To access the Company Info. Menu

Connect

F4

To connect companies on Tally.NET

Disconnect

Alt + F4

To disconnect companies from Tally.NET

Features

F11

To access the Company features for a company

Configure

F12

To access the configuration settings

Note: You cannot load or select companies with the same name at the same time. The loaded or
selected company will have to be shut first in order to load the other company.
Gateway of Tally (Accts with Inventory) à
In Accounts-with-Inventory Company, additional inventory related menus will be enabled:
• In Master Level – Inventory Info.
• In Transaction Level – Inventory Vouchers
• In Report Level - Stock summary
F11- Company Features in Tally.ERP 9à
Different features of a company can be selected or modified by using the F11: Features button. This
button is available in almost all the screens of Tally.ERP 9 enabling the user to modify it as and when
your requirements change.
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Go to Gateway of Tally > F11: Features
The F11: Features menu is displayed as shown:
The menu consists of the following options.
• Accounting Features(F1)
• Inventory Features(F2)
• Statutory & Taxation(F3)
• Audit Features (Applicable only for Auditor Edition) (F4)
• Tally.NET Features(F5)
• Add-On Features(F6)
F1 Accounting Features à
This feature enables you to set the various Accounting Features required for transaction entries.
Go to Gateway of Tally > F11: Features > F1: Accounting Features

We are going to explain the main Accounting Features:
Generalà
Integrate Accounts and Inventory: This option has a significant effect on the Balance Sheet and Profit
& Loss Account. If set to Yes, it extracts the stock/inventory balance figures from the inventory records
and provides a drill down to the Stock registers from the Balance Sheet. If set to No, it ignores the
inventory books figures and picks up manually entered closing stock balances from the ledger account
created. This facilitates the maintaining of accounts and inventory separately. Stock records often
contain compensating errors caused by wrong allocation to items. This feature enables finalization of
financial books without waiting for the reconciliation of stocks.
Income/Expense Statement Instead of P & L: By Default, this option is set to No. If set to Yes – Tally
displays Income & Expenses A/c instead of Profit & Loss A/c in the Gateway of Tally Menu. Income
and Expenditure statement generally used for Non-Trading accounts and Profit & Loss a/c are used for
trading accounts.
Allow Multi-Currency: By Default, this option is No. Set this option to Yes, if you want to create multiple
currencies and the Menu Currencies is displayed in Gateway of Tally > Accounts Info. Menu.
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Outstanding Managementà
Maintain Bill wise Details: The Bill-wise facility is made functional by setting this option to Yes. By activating
the Billwise feature, the ledger masters under Sundry Debtors and Sundry Creditors automatically display
an additional option called Maintain balances bill-by-bill. On setting this option to Yes, an additional
option Default Credit Period is displayed.
When you enter details of sales and purchases with the Bill-wise option activated, Tally.ERP 9 prompts
you to identify the invoice with an appropriate reference number. The reference can then be used to
allocate payments to the correct invoice to maintain an accurate account of outstanding.
Activate Interest calculation: Set this option to Yes to enable Tally.ERP 9 to calculate interest
automatically based on the interest rate and style of calculation specified. Enabling this option allows
interest calculation on outstanding balances for any ledger account or on each invoice for the period
it is outstanding completely or partly.
Use advanced parameters: The advanced parameters are useful when interest rates change from
time to time. Set this option to Yes to enable this function.
Cost/Profit Centres Managementà
Maintain Payroll: Set this option to Yes if you want to maintain Payroll information on Tally.ERP 9 for the
selected company.
Maintain Cost Centres: A Cost Centre can be defined as a unit of an organization to which transactions
can be posted. When only costs or expenses are allocated to these units, they are referred to as Cost
Centres. The Cost Centre feature is activated by setting this option to Yes.
Invoicingà
Allow Invoicing: Set this option to Yes, to create Sales and Purchase vouchers in the invoice format. The
advantage of using the invoice format for sales invoice entry is that it enables automatic calculations
of Duties and Taxes accounts.
Use Debit/Credit Notes: The Debit Note and Credit Note voucher types are made available only if this
feature is set to Yes.
F2- Inventory Featuresà
This feature enables you to set the Inventory Features required for the transactions. Go to Gateway of
Tally > F11: Features > F2: Inventory:

We are going to explain the main Inventory Features:
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Generalà
Allow Zero Valued Entries in Vouchers: Set this option to Yes, to allow zero valued entries in Inventory
vouchers.
Storage & Classificationà
Maintain Multiple Godowns: Set this option to Yes, if you have more than one stock point/storage
Locations/ Godowns, and you want to track stock movement across these Locations. You can create
any number of Stock Locations/Godowns. The Godowns/Locations option is displayed in Gateway of
Tally > Inventory Info menu only if you set this option to Yes. You will be able to identify your stocks at
each location as well as assign stock movement to one or more locations during voucher entry.
Order Processingà
Allow Purchase/Sales Order Processing: Set this option to Yes, to create Purchase/ Sales Orders. This
feature can also be used for pre-closure of purchase order.
Additional Inventory Vouchersà
Use Tracking Numbers (Delivery/Receipt Notes): Set this option to Yes, if you want to use tracking
numbers to maintain the relation between Delivery notes and Invoices/Bills. This is available for both
Purchases and Sales.
Use Rejection Inward/Outward Notes: Set this option to Yes, if you wish to record rejection of goods
separately and not through a common Debit Note or Credit Note.
F3- Statutory & Taxationà
This feature enables you to set the Statutory Features required for the transactions.
Go to Gateway of Tally > F11: Features > F3: Statutory & Taxation. You can enable the futures as per
your statutory requirement.

Shut a Companyà
Shut a Company is to unload it. It does not mean that you have deleted it. Simply select it again to
load and work on it again. You can shut a company in two ways – either using the button F1: Shut Cmp
(Alt + F1) or pressing Enter on Shut Company menu option on the Company Info. Menu
Alter a Companyà
This option allows you to alter information about the existing company, you can modify any information
at any time that is set while creating a company.
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Go to Gateway of Tally:
• Select F3: Cmp Info. (ALT+F3) from the button bar
• Select Alter and press Enter and
Delete a Companyà
This option allows you to delete an existing company. To delete a company, you have to load the
company first.
• Select F3: Cmp Info. (ALT+F3) from the Gateway of Tally to proceed to the Company Information
menu.
• Select Alter and press Enter.
• Select the company to be deleted. The Company Alteration screen is displayed.
• Use Alt + D to delete. Tally.ERP 9 will prompt for a confirmation on deleting the company
• Press Enter to delete the company
Note: Deletion of a company is irreversible. The company is permanently deleted from the system.
Groups and Ledgers in Tallyà
Groups: Groups are collection of ledgers having same nature. In Tally by specifying the Groups you can
post ledger in Trading Account, P/L Account, and Balance Sheet.
Pre-defined Groups in Tallyà
By default, Tally provides a list of Groups called pre-defined groups. The user can create any number
of Primary Groups and Sub Groups which are again grouped under a Primary Group/Sub Group.
There are 28 pre-defined Groups in Tally.ERP 9, out of which 15 are Primary Groups and 13 are SubGroups
15 Primary Groups

13 Sub Groups

Branch / Divisions

Bank Accounts

Capital Account

Bank OD A/c

Current Assets

Cash-in-hand

Current Liabilities

Deposits (Asset)

Direct Expenses

Duties & Taxes

Direct Incomes

Loans & Advances (Asset)

Fixed Assets

Provisions

Indirect Expenses

Reserves & Surplus

Indirect Incomes

Secured Loans

Investments

Stock-in-hand

Loans (Liability)

Sundry Creditors

Misc. Expenses (ASSET)

Sundry Debtors

Purchase Accounts

Unsecured Loans

Sales Accounts
Suspense A/c
Out of the 15 Primary Groups, 9 Primary Groups appear in the Balance Sheet which are Capital in
nature and 6 Primary Groups appear under Profit & Loss Account which are Revenue in nature.
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13 Sub Groups are classified under the 15 Primary Groups and they appear in the Balance Sheet.
Pre defined Sub Groups

Under

Bank Accounts

Current Assets

Bank OD A/c

Loans (Liability)

Cash-in-hand

Current Assets

Deposits (Asset)

Current Assets

Duties & Taxes

Current Liabilities

Loans & Advances (Asset)

Current Assets

Provisions

Current Liabilities

Reserves & Surplus

Capital Account

Secured Loans

Loans (Liability)

Stock-in-hand

Current Assets

Sundry Creditors

Current Liabilities

Sundry Debtors

Current Assets

Unsecured Loans

Loans (Liability)

Note: The Primary Group cannot be deleted, however, it can be renamed which is not suggested.
Creating Masters
Creating a groupà
In Tally.ERP 9 there are two options for creating Groups:
• Single Group – We can create only one Group by using Single Group creation screen.
• Multiple Groups – We can create multiple Groups by using Multiple Group Creation screen.
Creating a Single Groupà
Group is a collection of Ledgers of the same nature, Tally.ERP 9 allows you to create groups as per your
requirements.
Go to Gateway of Tally > Accounts Info. > Groups > Create under Single Group
The Group Creation screen is displayed as shown:
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Name of Group: Enter the name of the Group to be created.
For example “Administrative Expenses” in the name field.
Alias: Enter an alias name to allow access to the group using the Alias in addition to its name or leave
it blank.
Under: Specify under which existing (Parent) group the sub-classification is required.
Creating Multiple Groupà
Tally.ERP 9 allow you to create Multiple Groups simultaneously, you can create them by pressing Enter
on Create under Multiple Groups.
Go to Gateway of Tally > Accounts Info. > Groups > Create (under Multiple Groups)
You can create any number of Groups under an already created/selected Group. In this mode of
group creation, the sub-groups will automatically inherit the characteristics of their parent groups.

You can also create any number of Groups under different Groups by selecting All Items in “Under
Group” field.

Displaying a Groupà
You can display the Groups in Single mode or Multiple mode, since it is only display Tally.ERP 9 does not
allow you to alter any information in display mode.
Single Mode:
Go to Gateway of Tally > Accounts Info. > Group > Display (under Single Group).
Multiple Mode:
Go to Gateway of Tally > Accounts Info > Group > Display (under Multiple Group)
Altering a Groupà
You can alter the Groups in Single mode or Multiple mode by selecting Alter from the menu to change
any information. You can change the Name of any reserved group, but its characteristics will remain
the same.
Single mode:
Go to Gateway of Tally > Accounts Info. > Group > Alter (under Single Group)
Select the Group that you wish to alter from the List of Groups. Make the necessary changes and click
Yes to save the changes.
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Multiple Mode:
Go to Gateway of Tally > Accounts Info. > Group > Alter (under Multi Groups)
Select the Group for which you want to alter from the List of Groups. In Multi Group Alteration screen,
make the necessary changes and click Yes to save changes.
Deleting a Groupà
Go to Gateway of Tally > Accounts Info > Groups > Single/Alter
The Delete function is performed through the single alteration mode. You cannot delete groups from
the Multiple Alteration mode.
• Select the Group to be deleted
• Press ALT+D to delete
Ledgersà A Ledger is the actual account head to which you indentify a transaction and must be used
in all Accounting Vouchers. Without a ledger we can’t record any transactions.
All Ledgers have to be classified into Groups. Classification of Ledgers to the appropriate groups is very
important. These Groups and Ledgers are classified to Profit & Loss or Balance Sheet. The creation and
usage of Groups in Tally has been explained earlier. Now you will learn how Tally works with Ledgers.
Pre-defined Ledgers in Tallyà
There are two pre-defined ledgers available in Tally.ERP 9, they are: Cash and Profit and Loss Account;
Creating a Ledgerà
Go to Gateway of Tally > Accounts Info. > Ledgers
You can create either Single or Multiple Ledgers like Groups we explained earlier.
Single Mode:
Go to Gateway of Tally > Accounts Info > Ledgers > Single Ledger > Create

Name: Enter the Name of the account. You can provide the full name of the account. Tally fits it all in.
Press Enter to move to the next field. Tally does not allow the entry of duplicate names. The uniqueness
check is made here itself.
Alias: Enter an alias name if required. You can access the Ledgers using the original name or the alias
name.
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Under: All accounts must be classified under their appropriate Groups. Select the Group under which
the Ledger is created from the List of Groups. (To create a new Group from this field press [ALT + C]). A
wrong classification would affect the treatment of the Ledger account in final statements and during
voucher entry.
Opening Balance: If yours is an existing company whose books you are entering into Tally, Opening
Balance would be applicable in circumstances where the Ledger is an asset or a liability and if it
has a balance in the account as on the date of beginning of books in Tally. Tally recognizes normal
accounting principles of debit balances for Assets and credit balances for Liabilities. It accepts the
reverse for obverse balances. Revenue accounts normally do not have balances. Tally, however,
permits you to give balances even for such accounts - You may be transferring your books on to Tally in
the middle of the year and may not have closed them in your earlier system. Hence, you may specify
whether the balance is Debit or Credit. Simply D or C would suffice.
Multiple Mode:
You can create multiple Ledgers at a time in this mode. This will save the time of the user.
Go to Gateway of Tally > Accounts Info > ledgers > Multiple ledgers > Create
Same steps as we told in Groups.
Displaying / Altering a Ledger Account:
Information under Display and Alter is the same. Display option does not permit any modification. Alter
option permits you to alter the information.
You are allowed to alter any information of the ledger master with the exception of the Closing Balance
of a ledger account, if any, other than closing balance of accounts under the group Stock-in-hand.
Go to Gateway of Tally > Accounts Info. > Ledgers > Display or Alter
Modification of Account Ledgers is possible under Single Ledgers as well as Multiple Ledgers option.
However under Multiple Ledgers, all the fields are not available for alteration
Deletion:
You can delete the ledger if no vouchers have been created under this ledger.
Go to Gateway of Tally > Accounts Info > Ledgers > Alter > Press Alt+D.
If you want to delete a Ledger for which Vouchers have been created, then you have to first delete all
the Vouchers from that Ledger and then delete the Ledger Account.
Inventory Informationà
The Inventory Info menu, lists the inventory masters like Stock Group, Stock Items, Units of Measure of the
company, using which you can create, alter and display the inventory master details.
Go to Gateway of Tally > Inventory Info
Inventory information contains the inventory masters. Each master has Create,
Display and Alter functions.
These three functions are grouped under:
• Single
• Multiple
In Single, you can execute the function on one master. In Multiple, you can
execute
the function on multiple masters.
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Functionsà
Create: The Create option is used to create new masters. Any modification to the masters can be done
only through the Alter mode.
Display: The Display option is used to view the Master information. Master information cannot be
modified in Display mode.
Alter: The Alter option allows you to view and make the necessary changes to the master information.
This does not allow creation of masters. In Alteration mode, you can delete the master. [Press ALT+D
for deletion]
Stock Groupà
Stock Groups in Inventory are similar to Groups in Accounting Masters. They are helpful in the classification
of Stock Items. You can group Stock Items under different Stock Groups to reflect their classification
based on some common features such as brand name, product type, quality, etc. Grouping enables
you to locate Stock Items easily and report their details in statements.
Example:
Sub Group

Main Group

Brand A - 19” TFT

Stock Item

Brand A

Grade One

Brand A - 17” CRT

Brand A

Grade One

Brand B - 19” TFT

Brand B

Grade Two

Brand B - 17” CRT

Brand B

Grade Two

You now have ready details of Grade One and Grade Two products, duly classified. You can also view
the sub group classification.
Go to Gateway of Tally > Inventory Info. > Stock Groups
Creating Stock Group à
Stock Items are classified into stock groups to reflect their classification based on some community.

To create a Stock Group,

Go to Gateway of Tally > Inventory Info. > Stock Groups > Create (under Single Stock Group)
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A brief description on each of the fields in the Stock Group Creation screen follows:
Name: Enter the name of the Stock Group to be created. For example, Grade One.
Alias: Enter additional name apart from primary name [if required]. You can create any number of
additional names.
Under: Specify whether it is a primary group or a sub-group of another group, by selecting from the list.
Press Alt+C to create a parent group, if you do not have it in the list.
Can quantities of items be ADDED: This field pertains to information on measuring the units of the Stock
Items that you would categories under the Stock Group. The Stock Items categorized under the group
should have similar units for them to be added up. You cannot add quantities in Kgs to quantities in Pcs.
Creating Multiple Stock Groupsà
Same steps as we discussed in Multiple Ledger.
Displaying Stock Groupsà
Go to Gateway of TallyàInventory Info. à Stock groups à Display (Under Single or Multiple Stock
Group)
Altering Stock Groupà
Go to Gateway of TallyàInventory Info. à Stock groups à Alter (Under Single or Multiple Stock Group)
Deletionà
Go to Gateway of TallyàInventory Info. à Stock groups à Alter (Under Single Stock Group)àALT+D
Deletion is only possible if the Group is empty.
Stock Categoriesà
Stock Category offers a parallel classification of stock items. Like stock Groups, classification is done
based on similarity in behavior.
For example:
Stock Item

Sub Group

Main Group

Sub-Category

Main Category

Brand A - 19” TFT

Brand A

Grade One

TFT

Monitor

Brand A - 17” CRT

Brand A

Grade One

CRT

Monitor

Brand B - 19” TFT

Brand B

Grade Two

TFT

Monitor

Brand B - 17” CRT

Brand B

Grade Two

CRT

Monitor

Creation, Display, Alter option same as discussed in Stock Group.
Stock Itemsà
Stock Item refers to goods that you manufacture or trade. It is the primary inventory entity and is the
lowest level of information on your inventory. You have to create a Stock Item in Tally for each inventory
item that you want to account for.
Go to Gateway of Tally > Inventory Info. > Stock Items
Creating Stock Itemà
Stock items are goods that you manufacture or trade (sell and purchase). It is the primary inventory
entity. Stock Items in the Inventory transactions are similar to ledgers being used in accounting
transactions.
To create a Stock Item,
Go to Gateway of Tally > Inventory Info > Stock Item > Single Create (under Single Stock Item)
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Stock Item creation is displayed as shown:
A brief description of each field in the Stock Item
Creation screen follows:
Name: Specify the name of the Stock Item.
Alias: Specify the Alias name of Stock Item (if required).
Under: This field will show the List of Groups.
Here you can select the Stock Group to which the
Stock Item belongs. By default, Primary Stock
Group appears in this field.
Units: This field will show the Unit List.
Here you can select the Unit of measurement
applicable for the stock item. By default, Not Applicable appears in this field.
Opening Balance: Specify the details of Opening Stock, if any, for the Stock Item as on the date of
Beginning of Books.
• In the Quantity Field, specify the stock item Quantity, say 5 Nos.
• In the Rate Field, specify the stock item Rate, say Rs. 8000 per piece.
• In the Value Field, Tally.ERP 9 automatically calculates the value by multiplying the Quantity and
Rate. You can also edit the value, Tally.ERP 9 automatically refreshes the Rate field accordingly.
Displaying, Altering, and Deleting: Same as discussed earlier.
Voucher Entryà
Predefined Accounting Vouchers in Tallyà
Tally comprises of the following predefined Vouchers, to suit different business requirements for recording
various transactions. Tally also allows you to create user-defined Vouchers (Voucher Types) as per your
requirements.
• Contra Voucher (F4)
• Payment Voucher (F5)
• Receipt Voucher (F6)
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• Journal voucher (F7)
• Sales Voucher / Invoice (F8)
• Debit Note Voucher (CTRL+F9)
• Credit Note Voucher (CTRL+F8)
• Purchase Voucher / Invoice (F9)
There are two modes in Tally for Voucher Entry recording:
• Single Entry Mode
• Double Entry Mode
Contra Entry: As per the Accounting Principles, a Contra entry is a transaction involving transfer of cash
between one Cash A/c to another or one Cash A/c to another Bank A/c i.e., is a transaction indicating
transfer of funds from:
• Cash account to Cash account
• Cash account to Bank account
• Bank account to Cash account
• Bank account to Bank account
To view the Contra Voucher Entry Screen: Go to Gateway of Tally à Accounting Vouchers à Select F4:
Contra from the Button Bar or press F4.
Ex: `100000 is deposited into SBI Bank

Payment Entry: Payment Voucher is used to account all the payments made by the company by way
of Cash/Bank.
To Pass Payment Voucher à Go to Gateway of Tally à Accounting Vouchers à Select F5: Payment
from the button bar or press F5.
Payment voucher can be passed using Single Entry or Double Entry mode by configuring the setting
Use Single Entry mode for Pymt/Rcpt/Contra in F12 configuration.
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Ex: Making cash payment for Stationery-250, Postage-250, Staff Welfare-800

The above entry consists of both common narration and narrations for each entry. In case of multiple
debit/credit entries, you can give single line narration separately for every ledger account selected.
Special Keys for Voucher Narration Field
• ALT+R: Recalls the Last narration saved for the first ledger in the voucher, irrespective of the voucher
type.
• CTRL+R: Recalls the Last narration saved for a specific voucher type, irrespective of the ledger.
Receipt Entry: Any money received from debtors against sales Invoices or on Account and for all
transactions where money is received is accounted or entered into Tally using the Receipt Voucher.
To Pass Receipt Voucher à Go to Gateway of Tally à Accounting Vouchers à Select F6: Receipt from
the button bar or press F6.
Ex: Received Cheque from Matrix International for ` 249900 against the Sales made earlier.

Purchase Entry: Purchase voucher is used to record the Purchase transactions of the company. The
entry can be passed using the Voucher mode or the Invoice mode where the calculations can be
automated and the user can experience the ease of feeding the transactions into the system.

8.18 I The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program

To Pass a Purchase Voucher à Gateway of Tally à Accounting Vouchers àClick on F9:Purchase on
the Button Bar or press F9.
There are 3 modes for entering Purchase Voucher.
• Normal Purchase Voucher
• Account Invoice
• Item Invoice
Normal Purchase Invoice: Purchase goods from Local Supplier
For: Example Purchase goods worth Rs.50000 from Supplier A in credit.

Account Invoice: You will be directly selecting/debiting the Ledger account in case you are passing an
Account Invoice. This is useful especially when a Service Bill is entered and does not include Inventory.
Ex: Courier Service availed worth ` 10000 from XYZ Ltd.
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Item Invoice: You will be first selecting the Inventory and then allocating the same to the relevant
Ledger account. This is useful to record all the Inventory movements in books of account.
Ex: Purchase 100 Box of Apple @ ` 5500 per Box from LMN & Company Ltd on credit.

Sales Entry: When a sales transaction is made, a document detailing the transaction (item name,
tax, etc) has to be given to the buyer or debtor as proof of purchase by him. This document is called
Invoice or Bill or Cash Memo. Tally provides the option of creating Invoices.
There are 3 modes for entering Sales Voucher.
• Normal Sales Voucher
• Account Invoice
• Item Invoice
Account Invoice: Sales Account Invoice is generally used by professionals such as doctors and
consultants who require issuing an invoice for certain services provided such as consultancy charges,
professional fees, etc. Trading and manufacturing organizations also use the Account Invoice for
invoicing service charges. On the Sales entry screen, click on Acct Invoice button, which is displayed
on the Button Bar on the right-hand side of the screen to display the Sales Account Invoice screen as
shown.
Pass a Sales Account Invoice for Service provided to Debtor B:
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Item Invoice: Invoicing is generally used for sale of stock where the details of the items sold are listed.
Selecting the Item Invoice allows you to select the stock items that need to be invoiced. Trading and
manufacturing organizations commonly use this format. On the Sales invoice screen, click on the
button Item Invoice, which is displayed on the Button Bar on the right side of the screen and the Sales
Item Invoice appears as shown below:
Pass a Sales Invoice against sale of Apple – 50 Box. @ ` 6500/= per Box to Debtor C:

Note: Switch between Account Invoice Mode and Item Invoice Mode use: ALT+I
Switch between Invoice Mode and Accounting Voucher Mode use: CTRL+V
Printing Sales Invoice: To print any Invoice/voucher, press ALT+P or click on the button Print.
Note: You can configure the printing options, by selecting the appropriate buttons.
You can give additional information, change titles, print additional pages, and change printer settings.

The buttons Pre-Printed and Quick Format toggle between Plain Paper and Neat Format respectively.
These are print specifications that you set. Pre-printed is for pre-printed stationery.
Quick Format does not give fonts or other niceties but is ideal for fast printing.
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The Invoice Printing Configuration appears as shown:

Set the print options as desired. You can configure the invoice as per your requirement.
The options depend on the various F11: Features and F12: Configure parameters, that have been set
for your company and for the voucher either by you or by the administrator.
Journal Entry: Journal entries are usually used for finalization of accounts.
To pass a Journal Voucher àGo to Gateway of Tally > Accounting Vouchers à Click on F7: Journal on
the Button Bar or press F7.
For example, there may be entries made for interest accrued or interest due. If you have to receive
Interest from a party, the same can be entered using Journal Voucher. Debit the Party and Credit the
Interest Receivable Account.

Note: Normally Journals are adjustment entries, which do not involve cash. Tally has the flexibility of
passing such entries by enabling the option under F12 configuration.
Set Allow Cash Accounts in Journals to Yes in F12: Configure (Voucher Entry Configuration)
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Predefined Inventory Vouchers in Tallyà
Tally.ERP 9 comprises of the following predefined Vouchers, to suit different business requirements for
recording various transactions. Tally also allows you to create user-defined Vouchers (Voucher Types)
as per your requirements.
• Purchase order (ALT+F4)
• Sales order (ALT+F5)
• Job Work Out order (ALT+J)
• Job Work In order (ALT+W)
• Receipt note (ALT+F9)
• Delivery note (ALT+F8)
• Rejections Out (ALT+F6)
• Rejections In (CTRL+F6)
• Material Out (CTRL+J)
• Material In (CTRL+W)
• Stock Journal (ALT+S)
• Manufacturing Journal (ALT+S)
• Physical Stock (ALT+F10)
Receipt Note Voucher à
This voucher type is used for recording goods received from the supplier.
To enter the Receipt Note Voucher,
• From F11: Inventory Features, Enable the option Use Tracking Numbers (Delivery / Receipt Notes).
• Go to Gateway of Tally > Inventory Vouchers àPress the button Alt+F9 or Select the button F9:
Rcpt Note from the button bar.
For example, consider the situation where a company receives Item A from a supplier B, if a Purchase
Order exists for that Supplier B, select the Order Number from the List of Orders pop up menu to bring
up the order particulars automatically.
Once you accept the Order details, the cursor will move to the column Name of Item. On pressing
Enter, the Item Allocations screen is displayed. You can select existing Tracking number or create a
new Tracking Number. Tracking number is the reference to have a link between transactions. For eg: if
Tracking Number is selected in the Receipt Note, the details of the items are automatically displayed
in the Purchase Invoice.
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The Receipt Note after completion will appear as shown:

Save and Exit.
Rejections In Voucher (Sales Returns)à
A Rejections In Voucher is used to record goods that are rejected and returned by the customer.
To enter the Rejections In Voucher à From F11: Inventory Features, Enable the option Use Rejection
Inward / outward Notes à Go to Gateway of Tally > Inventory Vouchers à Press Ctrl+F6 or select the
button F6: Rej. In from the Button Bar
For example, Customer A returns Item A delivered by the company:
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Delivery Note Voucher à
The Delivery Note Voucher is used for recording goods delivered to a customer.
To pass the Delivery Note voucher à From F11: Inventory Features, Enable the option Use Tracking
Numbers (Delivery / Receipt Notes) à Go to Gateway of Tally à Inventory Vouchers à Press Alt+F8 or
select the button F8: Dely Note from the button bar
The Delivery Note Voucher after completion will appear as shown :

Rejections Out Voucher (Purchase Returns)à
The Rejections Out Voucher records goods that are rejected and returned to a supplier.
Material Outà
The Material Out Voucher is used to record the material transfer out.
Material Inà
The Material In Voucher is used to record the material transfer in.
Stock Journal Voucherà
Stock Journal is a Journal in which all types of Stock Adjustments are entered.
The stock adjustment may be due to:
Inter-Godown Transferà
This is useful to transfer the goods from one location to another. The quantity of Stock remains the same,
but the Location changes.
Additional Cost/Expenses involved in the Transfer of goods.
You can also account the additional cost incurred in connection of transfer of materials from one
location to another.
Accounting for Wastage of stock or shortage of stock
There may be a shortage or wastage of stock items, the quantity may have got changes. In such
cases, you have to enter a stock journal to account for the increase or decrease in the Stock Item.
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Manufacturing Process à
If you are involved in the manufacturing process in which raw materials are consumed and finished
goods are produced, then you can create a manufacturing Journal Voucher also.
To view the Stock Journal Voucher à Go to Gateway of Tally > Inventory Vouchers à Press the buttons
Alt + F7 or Select the button F7: Stk Jrnl from the Button Bar
For example, the company transfers Item B from the warehouse to the shop.
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UNIT - 9
TALLY.ERP9 - TAX DEDUCTED AT SOURCES (TDS)
Introduction à
TDS means Tax Deducted at Source. The concept of TDS was introduced in the Income Tax Act, 1961,
with the objective of deducting the tax on an income, at the source of income. It is one of the methods
of collecting Income Tax, which ensures regular flow of income to the Government.
Example: Medha Infotech is making the payment towards Rent to the owner of the building, it is
required to deduct the tax on the income (i.e. before payment to the owner), at the source of income.
TDS Process à
• A seller (Deductee) provides services to the buyer (Deductor).
• The buyer deducts the Tax at the time of payment of advances or while accounting the Bills
received.
• The buyer deposits the deducted amount to the designated branches of the authorised bank
• The buyer issues Form No.1 6A to the Deductee
• The buyer files annual returns electronically to the Income Tax department.
• The seller files returns, along with Form 16A claiming the credit of the Tax deducted at source.
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Time & Mode of TDS Payment à
• All the Tax deducted during a month are to be paid to the credit of Government on or before 7th
of the next month. In case 7th of the month happens to be a sunday or a bank holiday payment
can be made on the next working day
• TDS amount shall be paid to the government account through any designated branches of the
authorised banks, along with Income Tax Challan No.281.
• In case of collections made by or on behalf of the Government, the amount shall be cred-ited
within the time and in the manner aforesaid without the production of a challan.
Enable TDS Features in Tally à
It takes a one-time configuration in Tally.ERP 9 for TDS features to be activated. Follow the steps given
below to enable TDS in Tally.
To enable TDS Feature for a company, Tally.ERP 9 provides you a unique feature called Quick Setup.
Quick Setup is a Single Window Statutory Masters Configuration Screen. This tool guides the starters to
configure statutory masters required for the effective use of a particular statutory module.
To Enable TDS and to provide Company TDS Dedcutor Details Go to Gateway of Tally > Quick Setup >
Tax Deducted at Source
Quick Setup - Tax Deducted at Source will be displayed as shown:

From Quick Setup screen user can make required basic configurations like, company TDS details and
masters to account statutory transactions. It also allows making advance configura-tions wherever
applicable.
Configuration details will be displayed below the setup options once the configuration is done other
wise application will display the status as Not Configured for Company Setup and 0 of 0 Configured for
other setups (Masters/Advanced setup).
Company Setupà
Company Setup guides you to update relevant TDS details . To enter company TDS deductor details
Press Alt+C or Select the option C: Company TDS Details and press enter to view Company TDS Deductor
Details screen.
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In Company TDS Deductor Details screen, enter the details such as:
Tax Assessment Number (TAN):
TAN is a TEN digit alphanumeric number Issued by theIncome Tax Department (ITD) to the deductor,
which must be quoted on all Challans, Payment for TDS, Certificates issued in Form 16/16A, Returns and
in all documents and other correspondence with ITD.

Tips: The Format of TAN is AAAA*55555A, Where A* is the first character of the name of the Organization.
Example: TAN of ABC Company is BANA56015M
Head Office Tax Assessment Number: If the company created is the Branch of a company then
mention the head office’s Tax Assessment Number.
Income Tax Circle /Ward (TDS): Income Tax Circle/Ward, in which the deductors are assessed for
Income-Tax (TDS) with TAN of each person.
Deductor Type: According to the nature of the organisation Deductor type will be selected. In case
of Government, the option Government will be selected as the Deductor Type and if the deductor is
Non-Government body, Others will be selected.
Name of the person responsible: Person responsible means the person who is author-ised to file the TDS
returns of the company.
Designation: Mention the designation of the authorised person filing TDS returns.
After putting all the required information press Enter to accept the data.
Tips: Users can also enable TDS feature from Gateway of Tally > F11: Features > F3: Statutory & Taxation.
Creating TDS Masterà
To record the basic transactions in Tally you require 3 types of ledgers:
• Expense Ledger
• Party Ledger
• Tax Ledger
Master Setup: Master Setup guides you to create masters like Expenses ledgers, Party ledgers and Tax
ledgers by enabling relevant TDS options in the masters.
Expense Ledger: To Create Expense Ledgerà Go to Gateway of Tally à Quick Setup à Tax Deducted
at Source à Master Setup à X: Expense Ledgers (Press Alt + X).
The Expense Ledgers Setup screen displays only those fields which are must to be enabled to consider
the ledger created as a TDS expense ledger.
• In Name of Ledger field type Advertisement Expenses as the ledger name
• From the List of Groups select Indirect Expenses in the Under field
• By default, the field Is TDS Applicable will be set to Yes
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• In Default Nature of Payment filed select Payment to Contractors (Advertisement Contractors)
from the List of TDS Nature of Pymt.
Note: All the Payments/Expenses subject to TDS have to be associated with relevant predefined TDS
Nature of Payments.

Note: The Option any can be selected from the List of TDS Nature of Payment, where the user doesn’t
want to define the TDS Nature of payment during Ledger creation. This allows the user to use an Expense
Ledger (as a common ledger) to account multiple TDS Nature of Payments.
Users can create multiple expenses ledgers from Expense Ledgers Setup Screen.
Expense ledgers can also be created from Gateway of Tally > Accounts Info. > Ledgers> Create.
Tax Ledger : To create Tax Ledger à Go to Gateway of Tally à Quick Setup > Tax Deducted at Source
à Master Setup à T: Tax Ledgers (Press Alt + T)
The Tax Ledgers Setup screen displays only those fields which are must to be enabled to consider the
ledger created as a TDS Tax ledger.
• In Name of Ledger field type TDS – Contractors as the ledger name
• From the List of Groups select Duties & Taxes in the Under field
• In Nature of Payment filed select Payment to Contractors (Advertisement Con-tractors) from the
List of TDS Nature of Pymt.
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Noteà
• Users can create multiple tax ledgers from Tax Ledgers Setup Screen
• It is recommended that separate TDS ledgers be created with appropriate TDS nature of Payments.
However, Tally
provides you with the flexibility to use a common Duty ledger for different TDS Nature of Payments
by selecting the
Nature of Payments as any.
• Expense ledgers can also be created from Gateway of Tally > Accounts Info. > Ledgers > Create
Party Ledger à
To create party ledger àGo to Gateway of Tally à Quick Setup à Tax Deducted at Source > Master
Setup à A: Party Ledgers ((Press Alt + A). The Party Ledgers Setup screen displays only those fields which
are must to be enabled to consider the ledger created as a TDS party ledger:
• In Name of Ledger field type Super Agencies as the ledger name
• From the List of Groups select Sundry Creditors in the Under field
• By default, the field Is TDS Deductable will be set to Yes
• In Deductee Type field select Association of Persons from the List of Deductee Types
• Enter the PAN number of the party in PAN /IT No. field
The completed Party Ledgers Setup screen is displayed as shown:

Note:
• Users can create multiple party ledgers from Party Ledgers Setup Screen.
• The sellers who are receiving the TDS nature of payments, are required to be associated with the
predefined
Deductee Types.
• Expense ledgers can also be created from Gateway of Tally > Accounts Info. > Ledgers > Create
• The option UnKnown will be selected, when the Party’s deductee type details are not available
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TDS Transaction à
In this section we shall emphasis on understanding how Tally’s TDS features can be effectively used to
record basic TDS transactions to generate TDS Challan.
Let us take the example of ABC Company Ltd (Created and TDS enabled) to record TDS transactions
such as
• TDS on Expenses
• Payment to Party
• Payment of TDS
• Generating ITNS 281 Challan
TDS on Expenses (Journal Voucher) à
Under this, we will learn to Account expenses and deduct tax at source to arrive at the Net balance
payable to the party.
Ex: On April 12, 2013 ABC Company Ltd received a Bill (vide No. 220) from Super Agencies for Rs.
4,00,000 towards the Advertisement services provided.
Record the Transaction in Journal Voucher:
• Go to Gateway of Tally > Accounting Vouchers > Press F7: Journal
• Press F2 and change the date to 12-04-2013
• Select Advertisement Expenses in the Debit field
• Enter 4,00,000 in the Amount field.
• Select Super Agencies in the Credit field and press Enter to view TDS details screen.
The TDS Details screen is displayed as shown:
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In the TDS Details screen provide the following details:
Type of Ref.: Select New Ref from the method of Adjustment. Tally displays Two Methods of Adj viz., Agst
Ref and New Ref. New Ref is selected for new Financial Transactions where as Agst Ref is selected to
set off payment against the previously entered invoice.
Name: This filed display the Reference Number for the TDS Deducted. The default Reference Number
displayed is a combination of abbreviation of Journal, Voucher Number and Line Number. Example:
Jrnl / 1-1 which can be changed by the user. TDS payments are tracked with these Reference Numbers.
Nature of Payment: Select Payments to Contractors (advertisement Contractors) in Nature of Payment
field. The List of Nature of payments displays only that Nature of Payments which is specific to the
Expenses Ledgers, selected in the transaction.
TDS Duty Ledger: Select TDS – Contractors from the list of TDS Duty Ledgers. List of TDS Duty Ledgers
displays, ledgers created with specific nature of payment as well as the ledger created with the option
any.
Assessable Amount: Tally defaults the amount specified against the expenses ledger and skips the field.
Deduct now: This field will be set to Yes or No depending on the tax deduction. Set this field to Yes to
deduct the Tax in the same voucher.
TDS Amount: This field displays the Tax amount deducted at source
Payable Amount: This field displays the amount (after TDS) payable to the Party.
After putting the details press Enter to accept it.
Payable Amount as calculated in the TDS Details screen will be defaulted in the Party’s Amount (Credit)
field. Press Enter to view Bill–wise Details screen.
In Bill–wise Details screen à Select New Ref as the Type of Ref à In the Name field enter the Bill No à
Skip the Due Date or Credit Days field à Accept the default amount allocation and Dr/Cr. By default
Tally displays the Bill amount in the amount field as the credit balance à Press Enter, selects New Ref as
Type of Ref and Enter Bill no à Skip the Due Date or Credit Days field and accepts the default amount
allocation and Dr/ Cr. By default Tally displays the Tax amount in the amount field as the debit balance.
The completed Journal Voucher is displayed as shown:
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Note: Journal voucher is generally used to record transactions on due basis i.e., firstly a due entry in
favors of the party is created when the bill is received and then at the time of settlement of the referred
bill, a payment entry is passed.
Payment to Party à
Ex: On April 20, 2013, payment of Rs. 3,92,000 is made towards bill no. Bill-220 to Super Agencies for the
purchase of Advertisement services, vide cheque no. 336584
Record the transaction in Payment Voucher à Go to Gateway of Tally > Accounting Vouchers > Press
F5: Payment à Press F2 and change date to 20-04-2013 à In Debit field select Super Agencies from
the List of Ledger Accounts à Enter Rs. 3,92,000 in Amount field and press enter to view Bill-wise Details
screen à In Bill-wise Details screen à Select Agst Ref in the Type of Ref à Select Bill-220 from the List of
Pending Bills in Name field, Amount is defaulted automatically.
In Credit field select ICICI Bank from the List of Ledger Accounts, Amount is defaulted automatically à
Enter Cheque No. 336584 in Bank Details section (Inst No)
Completed Payment Voucher is displayed as shown:

Press Enter to Accept it.
Payment of TDS à
Payment of TDS (Using TDS Helper)à All the Tax deducted during a month is to be paid to the credit
of Government on or before 7th of the next month. In case 7th of the month happens to be a Sunday
or a bank holiday payment can be made on the next working day. TDS amount shall be paid to the
government account through any designated branches of the authorized banks, along with Income
Tax Challan No.281.
Ex: On May 5, 2013, paid TDS of Rs. 8,000 towards Advertisement Expenses, vide cheque no. 336725 for
the month of April, 2013.
First you have to configure the Payment Voucher. Steps are as follows:
Go to Payment Voucher à Press F12 à Set Use Single Entry mode for Pymt/Rcpt/Contra to Yes
Now you record the transaction by using following steps:
Press F2 and change date to 05-05-2013 à Press Alt+S or click on S: Stat Payment button on the Buttons
Bar to view Statutory Payment screen à
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Type of Duty/Tax: In this field select the Tax/Duty Type towards which tax payment entry is being
recorded. Here we are recording TDS payment entry, hence select TDS from the Type of Duty/Tax

Auto Fill Statutory Payment: Set this option to YES to auto calculates and fills the tax payable to the
Government
Set this option to NO, if the user wants to manually select the tax ledger and tax bills.

Deducted Till Date: In this field user may enter, till date of the period for which the TDS values should be
computed and auto-filled. Enter 30-04-2013 as the Till Date.
Section: As per the Act, separate TDS challans to be submitted for the payment of tax under each
section. In this field, Tally displays all the Sections under which, Tax deducted is pending for payment.
Select Section 194C from the list of section.
Nature of Payments: Based on the section selected in the Section field, Tally displays the section related
nature of payments under which, Tax deducted is pending for payment. Select Payment to Contractors
(Advertisement Contractors) as the Nature of Payment.
Deductee Status: Select the Deductee Status as Non Company.
Cash/ Bank: Depending on the mode of payment (Cash or Cheque) Cash or Bank ledger will be
selected. Select ICICI Bank from the List of Ledger Accounts.
The completed Statutory Payment screen is displayed as shown:
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• Press Enter to accept the Statutory Payment screen.
• The Bank Name through which the payment is made and TDS payable amount (with the respective
bill details) will be auto-filled.
• Set the option Provide Details to Yes to enter TDS payment details
• In the Payment Details Screen
• From Date: In this field enter the From date of the period for which the payment is made
• To Date: In this field enter the To date of the period for which the payment is made
• Cheque/DD No: In this field user can enter either the cheque or the DD No through which the TDS
payment is made. In this transaction payment is made through cheque no. 336725.
• Name of the Bank: This field is provided to mention the name of authorised bank, where the
payment is made.
• Bank Account Number: Enter the bank account number in this filed
• Branch Name: Enter the bank Branch name in this field.
• BSR Code: Enter the BSR code of the branch. BSR code is a 7 digit number allotted by Reserve Bank
of India (RBI) to bank branch.
• Challan No.: In this field enter the TDS payment Challan number. If the TDS payment chal lan
details are not available at the time of recording the TDS payment entry, such details can be
either by reconciling the TDS ledger or by altering the payment voucher.
• Challan Date: Enter the Challan Date.
The completed Payment Details screen is displayed as shown:

Now Press Enter to accept the details and Save the Voucher.
Generating TDS Challan (ITNS 281) à
Tax is remitted to the government account through Challans. For making the TDS payment, Challan
No. 281 is used.
In Tally TDS Challan (ITNS 28) will be printed from the TDS payment voucher.
To print the TDS Challan for the transaction entered on 05-05-2013:
• Press PageUp to go back to payment voucher entry
• Click on Print button or Press Alt + P from the payment voucher to view the Voucher Printing screen
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TDS Challan is displayed as shown:

TDS Reportsà
Tally helps the user to generate the TDS Computation Report, TDS Challan, Statutory Returns and other
related reports at the end of a month, quarter or year, as prescribed under the Act. To view the TDS
Reports. Go to Gateway of Tallyà Displayà Statutory Reports à TDS Reports
Computationà
TDS Computation report displays information about TDS transactions. It includes information about the
total expenses and advances on which TDS is applicable, TDS amount deducted, balance TDS amount
deductible, TDS amount paid and TDS amount pending for payment. To view TDS Computation report:
Go to Gateway of Tally à Display à Statutory Reports à TDS Reports à Computation

Challan Reconciliationà
Reconciliation of Challan Payments made to Bank for TDS accounts is done in Challan reconciliation.
Go to Gateway of Tally à Display > Statutory Reports à TDS Reports à Challan Reconciliation.
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The Challan Reconciliation report is displayed as shown:

TDS Challan Reconciliation screen displays all the vouchers related to the TDS Ledger selected. Challan
reconciliation is done only for those vouchers for which the payment details are not provided during
voucher entry. For Challan Reconciliation Press F5 key or Click on F5: Challan Reconciliation button to
reconcile the challan. TDS Challans can be reconciled either by updating the Cheque/DD No., Name
of Bank, Branch Name, BSR Code, Challan No., and Challan Date in the reconciliation screen OR
by using Set Challan Details (Alt +S) button from the Buttons Bar to reconcile challans. Click on S: Set
Challan Details button to fill the challan details. Enter the details as shown.
Returnà
Tally.ERP 9 allows the user to print Form 16 A and all the Quarterly and Annual TDS Return Forms and
Annexures.

E–Returnsà
The Income Tax department has now notified ‘Electronic Filing of Returns of Tax Deducted at Source
Scheme, 2003’. It is applicable to all deductors furnishing their TDS return in electronic form. As per this
scheme,
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• It is mandatory for corporate deductors to furnish their TDS returns in electronic form (e-TDS return)
with effect from June 1, 2003.
• For government deductors it is mandatory to furnish their TDS returns in electronic form (e-TDS
return) from financial year 2004-2005 onwards
• Deductors (other than government and corporates) may file TDS return in electronic or physical
form.
Deductors furnishing TDS returns in electronic form (e-TDS) have to furnish Form 27A. Form 27A is a
control chart to be furnished in physical form along with CD/ Floppy containing the e-TDS returns. Form
No 27A is required to be furnished separately for each TDS return. Form 27A is a summary of e-TDS returns
which contains control totals of ‘Amount paid and ‘Income tax deducted at source’. The control totals
mentioned on Form 27A should match with the corresponding control totals in e-TDS returns.
Forms

Periodicity

Due Date

Form 26Q

Quarterly

On or before 15th July, 15th October, 15th January and 5th June

Form 27Q

Quarterly

On or before 14the July, 14th October, 14the January and 14th April
or 14th June

Form 26

Annual

On or before 30th June, following the financial year.

Form 27

Annual

On or before 30th June, following the financial year.

Form 27A

Annual/Quarterly

Filed in physical form with each return i.e. Form 26Q, Form 27Q, Form
26 and Form 27.

E–TDSà
E-TDS menu displays the eTDS Quarterly and Annual Forms, which can be exported from Tally.ERP 9 and
validated using TDS/TCS File Validation Utility. To view the E-TDS Forms Go to Gateway of Tally à Display
à Statutory Reports à TDS Reports à E–Return à E–TDS
Note: It is mandatory to validate the TDS returns with File Validation Utility to confirm to the requirements
as prescribed by the Income tax department. In case of any errors in exported file (Returns), the FVU
prompts a error message with error code, the assessee may correct the same and revalidate the
returns. The File Validation Utility is available for Quarterly and Annual returns separately.

Tally exports Form 26Q & Form 27Q in the text (.txt) format as prescribed by NSDL.
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Outstanding à
In Outstanding reports user can view:
• TDS Payables: TDS Payable report gives you information on the status of TDS payable (pending) to
Government amounts for a particular Nature of Payment.
• Ledger outstanding: TDS Ledger Outstanding report displays ledger wise TDS outstanding. This
report can be viewed for all the ledgers or for one ledger
• Nature of payments Outstanding: TDS Nature of Payment Outstanding report displays Nature of
Payment wise TDS outstanding. This report can be viewed for all the Nature of Payment or for one
Nature of Payments
• TDS Not deducted: TDS Not Deducted report displays party wise TDS not deducted details.

9.14 I The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program

UNIT - 10
TALLY.ERP9 - GOODS AND SERVICE TAX
Introduction à
In this chapter we have covered three basic areas of common business practices which are made
through Tally ERP, namely, (a) GST related transactions for registered dealer, (b) Buying from unregistered
dealer (with RCM) and (c) payment of tax liability under GST.
Under the heading of (a) GST related transactions for registered dealer we have gone through the
following topics.
1.

Create stock items and ledgers

2.

Create purchase ledgers

3.

Create sales ledgers

4.

Create Party (customer) ledgers

5.

Create CGST, SGST, IGST ledgers

6.

Record Taxable Sale with E-Way Bill

7.

Print Sale Invoice with E-Way Bill No.

8.

Record Composite Supply

9.

Record Taxable Purchase (Local) without e-Way Bill

10. Record Taxable Purchase Return
11. Record Taxable Purchase of capital goods
12. Record Expenses with GST
13. Record Stock Transfer among Branches under GST
Under the heading of (b) Buying from unregistered dealer (with RCM) we have elaborated the following
topics
1.

Create unregistered supplier ledger

2.

Record purchase invoice

3.

Raise Tax Liability and Tax credit for Purchase from unregistered dealer

4.

Payment of tax liability under reverse charge

5.

Purchase Return to Unregistered Dealer (Reversed Charged under GST):

We conclude this chapter with a brief discussion on filing offline GST return through Tally ERP.
Goods and Service Tax à
The introduction of Goods and Services Tax on 1st July 2017 was an indirect tax reforms in India by
amalgamating a large number of Central and State taxes into a single tax. The aim was to reduce
double taxation in a major way. GST is applicable on supply of goods or services as against the concept
of tax on manufacture of goods and subsequently on sale of goods or services. GST is destination
based consumption taxation.
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Registration with GST à
Registration under GST act implies obtaining a state-wise PAN-based 15-digit Goods and Services
Taxpayer Identification Number (GSTIN) from the tax authority. If a supplier’s aggregate turnover
in a financial year exceeds twenty lakhs rupees (Rupees ten lakhs for the special category states),
he is liable to be registered under GST Act. The person is required to be registered in the state from
where his supplies are made. If supply is made within the state (Intra-State) then nature of tax will be
CGST and SGST, otherwise IGST (Inter-State). Other than the above mentioned person, the following
persons are also liable to be registered compulsorily under this act. Persons making inter-State taxable
supply, Casual taxable persons for taxable supply, Persons pay tax under reverse charge, Persons
pay tax under sub-section (5) of section 9 (electronic commerce operator), Non-resident taxable
persons for taxable supply, Persons require to deduct tax (TDS), Persons who supply taxable goods or
services or both as an agent, Input service distributor, persons who supply goods or services through
electronic commerce operator who collects tax at source, electronic commerce operator, person
supplying online information and database access or retrieval.
Types of Taxes under GST à
•

Central Goods and Services Tax (CGST) rate is levied by central government on intra-state supply
of taxable goods and services.

•

State Goods and Services Tax (SGST) rate is levied by state government on intra-state supply of
taxable goods and services.

•

Integrated Goods and Services Tax (IGST) rate is levied by central government on inter-state
supply of taxable goods and services. This tax is collected by the Central government and
distributed among the respective states.

•

Union Territory Goods and Services Tax (UTGST) rate is levied by the Union Territory (Andaman and
Nicobar Islands, Dadra and Nagar Haveli, Chandigarh, Lakshadweep and Daman and Diu) on
intrastate (within one Union Territory) supply of taxable goods and services.
Ø Input Tax – when a registered person incur central tax, state tax, integrated tax or Union
territory tax in relation to inward supply of goods or services or both is called Input Tax.
Ø Output Tax – when a registered person incur central tax, state tax, integrated tax or Union
territory tax in relation to outward supply of goods or services or both is called output Tax
(Excludes tax payable on reverse charge mechanism).
Ø Input Tax Credit: Payment of output tax liability is subject to set-off of the tax already paid
on inward supplies (i.e., credit against tax already paid on purchase) and pays the balance
amount. It is called input tax credit (ITC).

ITC can be avail against each of these 3 taxes are as follows:
ü CGST ITC – can be offset against CGST and IGST
ü SGST ITC – can be offset against SGST and IGST
ü IGST ITC – can be offset against IGST, CGST and SGST
Reverse Charge Mechanism à
It is a system where supplier of goods and services does not pay tax but receiver becomes liable to
pay tax and deposit with tax authority. It means chargeability turn into reverse. This mechanism is
applicable in the following cases.
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1.

When an unregistered vendor supplies goods or services to a person registered under GST. Then
required amount of GST (whether CGST, SGST or IGST) will have to be paid by the recipient of
goods or services by self invoicing mode directly to the tax authority under RCM. [RCM is not
applicable if aggregate value of such supplies does not exceed ` 5000 per day).

2.

Applicable on certain goods or services notified by the government under RCM.

3.

RCM is applicable on importing of goods and services. Here, IGST is calculated on Base Price +
Custom Duty.

GST Tax Invoice à
An invoice or a bill of supply is a record of goods sent or services rendered, along with the amount
due for payment. It is issued for sale, barter, exchange, transfer, license, rental, lease or disposal
within a prescribed time. A registered supplier requires providing GST-complaint invoices to their
customer. A GST-compliant invoice should contain Supplier and recipient (Registered) name,
address, address of delivery, a consecutive serial number (unique for a financial year), date of
issue, GSTN, HSN/SAC code for goods or services, description of goods and services, Taxable value
and discounts, rate and amount of tax (central tax, State tax, integrated tax, cess), whether GST is
payable on reverse charge basis, signature of supplier or his agent.
Supply of goods are required three copies of the invoice - Original, Duplicate, and Triplicate. The
original invoice is marked as ‘Original for recipient’ and issued to the receiver. Duplicate copy is
marked as ‘Duplicate for transporter’ and issued to the transporter. It is not required if supplier obtain
Invoice reference number from the GST portal. Triplicate copy is retained by the supplier in the name
of ‘Triplicate for supplier’.
Supplies of services are required two copies of the invoice- Original, Duplicate. Original invoice is
marked as ‘Original for recipient’ and issued to the receiver. The duplicate copy is retained by
supplier, and is marked as ‘Duplicate for supplier’.
On the other hand, a Bill of Supply can be issued by a registered supplier for Supply of exempted
goods or services and Supplier is paying tax under composition scheme.
e-Way Bill à
Electronic way bill is generated through e-Way Bill Portal before the commencement of movement
of goods. A registered person should generate an e-way bill if movement of goods is more than
` 50,000 in value in a vehicle. After generating an e-way bill, a unique e-way bill number (EBN) is
allocated and make it available to the supplier, recipient, and transporter. E-way bill can be
generated by registered person and transporter.
Activate GST in Tally ERP à
It takes a one time configuration for GST features to be enabled in Tally ERP 9. Follow the steps given
below to configure GST for a newly created company.
Note: Once activated, GST-related features are available in ledgers, stock items, transactions and
GST returns can be generated.
A. Gateway Of Tally > F11>F3>Enable Goods and Services Tax (GST) - Yes .
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B.

Set/alter GST details - Yes.

C. The GST Details screen is shown, with the
● State (Select state for your company). It helps in identifying local and interstate transactions.
● Select the Registration Type as Regular or Composition .
Set GST details for regular dealers
1.

Turn the option Assessee of Other Territory to Yes if your business is located in the Exclusive Economic
Zone (other territory).

2.

Put the GSTIN/UIN for the business. This can be printed in the invoices as required.

3.

Mention Applicable from date. GST will be applicable for your transactions from this date onwards.

4.

Select the Periodicity of GSTR-1 as Monthly or Quarterly, based on your business turnover.

5.

E-Way Bill: Enable e-Way Bill applicable to Yes. Mention the date from which e-Way Bill applicable
from. Set the e-Way Bill threshold limit. Also mention whether e-Way Bill applicable for intrastate.

6.

Set the option Enable tax liability on advance receipts to Yes to turn on calculation of tax liability
on advance receipts.
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If your turnover was less than ` 1.5 crores in the previous financial year, you need not pay tax on
advance receipts. Calculation of tax liability on advance receipts for supply of goods is disabled
by default.
If the turnover of business is above ` 1.5 crores, set the option to Yes to calculate tax liability on
advance receipts. The liability will be included in GSTR-1 and GSTR-3B returns.
7.

To activate calculation of tax liability for reverse charge on purchases from unregistered dealer,
Set the option Enable tax liability on reverse charge (Purchase from unregistered dealer) to Yes.

8.

Set/Alter GST rate details: you can set GST rate for your all GST related transactions at company
level, stock group level, stock item level, account ledger group level, and ledger level. You can
also set the GST rates for a particular price range/slab for multiple stock items.
At company level setting, you have to set this option to yes which implies that the given GST rate
will be applicable for all goods and service related transaction by default. If your company deals
in a single product or service OR a single GST rate then you can set this option to yes by providing
HSN/SAC details, tax details, tax type with respective rate.
In other cases, it would better to keep this option No.

9.

Enable GST classification: You can turn this option to yes in order to record the tax rate and other
details for a category or class of goods or services attracting a specific GST rate. For example,
creating GST Classifications based on electronic product or HSN code. When we add a new product
under the same class or category, the tax details of the goods or services will be automatically
captured. You can create GST Classifications for an accounts-only company as well.

10. Provide LUT/Bond details: Export can be recorded as using sales voucher. There are three types of
export. Taxable export, exempt export and export under LUT/Bond (No tax is applicable). Export
under LUT/bond is applicable when exporters sign up a letter of undertaking with the concerned
department for exporting of the goods without the payment of duty.
To provide details of the LUT/bond, set the options Provide LUT/Bond details to yes, and enter the
details in the LUT/Bond Details screen.
Set GST details for composition dealers à
If you are registered under the Composition Scheme you need to pay output tax at fixed rate of
total turnover, which is 2% for manufacturer, 5% for restaurant sector, and 1% for traders (At present).
No input tax credit is available to composite dealers. You have to file quarterly return and annual
return. You can identify turnover from the Profit & Loss A/c, or by selecting Sales Accounts in the Group
Summary Ledger report for a specified period.
•

Set the option Enable tax rate for purchase (Includes purchases under reverse charge) to yes will
help you to enter tax rate in the ledgers and stock items for evaluating GST in transactions.

A. GST Related transactions for Registered Dealer
1.

Create stock items and ledgers:
It helps you to maintain stock details of each item handled in your business. You can provide the
tax rate for calculating the tax at the time of purchase and sales invoice.
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• Gateway of Tally > Inventory Info. > Stock Items > Create

• Set/alter GST Details? > Yes, specify the required details
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• If the above screen does not appear with all the details and types then press F12 (Configuration)
and turn the fields Yes

Taxability: In this section you will get three options like Exempt, Nil Rated (0% tax rate under GST) and
Taxable. To view the history of tax rate changes, press Alt+L.
• Press Enter to accept.
2.

Create purchase ledgers
• Gateway of Tally > Accounts Info. > Ledgers > Create (Single Ledger).

• Select Purchase Accounts (Under), from the List of Groups.
• Is GST Applicable - Applicable.
• Set/alter GST Details – No [If you deals with many Purchase items but same tax rate turn this
option to Yes and specify tax rate. Then all kinds of purchase passes through this account will
consider given fixed rate of GST for calculating tax liability. If you purchase items with multiple
tax rates, turn it to NO and set all GST details at the stock item or stock group level.]
• Press Enter to accept.
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3.

Create sales ledgers
• Gateway of Tally > Accounts Info. > Ledgers > Create. (Single Ledger).

• Select Sales Accounts (Under), from the List of Groups.
• Is GST Applicable - Applicable.
• Set/alter GST Details – No [If you deals with many sale items but same tax rate turn this option to
Yes and specify tax rate. Then all kinds of sale passes through this account will consider given
fixed rate of GST for calculating tax liability. If you sell items with multiple tax rates turn this option
to No and set all GST details at the stock item or stock group level.]
• Press Enter to accept.
4.

Create Party (customer) ledgers
• Gateway of Tally > Accounts Info. > Ledgers > Create.
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• Enter name of supplier under sundry Creditor or customer under Sundry Debtor
• Turn Maintain balances bill-by-bill option to Yes.
• Enter Default credit period and other details if any.
• Set Inventory values are affected to No
• Set the option Set/Alter GST Details? Yes

• Specify Registration type from the list (Composition, Consumer, Regular, Unregistered)
• If the party is an Assessee of Other Territory, set it to Yes.
• Mention whether party is a e-Commerce operator
• Whether party is to be considered as Deemed exporter for purchases.
• Set Party type
• Enter the 15-digit GSTIN/UIN
• Mention whether the party is a transporter
• Press Enter to save.
5.

Create CGST, SGST, IGST ledgers
In Tally, a single CGST, SGST and IGST ledger can accommodate all types of input and output tax
liability.
• Gateway of Tally > Accounts Info. > Ledgers > Create.
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• Specify the name of the ledger [Central GST (CGST)] under Duties & Taxes
• Set Type of duty/tax is GST
• Set tax type as Central Tax [ Other available options are Cess, Integrated tax and State tax]
• Set the field Percentage of Calculation to No
• Select Rounding method as per your choice and accept.
In similar way you can create SGST ledger. Set tax type as State Tax [as given below]

To create IGST ledger you have to follow similar procedure as mention in CGST. Set tax type as Integrated
Tax [as given below]
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6.

Record Taxable Sale with E-Way Bill:
Ø Create transporter ledger. Transporter is to be treated as sundry creditor.
Gateway of Tally > Accounts Info. > Ledgers > Create (Single Ledger). Set transporter name
under Sundry Creditor. Put other details as follows.
• Set/Alter GST Details: Yes

• If your transporter type is Regular or Composition, you have to specify his GSTIN/UIN number and
set ‘is a transporter’ to yes.

• If your transporter is not registered under GST (Unregistered Type), he will provide you 15 digit
transporter ID obtain from e-way bill portal.
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Ø Pass the sales voucher
• Gateway of Tally > Accounting Voucher > Sales [providing invoice details and set GST/e-way bill
details to Yes]

• Before filling up all the required fields in the e-Way bill press F12 to enter the mandatory details
for generating e-Way Bill. Set Enable Consolidated e-Way Bill to Yes and Show Consignor Details
to Yes.
•

At the moment of generating invoice we do not have e-way bill number. It needs to be
collected from e-Way bill portal after invoice is made.
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• Sub type indicates purpose of movement of the goods. Movements for Exhibition or Fairs, Export,
For own use, Job Work, Lines Sales ( When output of one unit/division being transported as input
for next production line/unit/division in the same organisation), Others, Recipient not Known,
SKD/CKD (Semi Knocked Down and Complete Knocked Down. In implies condition of goods
while in transit), Supply.
• Fill the e-Way bill detail. If modes of transportation or vehicles are multiple then press Ctrl + T and
put the transporter details. Then accept the Transporter’s Details screen.

• If you need to generate multiple e-Way bill for a single transaction press Alt + W (e-Way Bill
Details). Fill all the details and accept e-Way bill Details Screen.

• After accepting sales invoice, Exporting Details for e-Way Bill screen will appear. Press Enter and
put the JSON file in a folder. [invoice details cannot be exported without e-Way Bill details and
HSN for the stock item]

To generate the e-Way Bill, upload the JSON file through GST portal. Open e-Way Bill System > e-Way
Bill Portal. Then return to the invoice in Tally and put the e-Way Bill number and Date to update e-Way
bill information.
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7.

Print Sale Invoice with E-Way Bill No.:
• Open your sale invoice under Accounting Voucher Alteration mode. Press Alt + P (Print),
Voucher Printing screen will open. Press F12 and turn Print e-Way Bill No. to Yes, accept invoice
configuration screen and press Enter to Print.

8.

Record Composite Supply:
Under GST, a composite supply would mean a supply made by a taxable person to a recipient
consisting of two or more taxable supplies of goods or services or both, or any combination thereof,
which are naturally bundled and supplied in conjunction with each other in the ordinary course of
business, one of which is a principal supply: Illustration: Where goods are packed and transported
with insurance, the supply of goods, packing materials, transport and insurance is a composite
supply and supply of goods is a principal supply.
• Create composite Supply (Service) ledger:
These kind of ledgers for service which form part of the item or service value need to be shown
in the invoice, such as delivery, packaging etc. It is considered as composite supply.
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1. Gateway of Tally > Accounts Info. > Ledgers > Create (Single Ledger).

2. Write ledger name (Example: Packaging Expenses) and Select Direct Expenses/Indirect
Expenses for expenses from List of Groups
3. Type of Ledger - Not Applicable.
4. Is GST Applicable? - Not Applicable.
5. Include in assessable value calculation for - GST.
6. Appropriate to Goods, for additional expenses or incomes on goods and Services.
7. Press Enter to accept.
• Sales of Composite supply (Goods considered as principal item)
1. Gateway of Tally > Accounting Voucher > F8 (Sale)
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2. You can see the tax break up by pressing Alt+A (Tax Analysis) then Alt + F1 (Detailed).

[Packaging expenses is apportioning on the basis of value of principal supply (Goods). At the
time of “packaging expenses” ledger creation, we have chosen method of calculation as
Based on Value. Otherwise, you may consider it as Based on Quantity].
9.

Record Taxable Purchase (Local) without e-Way Bill:
• Gateway of Tally > Accounting Voucher > F9 (Purchase)

• Put Supplier Invoice No. and date of sales invoice passed by the supplier
• Write Supplier’s name under Party A/c name and select purchase ledger
• Select item name and mention its quantity, rate
• Select CGST and SGST for local purchase (calculation automatically been made).
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• To view tax break up in details press Alt + A(Tax analysis), then Alt + F1(Detailed)

• Finally accept the purchase invoice.
• In case of interstate purchase follow the same procedure. In the place of CGST and SGST, select
only IGST.
10. Record Taxable Purchase Return:
• Gateway of Tally > F11 > Accounting Features > Turn the option “Use debit and credit note” to
Yes > turn the other two option “Record credit notes in invoice mode” and “Record debit notes
in invoice mode” to Yes. Accept Accounting Features screen.
• Gateway of Tally > Accounting Voucher > Ctrl + F9 (Debit Note)
• Put original purchase invoice no and invoice date
• Select party’s account name to whom goods will be returned
• Select purchase A/c under Purchase Ledger
• Put the item name, quantity of return and rate
• Select CGST, SGST, (IGST for interstate return) ledgers.
• Set GST Details to yes if you want to provide additional details for this return
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Ø You will get the following option and select appropriate one.
• 01-Sales Return - Return of goods or services after sales.
• 02-Post sale discount – After sales discount is allowed on goods or services.
• 03-Deficiency in service – Return due to deficiency in services.
•

04-Correction in invoice – When return is shown due to a correction in the invoice.

•

05-Change in POS – It implies change in place of supply that may change in tax amount.

•

06-Finalization of Provisional assessment - When a price or rate change is taken place after the
finalization of price for goods or services.

•

07-Others - Any other type of return.

[ In similar way you can make sales return by using Credit Note voucher mode.]
11. Record Taxable Purchase of capital goods:
• Create fixed asset (Furniture) ledger: Gateway of Tally > Accounting Info > Ledger > Create
(Under Single Ledger)

• Name the capital good under Fixed Assets
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• Set inventory value affected to No
• Turn “Is GST applicable?” to Applicable
• When you turn “set/alter GST Details” to Yes you will find the following screen

• Fill the GST details for that ledger. When you reach “Nature of Transaction”, a list of transaction
type screen will come. Select appropriate one.
• Set “Nature of transaction” as Capital Goods
• Mention whether the purchase item is taxable or not and put tax rate.
• Accept the GST Details screen and save the ledger.
• Gateway of Tally > Accounting Voucher > F9 (Purchase)
• Consider it As Voucher (Ctrl + V) with Accounting Invoice (Alt + I) mode
• Press F12 (Configure) > F12 (Advance). Turn Allow expenses/fixed assets in purchase vouchers
to Yes.
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• Put supplier invoice no and date. Supplier A/c is to be credited with asset value inclusive of tax.
• Debit, Asset A/c , CGST A/c and SGST A/c (for interstate purchase IGST A/c). Then save the
voucher.
12. Record Expenses with GST
For day to day business expenses when a registered dealer purchases services (e.g. stationery,
telephone bill, rent etc.) from another registered dealer, he is liable to pay GST at the point of
purchase or at the time of payment. Subsequently, he is entitled to get input tax credit facility. You
may record the expenses either through payment voucher, or a journal voucher, or a purchase
voucher.
• Create the Expense Ledger: Gateway og Tally > Accounts Info > Ledger > Create (Single Ledger)

• Put ledger name under Direct/ Indirect expenses
• Under statutory Information, set “ Is GST Applicable” to “ Applicable”
• Turn “Set/alter GST Details” to Yes and put HSN/SAC details,
• Set “Nature of Transaction” to Purchase Taxable (Considered as local purchase) and specify
tax rate.
• Record Expenses through Purchase Voucher
1. Gateway of Tally > Accounting Voucher > F9 (Purchase) [press Alt + I for getting into
Accounting Invoice]
2. You may set cash/Bank/Party name (Creditor) under “Party A/c name”
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3. Then specify particular Direct/Indirect Expenses ledger name
4. Tax calculation for CGST/SGST/IGST will be automatically done after choosing appropriate
tax ledger
5. Save the voucher

• Record Expenses through Payment Voucher
1. Gateway of Tally > Accounting Voucher > F5 (Payment)
2. Press F12 twice and turn both the options (Show Party Details for GST? and Allow modification
of tax details for GST ? ) to Yes
3. Select appropriate expenses and tax ledgers

The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program |10.21

Tally.ERP 9
4. When you credit cash/Bank then you need to provide party details and save the voucher.

• Record Expenses through Journal Voucher
1. Gateway of Tally > Accounting Voucher > F7 (Journal)
2. Pass the journal entry in the following manner

13. Record Stock Transfer among Branches under GST
Local Transfer: If transfers of goods across the branches are located in the same state and operates
with same GSTIN, then it does not attract any GST. However, goods transfer between branches
with different GSTIN under same state comes under the purview of CGST and SGST.
• Local stock transfer with same GSTIN
1. Create branch ledger
•

Gateway of Tally > Accounts Info. > Ledger > Create (Single Ledger) > Branch Name > Under
( Branch/Divisions) and specify State.
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•

Turn Set/alter GST details to Yes and put same GSTIN which is given at company level.

2. Create Local Inward Branch Ledger: As follows

3. Entry for local inward Branch Transfer:
• Gateway of Tally > Inventory Voucher > Alt+F9 (Receipt Note) [Press F11 > Set “Use tracking
numbers (enables deliver and receipt notes)” to Yes]
• At the place of “Party A/c name”, select Branch ledger
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• Under “purchase ledger” select Branch Transfer Inward ledger. Then put item name, quantity
and rate. [No GST is applicable for same GSTIN across the branchs]

4. For outward local branch transfer:
• we need to create “Branch Transfer Outward ledger” under “sale” group
• Record Delivery Note [Gateway of Tally > Inventory Voucher > Alt+F8 (Delivery Note)]

• Interstate Stock Transfer
When interstate stock transfer across the branches is occurred it comes under the purview of
Integrated Tax liability due to different GSTIN. Here, we will see interstate inward branch transfer
and interstate outward branch transfer.
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1. Interstate Inward Branch Transfer:
• Create branch ledger under Branch/Divisions, provide appropriate state and specify
GSTIN under “Set/alter GST details”.

• Create “Branch Transfer Inward- Interstate” A/c under Purchase group. Enable “Is GST
Applicable” to Applicable. If GST details is set at stock level turn the option “Set/alter GST
details” to No.
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• Inward branch transfer:
1. Gateway of Tally > Accounting Voucher > F9 (Purchase)
2. Put the Branch Ledger as “Party A/c Name”
3. Select “Branch Transfer Inward –Interstate” under Purchase Ledger.
4. Select stock item, quantity, rate and IGST as follows.

• For Outward branch transfer:
1. For outward branch transfer you have to create “Branch Transfer Outard - Interstate” under
Sales account.
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2. Then record interstate outward transfer through sales invoice.

B.

Buying from Unregistered Dealer (With Reverse Charge Mechanism):
If a person registered under GST, purchases good/services from an unregistered vendor then
GST (under reverse charge) will have to be paid directly by him to the Government instead of
the vendor. The receiver of the goods has to do self invoicing for the purchase which falls under
reverse charge. As an unregistered dealer, the supplier cannot issue a GST compliance invoice.
So, you become liable to pay tax on your supplier’s behalf. At first, raise your tax liability. Secondly,
claim your tax credit to report it as a self invoice. Thirdly, pay tax and finally file return. Purchase up
to ` 5000 from unregistered dealer does not come under the purview of GST.
1. Create unregistered supplier ledger
• Gateway of Tally > Accounts Info > Ledger > Create (Single ledger)
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• Create your supplier ledger under sundry creditor.
• Set/alter GST details as Unregistered type and accept it.

2. Record purchase invoice
• Gateway of Tally > Accounting Voucher > F9 (Purchase)
• Provide item name, quantity and rate

• Press Atl+A (Tax Analysis) > Alt+F1 (Detailed) to disply reverse charge amount.
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• Press Esc and get back purchase Invoice and save it.
3. Raise Tax Liability and Tax credit for Purchase from unregistered dealer
• To view reverse charge liability: Gateway of Tally > Display > Statutory Report > GST > GSTR 2 >
Select URD Purchase > Press Enter

• Press Alt + J (Stat Adjustment) [Showing at right hand side of Reverse Charge liability screen]

• Press enter and it takes you to journal voucher, then debit and credit tax ledgers with same
amount and provide GST details with appropriate Type of Input (None, Capital goods, goods,
services)
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4. Payment of tax liability under reverse charge:
• Gateway of Tally > Accounting Voucher > F5 (Payment) > Alt+S (Stat Payment) > select tax type
as GST > provide appropriate period > payment type will be Recipient Liability

• Debit tax ledgers and credit Bank A/c with appropriate amount
• Provide GST details to Yes and fill the required fields under Bank Details
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• Press enter and save the screen.
5. Purchase Return to Unregistered Dealer (Reversed Charged under GST):
• View purchase invoice of purchase from unregistered dealer

• Tax analysis of the above purchase

• For goods returned to unregistered dealer [Gateway of Tally > Accounting Voucher > Ctrl+F9
(Debit Note)
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• Enable “Provide GST details” to Yes and select appropriate reason for return.

• Press Alt+A to view Tax Analysis screen

• Press Esc to get back debit note screen and save the screen.
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C. Payment tax liability under GST:
• You can make payment tax to GST department through payment mode voucher. Gateway of
Tally > Accounting Voucher > Payment (F5)
• Press Alt+S (Stat Payment) and select payment type as Regular

• You can see due tax details from Duty & Taxes amount in Balance Sheet. Then pass the
appropriate tax ledgers to debit and credit side and make payment through your bank account.

• Enable option Provide GST details to Yes and fill up the bank details
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• Press enter and save the payment voucher screen.
In this chapter we have discuss upon some preliminary area of GST and its implementation in Tally ERP
9. As far as GST return is concerned, first, we have to download and install Return offline Tool from GST
portal. Then we will open our company in tally ERP 9. Right from Gateway of Tally > Display > Statutory
Report > GST, we open required return window such as GSTR 1, GSTR 2 or GSTR 3B. Then we proceed to
Export Return > select required format (EXCEL/JSON) and choose export location. After that we need
to upload this file to GST offline Tool for validation and a new JSON file will be generated to upload in
GST portal and saved subsequently. Finally, we need to log in GST portal and select service > Returns
> choose “prepare offline” for a particular return > upload the JSON file which is prepared under GST
offline Tool.

10.34 | The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program

UNIT - 11
TALLY.ERP9 - REPORT including GSTR-1
Financial Statements à
Financial Statements summarizes the individual transactions to show totals, ratios and statistics required
by the users to analyze the company’s financial data in a wide variety of ways. Broadly, financial
statements are classified into following three major statements, which form part of the statutory
requirements in most countries.
• Balance Sheet
• Profit & Loss A/c
• Trial Balance
1. All books are displayed as a monthly summary with opening and closing balances.
2. Select a month and press Enter to display all transactions for the month. The opening and closing
balances as well as the total of all transactions are displayed.
3. Select a transaction to bring up the voucher. The voucher displays either in alteration mode or
simply displays depending on your access rights.
A Balance Sheet is a financial statement that reports a firm’s financial position at a specific time. The
term balance sheet implies that a report shows the balance between two figures. It shows a balance
between the assets and liabilities of a firm and the owner’s funds. The fundamental accounting
equation applicable is therefore, Assets = Liabilities + Owner’s Equity.
To view the Balance Sheet:
Go to Gateway of Tally > Balance Sheet

Press F12: Configuration and set the required parameters to display the Balance Sheet according to
your preferences.
Note: Press F12: Configuration and set the required parameters to display the Balance Sheet according
to your preferences.
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Some of the Button Bar options are:
• Select F1:Detailed/Condensed to explode the summarized information.
• Change the date of the Balance Sheet using F2: Period.
• View different effect of different Stock Valuations on the Balance Sheet.
• Add up new columns to
 Display the Balance for different date to compare with current one
 Display the Balance Sheet of Another Company when more than One Company is opened
 Display the Balance Sheet in a different currency
 Display the Budget figures and analyze the variances
Schedule VI Balance Sheetà
A new button S: Schedule VI has been provided in Balance Sheet screen to view Schedule VI Balance
Sheet in the right hand side of Balance Sheet display screen.
Clink on S: Schedule VI button of press Alt+S to view Schedule VI Balance Sheet
The Schedule VI Balance Sheet is displayed as shown:

Show Vertical Balance Sheetà
By default, the Balance Sheet screen is displayed in the Horizontal form. However, you may configure
the Balance Sheet to appear in Vertical form, by pressing F12: Configure and set Show Vertical Balance
Sheet to Yes.

Accept Save.
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The Balance Sheet in Vertical Form showed as below:

Integrate Accounts with Inventoryà
Effect on Balance Sheet and Profit & Loss Account
Integrate Accounts with Inventory in F11: Features (F1: Accounting Features) has a significant effect on
the Balance Sheet and Profit & Loss Account.
• If Accounts with Inventory is set to Yes in F11: Accounting Features/ Inventory Features, the stock/
inventory balance figures are automatically updated from the inventory records. You may also
drill down to Stock Register from the Balance Sheet.
• If Accounts with Inventory is set to Yes in F11: Accounting Features/ Inventory Features, the stock/
inventory balance figures are automatically updated from the inventory records. You may also
drill down to Stock Register from the Balance Sheet.
Setting Closing stock manually in the Balance Sheetà
In Tally, the value of closing stock displayed in the Balance Sheet is based on the Costing Method
defined for each Stock Item in the Stock Item Master. The general principle of accounting is to value
the stock at purchase cost or market value, whichever is lower. Tally.ERP 9 allows you to enter the
closing stock value manually.
For example, consider that the market value of stock on 31-12-2008 is ` 25,000. To show this amount as
the closing stock value,
• Set Integrate Accounts and Inventory to No in F11: Features (F1:Accounting Features).
• Create a ledger Stock (under Stock-in-Hand).
• Create a ledger Stock (under Stock-in-Hand).
When the balances are carried forward to the next year, the opening value of stock would be taken as
25,000, if Integrate Account and Inventory option is set to No in F11: Features (F1:Accounting Features).
If this feature is set to Yes, the manual entry is not considered and the value is calculated automatically
based on the Inventory values. Tally.ERP 9 allows the flexibility to toggle the option Integrate Accounts
with Inventory to Yes or No.
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Display Profit & Loss Account à
Profit and Loss Account or Income Statement is a periodic statement, which shows the net result of
business operations for a specified period. All the expenses incurred and incomes earned during the
reporting period are recorded in the Profit and Loss account or Income and Expenditure account.
The profit and loss account in Tally displays the information based on the default primary groups. It is
updated instantly with every transaction/ voucher that is entered and saved. No special processing is
required to produce a profit and loss account in Tally.
To view the Profit & Loss Account of ABC Company,
Go to Gateway of Tallyà Profit & Loss A/c
The Profit & Loss Account is displayed as shown:

The Profit & Loss account is generated and updated immediately from the date of opening of books
till the date of last entry.
Press F2: Period to change the period as required. Press Alt+F1 for detailed
Click Alt+F1: Detailed, to view the Profit & Loss Account in detailed format.
Income/Expense Statement instead of P&Là
Account statements for Non-Trading Organizations:
Income/Expense Statements are appropriate for Non-Trading Organizations, which generally are
not engaged in trading of goods or services and thus the books of accounts comprises of only the
sources of Income and expenditure earned/incurred during a given period. This is useful for non-profit
organizations such as Trusts, Educational Institutions, NGOs, and Hospitals etc.
You can toggle between Income / Expenditure Statement & Profit & Loss A/c, by pressing F11 feature
and set Income/Expense Stmt instead of P & L to Yes or No.
The report menu will display Income & Expenditure A/c instead of Profit & Loss A/c.
The Income & Expenditure Statement is displayed as shown.
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Display Trial Balanceà
A Trial Balance is a summary of all ledger balances to check whether the figures are correct and
balanced. Considering that the journal entries are error-free and posted correctly to the general
ledger, the total of all debit balances should equal the total of all the credit balances.
In Tally, the matching of the Trial Balance is a foregone conclusion since all voucher entries are in Debit
- Credit format and must balance at the entry point.
To view the Trial Balance
Go to Gateway of Tally > Display >Trial Balance

Tally shows group wise Trial Balance. Next level detail for a group can be exploded by pressing Shift+Enter.
Details of all groups can also be obtained through configuration, except for groups behaving like subledgers.
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Select Alt+ F1: Detailed to break down the grouped information or simply drill down a Group for further
detail.
Select F5: Led-wise to list all ledgers and their closing balances. The screen is displayed as shown.
This report shows the flow of the accounts from Opening Balance to the effect of transactions on
Closing Balance.
Select F12: Configure and set the parameters as shown.

A Trial Balance can be shown with opening balance, transactions and closing balance or any one of
these. Choosing transactions will give further liberty to restrict Net transaction (Net of Dr and Cr). Net
transactions will be useful while viewing group summary for Expenditure groups / Income Groups.
The Trial Balance after configurations made is displayed as shown.

Budgetsà
A budget is a plan prepared for the flow of funds in an organization. It contains financial guidelines for
the future plan of action for a selected period of time.
A budget helps to refine goals and use funds efficiently. It provides accurate information for evaluation
of financial activities, aids in decision making and provides a reference for future planning.
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Multiple budgets can be created for specific purposes in Tally. Budgets for Banks, Head offices,
Departmental budgets like Marketing Budgets, Finance Budgets, and so on, can also be created. The
Budgeted figures in Tally can be compared with Actual figures and variance report can be generated.
In Tally, you can create, alter and delete a budget.
To activate the Budgets feature in Tallyà Select F11: Features à F1: Accounting Features à Set Maintain
Budgets and Controls to Yes à Accept to save.
Creating a Budgetà
To create a Budget in Tally à Go to Gateway of Tally à Accounts Info à Budgets à Create
In the Budget Creation screen enter a Name for your budget.
1. Select from the List of Budgets for Under field. You can have a hierarchical setup for budgets. In the
List of Budgets, Primary is at the top of the hierarchy and you can create more primary budgets.
Sub-budgets can be created under Primary budgets.
2. Enter the period of the budget in the From and To fields. The period entered can be a month, a year
or any other period.
3. In Set/Alter Budgets of, select
• Groups - To create a budget for a Group of ledger accounts.
• Ledgers - To create a budget for Ledgers.
• Cost Centres - To create a budget for Cost Centres.

Accept to save.
Altering a Budgetà
You can modify a budget, using the alter option.
Go to Gateway of Tally à Accounts Info > Budgets à Alter
In the Budget Alteration screen, modify the fields as required. Change the period or change budgets
of Groups, Ledgers and Cost Centres.
Deleting a Budgetà
To delete a budget:
Go to Gateway of Tally à Accounts Info à Budgets à Alter à Press Alt+D.
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Creating Budget for Groupsà
In the Budget Creation/Alteration screen, set Yes in the Groups field, to set budgets for a group or
group of ledgers.

In the Group Budget screen, select a Group from the List of Groups and enter Account Name.
Enter the cost centre for a group in Cost Centres field, select Not Applicable, if the budget is not for a
particular cost center.
In Type of Budget, select from the following two types à
On Nett Transactionsà
Select this option to monitor the transaction amounts and not the balances. Nett is net of debits and
credits for the specified period. Nett transactions Budgets specified for a period automatically gets
apportioned over the period. i.e., When On Nett transactions Budgets are defined, the debit amount
for the specified period after reducing the credits for the same period is considered without taking
into account opening and closing balances. For example to compare transactions against budgets,
especially revenue income and expenses On Nett Transactions can be selected.
On Closing Balanceà
Select this option to monitor the balances of the Accounts and the not the transactions. i.e., each
month will have the same budget value except that the actual Opening Balance is also taken into
account. Budgets on Closing balances can be set for Bank Account Ledgers, Debtors Ledger balances
and so on. For example to compare closing balance figures in final statements, especially Balance
Sheet items like assets and liabilities, select Closing Balances.
Enter the budget amount in the Amount field.

Similarly you can create budget for Ledgers or for Cost Centers.
Viewing Budget Varianceà
Budget Variance report can be viewed from Trial Balance, Group Summary, monthly summary etc.
The Budget Variance button (Alt+B) is active, if Budgets feature is enabled and at least one budget
created. Budget Variance displays Budgets, Actuals with percentage and Variance from the budget
with percentage.
Budget Variance can be accessed from:
Gateway of Tally à Display à Trial Balance to display the Trial Balance screen
Or form
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Gateway of Tally à Display à Account Books à Group Summary and select a group from List of
Groups to display the Group Summary screen
Click on Budget Variance (Alt+B) from the toolbar to display the Budget Analysis screen.
Select from the List of Budgets for Budgets/Scenario.
Three columns display Budget, Actuals and Budget Variance, respectively.

Corporate budget Column displays the values of the Budget, which is defined.
Actuals Column displays the value of Actual Expenditure incurred.
Corporate Budget Variance displays the values of the Variance of the Actuals and Budgets. i.e.,
Budgets – Actual = Variance .
Cost Centresà
A Cost Centre is any unit of an organization to which transactions (generally, revenue) can be allocated.
When only costs or expenses are allocated to these units, they are referred to as Cost Centres. When
profits are also allocated to these units, they become Profit Centres. You can now obtain a Profit and
Loss account of each such Profit Centre.
Cost Centre in Tally allows an additional dimension to a transaction where a Ledger account indicates
the nature of the transaction. It does not readily disclose, except in the narration field, which part of the
organization was involved in the transaction.
With the help of Cost Centres, a transaction can be allocated to it, which would then enable
accumulation of the all transactions for that particular Cost Centre. Tally.ERP 9 gives you the Cost
Centre break-up of each transaction as well as details of transactions for each Cost Centre.
Some examples of Cost Centres are:
• Departments of an organisation - Finance, Manufacturing, Marketing, and so on
• Products of a company
• Products of a company
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Use of Cost Centresà
You can classify Cost Centres, just as how you classify Group/Ledger accounts. You can have Primary
Cost Centres and several levels of Cost Centres under each Primary Cost Centre.
Consider the following example.
Primary Cost Centres à Finance, Manufacturing, Marketing.
Under Marketing, classify the company’s sales executives as Cost Centres. This will help you track a
sales executive’s performance, in terms of cost and revenue generated.
You will then have the following Cost Centre structure:
Primary Cost Centre – Marketing à
Under Marketing:
• Salesman A
• Salesman B
• Salesman C
Allocate expenditure incurred on sales by the salesmen, as well as the sales generated by them, directly
to their Cost Centres. The allocation is done at the time of voucher entry. This prevents allocation errors
at the end of the period.
By allocating expenses and sales transactions to the salesmen, you are setting up a valuable information
system that tracks the performance of your salesmen.
Creating a Single Cost Centre à
To create a Cost Centre, set Maintain Cost Centres to Yes in F11: Accounting Features. For parallel
allocation of Cost, you can set More than ONE Payroll/Cost Category to Yes.
By default, Tally activates the Cost Centre feature for Ledger accounts under Sales Accounts, Purchase
Accounts, Expense and Income groups.
Go to Gateway of Tallyà Accounts Info. à Cost Centres à Create (Single Cost Centre)
The Cost Centre Creation screen is displayed as shown.

A brief explanation on each of the fields in the Cost Centre Creation screen follows.
Nameà Enter the name of the Cost Centre in this field. For example, Name, function, activity,
department, task and so on.
AliasàEnter an alternative name, if required. For example, a short name or a code number
Underà Select the parent Cost Centre under which the Cost Centre is grouped or created from the List
of Cost Centres. If you want the Cost Centre to be a Primary Cost Centre, select Primary from the list.
Displaying a Single Cost Centreà
Displaying a Single Cost Centre à Go to Gateway of Tally à Accounts Info. > Cost Centres à Display
(under Single Cost Centre).
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The Cost Centre Display screen appears. It is not possible to make any modifications to the Cost Centre
master in the Display mode. You can only view the details in this mode.
Altering a Cost Centreà
To alter an existing Cost Centre à Go to Gateway of Tally> Accounts Info. à Cost Centresà Alter
(under Single Cost Centre) à Make the necessary changes and Accept to save.
Deleting a Cost Centreà
You can delete a Cost Centre from the Cost Centre Alteration screen by pressing ALT+D.
You can delete a Cost Centre only if
• It does not have any Cost Centres created under it.
• It is not used in any transactions.
Cost Categoriesà
Cost Categories are useful for organizations that require allocation of Revenue and Non-Revenue Items
to parallel sets of Cost Centres. Cost categories facilitate third dimensional reporting of Expenditure
and revenue. Some of the examples of Cost Categories can be Region wise or geography wise, Grade
wise, Department wise and so on.
Use of Cost Categoriesà
By using Cost Categories you may allocate, in parallel, a transaction to more than one set of Cost
Centres. The following example illustrates the use of Cost Categories.
The Cost Centres such as Marketing, Finance and Manufacturing can now belong to a category Departments.
The Salesmen A, B and C can be Cost Centres under a Category - Executives.
Similarly, you can create a new Cost Category Projects under which Cost Centres such as Airport
construction, Road construction and Buildings may be created. The classification appears as following:
Cost Categories
Cost Centre

Departments

Executives

Projects

Marketing

Salesman A

Airport Construction

Manufacturing

Salesman B

Road Construction

Finance

Salesman C

Buildings

Specify a Cost Category to allow allocation of only revenue items or items of both revenue and capital
(Non-Revenue) nature. Here in this instance, enable Revenue Items and Non-Revenue Items to Yes for
Departments and Projects Categories and only Allow Revenue Items for Executives.
By allocating expenses to parallel Cost Centres under different categories, you are simply assigning the
amounts to them; the amount does not increase. Tally performs an automatic reconciliation on realtime basis, saving you the effort of reconciling Ledgers and Cost Centres.
Creating a Single Cost Categoryà
To create a Cost Category, set Maintain Cost Centres to Yes in F11: Accounting Features and then set
More than ONE Payroll/Cost Category to Yes.
This option is by default, set to No. When this option is set to Yes, Tally creates a single Cost Category
called Primary Cost Category automatically and allows creation of Cost Centres under the Primary
Cost Category. However, you may also create new Cost Categories or alter existing Cost Categories.
To create a Cost Categoryà Go to Gateway of Tally à Accounts Info. à Cost Categories à Create
(under Single Cost Category)
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A brief description on each of the fields in the Cost Category Creation screen follows.

Nameà
Enter the name of the Cost Category.
Allocate Revenue Items à
Set this option to Yes, to allocate all sales, purchase, expenses and income related transactions to Cost
Centres created under this Cost Category. However, if you wish to allocate only capital/non-revenue
items to Cost Centres created under this Cost Category, set this option to No.
Allocate Non-Revenue Itemsà
Set this option to Yes, to allocate transactions related to capital or non-revenue nature to Cost Centres
created under this Cost Category. By default, this option is set to No.
Displaying a Single Cost Categoryà
To view the details of the selected Cost Category masters from this mode
Go to Gateway of Tallyà Accounts Info. à Cost Categoriesà Display (under Single Cost Category)
à Select a Cost Category from the List of Categories. The Cost Category Display screen is displayed.
Note: You cannot make any changes to the fields in the Display mode.
Altering and Deleting a Cost Categories in Tally follow the same steps as discussed earlier in Cost
Centres.
Creating Cost Centres under Cost Categoriesà
Go to Gateway of Tally à Accounts Info. à Cost Centre à Create (under Single Cost Centres)
Category à
This field appears only when you have opted for More than ONE Payroll/Cost Category in F11: Features.
Else, Tally automatically creates a Primary Cost Category to which all cost centres are assigned.
All the other fields are described in detail in the section Creating Cost Centres in Single mode
Displaying and Altering Cost Centres under Cost Categories in Single mode is similar to Displaying and
Altering Cost Centres in Single mode explained previously. The only additional field is Category.
Display Ratio Analysis Report à
Ratio analysis is a powerful tool for financial analysis. A meaningful analysis of a financial statement is
made possible by the use of ratios.
Ratios are a set of figures compared with another set. The comparison gives an understanding of the
financial position of a business unit. There are a number of ratios which can be computed from a single
set of financial statements. The ratios to be computed depend on the purpose for which these ratios
are required. A single ratio may sometimes give some information, but to make a comprehensive
analysis, a set of inter-related ratios are required to be analysed.
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To view the Ratio Analysisà
Go to Gateway of Tally à Ratio Analysis
The Ratio Analysis screen is displayed as shown:

The screen is divided into two parts:
• Principal Groups
• Principal Ratios
The Principal Groups are the key figures that give perspective to the ratios.
Principal Ratios relate two pieces of financial data to obtain a comparison that is meaningful.
Principal Groups and key figuresà
Working Capitalà
The Net Working Capital is calculated by subtracting Current Liabilities from Current Assets. Financial
Analysts often consider the total Current Assets as the Working Capital. This serves as a measure of how
far the firm is protected from liquidity problems.
Cash in Hand and Bank Balancesà
This data presents another perspective on the liquidity position.
Sundry Debtorsà
(due till today)
The list of all the debtors and the total debts due as on the date of the statement, are displayed.
Sundry Creditorsà
(due till today)
The list of all the creditors and the total credits due as on the date of the statement are displayed.
Sales and Purchase Accountsà
The Sales and Purchase Accounts, which collate the trading activity for the period, are displayed.
Stock in Handà
This field displays the stock in hand as on the date of the report and together with Cash and Bank
Balances and Debtors, completes the Current Assets aspect of the Working Capital.
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Nett Profità
This is derived from the Profit & Loss Account and is the profit after direct and indirect expenses.
Wkg. Capital Turnoverà
(Sales Accounts/Working Capital)
This is an activity or efficiency ratio that shows the number of times the working capital has been rolled
over during a particular period. It depicts how effectively the firm is using its working capital.
Inventory Turnoverà
(Sales Accounts/Closing Stock)
This is an activity or efficiency ratio that shows the number of times the stock has been rolled over
during the period of the report. It depicts how effectively the firm is using its inventories.
Principal Ratiosà
You can compare Principal Ratios of your company over a certain period with industry averages as
well as with ratios pertaining to other periods to assess current performance.
Current Ratioà
(Current Assets: Current Liabilities)
This indicates the solvency position of the enterprise. The ideal ratio is 2 under normal business conditions.
Quick Ratioà
(Current Assets – Stock in Hand : Current Liabilities)
This indicates the liquidity position of the enterprise. This ratio is useful in planning future cash requirements.
Debt Equity Ratioà
(Loans (Liabilities) : Capital + Net Profit)
This indicates the level of exposure to external borrowings and is a useful tool in determining the options
of raising additional capital internally or externally.
Gross profit % à
(Gross Profit / total Turnover)
This indicates the percentage of profit earned from direct operations (manufacturing)., This ratio is
useful, where an enterprise produces more than one product, in identifying the order of profitability
and making decisions such as increasing production capacity, continuance of a product etc.
Net Profit % à
(Net Profit/ Total Turnover)
This indicates the percentage of net profit earned by the enterprise after considering all expenses of
the enterprise. This is useful in identifying the overall profitability of the enterprise.
Operating Cost % à
(As percentage of Sales Accounts)
This is referred to as the percentage of operating cost with respect to the total turnover This ratio is
useful in making decisions in the areas of cost control, cost reduction etc.
Receivables Turnover in daysà
(Payment performance of Debtors)
This is an analysis of debtor wise payment performance and a useful tool in identifying the most preferred
and least preferred customers or agents and planning the receivables collection process.

11.14 I The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program

Return on Investment % à
(Nett Profit/Capital Account + Nett Profit) %
This is a useful tool in measuring returns expected from the project/product and plan additional capital
infusion, increase in production capacity (subject to market demand) etc.
Return on working capitalà
(Nett Profit/Working Capital) %
This is referred to as the percentage of net profit to working capital (current assets – current liabilities).
Working capital turnover ratioà
(Sales Account/Working Capital)
This indicates how effectively working capital is used in terms of turnover it can help to generate. It is a
useful tool in identifying the level of deployment of funds with respect to sales.
Inventory turnover ratioà
(Turnover / inventory)
This indicates the relationship of inventory with respect to sales. This is a useful tool in identifying the
extent of investment in stock and indicates:
• Stock control measures whether to be taken in case of change in demand
• Procurement planning
Split Company Dataà
The procedure to split data based on financial years is as follows:
Go to Gateway of Tally à F3: Cmp Info àSelect Split Company Data.
The Split Company Data menu appears:

• Select the option Select Company
• Select the required company whose data has to be split from the List of Companies.
• Enter the required date from which you wish to split in the Split From field.
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Tally will create two separate companies suffixing each company with the date from which it has been
split.
• Accept to split the company data.
Tally recommends the Split from date to be based on the existing data. It is recommended that the
Split from date is set as the beginning of the current financial year, even though Tally permits any date.
It is advisable to take a backup of the original data on to another media before splitting the company.
Remove the company which contained three years data as you may accidentally use it for entering
the current data.
The split occurs in a set of two periods. Hence, start to split the company with the latest period. E.g.,
the data is stored in the same company for a period of three years commencing rather than storing
data in three separate companies. Initially the user has to split the company for two periods between
01/01/2003 and 31/12/2005 and the other part is split for the remaining period.
Two new companies will be created between the periods 01/01/2003 and 31/12/2004, and 01/01/2005
and 31/12/2005, i.e., the historical data of one or more financial years will be preserved as one company
and your current financial year as the other. There is normally no reason to split the prior years again
into separate companies. Incase you wish to split the data for an earlier period, then repeat the above
mentioned steps.
The user can display or print financial reports such as Trial Balance, Balance Sheet, Profit & Loss, Stock
Summary etc., for each of the companies for the relevant periods and compare them for accuracy.
The user needs to alter the names of the two freshly created companies according to the requirement.
Split Data based on Financial Yearsà
Storing data in the same company for a few years has a lot of advantages, even though the data size
increases which in turn affects the overall performance of the computer. Tally.ERP 9 allows the user to
split the data based on financial years which will reduce the volume of the data, thereby reducing the
load on the computer.
When the user splits the data based on different financial years, new companies are created for the
respective split periods and the entire data is retained in the original company.
Important pre-split activityà
Before splitting the data the user must ensure that the following precautions are taken, failing which,
could result in mismatched information:
• All unadjusted Forex Gains/Losses have been fully adjusted by journal entries. Verify that this item
does not appear in the Balance Sheet.
• There are no Purchase Bills/Sales Bills due. Check the Profit & Loss Account and Inventory Statements
– Purchase/Sales Bills Pending. The user has to account them to the respective party accounts or
to respective Bills Pending Account.
• Ensure that a backup of the data exists.
Note: For users of Sales/Purchase Order Processing features: Open sales/purchase orders will not be
carried forward on splitting. The user has to re-enter the outstanding orders after splitting the company.
Similarly data pertaining to a cost centre is not carried forward.
Verify Split Dataà
A utility that has the capability to detect possible errors that occur while splitting the data and also
provides the user with possible solutions.
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Developed with an objective to reduce the repeated occurrence of possible errors while splitting the
data, this utility automatically detects possible errors in the data. On detecting these errors the system
prompts the user to rectify them with possible solutions so that the errors will not reoccur in future. Users
can opt to either resolve these errors manually or by using the helper available within this utility.
The Verify Split Data utility detects the possible error for:
• Units of Measurement incorrect for the Item
• Cost Centre does not belong to the category
• No Accounting Allocations
• Voucher Totals Do Not Match
• Cost Break-up total does not match
To start the data verification process follow the steps shown:
Go to Gateway of Tally à F3: Cmp Info à Split Company Data àVerify Company Data
The Data Verification for the selected company appears:

Export Dataà
The Export option in Tally allows the user to export reports or data. The exported reports or data can be
viewed or published using any one of the standard formats available. You can also import the same
data into another company using Tally.
The user can open any report in Tally and click on the E: Export button or press Alt + E to export data.

The Report Generation screen is displayed with the export details. Press Yes to accept or press
Backspace to change the export details:
Languageà
Based on the option selected in the Language field, the user can export reports in English or any of the
available Indian Language. When the user selects Default (All Languages) the report is exported in any
available Indian Language. If the user selects Restricted (ASCII Only), the reports are exported in English
only. However, the user has to select the appropriate display language before exporting.
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Note: If the user selects Restricted (ASCII Only) Language and uses PDF /HTML Format to export reports
of a company created using any one of the available Indian Languages (without English alias), the
exported values will appear as Question Marks (?).
Formatsà
By default Tally supports the following export formats, to read more about the Export Formats click on
one of the corresponding links:
• ASCII (Comma Delimited)
• Excel (Spreadsheet)
• HTML (Web Publishing)
• JPEG (Image)
• PDF (Portable Data Format)
• XML (Data Interchange)
Export Formatsà
The Export functionality available in Tally allows the user to export data or report in any one of the
standard available formats. Tally.ERP 9 allows the user to select the required format before exporting
the data and based on the format selected the user needs to specify the resolution, page size and
formatting.
Tally also allows you to export the data in non-editable formats such as JPEG and PDF formats. The JPEG
format has the with dual facility, where the user can store the file in printable format or as an image.

ASCII (Comma Delimited)à
By selecting the ASCII (Comma Delimited) format, the user can export all the reports or data from
Tally. The data exported is converted to plain text separated with commas and stored in a file with
the extension .txt. This file format is widely used for emailing and used for importing data into another
company using Tally.
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Excel Spreadsheet à
The user can export data and reports generated in Tally to Excel by selecting the Excel (Spreadsheet)
format. The report or data is put in columns and the file is saved with the extension .xls. Tally also gives
the user an option to export data with formatting and background colour as it appears in Tally. The user
can set the formatting and background colour in the Report Generation screen. The Excel file can be
emailed as an attachment and also used to generate graphs for better presentation.

HTML (Web Publishing) à
On selecting the HTML (Web Publishing) format, Tally exports the data in HTML format retaining the
colours and formatting. The file name has an extension .htm, It can be sent as an attachment and read
using an internet browser. It is recommended to choose a higher resolution for better quality output.

JPEG (Image)à
On selecting this format the specified report is exported as an image file which is stored with an
extension .jpg in the specified folder. The image file generated is non-editable, platform independent
and supports the highest level of compression. The user needs to specify the paper orientation and
paper size, opting to store the report on a User defined or customized paper size, the user is required to
specify the page width and height in millimeters. This image file can be mailed as an attachment to a
recipient, viewed using an image viewer and printed.

PDF (Portable Document Format) à
The report is converted to a portable data format document which is independent of the application
software, hardware and operating system. This document can be viewed using the Adobe Acrobat
Reader commonly known as the PDF Reader. On exporting the data using PDF format, the file is stored
in the specified location and assigned the extension .pdf. While configuring the system to export data
to PDF it is necessary for the user to specify the paper orientation and paper size. On opting to store
the report with User defined or customised paper dimensions, the user is required to specify the page
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width and height in millimeters. This PDF file can be mailed as an attachment to the desired recipient
and viewed using the Adobe Acrobat reader or PDF reader.

XML (data interchange)à
Extensible Markup Language (XML) is an extension of HTML. Using XML, data can be imported by other
systems. An XML file from Tally has an XML envelope and formatted with XML tags to enable import into
other systems. The destination system requires re-formatting of XSLT (XML Style Sheets) based on the
inherent style used in Tally before importing the data. When two systems are running different versions
of Tally, XML data can be directly imported using the import menu option, without re-formatting.
Export Data from Masters in Tallyà
With the Export feature of Tally, you can export Tally data using the available formats. The exported
data can be used by other programs. To export the Masters from Tally execute the following steps:
Go to Gateway of Tally à Display à List of Accounts
In the List of Accounts screen press E : Export.
• Select the Language in which you want the data to be exported.
• Select a format from the list of Formats available.
• Press Enter to accept the default Output Filename. In case you want to save the file in another
folder then type the desired path and filename.

• Accept to export the Masters to a XML format file.
The exported file is saved in the default Tally folder or the specified folder.
Export to Excel à
Using the Export feature you can export Tally data to Excel. Data exported to Excel can be e-mailed as
an attachment, used to generate graphs for better presentation and further analysis.
• Go to Gateway of Tally > Balance Sheet
• In the Balance sheet screen click E : Export or press Alt+E.
• Select the required language from the list of Languages displayed.
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• Select a format from the list of Formats displayed.
• By default, the exported file will be stored in C:\Program Files\Tally.ERP 9 for Windows 7 and C:\
Tally.ERP 9 for Windows XP operating systems
• Press Enter to accept the default Output Filename or type the filename of your choice in order to
save the file with a different name.
• Press Enter to accept the default Output Sheet Name.
• To update the existing file select Yes in Update Existing File.
• To format the contents of the file select Yes in Excel (Spreadsheet) formatting.
• Select Yes for the Field with Colour, to retain the background colour in the exported file.

• Accept to export the Balance Sheet to an excel file.
The exported file is saved in the default Tally or the specified folder, you can use this file for further
analysis.
Import Dataà
In Tally you can import data from earlier versions of Tally, Tally and any third party application using the
predefined format of XML.

To Import Data
• Go to Gateway of Tally à Import of Data
• The Import of Data menu is displayed as shown.
Import Mastersà
To Import Masters execute the following steps:
Go to Gateway of Tally à Import of Data à Masters
• In the Import of Masters screen:
• Enter the required path and filename in the Import File Name (XML) field. If the file is located in the
default folder, then you need to provide the filename only.
• In the field Treatment of entries already existing select the required Behaviour
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• Combine Opening Balances: Select this option to import data of different branches and
consolidate the opening balances. You can also select this option when the opening balances of
existing masters are Zero and need to be overwritten by the balances in the data being imported.
• Ignore Duplicates Select this option to import new masters along with the existing masters in Tally
ignoring the duplicates.
• Modify with New Data Select this option to replace the existing balances with those existing in the
data imported and also override the other options available in Behaviour list.

• Press Enter to Import Masters.
• Double click on Tally.imp file located in the Tally folder to view the import log.
Import Vouchersà
To import vouchers execute the following steps:
Go to Gateway of Tally à Import of Data à Vouchers
• In the Import of Vouchers screen, enter the required path and filename in the Import File Name
(XML) field.

• Press Enter to import the Vouchers
• Double click on Tally.imp file located in the Tally folder to view the import log.
Merging Company Data à
Maintaining Group Company in Tally à
The books of Account of different companies belonging to the same management or owners are
required to be consolidated to present the financial position of the group of companies as a whole.
This is mandatory in many developed countries and currently shareholders would rather know the
performance of the group as a whole and not the performance of individual constituent companies.
Tally simplifies the task of consolidation of accounts. You can consolidate the accounts of any number
of companies as well as keep them separate.
The first step is to create a Group Company, which is simply a name and identity given to the merged
accounts of constituent (member) companies of the group. A group company may also include other
group companies.
Note: Do not confuse the word Group to refer to a member of the group! It simply contains the
consolidated accounts of member companies. In other words, it is the parent company – under which
you have the individual companies.
Creating a Group Companyà
A Group Company can be created only for companies that have already been loaded. Hence,
you must first load the companies whose accounts are to be grouped. Select the companies using
F1:Select Cmp button.
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Tally now displays two company names in the Gateway of Tally.

Note: The Company which is in bold, is the active company. Here, Company A is the active company.
Use Alt+F3 to get the company info Menu in which there is an additional option Create Group Company
(this is available only when two or more companies are loaded).

Press Enter on Create Group Company. The Group Company Creation screen is displayed.

All the loaded companies are displayed under List of companies. Select the member companies from
the List of companies and accept to Create the Group Company.

At the Gateway of Tally, Tally displays AB Group company and the member companies. You can
close the member companies by pressing Alt+F1, so that only the Group Company is displayed in the
Gateway of Tally.
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Noteà
• Entering a Transaction is not possible in Group Company, that is, in AB Group company. [You have
to enter the transaction in a member company only, that is, Company A or Company B]
• The Group company will give the summary (report) level consolidation and NOT transaction
(voucher) level consolidation (that is, NO Merging of vouchers)
• The member companies of a Group Company should have the same Base Currency Symbol and
Formal Name (you cannot group a company with $ as symbol with another company having ` as
the currency symbol)
Altering a Group Companyà
You can alter a Group company by editing the details or adding or removing the member companies.
Load the Group Company and from Gateway of Tally > Press Alt+F3 > Select Alter > Press Enter
Select Group Company [Group companies are marked with an asterisk]

The Group Company Alteration screen is displayed as shown:

Any modifications made will come into effect only on shutting the group company and then reloading
it.
Points to remember:
• The Group Company must contain at least two members.
• It is possible to combine accounts of different companies.
• Create as many Group companies as you need.
• A constituent company can be a member of more than one group.
• A group company can also be a constituent of another group company.
Noteà
• It is advisable not to delete the member company, which belongs to Group Company.
• If the member company has a password then without entering the password the Group Company
cannot be opened.
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• Where the member companies have the same Name of User and Password, user is required to
provide the login details only once. This will automatically open all the member companies. Where
only select member companies have the same login details, but they are not listed one after the
other, Name of User and Password will have to be provided individually.
With Tally.ERP 9, we can file GSTR-1 in two easy ways: by generating JSON (Java Script Object Notation)
from Tally.ERP 9, by using the GST Offline tool. In this chapter we will discuss how to generate GSTR-1 (in
JSON format) in Tally ERP 9 and file it on the GST portal.
Generate and file GSTR-1 on the GST portal through Tally ERP 9à
Steps to be followed:
Step 1: Preparing data for GSTR-1 (Incomplete or mismatch in information must be zero)
Step 2: Generate GSTR-1 returns in JSON format [Export to JSON (Data Interchange) format]
Step 3: Upload GSTR-1 (JSON) on GSTN portal under GSTN-1prepare offline
Step 4: Verify the uploaded GSTR-1 Table wise details under “Prepare Online and Save”
Step 5: Acknowledge submit and file GSTR-1 successfully.
Ø Generating GSTR-1 returns in the JSON formatà
1. Gateway of Tally > Display > Statutory Reports > GST > GSTR-1
2. Press F2 (Period): Select the period for which returns is to be filed.

3. Press F12 (Configure): To view the export options for HSN/SAC details, enable Show HSN/SAC
Summaryto “Yes”
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4. Press Ctrl+E (Export GSTR-1).
5. Select JSON (Data Interchange) as the Format.

● Export HSN/SAC details even if UQC is not available? - Yes, to export transactions where UQCs
are not available.
● Export HSN/SAC details not included for other reasons? - Yes, to export transactions that are
not included in the HSN/SAC Summary due to various reasons. You have to enter this data
directly on the portal.
● Allow Export of:
o All Vouchers: To export all the transactions that have been already filed on the GST portal.
o Only New Vouchers: To export the transactions that are not filed on GSTN portal.
• The JSON file generated from Tally. ERP 9 will be available in the Export Location(as per the user’s
choice location)
6. Press Enter to export.
Ø Upload the JSON file generated from Tally.ERP 9 to the portal for filing returns à
1. Press Ctrl+O (Open GST portal) from GSTR-1 report.
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2. Log in to the GST portal.

3. Click Services > Returns > Returns Dashboard.
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4. Select the Financial Year&Return Filing Period (Month) from the drop-down list. Press SEARCH
button

5. Select option for Quarterly or Monthly Return and press Yes or No based on your turnover.
6. Press SUBMIT> PROCEED
7. Press PREPARE OFFLINE.
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8. Press Choose File to import the JSON file generated from Tally.ERP 9 or the offline tool.

Once your JSON file is uploaded successfully, you will be notified by a message.
9. Check the uploaded details after the time specified in the GSTR screen.You have to manually
enter the details for Nil Rated Supplies and Documents Issued by referring to the table-wise format
of GSTR-1 , because these details do not get directly uploaded to the portal.
10. Go to Services > Returns > Returns Dashboard, and Press Prepare Online .
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11. Go to 8A, 8B, 8C, 8D - Nil Rated Suppliespage to add consolidated details of nil rated, exempted,
Non-GST Outward supplies and enter the details.

12. Go to the 13 - Documents Issued pageand enter the details.

13. Submit your returns and e-sign.
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E-FILLING OF RETURN

UNIT - 12
E-FILLING OF TAX DEDUCTED AT SOURCE (TDS)
E-Filing of Direct & Indirect Tax Returns :
E-Filing of TDS & TCS Returns :
Before going to e-filing of Quarterly and Annual Return of TDS & TCS you have to download requisites
return preparation utility software from https://www.tin-nsdl.com
For Quarterly Return
https://www.tin-nsdl.com à Download à e-TDS/e-TCS à Quarterly Return à Regular à NSDL e-TDS/
TCS Return Preparation Utility à click on e-TDS/TCS RPU (version 3.6) for statements from FY 2007-08
onwards à Download the software à Right click on e-TDS_RPU_3.6 à click on Extract file à click on ok
àOpen the Extracted Folder named e-TDS_RPU_3.6 àOpen the zip file named e-TDS_RPU_3.6 à Now
click on unzip à Now go to my computer à open e-TDS RPU à then open e-TDS_RPU_3.6 àNow open
the file RPU.
Preparation of Quarterly Return
Ex: Suppose ` 55000 payable as Rent to Mr. A.K. Banerjee as on 30-06-2013 which subsequently paid
as on 03-07-2013 after deduction of TDS u/s 194 I @10% on bill value which is comes to ` 5500. Now we
have to prepare return for the same for the 1st Quarter of 2013-14.

• Form No: Select 26Q from dropdown list
• Select the type of Statement to be Prepared: Select Regular from Radio Button
• Then click on: Click to Continue
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On the Next screen there are the Tab:
• Form
• Challan
• Annexure I
Forms :
First you have to put data in the Form Tab. Here * marks fields are compulsory.
In the Particulars of Return Section –
• For Quarter Ended: Select the quarter form the list
• Year: Put the year return
• Tax Deduction and Collection Account No.(TAN): Put the TAN no of Deductor
• Financial Year: Select year from the list
• Permanent Account No: Put the PAN no of Deductor
• Type of Deductor: Select the type from list
In the Particulars of Deductor Section–
• Name: Put the Name of Deductor
• Flat No: Put the Flat No or House No of Deductor as per TAN registration
• Area/Location: Mention the respective area as per TAN registration
• Town/City/District: Put the as per TAN
• Has address changed Since Last Return: Select Y if the address has changed otherwise select
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In the Particulars of the Person Responsible for Deduction of Tax Section
• Name: Mentioned the person name who is responsible for TDS deduction on behalf of the Deductor
• Designation: Put the post of the person whose name is mentioned in above
• Flat No: House/Flat No of the person
• Has address changed Since Last Return: Select Y if the address is changed otherwise select N
After put all the data click on Save to Save the data.
Challan

In Challan Tab first you have to click on insert Row, a dialog box will appear, then put the how many
rows you want to add, and then click on ok. A blank row or rows will appear where you have to put the
challans details of the TDS deposited in the Bank.
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You have to put the following things from the Bank challan copy :
• TDS: TDS amount as per challan
• Surcharge: Amount as per Bank Challan
• Education Cess: Amount as per Bank Challan
• Interest: In case of late payment you have to put interest amount
• Fess: As per your Bank Challan
• Others: As per your Bank Challan
Note: don’t left the above mentioned field blank, if there is nothing then put zero.

• BSR Code/24G Receipt No: Mention the BSR code as in the Bank Challan
• Date on which Tax Deposited: Mention the Date as per Bank Challan
• DDO/Transfer Voucher/Challan Serial No: Mention the unique Challan No as per Bank Challan
• Whether TDS Deosited Bank Entry(Yes/No): Select No from list
Note: If payment to the parties (on which TDS has been deducted) has been made actually i.e. by
cash, cheque, demand draft or any other acceptable mode, then “otherwise” has to be mentioned in
the specified field. But if payment has not been actually made and merely a provision has been made
on the last date of the accounting year, then the option “Paid by Book Entry” has to be selected.
• Interest: Put the amount otherwise mention zero
• Others: Put the amount otherwise mention zero
• Minor Head of Challan 200- TDS payable by taxpayer 400-TDS regular assessment: Select 200 form
list in normal case
Annexure I
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In Annexure I Tab first you have to click on insert Row, a dialog box will appear, then put the how many
rows you want to add, and then click on ok. A blank row or rows will appear where you have to put the
challans details of the TDS deposited in the Bank.

• Challan Serial No: Select 1 from the dropdown list, it will automatically capture the details
mentioned in Challan Tab
• Section Under Which Payment Made: Select section form the dropdown for which TDS is deducted
• Sr No: Put Row Serial No

• Deductee Reference Number Provided by the deductor if available: If No is available then put it,
otherwise left the field as blank
• PAN of the deductee: Put the PAN no of deductee
• Name of the Deductee: Mentioned the Name of Deductee
• Date of Payment/Credit: Mentioned the date on which payment is made
• Amount Paid/Credit: Mentioned the amount on which TDS is deducted
• TDS: Mentioned the TDS amount
• Surcharge: Put amount as per Bank Challan otherwise put Zero
• Education Cess: Put amount as per Bank Challan otherwise put Zero
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• Total Tax Deposited: Put the amount from Bank Challan
• Date of Deduction: Put the date as per Bank Challan
• Deductee Code(01-Company, 02-Other than Company): In case of Limited and Private Limited
company code- 01 and for all other case select 02
To complete the Return you have to download Challan Status Identification file from:
https://www.tin-nsdl.com à Challan Status Enquiry à
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From the Next screen:

Now Click on TAN Based ViewFrom the Next screen:
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Enter the Tan No of Deductor and Challan Tender Date/Date of Deposit(period) by selecting Date
from Date fields.

You can either confirm the Amount by clicking on Confirm amount Button, if amount is matched or
otherwise, a confirmation message window will appear. On the other hand you are sure about the
particular challan then you click on Download Challan file.
Example: “CALT01585D100913.csi” file downloaded.
Now you again go to RPU version 3.6 and click on Create File, following screen will appear:
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• Input File name with Path for CSI file: Select the downloaded csi file and opened it.
• Error/Upload Statistic Report File Path: Enter any file name save it at any folder.
Click on validate button. A message box will appear after successful or otherwise validation

Now your file is saved in a particular folder with file extension .fvu if message box shown the above
message.
Now you need to download Form 27A in Excel format form internet and fill up the form 27A, take print
out of the 27A and signed it. Copy the .fvu file in CD or Pen Drive along with Singed copy of Form 27A.

The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program I 12.9

E-Filing of Return
Sample form 27A:

Now you can prepare the Return 24Q, 27Q, 27EQ (for TCS return) like the above.
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UNIT - 13
E-FILING OF RETURN – GST
Introduction :
Persons, those who are registered under the GST Act, have to furnish periodically the details of outward
supplies, purchase, tax collected, tax paid, debit note, credit note, advance received and others
related information by filing GST returns online. Filing the returns without the payment of tax due would
be considered invalid.
The return has been designed in such a manner that all the transactions are sync with each other and
no transaction is left to be unattended between buyer and seller.
Eligibility :
•

Person who shall be required to be registered under GST ACT is eligible to file GST returns.
1.

Any supplier whose taxable supplies of goods and services or both in a financial year exceeds
` 20 lakh (` 10 lakhs for North Eastern and hill states).

2.

Person who drives inter-state taxable supply of goods

3.

Casual taxable person supplies taxable goods and services

4.

Person paying tax under reverse charge mechanism

5.

Non resident taxable person for taxable supply

6.

Agents of a supplier

7.

Input service distributor

8.

E-Commerce operator

9.

Person supplying online information and database access or retrieval services from a place
outside India to a person in India, other than a registered taxable person

10. Person who supplies via e-commerce aggregator
11. Persons who are required to deduct tax under section 51.
Mode of Filing Return :
1.

Online entry on the GST Portal (www.gst.gov.in).

2.

Using GSTN offline utilities Tool.

3.

Using third party application Software Provider (ASPs) through GST Suvidha Providers (GSPs).
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GST Returns à
Category

GST Return Form

Frequency

Due Date

Details to be Furnished

GSTR-1

Monthly

10th of succeeding
month

Outward supplies of taxable goods and/or
services effected

GSTR-2A

Monthly

Don’t have to file

System generated ‘draft’ Statement of
Inward Supplies for a Receiver Taxpayer. It is
auto-populated from the GSTR-1/5, GSTR 6,
GST 7, and GSTR 8 file by the supplier taxpayer
in a given tax period.

GSTR-2

Monthly

15th of succeeding
month

Details of inward supplies of taxable goods
and/or services for claiming input tax credit.

GSTR-1A

Monthly

From 16th till 17th of
succeeding month

Details of outward supplies as added/
modified/rejected by the recipient in their
Form GSTR- 2/4/6 will be auto populated to
supplier

GSTR-3

Monthly

20th of succeeding
month

Monthly return auto-populated on the basis
of GSTR-1 and GSTR-2 along with other tax
liabilities.

GST MIS-1

Monthly

—

Final acceptance of input tax credit claim of
any tax period is available to the recipient

GSTR-3B

Monthly

20th of succeeding
month

Declaration of summary GST liabilities for
any tax period and the discharge of these
liabilities in a timely manner

GSTR-9

Annually

GSTR-4A

Quarterly

—

Auto populated details of inward supplies
of a composition supplier received from
registered persons filing GSTR-1

GSTR-4

Quarterly

18th of the month
succeeding the
relevant quarter

Furnish consolidated details of outward
supply of goods and services. This includes
auto-populated details from GSTR-4A, tax
payable and payment of tax.

GSTR-9A

Annual

31st December

Furnish the consolidated details of quarterly
returns filed along with tax payment details.

GSTR-5

Monthly

20th of succeeding
month

Furnish details of import of goods, taxable
outward supplies, ITC availed, tax paid, and
closing stock

GSTR-5A

Monthly

20th of succeeding
month

Details of taxable outward supplies made
to non-taxable persons in India, and to view
details of interest, or any other amount and
offset the liabilities

GSTR-6A

Monthly

0n 11th of
succeeding month

System generated draft statement of inward
supplies made available to the ISD recipient

GSTR-6

Monthly

13th of succeeding
month

Furnish the details of distribution of input tax
credit and filed by input credit distributed

GSTR-7

Monthly

10th of succeeding
month

Furnish the details of TDS deducted, TDS
liability payable, TDS refund claimed.

GSTR-7A

Monthly

TDS certificate to be
made available for
download

TDS Certificate – capture details of value on
which TDS is deducted and deposit on TDS
deducted into appropriate Govt.

Regular Dealer

Tax Payer under
Composition
Scheme

Non-Resident
Foreign Taxpayer
Online Information
and Database
Access or Retrieval
services provider
Input Service
Distributor

Tax Deductor

Furnish the details regarding the ITC availed
31st Dec of next fiscal and CGST, SGSTand IGST paid which includes
local, interstate and import/exports
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Category

GST Return Form

Frequency

Due Date

Details to be Furnished

GSTR-8

Monthly

10th of succeeding
month

Details of supplies effected through
e-commerce operator and the amount of
TCS (Tax Collection at source) collected on
such supplies

GSTR-9B

Annually

GSTR-9C

Annually

E-commerce

Annual Turnover
Exceeds INR 2
Crores
Taxable persons
whose registration
is surrendered or
cancelled
Specialised agency
of the United Nations
Organisation or
any multilateral
Financial Institution
and notified United
Nations Bodies,
Consulate or
Embassy of foreign
countries

GSTR-10

Monthly

GSTR-11

Monthly

Furnish the details of outward supplies of
31th Dec of next fiscal goods or services or both, including the
supplies of goods or services or both returned
Annual, 31st Dec of
next fiscal

Audited
annual
accounts
and
a
reconciliation statement of tax already paid
and tax payable, duly certified.

Within 3 months
from the date of
cancellation of
Furnish details of closing stock and capital
registration or date of goods held, tax paid and payable.
cancellation Order,
whichever is later

28th of succeeding
month

Details of inward supplies to be furnished by
UIN holder.

Mechanism of filing return :
Suppliers registered under GST act, furnish their outward supplies details of a month through GSTR–1 by
10th day of the succeeding month. All those details become available to receiver taxpayer in the PART-A
of FORM GSTR-2A from 11th to 15th day. It is a system generated draft statement of inward supplies autopopulated from GSTR-1/5, GSTR 6, GSTR 7, GSTR 8 file by supplier taxpayer. The information displayed
in GSTR-2A is also available in GSTR-2 format. If any outward supplies is mismatch with recipient inward
supplies, the receiver taxpayer can add/modify/reject the details and has to file GSTR-2 on or before
15th day of succeeding the relevant month.
The revised detail as per GSTR-2 is auto-populated and reflected in form GSTR-1A which is available
to the supplier from 16th till 17th day of succeeding the relevant month. GSTR-1A is generated if the
recipient in form GSTR-2/4/6 makes inclusion/modification/rejection. The supplier may accept or reject
the modification made by the recipient and may submit GSTR-1A with or without any modification. In
the next step, tax liability in GSTR-3 (auto generated) would take into consideration the details in GSTR1A. Form GSTR-3 to be filed by the supplier on or before 20th day of the month succeeding the relevant
month. GSTR-1A is not mandatory to be submitted before generation of GSTR-3.
If time limit for furnishing details of GSTR-1 and GSTR-2 is extended, return in GSTR-3B, in the place of
GSTR-3, may be furnished as per notified made by the Commissioner.
GSTR-1 :
It prescribes the details to be provided electronically on the GST Portal by every registered dealer
(except person opting for Composition Levy, Non-Resident Taxable Person, person required to deduct
tax at source, e-Commerce operators, Input Service Distributors and person required to collect tax at
source as there are separates return for them) in relation to outward supply of goods and services or
both for the relevant period.
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Due Date: It is a monthly return. It is filed between 1st and 10th of the month succeeding the relevant tax
period.
Pre-requisites for Return:
1.

A valid User-ID and password for logging in to GST Portal.

2.

Registered taxpayer with an active GSTIN during the tax period for which GSTR-1 has to be furnished;

3.

Signing by DSC requires an active and non-expired/ revoked digital signature (DSC)

4.

In case of EVC, tax payer must have access to the registered mobile number of the Primary
Authorized Signatory.

5.

E-sign option requires a valid Aadhaar card with a linked mobile number.

Details to be furnished for GSTR-1:
1.

Invoice level details of supplies to registered persons.

2.

Invoice level details of Inter- State supplies to unregistered dealer for invoice value greater than Rs.
2,50,000.

3.

Details of Credit/Debit Notes issued.

4.

Details of export of goods and services including deemed exports (SEZ);

5.

Summarised details of supplies to unregistered persons.

6.

Summary Details of Advances received in relation to future supply and their adjustment.

7.

Details of any amendments effected to the reported information for above categories.

8.

Nil- rated, exempted, and non-GST supplies

9.

HSN/SAC wise summary of outward supplies.

Steps to be followed for submission of GSTR-1:
1.

Open www.gst.gov.in URL.

2.

Login with your User ID and Password

3.

Click the Services > Returns > Returns Dashboard

4.

Select the Financial Year & Return Filing Period (Month) from the drop-down list.

1.

Click on SEARCH button.
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Select option for Quarterly or Monthly Return
2.

Now you can see “option Form for Quarterly Return filing by Normal Taxpayer”

3.

When you select “Whether you aggregate turnover during the previous Financial Year was upto
` 1.5 Crores or Do you expect your aggregate turnover during the Current Financial Year to be
upto ` 1.5 Crores?” as Yes and also select “ Would you like to opt for quarterly filing of tax return”
as Yes, then click on submit option.

4.

Press Proceed option.
• In case of monthly return you have to select the following option
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Press Submit > Proceed.

• If you select “Whether you aggregate turnover during the previous Financial Year was upto ` 1.5
Crores or Do you expect your aggregate turnover during the Current Financial Year to be upto
` 1.5 Crores?” as No.

Then click on Submit > Proceed

• In this case, for quarterly return you have to press Edit option. Then edit the preference and press
Submit.
5.

In the GSTR-1 tile, Press PREPARE ONLINE button to prepare the return by making entries on the GST
Portal directly.
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Otherwise, you may press PREPARE OFFLINE button to upload the JSON (Java Script Object Notation)
file containing GSTN specified invoice details prepared through the GSTN provided offline tools or
any other software.

6.

It will take you “Details of outward supplies of goods or services”. Aggregate turnover in the
preceding financial year will be auto-populated. Rest of the fields need to be filled up.

• Scroll down to the bottom of the page and select Generate GSTR1 Summary.

7.

Now, you have to provide (a) Invoice Details and (b) Other Details of outward supplies
(a) Invoice Details
• 4A,4B,4C,6B,6C-B2B Invoices: To add an invoice for taxable outward supplies to a registered
person
• 5A,5B-B2C (Large) Invoices: To add an invoice for taxable outwards supplies to a consumer,
where place of supply is other than the State where supplier is located (Inter-State Supplies)
and invoice value is more than Rs. 2.5 Lakh
• 9B-Credit/Debit Notes (Registered): To add details of credit or debit notes issued to the
registered receipents.
• 9B-Credit/Debit Notes (Unregistered): To add details of credit, debit notes or refund issued
to the unregistered recipients.
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• 6A-Exports Invoices: To add an invoice for supplies exported
• 9A-Amended B2B Invoice: To make amendments to details of outward supplies to a
registered person of earlier tax periods.
• 9A-Amended B2C (Large) Invoice: To make amendments to taxable outward supplies to
an unregistered person of earlier tax periods.
• 9A-Exports Invoices: To make amendments to supplies exported
• 9C-Amended Credit/Debit Notes (Registered): To make amendments to details of credit/
debit notes issued to the registered recipients of earlier tax periods.
• 9C-Amended Credit/Debit Notes (Unregistered): To make amendments to details of credit/
debit notes issued to the unregistered recipients of earlier tax periods.
(b) Other Details of outward supplies
• 7-B2C Others: To add consolidated details of taxable outwards supplies to a customer where
invoice value is less than Rs. 2.5 lakh and all intra state supplies to unregistered customers.
•

8A, 8B, 8C, 8D - Nil Rated Supplies: To add consolidated details of nil rated, exempted and
Non-GST Outward supplies.

• 11A(1), 11A(2) - Tax Liability (Advances Received): To add details of transactions attracting
tax liability arising on account of Time of Supply (like receipt of advances)
• 11B(1), 11B(2) - Adjustment of Advances: To add the advance amount received in earlier
tax period and adjusted against the supplies being shown in the current tax period
• 12 - HSN-wise-summary of outward supplies: To furnish the summarized details of all outward
supplies HSN and rate wise along with quantitative details.
• 13 - Documents Issued: To add the details of documents issued during the current tax period
• 11A - Amended Tax Liability (Advance Received): Consolidated statement for amendments
of information furnished in earlier tax period
• 11B - Amended of Adjustment of Advances: Consolidated statement for amendments of
information furnished in earlier tax period
• 10 - Amended B2C (Others): To make amendments to details of B2C of earlier tax periods
8.

Start with GSTR-1 Invoice Details. Select 4A, 4B, 4C, 6B, 6C - B2B Invoices tile and provide invoice
details for B2B transactions.

• Press Add Invoice option

13.8 | The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program

• Select the appropriate checkbox for Deemed Exports or SEZ Supplies with payment or SEZ
supplies without payment
• Then others required fields needs to be filled up
• If supply comes under the purview of reverse charge mechanism select the Supply attract
Reverse Charge checkbox.
• If supply is eligible taxable at a differential percentage of the existing rate select the checkbox
“Is the supply eligible to be taxed at a differential percentage (%) of the existing rate of tax, as
notified by the Government?”
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• In case of Intra-State transaction [on the basis of Place of Supply (POS)], fields for Central Tax
and State/UT Tax will appear. Enter the taxable value of goods and services against respective
rates (Amount of Tax field is auto-populated). Enter the cess amount if applicable.
• In case of Inter-State transaction, fields for Integrated Tax will appear. Remaining things are
same as above.
• Press the save option to save Invoice Details.
• You will be redirected to the previous page which shows the summary of all the invoices entered.
You can modify (edit/add/delete) your invoices.

• In this summary screen you will see four options.
(a) Uploaded by taxpayer: Invoices you have uploaded for a given tax period
(b) Uploaded by Receiver: Invoices that have not been entered in your GSTR-1, but were
uploaded by your receiver tax payer for making corrections.
(c) Modified by Receiver: Invoices which have been uploaded in your GSTR-1 were modified
by receiver taxpayer. You have to be taken necessary action.
(d) Rejected by Receiver: Invoices that have been entered in your GSTR-1 were rejected by
receiver tax payer for taking necessary correction.]
• Press BACK button to get back Receiver Wise Summary. Press ADD INVOICE to add a new
invoice.

• Press BACK button to get back to GSTR-1 page. B2B Invoice tile reflects the number of invoices
added along with Total Invoice value, Total taxable value, and total tax liability.
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9.

Select 5A, 5B-B2C (Large) Invoices tile and provide invoice details for inter-state taxable outward
supplies of value greater than 2.5 lacs. Summary page will display. Press ADD INVOICE button to
add new invoice.

In the invoice details you have to provide data regarding POS, Invoice no., Invoice Date and
Invoice Value. If supply is made through an e-commerce company, select the checkbox “Is
E-Commerce” and enter the GSTIN of the e-commerce company. Enter the taxable value of
goods and services against respective rates (Amount of Tax field is auto-populated). Enter the cess
amount if applicable.
• Press SAVE button to save the invoice details.
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• You will be redirected to the previous page where you can edit/delete the added invoices.
Press the BACK button to get back to the GSTR-1 page.

• B2C (Large) Invoices tile in GSTR-1 page will reflects the number of invoices added along with
Total Invoice value, Total taxable value, and total tax liability.

10. Select 9B-Credit/Debit Notes (Registered) tile to enter details of credit/debit note issued to the
registered recipients. Summary page will display. Press ADD DETAILS button to add Credit/Debit
note.

• Fill the required field (Receiver GSTIN/UIN, Debit/Credit Note No., Debit/Credit Note Date,
Original Invoice Number, Original Invoice Date.
• Select Debit/Credit Note or Refund Voucher from Note Type drop-down list.
• Then enter the note or refund value
• Mention the invoice of Inter-state or Intra-state transaction from Supply Type drop-down list.
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• If supply is eligible to be taxed at a differential percentage of the existing rate of tax, select the
checkbox given as “Is the supply eligible to be taxed at a differential percentage (%) of the
existing rate of tax, as notified by the Government?”
• Enter the taxable value of goods and services against respective rates (Amount of Tax field is
auto-populated). Enter the cess amount if applicable.
• Press SAVE button to save the details.
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• You will be redirected to the previous page where you can edit/delete the added invoices.

• In this summary screen you will see four options.
(a) Uploaded by taxpayer: All Debit/Credit Note/Return Invoices you have uploaded for a
given tax period
(b) Uploaded by Receiver: Debit/Credit Note/Return Invoices that have not been entered
in your GSTR-1, but were identified and uploaded by your receiver tax payer for making
corrections.
(c) Modified by Receiver: Debit/Credit Note/Return Invoices which have been uploaded in
your GSTR-1 were modified by receiver taxpayer. You have to be taken necessary action.
(d) Rejected by Receiver: Debit/Credit Note/Return Invoices that have been entered in your
GSTR-1 were rejected by receiver tax payer for taking necessary correction.
• Press the BACK button to get back to the GSTR-1 page. You will see the summary of Debit/Credit
Note/Return voucher added under 9B-Credit/Debit Notes (Registered) tile.
11. Press 9B - Credit / Debit Notes (Unregistered) tile to add the details of credit or debit notes issued
to the unregistered dealers.

• Summary page will display. Press ADD DETAILS button to add Credit/Debit note.
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• Remaining steps are identical as 9-B Credit/Debit Notes (Registered)

• After providing required details save the page and back to GSTR-1 page. The page will show
the number of Credit/Debit note/refund vouchers added.

12. To add the invoices for export press 6A- Export Invoices tile. On summary page select ADD INVOICE
to add export invoice.
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• Enter Invoice No.,Invoice Date, Port Code, Shipping Bill No./Bill of Export No. (minimum 3 and
maximum 15 digit numeric), Total Invoice Value.
• From GST Payment drop-down list select whether GST is paid or not.
• If supply is eligible to be taxed at a differential percentage of the existing rate of tax, select the
checkbox given as “Is the supply eligible to be taxed at a differential percentage (%) of the
existing rate of tax, as notified by the Government?”
• Enter the taxable value of goods and services against respective rates (Amount of Tax field is
auto-populated). Enter the cess amount if applicable.
• Press SAVE button to save the details.
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• You will be redirected to the previous page where you can edit/delete the added invoices.

• Press the BACK button to get back to the GSTR-1 page. You will see the number of invoices
added along with total invoice value, total taxable value and total tax liability..

13. If you need to make necessary amendment of the following sections press the respective tiles and
fill the revised details.
• 9A-Amended B2B Invoice: To make amendments to details of outward supplies to a registered
person of earlier tax periods.
• 9A-Amended B2C (Large) Invoice: To make amendments to taxable outward supplies to an
unregistered person of earlier tax periods.
• 9A-Exports Invoices: To make amendments to supplies exported
• 9C-Amended Credit/Debit Notes (Registered): To make amendments to details of credit/debit
notes issued to the registered recipients of earlier tax periods.
• 9C-Amended Credit/Debit Notes (Unregistered): To make amendments to details of credit/
debit notes issued to the unregistered recipients of earlier tax periods.
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B. Other Details of outward supplies
14. 7-B2C (Others): To add consolidated details of taxable outwards supplies to a customer where
invoice value is less than ` 2.5 lakh and all intra state supplies to unregistered customers.

• Press 7-B2C (Others) tile B2C (Others) Details – Summary page will open. Here, transactions
through two options are available. Other than E-commerce tab and E-commerce tab.

• Press ADD DETAILS to add item details. The following fields will appear when you select
E-commerce tab.
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• In case of intra-state supplies the following screen will appear. After fill up all the details save the
screen.

• In case of inter-state supplies the following screen will appear. After fill up all the details save the
screen.

• Press on back button and you will be redirected to the GSTR-1 which will reflect number of
invoices added along with total taxable value and total tax liability under B2C (Others) tile.

15. 8A, 8B, 8C, 8D - Nil Rated Supplies: To add consolidated details of nil rated, exempted and NonGST Outward supplies.
• Press the Nil Rated Supplies tile and select uploaded by taxpayer.
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• Press Edit button to enable the fields to be displayed

• Enter details in Nil Rated Supplies, Exempted (Other than Nil rated/non-GST supply), and NonGST Supplies Amount fields against (a) Inter-state supplies to registered person (b) Inter-state
supplies to unregistered person (c) Intra-state supplies to registered person (d) Intra-state
supplies to unregistered person.
• Press save and Back button subsequently. You are taken to the GSTR-1 page which will reflect
Total Nil Amount, Total Exempted Amount and Total Non-GST Amount under Nil Rated Supplies
tile.
16. 11A(1), 11A(2) - Tax Liability (Advances Received): To add details of transactions attracting tax
liability arising on account of Time of Supply (like receipt of advances) press Tax Liability (Advances
Received) tile.

• The Tax Liability (Advance Received) – Summary page will open. Click the ADD DETAILS button.

• The following screen will appear. Fill up POS field, Supply Type column would be auto-populated
as Inter-state or Intra-state. In case of Intra-State transaction: Central Tax, State/UT Tax & CESS
will appear in the screen. Enter the amount paid by the receiver to the supplier for the goods/
service without any invoice against the rate is applicable. Enter the amount in CESS field.
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• In case of Inter-State transaction, fields for Integrated Tax & CESS will appear in the screen. After
fill up all the required fields press SAVE button.

• The summary table will appear. You can edit or delete item by using the Edit and Delete icons.
Press the BACK button to get back to the GSTR-1 page. Tax Liability (Advance Recieved) tile will
reflect the Gross Advance Received and Total Tax Liability.
17. 11B(1), 11B(2) - Adjustment of Advances: To add the advance amount received in earlier tax
period and adjusted against the supplies being shown in the current tax period, press 11B(1),
11B(2)- Adjustment of Advances tile.

The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program |13.21

E-Filing of Return

• Tax already paid on invoices issued in the current period – Summary page will open. Press ADD
DETAILS button to add invoices issued for which tax has already been paid.

• Tax already paid on invoices issued in the current period - Add Details page will open.

• For Intra-State transaction, fields like Central Tax, State/UT Tax & CESS will appear. In the Gross
Advance adjusted field, enter the amount paid by the receiver against the applicable Rate (%).
Enter the CESS amount in CESS field.
• In case of Inter-State transaction, fields for Integrated Tax & CESS will appear in the screen. After
fill up all the required fields press SAVE button.
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• The summary table will appear. You can edit or delete item by using the Edit and Delete icons.
Press the BACK button to get back to the GSTR-1 page. Adjustment of Advances tile will reflect
the Gross Advance Adjusted and Total Tax Liability.
18. 12-HSN-wise-summary of outward supplies: To furnish the summarized details of all outward supplies
HSN and rate wise along with quantitative details, press 12-HSN-wise-summary of outward supplies
tile.

• The HSN-wise summary of outward supplies– Summary page will appear. Press ADD DETAILS
button to add invoices issued for which tax has been paid.

• The HSN summary of outward supplies – Add/Edit Details page is displayed. Fill up HSN code,
Description field, UQC field, Total Quantity field, Total Value field, Total Taxable Value field of the
outward supply.
• For Intra-State transaction, fields like Central Tax, State/UT Tax & CESS will appear. In case of
Inter-State transaction, fields for Integrated Tax & CESS will appear in the screen. After fill up all
the required fields press ADD button.
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• You will be taken to Added/Edited Invoices to be saved page. You may alter or add invoice
details.

• Press BACK button to get back to the GSTR-1 page. HSN summary of outward supplies tile will be
updated.
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19. 13 - Documents Issued: To add the details of documents issued during the current tax period press
13 - Documents Issued tile.

• There are 12 categories of documents. Enter the serial no. of invoice issued, Total number of
invoices issued and cancelled invoices in respective fields. The net invoices field will be auto
populated.
• Invoices for outward supply screen will appear. Press on Add Document and add the details.

In the similar way rest of the documents are to be filled up as follows.
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• Press SAVE and BACK button subsequently. You are taken to GSTR-1 page. 13 - Documents
Issued tile will be updated.
20. If you need to make necessary amendment of the following sections press the respective tiles and
fill the revised details.
• 11A - Amended Tax Liability (Advance Received): Consolidated statement for amendments of
information furnished in earlier tax period
• 11B - Amended of Adjustment of Advances: Consolidated statement for amendments of
information furnished in earlier tax period
• 10 - Amended B2C (Others): To make amendments to details of B2C of earlier tax periods
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• After completion of the above steps you need to generate GSTR-1 Summary to added invoices,
press the PREVIEW button and download the draft Summary page of your GSTR-1 for review
purpose.

• Once your review is completed and you find all the information furnished is correct, select the
acknowledgement checkbox. Then SUBMIT button will be enabled.
Press the SUBMIT button. [This process will freeze the invoices uploaded in the GSTR-1 for that
particular month. You are unable to upload any further invoices for that month.]

• Now press PROCEED button. Status of the GSTR-1 page shows “submitted”.

• Press PREVIEW button again to download the submitted GSTR-1 in PDF format.
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21. Submission of GSTR-1 with DSC(Digital Signature Certificate)/EVC (Electronic Verification Code):
•

Press FILE RETURN button

• Returns Filing for GSTR1 page will open. Select the Declaration checkbox.
•

Select authorized signatory under Authorised Signatory drop-down list. You will find two active
buttons - FILE WITH DSC or FILE WITH EVC.

• Press FILE WITH DSC or FILE WITH EVC button. (notification through e-mail and SMS will be sent to
the Authorized Signatory).

• In case of FILE WITH DSC, press PROCEED button, then Select the certificate and press the SIGN
button. In case of FILE WITH EVC put the OTP sent on email and mobile number of the Authorized
Signatory and press the VERIFY button.
• Finally, the status of the GSTR-1 shows “Filed”.
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In this chapter we have discussed only submission of GSTR-1 through GST portal. For the purpose of log
in this portal the required web address is as given below.
https://www.gst.gov.in/
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UNIT - 14
E-FILING OF RETURN – INCOME TAX
Different Modes of Filing the Return of Income
TheReturnFormcanbefiledwiththeIncome-taxDepartmentinanyofthefollowingways,(i) by furnishing the return in a paper form;
(ii) by furnishing the return electronically under digital signature;
(iii) bytransmittingthedatainthereturnelectronicallyunderelectronicverificationcode;
(iv) bytransmittingthedatainthereturnelectronicallyandthereaftersubmittingtheverificationof
the return in Return Form ITR-V.
 Income Tax Returns Form:
Form No.
ITR-1 SAHAJ

Who can file
For individuals being a resident other than not ordinarily resident having Income from
Salaries, pension income,one house property (not a case of brought forward loss),
othersources(notbeinglotterywinningsandincomefromracehorses,incometaxable
undersection115BBDAorincomereferredinsection115BBDA)andhavingtotalincome
upto ` 50 lakh
ITR-2
For individual or an Hindu Undivided Family who is not eligible to file Sahaj ITR-1 and
whoseincomechargeabletoincome-taxunderthehead“Profitsorgainsofbusiness
orprofession”isinthenatureofinterest,salary,bonus,commissionorremuneration,by
whatevernamecalled,dueto,orreceivedbyhimfromapartnershipfirm.
ITR-3
ForindividualsandHUFshavingincomefromprofitsandgainsofbusinessorprofession.
ITR-4-Sugam Applicable to individuals or Hindu Undivided Family or partnership firm (other than
limitedliabilitypartnershipfirm)whohaveoptedforthepresumptivetaxationscheme
ofsection44AD/44ADA/44AE.
ITR-5
Applicable to a person being a firm, LLP, AOP, BOI, artificial juridical person referred
to in section 2(31)(vii), co-operative society and local authority. However, a person
who is required to file the return of income under section 139(4A) or139(4B) or
139(4C)or139(4D)orsection139(4E)orsection139(4F)shallnotusethisform(i.e.,trusts,
politicalparties,institutions,colleges,investmentfundetc.).
ITR-6
ForCompaniesotherthancompaniesclaimingexemptionundersection11(exemption
undersection11canbeclaimedbycharitable/religioustrust).
ITR-7
For persons including companies required to furnish return under sections 139(4A) or
139(4B)or139(4C)or139(4D)or139(4E)or139(4F)(i.e.,trusts,politicalparties,institutions,
colleges,investmentfund,etc.).
ITR-V
Itistheacknowledgementoffilingthereturnofincome.
 Due Date of Annual Return of Income
Category

Due Date of Annual
Return of Income
All assessee other than (a) corporate-assessee or (b) non-corporate assessee
31st July
(whose books of account are required to be audited) or (c) working partner
ofafirmwhoseaccountsarerequiredtobeauditedor(d)anassesseewhois
requiredtofurnishareportundersection92E.
Theassessee(nothavinganyinternationalorspecifieddomestictransaction)is 30th September
(a)corporate-assesseeor(b)non-corporateassessee(whosebooksofaccount
arerequiredtobeaudited)or(c)workingpartnerofafirmwhoseaccountsare
requiredtobeaudited).
Inthecaseofanassesseeifhe/itisrequiredtosubmitareportundersection
30th November
92Epertainingtointernationalorspecifieddomestictransaction(s)
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 Applicable Mode of Furnishing the Return of Income
Person

Condition
Accountsarerequiredtobeaudited
under section 44AB of the Act

Individual or Hindu
undivided family

Electronicallyunderdigitalsignature

Where total income assessable under the 1. Electronicallyunderdigitalsignature;or
Actduringthepreviousyearofaperson,- 2. Transmitting the data electronically in
being an individual of the age of 80 years
the return under electronic verification
or more at any time during the previous
code; or
year; or whose income does not exceed
3.
Transmitting the data in the return
five lakh rupees and no refund is claimed
electronically and thereafter submitting
inthereturnofincome,andwhofurnishes
the verification of the return in Form
the return in Form No. SAHAJ ITR-1 or Form
ITR-V;
or
No. SUGAM (ITR-4)
4. Paper form

In any other case
Company

1. Electronicallyunderdigitalsignature;or
2. Transmitting the data electronically in
the return under electronic verification
code; or
3. Transmitting the data in the return
electronically and thereafter submitting
theverificationofthereturninForm ITR-V;

In all cases

Electronicallyunderdigitalsignature

In case of a political party;

Electronicallyunderdigitalsignature

In any other case
A person required
to furnish the return
in Form ITR-7

Firm or limited liability
partnership or any
person (other than a
person mentioned in
abovethree)whois
requiredtofilereturn
in Form ITR-5

Manner of furnishing return of income

1. Electronicallyunderdigitalsignature;or
2. Transmitting the data electronically in
the return under electronic verification
code; or
3. Transmitting the data in the return
electronically and thereafter submitting
theverificationofthereturninForm ITR-V

Accounts are required to be audited Electronicallyunderdigitalsignature
under section 44AB of the Act;

In any other case

1. Electronicallyunderdigitalsignature;or
2. Transmitting the data electronically in
the return under electronic verification
code; or
3. Transmitting the data in the return
electronically and thereafter submitting
theverificationofthereturninForm ITR-V

Steps for e-filing (for corporate assessee):
1.

Registration of Person: It helps in creating a user account in the e-Filing portal. Taxpayer needs
to be registered on the e-Filing website to leverage the services such as filing ITR, viewing 26AS
Statement, status of Income Tax Return, File Rectification, Refund re-issue request,tax deducted
details,refundstatusandsoon.Briefly,taxpayercantrackalltax-relatedactivitiesonthiswebsite.

Registration for other than individual and HUF:
Prerequisite:
Theusermusthavethefollowingmandatorydetails:
• ValidPANCard
• ValidMobileNumber
• ValidEmailAddress,preferablybelongingtoPrincipalcontactperson
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Registration Process:
• Visitthee-filingportalwww.incometaxindiaefiling.gov.in
• Press“RegisterYourself”buttonlocatedatrightsideofthehomepage
• Selectthefollowingcategoryunder“OtherthanindividualandHUF”asperPANstatus(Company,
BOI,LocalAuthority,Firm,Trust,AOP,ArtificialJuridicalPerson,Government)andpress“Continue”.
• Provide PAN of the Organization, Organization Name and Date of Incorporation. In case of
company,selectthe“TypeofCompany”andpress“Continue”
• Providepassworddetails,personaldetailsandcontactdetailsofprincipalcontactperson,address
oforganizationandsubmittheabovedetails
• Afterregistration,forResidents,asixdigitsOTP1andOTP2willbesharedonyourmobilenumberand
emailID,specifiedatthetimeofregistration.ForNon-residents,OTPwillbesharedonyourprimary
email ID, specified at the time of registration.Enter the correct OTP to complete the registration
process.
2.

Login to e-filing:
• Visitthee-filingportalwww.incometaxindiaefiling.gov.in
• Press“LoginHere”buttonlocatedatrightsideofthehomepage
• Enter‘UserID*’(Note:TheUserIddiffersbasedontheusertype.
• Enter‘Password*’(Note:Thepasswordissetatthetimeofregistrationinthee-Filingportal)
• Enterthevalueof‘Captcha*’ as displayed on the screen or ‘Request OTP’ instead of Captcha.
OTPwillbesharedtoregisteredMobileNumber.

3.

E-Filing of ITR: ThetaxpayercanfiletheIncomeTaxReturn(ITR)intwoways,OfflineandOnline.

Offline Mode: Inthismodetheuserenter“e-filing”portalwww.incometaxindiaefiling.gov.in.
• Open“Downloads”locatedbelowloginbutton>“OfflineUtilities”>“IncomeTaxReturnPreparation
Utilities”>selectappropriateITRformandpress“Download”linkavailableunder“ExcelUtility”or
“JavaUtility”column.
• OpentheextractedZIPfile(excelfilewillworkonlyif‘Macros’and‘ActiveX’functionoftheExcel
workbookisenabled.)
• Attach the ‘Pre-filled XML’ file which has been downloaded (If not downloaded previously, then
opene-filingportal>MyAccount>DownloadPre-fillXMLafterselectingassessmentyearandform
name).
• Attachthedownloaded‘Pre-fillXML’filetopopulatetherelevantdetails.Thenenterallmandatory
fieldsandcalculatetax>GenerateXML>SaveXMLfileatappropriatedrive.
• UploadtheXMLfileate-FilingWebsite(frome-filingportal,opene-file>IncomeTaxReturn>provide
assessmentyearandITRformname>Original/RevisedReturn>selectSubmissionMode’as ‹Upload
XML
Online Mode:
• Inthismodetheuserenter“e-filing”portalwww.incometaxindiaefiling.gov.in.
• Select“e-File”>IncomeTaxReturn>provideAssessmentYearandITRFormName>Original/Revised
Return>select“SubmissionMode”as‘Prepare and Submit Online’fromthedropdownlist.
• ChooseanyoneofthefollowingoptiontoverifytheIncomeTaxReturn:1.DigitalSignatureCertificate
(DSC) 2. Aadhaar OTP 3. EVC using Pre-validate Bank Account Details 4. EVC using Pre-validate
DematAccountDetails5.Idon’twanttoverifythisIncomeTaxReturnandwouldliketosendsigned
ITR-V through normal or speed post to “Centralized Processing Center, Income Tax Department,
Bengaluru – 560500.
• Then continue and filing the details of ITR, under category “Return Filed” (Before submitting the
data,savethedatabyclickingon‘Save as Draft’ to recheck any mistakes).
• PressPreviewandSubmit>Submit
• Aftersuccessfulsubmission,IncomeTaxDepartmentwillprocessyourITRandsendaconfirmation
email stating the same.
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4.

Instructions for filling out FORM ITR-6 (ForCompaniesotherthancompaniesclaimingexemption
under section 11).
This Form has to be compulsorily furnished electronically under digital signature to the Income
TaxDepartment.Tax-payersarerequiredtomatchthetaxesdeducted/collected/paidbyoron
behalfofthemwiththeirTaxCreditStatement(Form26AS)throughwww.incometaxindia.gov.in.
• Under the heading “Filing Status” in the Return Form the relevant box needs to be checked
regardingsectionunderwhichthereturnisbeingfiledonthebasisoffollowing.

How the return is filed
Check Box No.
Voluntarilyonorbeforetheduedateundersection139(1)
1
Voluntarilyaftertheduedateundersection139(4)
2
Revisedreturnundersection139(5)
3
Modifiedreturnundersection92CD
4
Under section 119(2)(b) on an application to be made separately before
5
the Income-tax authority (The return shall be treated as valid only after the
application/ claim/ relief under section 119(2)(b) has been admitted by the
Income-taxAuthority).
Inresponsetonoticeundersection139(9)
6
In response to notice under section 142(1)
7
In response to notice under section 148
8
Inresponsetonoticeundersection153A/153C
9
• Before filling out the ITR-6 we need to compute total income under the following heads of
income-(A)“Incomefromhouseproperty”;(B)“Profitandgainsfrombusinessorprofession”;(C)
“Capitalgains”;and(D)“Incomefromothersources”.[Theremaybenoincomeunderoneor
moreoftheheadsat(A),(B),(C)and(D)].Then,computetaxableincomeundereachhead
ofincomeseparatelyintheSchedules.Setoffcurrentyear’sheadwiseloss(es)againstcurrent
year’sheadwiseincome(s)andcomputeloss(es)and/orallowance(s)thatcouldbesetoffin
futureandis(are)tobecarriedforwardasperproceduresprescribedbythelaw.
• Computeincome-taxpayableonthetotalincome.Incase,thetaxliabilitycomputedasabove
islessthan18.5%ofbookprofit,thecompanyisrequiredtopayminimumalternatetax(MAT)
undersection115JBattherateof18.5%oftheprofit.Computesurchargeontaxpayableon
deemedtotalincomeortotalincomeasapplicable.AddEducationCessincludingsecondary
andhighereducationcessattherateof3%onthetaxpayableandsurchargethereon.Claim
relief(s)asprescribedbythelaw,fordoubletaxationandcalculatebalancetaxpayable.Add
interestandfeepayableasprescribedbythelawtoreachtotaltax,interestandfeepayable.
Deduct the amount of prepaid taxes, if any, “tax deducted at source”, “advance-tax” and
“self-assessment-tax”.Theresultwillbetaxpayable(orrefundable).
• Scheme of the form: The ITR-6 form has been divided into three parts. It also has schedules. The
sequenceforfillingoutpartsandSchedulesare(i) Part A (ii) Schedules (iii) Part B (iv) Verification
respectively.
• The details of these parts and the schedules are as underPart-A has eight sub-divisions (i) Part A-GEN mainly seeks general information requiring
indemnificatoryandotherdata.(ii)PartA-BSseeksthebalancesheet(iii)PartA-BS-IndASseeks
the balance sheet (iv) Part A-P&L seeks information regarding the Profit and loss account for
thefinancialyear(v)PartA-P&L-INDASseeksinformationregardingtheProfitandlossaccount
forthefinancialyear(vi)PartA-OIseeksotherinformation.Itisoptionalinacasenotliablefor
auditundersection44AB.(vii)PartA-QDseeksinformationregardingquantitativedetailsofthe
principal item of goods traded. It is optional in a case not liable for audit under section 44AB (viii)
PartA-OListobefilledincaseofcompanyunderliquidation.
[Note: ThePartA-BS-IndASandPartA-P&L-IndASareapplicableincaseofacompanywhose
financialstatementsaredrawnupincompliancetotheIndianAccountingStandards(IndAS)
specifiedinAnnexuretotheCompanies(IndianAccountingStandards)Rules,2015].
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FORM

INDIAN INCOME TAX RETURN
[For Companies other than companies claiming exemption
under section 11]
(Please see rule 12 of the Income-tax Rules,1962)
(Also see attached instructions)

ITR-6

PERSONAL INFORMATION

Part A-GEN

Assessment Year

2 0 1 8 - 1 9

GENERAL

Name

PAN

Is there any change in the company’s name? If yes, please furnish the old name

Corporate Identity Number (CIN)
issued by MCA

Flat/Door/Block No

Name of Premises/Building/Village

Road/Street/Post Ofﬁce

Area/Locality

Date of incorporation
(DD/MM/YYYY)
/
/
Type of company
(Tick any one) þ
(i) Domestic Company

Town/City/District

State

Pin code/Zip code

Country
Ofﬁce Phone Number with STD code/ Mobile No. 1

Mobile No. 2

(ii) Foreign Company
If a public company
write 6, and if private
company write 7 (as
deﬁned in section 3 of
The Company Act)
Income Tax Ward/Circle

o
o

o

Email Address-1
Email Address-2
(a)
(b)

AUDIT
INFORMATION

FILING STATUS

(c)

Return ﬁled(Tick)[Please see instruction number-5]o On or before due date-139(1), o After due date-139(4), o Revised Return-139(5) o
Modiﬁed return-92CD, o under section 119(2)(b),Or In response to notice o 139(9)- Defective, o 142(1), o 148, o 153A, o 153C
If revised/in response to defective/Modiﬁed, then
enter Receipt No and Date of ﬁling original return
___ /___/____
(DD/MM/YYYY)
If ﬁled, in response to notice u/s 139(9)/142(1)/148/153A/153C enter date of such notice, or u/s 92CD enter date of
/
/
advance pricing agreement

(d)

Residential Status

(Tick) þ o Resident

o Non-Resident

(e)

Whether opting for section 115BA? (Yes/No) (applicable on Domestic Company)

(f)

Whether total turnover/ gross receipts in the previous year 2015-16 exceeds 50 crore rupees? (Yes/No) (applicable on Domestic Company)

(g)

Whether assessee is a resident of a country or speciﬁed territory with which India has an agreement referred to in sec 90 (1 ) or Central
Government has adopted any agreement under sec 90A(1)?

(h)

In the case of non-resident, is there a Permanent Establishment (PE) in India (Tick) þ

(i)

Whether assessee is required to seek registration under any law for the time being in force relating to companies?

(j)
(k)

o Yes

o No

Whether the ﬁnancial statements of the company are drawn up in compliance to the Indian Accounting Standards speciﬁed in Annexure to
the companies (Indian Accounting Standards) Rules, 2015
(Tick) þ
o Yes
o No
Whether assessee is located in an International Financial Services Centre and derives income solely in convertible foreign exchange?
(Tick) þ
o Yes
o No

(l)

Whether the assessee company is under liquidation (Tick) þ

(m)

Whether you are an FII / FPI? Yes/No

o Yes

o No

If yes, please provide SEBI Regn. No.

(n)

Whether any transaction has been made with a person located in a jurisdiction notiﬁed u/s 94A of the Act? o Yes o No

(o)

Whether this return is being ﬁled by a representative assessee? (Tick) þ
If yes, please furnish following information (1)

Name of the representative assessee

(2)

Address of the representative assessee

(3)

Permanent Account Number (PAN) of the representative assessee

o Yes

(a)

Whether liable to maintain accounts as per section 44AA?

(b)

Whether liable for audit under section 44AB?

(c)

If (b) is Yes, whether the accounts have been audited by an accountant? (Tick) þ
If Yes, furnish the following information below

(Tick) þ

(1)

Mention the date of furnishing of audit report

(2)

Name of the auditor signing the tax audit report

(Tick) þ
o Yes

o No

o Yes

o No

o No
o Yes

o No

(DD/MM/YYYY)
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(d)

(3)

Membership No. of the auditor

(4)

Name of the auditor (proprietorship/ ﬁrm)

(5)

Proprietorship/ﬁrm registration number

(6)

Permanent Account Number (PAN) of the auditor (proprietorship/ ﬁrm)

(7)

Date of audit report

If liable to furnish other audit report under the Income-tax Act, mention the date of furnishing the audit report? (DD/MM/YY) (Please see
Instruction 5(ii))

115JB

92E
(e)

Mention the Act, section and date of furnishing the audit report under any Act other than the Income-tax Act
(DD/MM/YY)

HOLDING STATUS

Act and section
(a)

Nature of company (write 1 if holding company, write 2 if a subsidiary company, write 3 if both, write 4 if any other)

(b)

If subsidiary company, mention the details of the Holding Company
PAN
Name of Holding Company
Address of Holding Company

Percentage of Shares held

If holding company, mention the details of the subsidiary companies
PAN
Name of Subsidiary Company
Address of Subsidiary Company

Percentage of Shares held

(c)

(a)

BUSINESS ORGANISATION

(b)

KEY PERSONS

Address of Resulting Company

Name of Resulting Company

In case of resulting company, mention the details of demerged company
PAN

SHAREHOLDERS
INFORMATION

Address of Amalgamating Company

Name of Amalgamating Company

In case of demerged company, mention the details of resulting company
PAN

(d)

Address of Amalgamated Company

Name of Amalgamated Company

In case of amalgamated company, mention the details of amalgamating company
PAN

(c)

o

In case of amalgamating company, mention the details of amalgamated company
PAN

OWNERSHIP
INFORMATION

(DD/MM/YY)

Act and section

Address of Demerged Company

Name of Demerged Company

Particulars of Managing Director, Directors, Secretary and Principal ofﬁcer(s) who have held the ofﬁce during the previous year
Director Identiﬁcation Number
S.No.
Name
Designation
Residential Address
PAN
(DIN) issued by MCA, in case
of Director

Particulars of persons who were beneﬁcial owners of shares holding not less than 10% of the voting power at any time of the previous year
S.No.

Name and Address

Percentage of shares held

PAN (if allotted)

In case of unlisted company, particulars of natural persons who were the ultimate beneﬁcial owners, directly or indirectly, of shares holding not
less than 10% of the voting power at any time of the previous year (if available)
S.No.

Name and Address

Percentage of shares held

PAN (if allotted)

NATURE
OF
COMPAN
Y AND
ITS
BUSINESS

Nature of company

(Tick) þ

1

Whether a public sector company as deﬁned in section 2(36A) of the Income -tax Act

o Yes

o No

2

Whether a company owned by the Reserve Bank of India

o Yes

o No
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3

Whether a company in which not less than forty percent of the shares are held (whether singly or taken
together) by the Government or the Reserve Bank of India or a corporation owned by that Bank

o Yes

o No

4

Whether a banking company as deﬁned in clause (c) of section 5 of the Banking Regulation Act,1949

o Yes

o No

o Yes

o No

Whether a scheduled Bank being a bank included in the Second Schedule to the Reserve Bank of India
Act
Whether a company registered with Insurance Regulatory and Development Authority (established
under sub-section (1) of section 3 of the Insurance Regulatory and Development Authority Act, 1999)

5
6
7

Whether a company being a non-banking Financial Institution

o Yes

o No

o Yes

o No

Nature of business or profession, if more than one business or profession indicate the three main activities/ products
Code [Please see instruction No.7(i)]

S.No.

Description

(i)
(ii)
(iii)
BALANCE SHEET AS ON 31ST DAY OF MARCH, 2018 OR AS ON THE DATE OF AMALGAMATION

Part A-BS
I

Equity and Liabilities
1

Shareholder’s fund
A

Share capital
i

Authorised

Ai

ii Issued, Subscribed and fully Paid up

Aii

iii Subscribed but not fully paid

Aiii

iv Total (Aii + Aiii)
B

i

Capital Reserve

Bi

ii Capital Redemption Reserve

Bii

iii Securities Premium Reserve

Biii

iv Debenture Redemption Reserve

Biv

v

Revaluation Reserve

vi Share options outstanding amount
vii

EQUITY AND LIABILITIES

Aiv

Reserves and Surplus

Bv
Bvi

Other reserve (specify nature and amount)
a

viia

b

viib

c

Total (viia + viib)

Bvii

Surplus i.e. Balance in proﬁt and loss account (Debit balance
viii
Bviii
to be shown as –ve ﬁgure)
ix

Total (Bi + Bii + Biii + Biv + Bv + Bvi + Bvii + Bviii) (Debit balance to be shown as –ve ﬁgure)

Bix

C Money received against share warrants

1C

D Total Shareholder’s fund (Aiv + Bix + 1C)

1D

2 Share application money pending allotment
i Pending for less than one year

i

ii Pending for more than one year

ii

iii Total (i + ii)

2

3 Non-current liabilities
A Long-term borrowings
i

ii

Bonds/ debentures
a

Foreign currency

ia

b

Rupee

ib

c

Total (ia + ib)

ic

Term loans
a

Foreign currency

b

Rupee loans
1

From Banks

iia

b1
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c

2

From others

b2

3

Total (b1 + b2)

b3

Total Term loans (iia + b3)

iic

iii Deferred payment liabilities

iii

iv Deposits from related parties (see instructions)

iv

v

Other deposits

v

vi Loans and advances from related parties (see instructions)

vi

vii Other loans and advances

vii

viii Long term maturities of ﬁnance lease obligations

viii

ix Total Long term borrowings (ic + iic + iii + iv + v + vi + vii + viii)
B Deferred tax liabilities (net)

3A
3B

C Other long-term liabilities
i

Trade payables

i

ii

Others

ii

iii Total Other long-term liabilities (i + ii)

3C

D Long-term provisions
i

Provision for employee beneﬁts

i

ii

Others

ii

iii Total (i + ii)

3D

E Total Non-current liabilities (3A + 3B + 3C + 3D)

3E

4 Current liabilities
A Short-term borrowings
i

Loans repayable on demand
a From Banks

ia

b From Non-Banking Finance Companies

ib

c From other ﬁnancial institutions

ic

d From others

id

e Total Loans repayable on demand (ia + ib + ic + id)
ii

ie

Deposits from related parties (see instructions)

ii

iii Loans and advances from related parties (see instructions)

iii

iv Other loans and advances

iv

v

Other deposits

v

vi Total Short-term borrowings (ie + ii + iii + iv + v)

4A

B Trade payables
i

Outstanding for more than 1 year

ii Others

i
ii

iii Total Trade payables (i + ii)
C

4B

Other current liabilities
i

Current maturities of long-term debt

i

ii

Current maturities of ﬁnance lease obligations

ii

iii Interest accrued but not due on borrowings

iii

iv Interest accrued and due on borrowings

iv

v

Income received in advance

vi Unpaid dividends
vii

Application money received for allotment of securities and
due for refund and interest accrued

viii Unpaid matured deposits and interest accrued thereon

v
vi
vii
viii

ix Unpaid matured debentures and interest accrued thereon

ix

x

x

Other payables

xi Total Other current liabilities (i + ii + iii + iv + v + vi + vii + viii + ix + x)
D

4C

Short-term provisions
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i

Provision for employee beneﬁt

i

ii

Provision for Income-tax

ii

iii Proposed Dividend

iii

iv Tax on dividend

iv

v

v

Other

vi Total Short-term provisions (i + ii +iii + iv + v)

4D

E Total Current liabilities (4A + 4B + 4C + 4D)

4E

Total Equity and liabilities (1D + 2 + 3E + 4E)
II

I

ASSETS
1

Non-current assets
A

Fixed assets
i

ii

Tangible assets
a

Gross block

ia

b

Depreciation

ib

c

Impairment losses

ic

d

Net block (ia – ib - ic)

id

Intangible assets
a

Gross block

iia

b

Amortization

iib

c

Impairment losses

iic

d

Net block (iia – iib - iic)

iid

iii Capital work-in-progress

iii

iv Intangible assets under development

iv

v Total Fixed assets (id + iid + iii + iv)

Av

B Non-current investments
i

Investment in property

i

ii Investments in Equity instruments
a

Listed equities

iia

b Unlisted equities

iib

c

iic

Total (iia + iib)

iii Investments in Preference shares

iii

iv Investments in Government or trust securities

iv

v Investments in Debenture or bonds

v

vi Investments in Mutual funds

vi

vii Investments in Partnership ﬁrms

vii

viii Others Investments

viii

ix

Total Non-current investments (i + iic + iii + iv + v + vi + vii + viii)

C Deferred tax assets (Net)

Bix
C

D Long-term loans and advances
Capital advances

i

ii Security deposits

i

ii

iii Loans and advances to related parties (see instructions)

iii

iv Other Loans and advances

iv

v Total Long-term loans and advances (i + ii + iii + iv)

Dv

vi Long-term loans and advances included in Dv which is
a
b
c

for the purpose of business or profession

via

not for the purpose of business or profession

vib

given to shareholder, being the beneﬁcial owner of
share, or to any concern or on behalf/ beneﬁt of such
shareholder as per section 2(22)(e) of I.T. Act

vic

E Other non-current assets
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i

Long-term trade receivables
a Secured, considered good

ia

b Unsecured, considered good

ib

c Doubtful

ic

d Total Other non-current assets (ia + ib + ic)

id

ii Others

ii

iii Total (id + ii)
Non-current assets included in Eiii which is due from
shareholder, being the beneﬁcial owner of share, or from
iv
any concern or on behalf/ beneﬁt of such shareholder as
per section 2(22)(e) of I.T. Act

Eiii
iv

F Total Non-current assets (Av + Bix + C + Dv + Eiii)
2

1F

Current assets
A

Current investments
i

Investment in Equity instruments
a Listed equities

ia

b Unlisted equities

ib

c Total (ia + ib)

ic

ii Investment in Preference shares

ii

iii Investment in government or trust securities

iii

iv Investment in debentures or bonds

iv

v

Investment in Mutual funds

v

vi Investment in partnership ﬁrms

vi

vii Other investment

vii

viii Total Current investments (ic + ii + iii + iv + v + vi + vii)
B

Aviii

Inventories
i

Raw materials

i

ii

Work-in-progress

ii

iii

Finished goods

iii

iv

Stock-in-trade (in respect of goods acquired for trading)

iv

v

Stores and spares

v

vi

Loose tools

vi

vii Others

vii

viii Total Inventories (i + ii + iii + iv + v + vi + vii)
C

D

E

Bviii

Trade receivables
i

Outstanding for more than 6 months

i

ii

Others

ii

iii

Total Trade receivables (i + ii + iii)

Ciii

Cash and cash equivalents
i

Balances with Banks

i

ii

Cheques, drafts in hand

ii

iii

Cash in hand

iii

iv

Others

iv

v

Total Cash and cash equivalents (i + ii + iii + iv)

Dv

Short-term loans and advances
i

Loans and advances to related parties (see instructions)

i

ii

Others

ii

iii

Total Short-term loans and advances (i + ii)

iv

Short-term loans and advances included in Eiii which is

Eiii

a

for the purpose of business or profession

iva

b

not for the purpose of business or profession

ivb
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given to a shareholder, being the beneﬁcial owner
of share, or to any concern or on behalf/ beneﬁt of
such shareholder as per section 2(22)(e) of I.T. Act

c

F

Other current assets

G

Total Current assets (Aviii + Bviii + Ciii + Dv + Eiii + F)

ivc

F
2G

Total Assets (1F + 2G)

Part A-BS – Ind AS
I

II

BALANCE SHEET AS ON 31ST DAY OF MARCH, 2018 OR AS ON THE DATE OF BUSINESS COMBINATION [applicable for
a company whose ﬁnancial statements are drawn up in compliance to the Indian Accounting Standards speciﬁed in Annexure to the
companies (Indian Accounting Standards) Rules, 2015]

Equity and Liabilities
1 Equity
A Equity share capital
i

Authorised

Ai

ii Issued, Subscribed and fully paid up

Aii

iii Subscribed but not fully paid

Aiii

iv Total (Aii + Aiii)

Aiv

B Other Equity
i

Other Reserves
a Capital Redemption Reserve

ia

b Debenture Redemption Reserve

ib

c Share Options Outstanding account

ic

d Other (specify nature and amount)

id

e Total other reserves (ia + ib + ic + id)

ie

Retained earnings (Debit balance of statement of P&L to be
ii
shown as –ve ﬁgure)
iii

ii

Total (Bie + ii) (Debit balance to be shown as –ve ﬁgure)

Biii

C Total Equity (Aiv + Biii)

1C

2 Liabilities
A Non-current liabilities
I

Financial Liabilities
Borrowings
a

Bonds or debentures
1 Foreign currency

a1

2 Rupee

a2

3 Total (1 + 2)
b

a3

Term loans
1 Foreign currency

b1

2 Rupee loans
i From Banks

i

ii From other parties

ii

iii Total (i + ii)

b2

3 Total Term loans (b1 + b2)

b3

c

Deferred payment liabilities

c

d

Deposits

d

e

Loans from related parties (see instructions)

e

f

Long term maturities of ﬁnance lease obligations

f

g

Liability component of compound ﬁnancial instruments

g

h

Other loans

h

i

Total borrowings (a3 + b3 + c + d + e + f + g + h)

i

j

Trade Payables

j

k

Other ﬁnancial liabilities (Other than those speciﬁed in II under provisions)

k

II Provisions
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a

Provision for employee beneﬁts

a

b

Others (specify nature)

b

c

Total Provisions

IIc

III Deferred tax liabilities (net)

III

IV Other non-current liabilities
a

Advances

a

b

Others (specify nature)

b

c

Total Other non-current liabilities

IVc

Total Non-Current Liabilities (Ii + Ij + Ik + IIC + III + IVc)

2A

B Current liabilities
I

Financial Liabilities
i

Borrowings
a Loans repayable on demand
1 From Banks

1

2 From Other parties

2

3 Total Loans repayable on demand (1 + 2)

3

b Loans from related parties

b

c Deposits

c

d Other loans (specify nature)

d

Total Borrowings (a3 + b + c + d)

Ii

ii Trade payables

Iii

iii Other ﬁnancial liabilities
a Current maturities of long-term debt

a

b Current maturities of ﬁnance lease obligations

b

c Interest accrued

c

d Unpaid dividends

d

Application money received for allotment of securities
to the extent refundable and interest accrued thereon

e

f Unpaid matured deposits and interest accrued thereon

f

e

Unpaid matured debentures and interest accrued
g
thereon

g

h Others (specify nature)

h

i Total Other ﬁnancial liabilities (a + b +c +d +e +f +g+ h)

Iiii

iv Total Financial Liabilities (Ii + Iii + Iiii)

Iiv

II Other Current liabilities
a Revenue received in advance

a

b Other advances (specify nature)

b

c Others (specify nature)

c

d Total Other current liabilities (a + b+ c)

IId

III Provisions
a Provision for employee beneﬁts

a

b Others (specify nature)

b

c Total provisions (a + b)

IIIc

IV Current Tax Liabilities (Net)

IV

Total Current liabilities (Iiv + IId + IIIc+ IV)

2B

Total Equity and liabilities (1C + 2A +2B)
II

I

ASSETS
1 Non-current assets
A Property, Plant and Equipment
a

Gross block

a

b Depreciation

b

c

c

Impairment losses
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d Net block (a – b - c)

Ad

B Capital work-in-progress

B

C Investment Property
a Gross block

a

b Depreciation

b

c Impairment losses

c

d Net block (a – b - c)

Cd

D Goodwill
a

Gross block

b Impairment losses
c

a
b

Net block (a – b )

Dc

E Other Intangible Assets
a

Gross block

a

b Amortisation

b

c

c

Impairment losses

d Net block (a – b - c)

Ed

F Intangible assets under development

F

G Biological assets other than bearer plants
a

Gross block

b Impairment losses
c

a
b

Net block (a – b )

Gc

H Financial Assets
I

Investments

i

Investments in Equity instruments
a Listed equities

ia

b Unlisted equities

ib

c Total (ia + ib)

ic

ii Investments in Preference shares

ii

iii Investments in Government or trust securities

iii

iv Investments in Debenture or bonds

iv

v

Investments in Mutual funds

v

vi Investments in Partnership ﬁrms

vi

vii Others Investments (specify nature)

vii

viii Total non-current investments (ic + ii + iii + iv + v + vi + vii)

HI

II Trade Receivables
a Secured, considered good

a

b Unsecured, considered good

b

c Doubtful

c

d Total Trade receivables

HII

III Loans
i Security deposits

i

ii Loans to related parties (see instructions)

ii

iii Other loans (specify nature)

iii

iv Total Loans (i + ii + iii)

HIII

v Loans included in HIII above which is-

IV

a for the purpose of business or profession

va

b not for the purpose of business or profession

vb

given to shareholder, being the beneﬁcial owner of
c share, or to any concern or on behalf/ beneﬁt of
such shareholder as per section 2(22)(e) of I.T. Act

vc

Other Financial Assets
i Bank Deposits with more than 12 months maturity

i
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ii Others

ii

iii Total of Other Financial Assets (i + ii)
I

HIV

Deferred Tax Assets (Net)

I

J Other non-current Assets
i

Capital Advances

i

ii Advances other than capital advances

ii

iii Others (specify nature)

iii

iv Total non-current assets (i + ii + iii)

J

Non-current assets included in J above which is due from
shareholder, being the beneﬁcial owner of share, or from
any concern or on behalf/ beneﬁt of such shareholder as
per section 2(22)(e) of I.T. Act

v

v

Total Non-current assets (Ad + B + Cd + Dc + Ed + F + Gc + HI + HII + HIII + HIV + I + J)

1

2 Current assets
A

Inventories
i

Raw materials

i

ii

Work-in-progress

ii

iii

Finished goods

iii

iv

Stock-in-trade (in respect of goods acquired for trading)

iv

v

Stores and spares

v

vi

Loose tools

vi

vii Others

vii

viii Total Inventories (i + ii + iii + iv + v + vi + vii)
B

Financial Assets

I

Investments

2A

i Investment in Equity instruments
a Listed equities

ia

b Unlisted equities

ib

c Total (ia + ib)

ic

ii Investment in Preference shares

ii

iii Investment in government or trust securities

iii

iv Investment in debentures or bonds

iv

v Investment in Mutual funds

v

vi Investment in partnership ﬁrms

vi

vii Other Investments

vii

viii Total Current investments (ic + ii + iii + iv + v + vi + vii)
II

I

Trade receivables
i

Secured, considered good

i

ii

Unsecured, considered good

ii

iii

Doubtful

iii

iv

Total Trade receivables (i + ii + iii)

II

III Cash and cash equivalents
i

Balances with Banks (of the nature of cash and cash
equivalents)

i

ii

Cheques, drafts in hand

ii

iii

Cash on hand

iii

iv

Others (specify nature)

iv

v

Total Cash and cash equivalents (i + ii + iii + iv)

III

IV Bank Balances other than III above
V

IV

Loans
i

Security Deposits

i

ii

Loans to related parties (see instructions)

ii

iii

Others(specify nature)

iii
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iv

Total loans (i + ii + iii)

v

Loans and advances included in V above which is-

V

a for the purpose of business or profession

va

b not for the purpose of business or profession

vb

given to a shareholder, being the beneﬁcial owner
c of share, or to any concern or on behalf/ beneﬁt of
such shareholder as per section 2(22)(e) of I.T. Act

vc

VI Other Financial Assets

VI

Total Financial Assets (I + II + III + IV + V + VI)
C

Current Tax Assets (Net)

D

Other current assets
i

Advances other than capital advances

ii Others(specify nature)

2B
2C

i
ii

iii Total

2D

Total Current assets (2A + 2B + 2C + 2D)

2

Total Assets (1 + 2)

II

Proﬁt and Loss Account for the ﬁnancial year 2017-18 (ﬁll items 1 to 52 in a case where regular books of accounts are maintained,
otherwise ﬁll item 53)

Part A-P& L

1 Revenue from operations
A Sales/ Gross receipts of business (net of returns and refunds and duty or tax, if any)
i

Sale of products/goods

ii Sale of services

I
Ii

iii Other operating revenues (specify nature and amount)
a

Iiia

b

Iiib

CREDITS TO PROFIT AND LOSS ACCOUNT

c

Total (iiia + iiib)

Iiic

iv Interest (in case of ﬁnance company)

Iv

v Other ﬁnancial services (in case of ﬁnance company

V
Avi

vi Total (i + ii + iiic + iv + v)
B Duties, taxes and cess received or receivable in respect of goods and services sold or supplied
i

Union Excise duties

i

ii Service tax

ii

iii VAT/ Sales tax

iii

iv Central Goods & Service Tax (CGST)

iv

v State Goods & Services Tax (SGST)

v

vi Integrated Goods & Services Tax (IGST)

vi

vii Union Territory Goods & Services Tax (UTGST)

vi

viii Any other duty, tax and cess

viii
Bix

ix Total (i + ii + iii + iv + v + vi + vii + viii)

1C

C Total Revenue from operations (Avi + Bix)
2 Other income
i

Interest income (in case of a company, other than a ﬁnance
company)

I

ii Dividend income

Ii

iii Proﬁt on sale of ﬁxed assets

iii

iv

Proﬁt on sale of investment being securities chargeable to
iv
Securities Transaction Tax (STT)

v

Proﬁt on sale of other investment

vi Rent

v
vi

vii Commission

vii

viii Proﬁt on account of currency ﬂuctuation

viii

ix Agricultural income

ix
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x

Any other income (specify nature and amount)
a

xa

b

xb

c Total (xa + xb)

xc
2xi

xi Total of other income (i + ii + iii + iv + v + vi + vii + viii + ix + xc)
3 Closing Stock
Raw material

3i

ii Work-in-progress

i

3ii

iii Finished goods

3iii
3iv

Total (3i + 3ii + 3iii)

4

DEBITS TO PROFIT AND LOSS
ACCOUNT

4 Total of credits to proﬁt and loss account (1C + 2xi + 3iv)
5 Opening Stock
Raw material

5i

ii Work-in-progress

i

5ii

iii Finished goods

5iii
5iv

iv Total (5i + 5ii + 5iii)

6

6 Purchases (net of refunds and duty or tax, if any)
7 Duties and taxes, paid or payable, in respect of goods and services purchased
i

Custom duty

7i

ii Counter veiling duty

7ii

iii Special additional duty

7iii

iv Union excise duty

7iv

v Service tax

7v

vi VAT/ Sales tax

7vi

vii Central Goods & Service Tax (CGST)

7vii

viii State Goods & Services Tax (SGST)

7viii

ix Integrated Goods & Services Tax (IGST)

7ix

x Union Territory Goods & Services Tax (UTGST)

7x

xi Any other tax, paid or payable

7xi
7xii

7xii Total (7i + 7ii + 7iii + 7iv + 7v + 7vi + 7vii+7viii+7ix+7x+7xi)
8 Freight

8

9 Consumption of stores and spare parts

9

10 Power and fuel

10

11 Rents

11

12 Repairs to building

12

13 Repairs to plant, machinery or furniture

13

14 Compensation to employees
i

Salaries and wages

14i

ii Bonus

14ii

iii Reimbursement of medical expenses

14iii

iv Leave encashment

14iv

v Leave travel beneﬁts

14v

vi Contribution to approved superannuation fund

14vi

vii Contribution to recognised provident fund

14vii

viii Contribution to recognised gratuity fund

14viii

ix Contribution to any other fund

14ix

Any other beneﬁt to employees in respect of which an
14x
expenditure has been incurred
Total compensation to employees (14i + 14ii + 14iii + 14iv + 14v + 14vi + 14vii + 14viii + 14ix +
xi
14x)
Whether any compensation, included in 14xi, paid to nonxii
xiia
Yes / No
resident
x

If Yes, amount paid to non-residents

14xi

xiib
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15 Insurance
i

Medical Insurance

15i

ii Life Insurance

15ii

iii Keyman’s Insurance

15iii

iv Other Insurance including factory, ofﬁce, car, goods, etc.

15iv

v

Total expenditure on insurance (15i + 15ii + 15iii + 15iv)

15v

16 Workmen and staff welfare expenses

16

17 Entertainment

17

18 Hospitality

18

19 Conference

19

20 Sales promotion including publicity (other than advertisement)

20

21 Advertisement

21

22 Commission
Paid outside India, or paid in India to a non-resident other
than a company or a foreign company

i

ii To others

i
ii

iii Total (i + ii)

22iii

23 Royalty
Paid outside India, or paid in India to a non-resident other
than a company or a foreign company

i

ii To others

i
ii

iii Total (i + ii)

23iii

24 Professional / Consultancy fees / Fee for technical services
Paid outside India, or paid in India to a non-resident other
than a company or a foreign company

i

ii To others

i
ii

iii Total (i + ii)

24iii

25 Hotel, boarding and Lodging

25

26 Traveling expenses other than on foreign traveling

26

27 Foreign traveling expenses

27

28 Conveyance expenses

28

29 Telephone expenses

29

30 Guest House expenses

30

31 Club expenses

31

32 Festival celebration expenses

32

33 Scholarship

33

34 Gift

34

35 Donation

35

36 Rates and taxes, paid or payable to Government or any local body (excluding taxes on income)
i

Union excise duty

ii Service tax

36i
36ii

iii VAT/ Sales tax

36ii

iv Cess

36iv

v

Central Goods & Service Tax (CGST)

36v

vi State Goods & Services Tax (SGST)

36vi

vii Integrated Goods & Services Tax (IGST)

36vii

viii Union Territory Goods & Services Tax (UTGST)

36vii
i

ix Any other rate, tax, duty or cess incl. STT and CTT
x

36ix

Total rates and taxes paid or payable (36i + 36ii + 36iii + 36iv + 36v + 36vi + 36vii + 36viii+ 36ix)

37 Audit fee

36x
37

38 Other expenses (specify nature and amount)
i

i

ii

ii
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iii Total (i + ii)

38iii

Bad debts written off (specify PAN of the person, if it is available, for whom Bad Debt for amount of Rs. 1
39
lakh or more is claimed and amount)
i

39i

ii

39ii

iii

39iii

Others (more than Rs. 1 lakh) where PAN is
iv
not available

39iv

v

39v

Others (amounts less than Rs. 1 lakh)

vi Total Bad Debt (39i + 39ii + 39iii + 39iv + 39v)

39vi

40 Provision for bad and doubtful debts

40

41 Other provisions

41

Proﬁt before interest, depreciation and taxes [4 – (5iv + 6 + 7xii + 8 to 13 + 14xi + 15v + 16 to 21 + 22iii +
42
23iii + 24iii + 25 to 35 + 36x + 37 + 38iii + 39vi + 40 + 41)]

42

43 Interest
i

Paid outside India, or paid in India to a non-resident other
than a company or a foreign company

i

ii

To others

ii

NO ACCOUNT
CASE

PROVISIONS FOR TAX AND APPROPRIATIONS

iii Total (i + ii)

43iii

44 Depreciation and amortization

44

45 Proﬁt before taxes (42 – 43iii – 44)

45

46 Provision for current tax

46

47 Provision for Deferred Tax and deferred liability

47

48 Proﬁt after tax (45 - 46 - 47)

48

49 Balance brought forward from previous year

49

50 Amount available for appropriation (48 + 49)

50

51 Appropriations
Transfer to reserves and surplus

51i

ii Proposed dividend/ Interim dividend

i

51ii

iii Tax on dividend/ Tax on dividend for earlier years

51iii

Appropriation towards Corporate Social Responsibility (CSR)
iv activities (in case of companies covered under section 135 of 51iv
Companies Act, 2013)
v Any other appropriation

51v
51vi

vi Total (51i + 51ii + 51iii + 51iv+51v)

52

52 Balance carried to balance sheet (50-51vi)
In a case where regular books of account of business or profession are not maintained, furnish the
53
following information for previous year 2017-18 in respect of business or profession
a Gross receipts
b Gross proﬁt
c

53a
53b

Expenses

53c

d Net proﬁt

53d

Proﬁt and Loss Account for the ﬁnancial year 2017-18 (ﬁll items 1 to 54 in a case where regular books of accounts are maintained,
Part A-P& L – Ind AS otherwise ﬁll item 55) [applicable for a company whose ﬁnancial statements are drawn up in compliance to the Indian Accounting
Standards speciﬁed in Annexure to the companies (Indian Accounting Standards) Rules, 2015]

CREDITS TO PROFIT AND LOSS
ACCOUNT

1 Revenue from operations
A Sales/ Gross receipts of business (net of returns and refunds and duty or tax, if any)
i

Sale of products/goods

ii Sale of services

i
ii

iii Other operating revenues (specify nature and amount)
a

iiia

b

iiib

c

Total (iiia + iiib)

iiic

iv Interest (in case of ﬁnance company)

iv

v Other ﬁnancial services (in case of ﬁnance company

v

vi Total (i + ii + iiic + iv + v)

Avi
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B Duties, taxes and cess received or receivable in respect of goods and services sold or supplied
i

Union Excise duties

i

ii Service tax

ii

iii VAT/ Sales tax

iii

iv Central Goods & Service Tax (CGST)

iv

v State Goods & Services Tax (SGST)

v

vi Integrated Goods & Services Tax (IGST)

vi

vii Union Territory Goods & Services Tax (UTGST)

vii

viii Any other duty, tax and cess

viii
Bix

ix Total (i + ii + iii + iv + v + vi + vii + viii)

1C

C Total Revenue from operations (Avi + Bix)
2 Other income
i

Interest income (in case of a company, other than a ﬁnance
company)

ii

Dividend income

i
ii

iii Proﬁt on sale of ﬁxed assets

iii

iv

Proﬁt on sale of investment being securities chargeable to
iv
Securities Transaction Tax (STT)

v

Proﬁt on sale of other investment

v

vi Rent

vi

vii Commission

vii

viii Proﬁt on account of currency ﬂuctuation

viii

ix Agricultural income
x

ix

Any other income (specify nature and amount)
a

xa

b

xb

c Total (xa + xb)

xc
2xi

xi Total of other income (i + ii + iii + iv + v + vi + vii + viii + ix + xc)
3 Closing Stock
Raw material

3i

ii Work-in-progress

i

3ii

iii Finished goods

3iii
3iv

Total (3i + 3ii + 3iii)

4

DEBITS TO PROFIT AND LOSS
ACCOUNT

4 Total of credits to proﬁt and loss account (1C + 2xi + 3iv)
5 Opening Stock
Raw material

5i

ii Work-in-progress

i

5ii

iii Finished goods

5iii
5iv

iv Total (5i + 5ii + 5iii)

6

6 Purchases (net of refunds and duty or tax, if any)
7 Duties and taxes, paid or payable, in respect of goods and services purchased
i

Custom duty

7i

ii Counter veiling duty

7ii

iii Special additional duty

7iii

iv Union excise duty

7iv

v Service tax

7v

vi VAT/ Sales tax

7vi

vii Central Goods & Service Tax (GST)

7vii

viii State Goods & Services Tax (SGST)

7viii

ix Integrated Goods & Services Tax (IGST)

7ix

x Union Territory Goods & Services Tax (UTGST)

7x

xi Any other tax, paid or payable

7xi
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7xii

xii Total (7i + 7ii + 7iii + 7iv + 7v + 7vi + 7vii+7viii + 7ix + 7x + 7xi)
8 Freight

8

9 Consumption of stores and spare parts

9

10 Power and fuel

10

11 Rents

11

12 Repairs to building

12

13 Repairs to plant, machinery or furniture

13

14 Compensation to employees
i

Salaries and wages

14i

ii Bonus

14ii

iii Reimbursement of medical expenses

14iii

iv Leave encashment

14iv

v Leave travel beneﬁts

14v

vi Contribution to approved superannuation fund

14vi

vii Contribution to recognised provident fund

14vii

viii Contribution to recognised gratuity fund

14viii

ix Contribution to any other fund

14ix

Any other beneﬁt to employees in respect of which an
x
14x
expenditure has been incurred
Total compensation to employees (14i + 14ii + 14iii + 14iv + 14v + 14vi + 14vii + 14viii + 14ix +
xi
14x)
Whether any compensation, included in 14xi, paid to nonxii
xiia
Yes / No
resident
If Yes, amount paid to non-residents

14xi

xiib

15 Insurance
i

Medical Insurance

15i

ii Life Insurance

15ii

iii Keyman’s Insurance

15iii

iv Other Insurance including factory, ofﬁce, car, goods, etc.

15iv

v Total expenditure on insurance (15i + 15ii + 15iii + 15iv)

15v

16 Workmen and staff welfare expenses

16

17 Entertainment

17

18 Hospitality

18

19 Conference

19

20 Sales promotion including publicity (other than advertisement)

20

21 Advertisement

21

22 Commission
i

Paid outside India, or paid in India to a non-resident other
than a company or a foreign company

ii To others

i
ii

iii Total (i + ii)

22iii

23 Royalty
i

Paid outside India, or paid in India to a non-resident other
than a company or a foreign company

ii To others

i
ii

iii Total (i + ii)

23iii

24 Professional / Consultancy fees / Fee for technical services
i

Paid outside India, or paid in India to a non-resident other
than a company or a foreign company

ii To others
iii Total (i + ii)

i
ii
24iii

25 Hotel, boarding and Lodging

25

26 Traveling expenses other than on foreign traveling

26

27 Foreign traveling expenses

27

28 Conveyance expenses

28
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29 Telephone expenses

29

30 Guest House expenses

30

31 Club expenses

31

32 Festival celebration expenses

32

33 Scholarship

33

34 Gift

34

35 Donation

35

36 Rates and taxes, paid or payable to Government or any local body (excluding taxes on income)
i

Union excise duty

36i

ii Service tax

36ii

iii VAT/ Sales tax

36ii

iv Cess

36iv

v Goods & Service Tax (GST)

36v

vi State Goods & Services Tax (SGST)

36vi

vii Integrated Goods & Services Tax (IGST)

36vii

viii Union Territory Goods & Services Tax (UTGST)

36viii

ix Any other rate, tax, duty or cess incl. STT and CTT

36ix

x Total rates and taxes paid or payable (36i + 36ii + 36iii + 36iv + 36v + 36vi + 36vii + 36viii + 36ix)
37 Audit fee

36x
37

38 Other expenses (specify nature and amount)
i

i

ii

ii

iii Total (i + ii)

38iii

Bad debts written off (specify PAN of the person, if it is available, for whom Bad Debt for amount of Rs. 1
39
lakh or more is claimed and amount)
i

39i

ii

39ii

iii

39iii

Others (more than Rs. 1 lakh) where PAN is
iv
not available

39iv

v

39v

Others (amounts less than Rs. 1 lakh)

vi Total Bad Debt (39i + 39ii + 39iii + 39iv + 39v)

39vi

40 Provision for bad and doubtful debts

40

41 Other provisions

41

Proﬁt before interest, depreciation and taxes [4 – (5iv + 6 + 7xii + 8 to 13 + 14xi + 15v + 16 to 21 + 22iii +
42
23iii + 24iii + 25 to 35 + 36x + 37 + 38iii + 39vi + 40 + 41)]

42

43 Interest
i

Paid outside India, or paid in India to a non-resident other
than a company or a foreign company

i

ii

To others

ii

PROVISIONS FOR TAX AND
APPROPRIATIONS

iii Total (i + ii)

43iii

44 Depreciation and amortization

44

45 Proﬁt before taxes (42 – 43iii – 44)

45

46 Provision for current tax

46

47 Provision for Deferred Tax and deferred liability

47

48 Proﬁt after tax (45 - 46 - 47)

48

49 Balance brought forward from previous year

49

50 Amount available for appropriation (48 + 49)

50

51 Appropriations
Transfer to reserves and surplus

51i

ii Proposed dividend/ Interim dividend

i

51ii

iii Tax on dividend/ Tax on dividend for earlier years

51iii

Appropriation towards Corporate Social Responsibility (CSR)
iv activities (in case of companies covered under section 135 of 51iv
Companies Act, 2013)
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v Any other appropriation

51v
51vi

vi Total (51i + 51ii + 51iii + 51iv+51v)

52

52 Balance carried to balance sheet (50 – 51vi)
53 Other Comprehensive Income
A Items that will not be reclassiﬁed to P&L
i Changes in revaluation surplus

i

ii Re-measurements of the deﬁned beneﬁt plans

ii

iii Equity instruments through OCI

iii

Fair value Changes relating to own credit risk of ﬁnancial
liabilities designated at FVTPL
Share of Other comprehensive income in associates and joint
v
ventures , to the extent not to be classiﬁed to P&L

iv

iv

vi Others (Specify nature)

vi

vii Income tax relating to items that will not be reclassiﬁed to P&L

vii

v

53A

viii Total
B Items that will be reclassiﬁed to P&L
i

Exchange differences in translating the ﬁnancial statements of a
foreign operation

ii Debt instruments through OCI

i
ii

The effective portion of gains and loss on hedging instruments in
iii
a cash ﬂow hedge
Share of OCI in associates and joint ventures to the extent to be
iv
iv
classiﬁed into P&L

iii

v Others (Specify nature)

v

vi Income tax relating to items that will be reclassiﬁed to P&L

vi
53B

vii Total

54

54 Total Comprehensive Income (48 + 53A + 53B)

NO ACCOUNT
CASE

In a case where regular books of account of business or profession are not maintained, furnish the
55
following information for previous year 2017-18 in respect of business or profession
a Gross receipts

55a

b Gross proﬁt

55b

c

Expenses

55c

d Net proﬁt

55d

Other Information (optional in a case not liable for audit under section 44AB)

Part A- OI

1 Method of accounting employed in the previous year (Tick) þ

o mercantile

o cash

2 Is there any change in method of accounting

o Yes

o No

(Tick) þ

Increase in the proﬁt or decrease in loss because of deviation, if any, as per Income Computation
Disclosure Standards notiﬁed under section 145(2) [column 11 a(iii) of Schedule ICDS]
Decrease in the proﬁt or increase in loss because of deviation, if any, as per Income Computation
3b
Disclosure Standards notiﬁed under section 145(2) [column 11b(iii) of Schedule ICDS]
3a

3a
3b

OTHER INFORMATION

4 Method of valuation of closing stock employed in the previous year
a Raw Material (if at cost or market rates whichever is less write 1, if at cost write 2, if at market rate write 3)

¨

b Finished goods (if at cost or market rates whichever is less write 1, if at cost write 2, if at market rate write 3)

¨

c Is there any change in stock valuation method

(Tick) þ

o Yes

o No

d Increase in the proﬁt or decrease in loss because of deviation, if any, from the method of valuation
speciﬁed under section 145A
e Decrease in the proﬁt or increase in loss because of deviation, if any, from the method of valuation
speciﬁed under section 145A

4d
4e

5 Amounts not credited to the proﬁt and loss account, being a the items falling within the scope of section 28
b the proforma credits, drawbacks, refund of duty of customs or
excise or service tax, or refund of sales tax or value added tax, or
refund of GST, where such credits, drawbacks or refunds are
admitted as due by the authorities concerned
c escalation claims accepted during the previous year

5a
5b
5c

d any other item of income

5d

e capital receipt, if any

5e

f

Total of amounts not credited to proﬁt and loss account (5a+5b+5c+5d+5e)

5f
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6 Amounts debited to the proﬁt and loss account, to the extent disallowable under section 36 due to nonfulﬁlment of condition speciﬁed in relevant clauses Premium paid for insurance against risk of damage or
a
6a
destruction of stocks or store [36(1)(i)]
Premium paid for insurance on the health of employees
[36(1)(ib)]
Any sum paid to an employee as bonus or commission for services
c rendered, where such sum was otherwise payable to him as
proﬁts or dividend [36(1)(ii)]
Any amount of interest paid in respect of borrowed capital
d
[36(1)(iii)]
b

e Amount of discount on a zero-coupon bond [36(1)(iiia)]
Amount of contributions to a recognised provident fund
[36(1)(iv)]
Amount of contributions to an approved superannuation fund
g
[36(1)(iv)]
Amount of contribution to a pension scheme referred to in section
h
80CCD [36(1)(iva)]
f

6b
6c
6d
6e
6f
6g
6h

i

Amount of contributions to an approved gratuity fund [36(1)(v)]

6i

j

Amount of contributions to any other fund

6j

Any sum received from employees as contribution to any
provident fund or superannuation fund or any fund set up under
k ESI Act or any other fund for the welfare of employees to the
extent not credited to the employees account on or before the due
date [36(1)(va)]

6k

Amount of bad and doubtful debts [36(1)(vii)]

6l

m Provision for bad and doubtful debts [36(1)(viia)]

6m

n Amount transferred to any special reserve [36(1)(viii)]

6n

l

Expenditure for the purposes of promoting family planning
amongst employees [36(1)(ix)]
Amount of securities transaction paid in respect of transaction in
p securities if such income is not included in business income
[36(1)(xv)]
o

q Any other disallowance

6o
6p
6q

r Total amount disallowable under section 36 (total of 6a to 6q)
s

6r

Total number of employees employed by the company (mandatory in case company has recognized
Provident Fund)
i deployed in India
i
ii deployed outside India

ii

iii Total

iii

7 Amounts debited to the proﬁt and loss account, to the extent disallowable under section 37
a Expenditure of capital nature [37(1)]

7a

b Expenditure of personal nature [37(1)]

7b

Expenditure laid out or expended wholly and exclusively NOT for the
purpose of business or profession [37(1)]
Expenditure on advertisement in any souvenir, brochure, tract,
d
pamphlet or the like, published by a political party [37(2B)]
Expenditure by way of penalty or ﬁne for violation of any law for the
e
time being in force
c

7d
7e

f

Any other penalty or ﬁne

7f

g

Expenditure incurred for any purpose which is an offence or which is
prohibited by law

7g

h Expenditure incurred on corporate social responsibility (CSR)

8

7c

7h

i

Amount of any liability of a contingent nature

7i

j

Any other amount not allowable under section 37

7j

k Total amount disallowable under section 37 (total of 7a to 7j)
A. Amounts debited to the proﬁt and loss account, to the extent disallowable under section 40
Amount disallowable under section 40 (a)(i), on account of
a
Aa
non-compliance with the provisions of Chapter XVII-B
Amount disallowable under section 40(a)(ia) on account of
b
Ab
non-compliance with the provisions of Chapter XVII-B
Amount disallowable under section 40(a)(ib) on account of
c non-compliance with the provisions of Chapter VIII of the
Ac
Finance Act, 2016
Amount disallowable under section 40(a)(iii) on account of
d
Ad
non-compliance with the provisions of Chapter XVII-B
e Amount of tax or rate levied or assessed on the basis of
Ae
proﬁts [40(a)(ii)]
f Amount paid as wealth tax [40(a)(iia)]
Af

7k
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g Amount paid by way of royalty, license fee, service fee etc. as
per section 40(a)(iib)
h Amount of interest, salary, bonus, commission or
remuneration paid to any partner or member [40(b)]
i Any other disallowance
j
B.

Ag
Ah
Ai

Total amount disallowable under section 40(total of Aa to Ai )

Aj

Any amount disallowed under section 40 in any preceding previous year but allowable during the
previous year

8B

9 Amounts debited to the proﬁt and loss account, to the extent disallowable under section 40A
a Amounts paid to persons speciﬁed in section 40A(2)(b)

9a

Amount paid otherwise than by account payee cheque or account
b payee bank draft or use of electronic clearing system through a
bank account, disallowable under section 40A(3)

9b

c Provision for payment of gratuity [40A(7)]

9c

any sum paid by the assessee as an employer for setting up or as
d contribution to any fund, trust, company, AOP, or BOI or society
or any other institution [40A(9)]

9d

e Any other disallowance

9e

f
10

Total amount disallowable under section 40A

9f

Any amount disallowed under section 43B in any preceding previous year but allowable during the previous
year
a Any sum in the nature of tax, duty, cess or fee under any law
b
c
d

e
f

Any sum payable by way of contribution to any provident fund or
superannuation fund or gratuity fund or any other fund for the
welfare of employees
Any sum payable to an employee as bonus or commission for
services rendered
Any sum payable as interest on any loan or borrowing from any
public ﬁnancial institution or a State ﬁnancial corporation or a
State Industrial investment corporation
Any sum payable as interest on any loan or borrowing from any
scheduled bank or a co-operative bank other than a primary
agricultural credit society or a primary co-operative agricultural
and rural development bank
Any sum payable towards leave encashment

Any sum payable to the Indian Railways for the use of railway
g
assets

10a
10b
10c
10d

10e
10f
10g

h Total amount allowable under section 43B (total of 10a to 10g )

10h

11 Any amount debited to proﬁt and loss account of the previous year but disallowable under section 43B
a Any sum in the nature of tax, duty, cess or fee under any law
b Any sum payable by way of contribution to any provident fund or
superannuation fund or gratuity fund or any other fund for the
welfare of employees
c Any sum payable to an employee as bonus or commission for
services rendered
d Any sum payable as interest on any loan or borrowing from any
public ﬁnancial institution or a State ﬁnancial corporation or a
State Industrial investment corporation
e Any sum payable as interest on any loan or borrowing from any
scheduled bank or a co-operative bank other than a primary
agricultural credit society or a primary co-operative agricultural
and rural development bank
f Any sum payable towards leave encashment
g

Any sum payable to the Indian Railways for the use of railway
assets

11a
11b
11c
11d

11e
11f
11g

h Total amount disallowable under Section 43B(total of 11a to 11g)

11h

12 Amount of credit outstanding in the accounts in respect of
a Union Excise Duty

12a

b Service tax

12b

c VAT/sales tax

12c

d Central Goods & Service Tax (CGST)

12d

e State Goods & Services Tax (SGST)

12e

f

Integrated Goods & Services Tax (IGST)

12f

g Union Territory Goods & Services Tax (UTGST)

12g

h Any other tax

12h

i

Total amount outstanding (total of 12a to 12h)

12i
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13 Amounts deemed to be proﬁts and gains under section 33AB or 33ABA or 33AC

13

14 Any amount of proﬁt chargeable to tax under section 41

14

15 Amount of income or expenditure of prior period credited or debited to the proﬁt and loss account (net)

15

Part A – QD

Quantitative details (optional in a case not liable for audit under section 44AB)

(a) In the case of a trading concern
1

Opening stock

1

2

Purchase during the previous year

2

3

Sales during the previous year

3

4

Closing stock

4

5

Shortage/ excess, if any

5

(b) In the case of a manufacturing concern

QUANTITATIVE DETAILS

6

7

Part A – OL

Raw materials
a Opening stock

6a

b Purchases during the previous year

6b

c Consumption during the previous year

6c

d Sales during the previous year

6d

e Closing stock
f Yield ﬁnished products

6e

g Percentage of yield

6g

6f

h Shortage/ excess, if any
Finished products/ By-products

6h

a opening stock

7a

b purchase during the previous year

7b

c quantity manufactured during the previous year

7c

d sales during the previous year

7d

e closing stock

7e

f shortage/ excess, if any

7f

Receipt and payment account of company under liquidation

1 Opening balance

Receipt and payment account of company under liquidation

i

Cash in hand

1i

ii Bank

1ii

iii Total opening balance

1iii

2 Receipts
i Interest

2i

ii Dividend

2ii

iii Sale of assets (pls. specify nature and amount)
a

2iiia

b

2iiib

c

2iiic

d Total (iiia + iiib + iiic)

2iiid

iv Realisation of dues/debtors

2iv

v Others (pls. specify nature and amount)
a

2va

b

2vb

c

Total of other receipts (va + vb)

vi Total receipts (2i + 2ii + 2iiid+ 2iv + 2vc)

2vc
2vi

3 Total of opening balance and receipts

3

4 Payments
i Repayment of secured loan

4i

ii Repayment of unsecured loan

4ii
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iii Repayment to creditors

4iii

iv Commission

4iv

v Others (pls. specify)
a

4va

b

4vb

c Total of other payments (4va + 4vb)

4vc

vi Total payments (4i + 4ii + 4iii + 4iv + 4vc)
5

6

4vi

Closing balance
i Cash in hand

5i

ii Bank

5ii

iii Total of closing balance (5i + 5ii)

5iii

Total of closing balance and payments (4vi + 5iii)

6

• Part B, is divided into two parts. The first part (Part B-TI) is the summary of income computed
undervariousheadsandassetoffinScheduleCFLAandScheduleBFLA.Thesecondpart(Part
B-TTI)showsliabilityontotalincomeinrespectofincomechargeabletotax.
Part B - TI

Computation of total income

1

Income from house property (3b of Schedule-HP) (enter nil if loss)

2

Proﬁts and gains from business or profession

1

i

Proﬁts and gains from business other than speculative business and
2i
speciﬁed business (A39 of Schedule BP) (enter nil if loss)
Proﬁts and gains from speculative business (B43 of Schedule BP) (enter 2ii
nil if loss and take the ﬁgure to schedule CFL)
iii Proﬁts and gains from speciﬁed business ( C49 of Schedule BP)(enter nil 2iii
if loss and take the ﬁgure to schedule CFL)
iv Income from patent u/s 115BBF (3d of Schedule BP)
2iv
ii

3

v

Income from transfer of carbon credits u/s 115BBG (3e of Schedule BP) 2v

vi

Total (2i + 2ii+2iii + 2iv + 2v)

a

TOTAL INCOME

b

c
4

2vi

Capital gains
Short term
i

Short-term chargeable @ 15% (7ii of item E of schedule CG)

ai

ii

Short-term chargeable @ 30% (7iii of item E of schedule CG)

aii

iii

Short-term chargeable at applicable rate (7iv of item E of schedule
aiii
CG)

iv

Total Short-term (ai + aii + aiii)

3aiv

Long-term
i

Long-term chargeable @ 10% (7v of item E of schedule CG)

bi

ii

Long-term chargeable @ 20% (7vi of item E of schedule CG)

bii

iii

Total Long-term (bi + bii) (enter nil if loss)

biii

Total capital gains (3aiv + 3biii) (enter nil if loss)

3c

Income from other sources
a

from sources other than from owning and maintaining race horses
and income chargeable to tax at special rate (1k of Schedule OS)
(enter nil if loss)

4a

b

Income chargeable to tax at special rate (1fvi of Schedule OS)

4b

c

from owning and maintaining race horses (3e of Schedule OS) (enter
nil if loss)

4c

d

Total (4a + 4b + 4c)

4d

5

Total (1 + 2vi + 3c + 4d)

6

Losses of current year to be set off against 5 (total of 2xiii, 3xiii and 4xiii of Schedule CYLA)

5
6

7

Balance after set off current year losses (5 – 6) (total of column 5 of schedule CYLA + 4b)

7

8

Brought forward losses to be set off against 7 (total of 2xii, 3xii and 4xii of Schedule BFLA)

8

9

Gross Total income (7 – 8) (5xiii of Schedule BFLA + 4b)

9

10 Income chargeable to tax at special rate under section 111A, 112 etc. included in 9

10

11 Deduction u/s 10AA (e of Sch. 10AA)

11

12 Deductions under Chapter VI-A
a

Part-B of Chapter VI-A [1 of Schedule VI-A and limited upto (9-10)]

12a

b

Part-C of Chapter VI-A [2 of Schedule VI-A and limited upto (9-10-2iii)]

12b

c

Total (12a + 12b) [limited upto (9-10)]

12c

13 Total income (9– 11-12c)

13

14 Income chargeable to tax at special rates (total of (i) of schedule SI)

14

15 Income chargeable to tax at normal rates (13 - 14)

15

16 Net agricultural income(4 of Schedule EI)

16

17 Losses of current year to be carried forward (total of xi of Schedule CFL)

17

18 Deemed total income under section 115JB (9 of Schedule MAT)

18
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Part B - TTI
1

Computation of tax liability on total income

a Tax Payable on deemed total Income under section 115JB (10 of Schedule MAT)

1a

b Surcharge on (a) above
c Education cess, including secondary and higher education cess on (1a+1b) above

1b

d Total Tax Payable u/s 115JB (1a+1b+1c)

1d

2 Tax payable on total income
a Tax at normal rates on 15 of Part B-TI

1c

2a

b Tax at special rates (total of col. (ii) of Schedule-SI)

2b

c Tax Payable on Total Income (2a + 2b)

2c

COMPUTATION OF TAX LIABILITY

d Surcharge
i 25% of 12(ii) of Schedule SI
ii On [(2d) – (12(ii) of Schedule SI)]

2di
2dii
2diii

iii Total (i + ii)
e Education cess, including secondary and higher education cess on (2c+2diii)

2e

f

2f

Gross tax liability (2c+2diii+2e)

3 Gross tax payable (higher of 1d and 2f)

3

Credit under section 115JAA of tax paid in earlier years (if 2f is more than 1d)
4
( 5 of Schedule MATC)

4

5 Tax payable after credit under section 115JAA [ (3 - 4)]

2g(ii
)

6 Tax relief
a Section 90/90A(2 of Schedule TR)

6a

b Section 91(3 of Schedule TR)

6b

c Total (6a + 6b)

5

6c

7 Net tax liability (5 – 6c) (enter zero if negative)

7

8 Interest and fee payable
a Interest for default in furnishing the return (section 234A)

8a

b Interest for default in payment of advance tax (section 234B)

8b

c Interest for deferment of advance tax (section 234C)

8c

d Fee for default in furnishing return of income (section 234F)

8d

e Total Interest and Fee Payable (8a+8b+8c+8d)

8e

9 Aggregate liability (7 + 8e)

9

BANK ACCOUNT

TAXES PAID

10 Taxes Paid
a Advance Tax (from column 5 of 16A)

10a

b TDS (total of column 9 of 16B)

10b

c TCS (total of column 7 of 16C)

10c

d Self-Assessment Tax (from column 5 of 16A)

10d

e Total Taxes Paid (10a+10b+10c + 10d)

10e

11 Amount payable (9 - 10e) (Enter if 9 is greater than 10e, else enter 0)

11

12 Refund (If 10e is greater than 9) (Refund, if any, will be directly credited into the bank account)

12

Details of all Bank Accounts held in India at any time during the previous year (excluding dormant accounts) (In case of non-residents, details of
13
any one foreign Bank Account may be furnished for the purpose of credit of refund)
Sl.
IFS Code of the Bank in case of Bank
Name of the Bank
Account Number (IBAN in case of
Indicate the account in
Accounts held in India (SWIFT Code in
which you prefer to get your
foreign Bank Accounts)
case of foreign Bank Account)
refund credited, if any (tick
one account þ )
i
ii
14 Do you at any time during the previous year,(i) hold, as beneﬁcial owner, beneﬁciary or otherwise, any asset (including ﬁnancial interest in any entity) located
outside India; or
(ii) have signing authority in any account located outside India; or
(iii) have income from any source outside India?
[applicable only in case of a resident]
[Ensure Schedule FA is ﬁlled up if the answer is Yes ]

o Yes

No
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E-Filing of Return
• Verification: Incaseofacompany,returnofincomecanbeverifiedbythemanagingdirector,
orbyanydirectorincasesreferredtoinclause(c)ofsection140oftheIncome-taxAct.The
permanent account number of above persons is required to be mentioned in verification. It
needstobeensuredthattheverificationhasbeensignedbeforefurnishingthereturn.Writethe
designation of the person signing the return.
VERIFICATION

I,
son/ daughter of
, solemnly declare that to the best
of my knowledge and belief, the information given in the return and the schedules thereto is correct and complete is in accordance with
the provisions of the Income-tax Act, 1961.
I further declare that I am making this return in my capacity as
and I am also competent to make this return and verify it. I am
holding permanent account number
(if allotted) (Please see instruction).
I further declare that the critical assumptions specified in the agreement have been satisfied and all the terms and conditions of the
agreement have been complied with. (Applicable, in a case where return is furnished under section 92CD)
Place

ADVANCE/ SELF
ASSESSMENT TAX

15
A

TAX PAYMENTS
Details of payments of Advance Tax and Self-Assessment Tax
Sl
No
(1)
i
ii
iii
NOTE ►

B

BSR Code

Date of Deposit (DD/MM/YYYY)

Serial Number of Challan

Amount (Rs)

(2)

(3)

(4)

(5)

Enter the totals of Advance tax and Self-Assessment tax in Sl No. 10a & 10d of Part B-TTI
Details of Tax Deducted at Source (TDS) on Income [As per Form 16 A issued or Form 26QB/26QC furnished by Deductor(s)]

TAN of the
Name of the
Sl Deductor/ PAN
Deductor/Buyer/
No of the Buyer/
Tenant
Tenant
TDS ON INCOME

Sign here 

Date

(1)

(2)

(3)

Unique TDS
Certificate
Number

Unclaimed TDS
brought forward
(b/f)

TDS of the current fin. year

Deducted in the hands
Fin. Year
Amount Deducted in of any other person as
in which
b/f
own hands
per rule 37BA(2) (if
deducted
applicable)
(5)
(6)
(7)
(8)

(4)

Income TDS

TDS credit
TDS credit out of (7) or (8)
out of (7)
being claimed this Year (only if
or (8) being
corresponding income is being
carried
offered for tax this year)
forward
Claimed in the hands
Claimed
of any other person as
in own
per rule 37BA(2) (if
hands
applicable)
(9)
(10)
(11)

PAN of
other
person

InTDS
come

PAN of
other
person

i
ii
NOTE ►

Please enter total of column (8) in 10b of Part B-TTI

TCS ON INCOME

C

Details of Tax Collected at Source (TCS) [As per Form 27D issued by the Collector(s)]
Unclaimed TCS brought
forward (b/f)

Sl
No

Tax Deduction and Tax
Collection Account Number of
the Collector

Name of the Collector

(1)

(2)

(3)

Fin. Year in
which collected

Amount b/f

TCS of the
current fin.
year

(4)

(5)

(6)

Amount out of (5) or (6)
being claimed this Year Amount out of (5)
(only if corresponding
or (6) being
income is being offered for carried forward
tax this year)
(7)

(8)

i
ii
NOTE ►

Please enter total of column (7) in 10c of Part B-TTI

NOTE: PLEASE FILL SCHEDULES TO THE RETURN FORM (PAGES S1- S21) AS APPLICABLE
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• Thelastpartiscontained32Schedulesofreturnform(Fillasapplicable).Thedetailsofwhichareas
follows.


I. Schedule-HP:ComputationofincomeundertheheadIncomefromHouseProperty

II.Schedule-BP:Computationofincomeunderthehead“profitandgainsfrombusinessorprofession”


III. Schedule-DPM:ComputationofdepreciationonplantandmachineryundertheIncometaxAct



IV. ScheduleDOA:ComputationofdepreciationonotherassetsundertheIncome-taxAct



V. ScheduleDEP:SummaryofdepreciationonalltheassetsundertheIncome-taxAct



VI. ScheduleDCG:Computationofdeemedcapitalgainsonsaleofdepreciableassets



VII. ScheduleESR:Deductionundersection35(expenditureonscientificresearch)



VIII. Schedule-CG:ComputationofincomeundertheheadCapitalgains.



IX. Schedule-OS:ComputationofincomeundertheheadIncomefromothersources.



X. Schedule-CYLA:Statementofincomeaftersetoffofcurrentyear’slosses



XI. Schedule-BFLA:Statementofincomeaftersetoffofunabsorbedlossbroughtforwardfrom
earlier years.



XII. Schedule-CFL:Statementoflossestobecarriedforwardtofutureyears.



XIII. Schedule–UD:Detailsofunabsorbeddepreciation.



XIV. Schedule-ICDS:Statementofeffectofincomecomputationdisclosurestandardsonprofit.



XV. Schedule-10AA:Computationofdeductionundersection10AA



XVI. Schedule-80G:Detailsofdonationentitledfordeductionundersection80G



XVII. Schedule-80IA:Computationofdeductionundersection80IA



XVIII. Schedule-80IB:Computationofdeductionundersection80IB



XIX. Schedule-80ICor80IE:Computationofdeductionundersection80ICor80IE



XX. Schedule-VIA:Statementofdeductions(fromtotalincome)underChapterVIA.



XXI. Schedule-SI:Statementofincomewhichischargeabletotaxatspecialrates



XXII. Schedule-EI:StatementofIncomenotincludedintotalincome(exemptincomes)



XXIII. Schedule-PTI:StatementofincomefromBusinessTrustorInvestmentFundaspersection
115UA,115UB.



XXIV. Schedule-MAT:ComputationofMinimumAlternateTaxpayableundersection115JB



XXV. Schedule-MATC:Computationoftaxcreditundersection115JAA



XXVI. Schedule-DDT:DetailsofpaymentofDividendDistributionTax(aa)ScheduleBBS:Details
oftaxondistributedincomeofdomesticcompanyonbuybackofshares,notlistedon
stockexchange



 (bb)ScheduleFSI:DetailsofincomeaccruingorarisingoutsideIndia



 (cc)ScheduleTR:DetailsofTaxespaidoutsideIndia(dd)ScheduleFA:DetailsofForeign
Assets and Income



 (ee)Schedule GST: Details of total expenditure incurred with entities registered or not
registered under the GST on or after 01.07.2017.



 (ff)ScheduleFD:Detailsofreceiptsandpaymentsmadeduringtheyearinforeigncurrency.
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SCHEDULES TO THE RETURN FORM (FILL AS APPLICABLE)
Details of Income from House Property (Please refer instructions)

Schedule HP
1

Town/ City

Address of property 1

Is the property co-owned? o Yes

o No

State

PIN Code

(if “YES” please enter following details)

Assessee’s percentage of share in the property
Name of Co-owner(s)

PAN of Co-owner (s)

Percentage Share in Property

I
II
Name(s) of Tenant (if let out)

[Tick þ the applicable option]
o Let out
o Deemed let out
a

HOUSE PROPERTY

b

2

PAN of Tenant(s) (if available)

Annual letable value or rent received or receivable (higher of the two, if let out for whole of the year,
lower of the two if let out for part of the year)
The amount of rent which cannot be realized
1b

c

Tax paid to local authorities

1c

d

Total (1b + 1c)

1d

1a

e

Annual value (1a – 1d)

f

Annual value of the property owned (own percentage share x 1e)

1e

g

30% of 1f

1g

h

Interest payable on borrowed capital

1h

i

Total (1g + 1h)

1i

j

Income from house property 1 (1f – 1i)

1j
Town/ City

Address of property 2

Is the property co-owned? o Yes

1f

o No

State

PIN Code

(if “YES” please enter following details)

Assessee’s percentage of share in the property
Name of Co-owner(s)

PAN of Co-owner (s)

Percentage Share in Property

I
II
Name(s) of Tenant (if let out)
PAN of Tenant(s) (if available)
[Tick þ the applicable option]
o Let out
I
o Deemed let out
II
Annual letable value or rent received or receivable (higher of the two, if let out for whole of the year,
a
2a
lower of the two, if let out for part of the year)
b
The amount of rent which cannot be realized
2b
c

Tax paid to local authorities

2c

d

Total (2b + 2c)

2d

e

Annual value (2a – 2d)

f

Annual value of the property owned (own percentage share x 2e)

2e

g

30% of 2f

2g

h

Interest payable on borrowed capital

2h

i

Total (2g + 2h)

2i

j

Income from house property 2 (2e – 2h)

2j

2f

3 Income under the head “Income from house property”
a
Unrealized rent and Arrears of rent received during the year under section 25A after deducting
30%
Total (1j + 2j + 3a)
b

3a
3b

INCOME FROM
BUSINESS OR
PROFESSION

Schedule BP
Computation of income from business or profession
A From business or profession other than speculative business and speciﬁed business
Proﬁt before tax as per proﬁt and loss account (item 45 or 53 of Part A-P&L) / (item 45 or 55 of Part AP&L – Ind AS) (as applicable)
Net proﬁt or loss from speculative business included in 1 (enter –ve sign in
2a
2a case of loss)
1

Net proﬁt or Loss from Speciﬁed Business u/s 35AD included in 1 (enter –ve
2b sign in case of loss)

2b

Income/ receipts credited to proﬁt and loss account
3 considered under other heads of income/chargeable
u/s 115BBF/ chargeable u/s 115BBG

a House property

3a

b Capital gains

3b

1
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Proﬁt or loss included in 1, which is referred to in
4 section 44AE/44B/44BB/44BBA/44BBB/ 44D/44DA/
Chapter-XII-G/ First Schedule of Income-tax Act

c Other sources

3c

d u/s 115BBF

3d

e u/s 115BBG
a u/s 115B

4a

b Other

4b

3e

5 Income credited to Proﬁt and Loss account (included in 1) which is exempt
a

Share of income from ﬁrm(s)

5a

b

Share of income from AOP/ BOI
Any other exempt income (specify nature and
amount)
i

5b

c

ii
iii Total (ci + cii)

ci
cii
5ciii

d Total exempt income (5a + 5b + 5ciii)
6 Balance (1– 2a – 2b – 3a - 3b – 3c – 3d – 3e – 4– 5d)

Expenses debited to proﬁt and loss account
7 considered under other heads of income/related to
income chargeable u/s 115BBF or u/s 115BBG

5d
6
a House property

7a

b Capital gains

7b

c Other sources

7c

d u/s 115BBF

7d

e u/s 115BBG
8 Expenses debited to proﬁt and loss account which relate to exempt income
9 Total (7a + 7b + 7c + 7d + 7e + 8)

7e
8
9

10 Adjusted proﬁt or loss (6+9)

10

11 Depreciation and amoritisation debited to proﬁt and loss account

11

12 Depreciation allowable under Income-tax Act
i Depreciation allowable under section 32(1)(ii) and 32(1)(iia) (item 6 of
Schedule-DEP)
ii Depreciation allowable under section 32(1)(i)
(Make your own computation refer Appendix-IA of IT Rules)

12i
12ii

iii Total (12i + 12ii)
13 Proﬁt or loss after adjustment for depreciation (10 +11 – 12iii)
Amounts debited to the proﬁt and loss account, to the extent disallowable
14
under section 36 (6r of Part A-OI)
15 Amounts debited to the proﬁt and loss account, to the extent disallowable
under section 37 (7k of Part A-OI)
Amounts debited to the proﬁt and loss account, to the extent disallowable
16
under section 40 (8Aj of Part A-OI)
Amounts debited to the proﬁt and loss account, to the extent disallowable
17
under section 40A (9f of Part A-OI)
Any amount debited to proﬁt and loss account of the previous year but
18
disallowable under section 43B (11h of Part A-OI)
Interest disallowable under section 23 of the Micro, Small and Medium
19 Enterprises Development Act, 2006
20 Deemed income under section 41
Deemed income under section 32AC/ 32AD/ 33AB/ 33ABA/35ABA/ 35ABB/
21
35AC/ 40A(3A)/ 33AC/ 72A/ 80HHD/ 80-IA
22 Deemed income under section 43CA

12iii
13
14
15
16
17
18
19
20
21
22

23 Any other item of addition under section 28 to 44DA
23
Any other income not included in proﬁt and loss account/any other expense
24 not allowable (including income from salary, commission, bonus and interest 24
from ﬁrms in which company is a partner)
Increase in proﬁt or decrease in loss on account of ICDS adjustments and
25
25
deviation in method of valuation of stock (Column 3a + 4d of Part A- OI)
26 Total (14 + 15 + 16 + 17 + 18 + 19 + 20 + 21+22 +23+24+25)

26

27 Deduction allowable under section 32(1)(iii)
28 Deduction allowable under section 32AD

27
28

29 Amount allowable as deduction under section 32AC

29

30
31
32
33

Amount of deduction under section 35 or 35CCC or 35CCD in excess of the
amount debited to proﬁt and loss account (item x(4) of Schedule ESR) (if
amount deductible under section 35 or 35CCC or 35CCD is lower than amount
debited to P&L account, it will go to item 24)
Any amount disallowed under section 40 in any preceding previous year but
allowable during the previous year(8B of Part A-OI)
Any amount disallowed under section 43B in any preceding previous year but
allowable during the previous year (10g of Part A-OI)
Any other amount allowable as deduction
33

30
31
32
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Decrease in proﬁt or increase in loss on account of ICDS
34 adjustments and deviation in method of valuation of stock (Column
3b + 4e of Part A- OI)

34

35 Total (27+28+29+30+31+32+33+34)

35

36 Income (13+26-35)

36

37 Proﬁts and gains of business or profession deemed to be under i

Section 44AE

37ii

iii Section 44BB

37iii

iv Section 44BBA

37iv

v Section 44BBB

37v

vi Section 44D

37vi

vii Section 44DA

37vii

(item 4 of Form 3CE)

viii Chapter-XII-G (tonnage)

37viii

(total of col. 7 of item 10 of Form 66)
a u/s 115B
b Other

ix First Schedule of Income-tax Act

38

37i

ii Section 44B

37ix

x Total (37i to 37ix)
Net proﬁt or loss from business or profession other than speculative and speciﬁed business (34+37x)

Net Proﬁt or loss from business or profession other than speculative business and speciﬁed business after
39 applying rule 7A, 7B or 8, if applicable (If rule 7A, 7B or 8 is not applicable, enter same ﬁgure as in 38) (If
loss take the ﬁgure to 2i of item E)
B Computation of income from speculative business
40 Net proﬁt or loss from speculative business as per proﬁt or loss account
41 Additions in accordance with section 28 to 44DA

37x
38
A39

40
41

42 Deductions in accordance with section 28 to 44DA

42

43 Income from speculative business (40+41-42) (if loss, take the ﬁgure to 6xi of schedule CFL)

B43

C Computation of income from speciﬁed business under section 35AD
44 Net proﬁt or loss from speciﬁed business as per proﬁt or loss account

44

45 Additions in accordance with section 28 to 44DA

45

46

Deductions in accordance with section 28 to 44DA (other than deduction under section,- (i) 35AD, (ii) 32 or 35
on which deduction u/s 35AD is claimed)

46

47 Proﬁt or loss from speciﬁed business (44+45-46)

47

48 Deductions in accordance with section 35AD(1)

48

49 Income from Speciﬁed Business (47-48) (if loss, take the ﬁgure to 7xi of schedule CFL)
C49
Relevant clause of sub-section (5) of section 35AD which covers the speciﬁed business (to be selected from
50
C50
drop down menu)
D
Inco
D
D Income chargeable under the head ‘Proﬁts and gains from business or profession’ (A38+B43+C49)
me
E char
Intra head set off of business loss of current year
geab
Income of current year (Fill this column only
Business income remaining after set
le
Business loss set off
if ﬁgure is zero or positive)
off
Sl. Type of Business income
unde
r the
(1)
(2)
(3) = (1) – (2)
headLoss to be set off (Fill this row
i
(A39)
‘Pro
only if ﬁgure is negative)
ﬁts
ii
Income
from
speculative
business
(B43)
and

DEPRECIATION ON PLANT
AND MACHINERY

gain
iii Income from speciﬁed business
(C49)
s’
iv Total loss set off (ii + iii)
(A37
+B4
v Loss remaining after set off (i – iv)
1+C
47)
Depreciation on Plant and Machinery (Other than assets on which full capital expenditure is allowable as deduction under any other
Schedule DPM
section)
1
Block of assets
Plant and machinery
2

Rate (%)

15

30

40

(i)

(ii)

(iii)

3(a) Written down value on the ﬁrst day of
previous year
3(b) Written down value on the ﬁrst day of
previous year, of those block of assets which
were eligible for depreciation @ 50%, 60%
or 80% as per the old Table
4 Additions for a period of 180 days or more
in the previous year

14.32 | The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program

5 Consideration or other realization during
the previous year out of 3 or 4
6 Amount on which depreciation at full rate to
be allowed (3(a) + 3(b) + 4 -5) (enter 0, if
result is negative)
7 Additions for a period of less than 180 days
in the previous year
8 Consideration or other realizations during
the year out of 7
9 Amount on which depreciation at half rate
to be allowed (7 – 8) (enter 0, if result is
negative)
10 Depreciation on 6 at full rate
11 Depreciation on 9 at half rate
12 Additional depreciation, if any, on 4
13 Additional depreciation, if any, on 7
14 Additional
depreciation
relating
to
immediately preceding year on asset put
to use for less than 180 days
15 Total depreciation (10+11+12+13+14)
16 Depreciation disallowed under section 38(2)
of the I.T. Act (out of column 15)
17 Net aggregate depreciation (15-16)
18 Proportionate
aggregate
depreciation
allowable in the event of succession,
amalgamation, demerger etc.
(out of column 17)
19 Expenditure incurred in connection with
transfer of asset/ assets
20 Capital gains/ loss under section 50
(5 + 8 -3(a) – 3(b) - 4 -7 -19) (enter negative
only, if block ceases to exist)
21 Written down value on the last day of
previous year* (6+ 9 -15) (enter 0, if result is
negative)
Schedule DOA
1

Depreciation on other assets (Other than assets on which full capital expenditure is allowable as deduction)
Block of assets

DEPRECIATION ON OTHER ASSETS

2 Rate (%)

Land

Building (not including land)

Nil

5

10

40

Furniture and
ﬁttings
10

(i)

(ii)

(iii)

(iv)

(v)

Intangible assets

Ships

25

20

(vi)

(vii)

3 Written down value on the ﬁrst day of
previous year
4 Additions for a period of 180 days or more
in the previous year
5 Consideration or other realization during
the previous year out of 3 or 4
6 Amount on which depreciation at full rate
to be allowed (3 + 4 -5) (enter 0, if result is
negative)
7 Additions for a period of less than 180 days
in the previous year
8 Consideration or other realizations during
the year out of 7
9 Amount on which depreciation at half rate
to be allowed (7-8) (enter 0, if result is
negative)
10 Depreciation on 6 at full rate
11 Depreciation on 9 at half rate
12 Total depreciation (10+11)
13 Depreciation disallowed under section 38(2)
of the I.T. Act (out of column 12)
14 Net aggregate depreciation (12-13)
15 Proportionate aggregate depreciation
allowable in the event of succession,
amalgamation, demerger etc. (out of column
14)
16 Expenditure incurred in connection with
transfer of asset/ assets
17 Capital gains/ loss under section 50*
(5 + 8 -3-4 -7 -16) (enter negative only if block
ceases to exist)
18 Written down value on the last day of
previous year* (6+ 9 -12) (enter 0 if result is
negative)
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Schedule DEP

Summary of depreciation on assets (Other than on assets on which full capital expenditure is allowable as deduction under any other
section)

1 Plant and machinery
Block entitled for depreciation @ 15 per cent
( Schedule DPM - 17i or 18i as applicable)
Block entitled for depreciation @ 30 per cent
b
( Schedule DPM - 17ii or 18ii as applicable)
Block entitled for depreciation @ 40 per cent
c
( Schedule DPM - 17iii or 18iii as applicable)

SUMMARY OF DEPRECIATION ON ASSETS

a

1a
1b
1c

d Total depreciation on plant and machinery ( 1a + 1b + 1c)

1d

2 Building (not including land)
a Block entitled for depreciation @ 5 per cent
(Schedule DOA- 14ii or 15ii as applicable)
b Block entitled for depreciation @ 10 per cent
(Schedule DOA- 14iii or 15iii as applicable)
c Block entitled for depreciation @ 40 per cent
(Schedule DOA- 14iv or 15iv as applicable)
d Total depreciation on building (2a+2b+2c)

2a
2b
2c

3 Furniture and ﬁttings(Schedule DOA- 12v)

2d
3

4 Intangible assets (Schedule DOA- 12vi)

4

5 Ships (Schedule DOA- 12vii)

5

6 Total depreciation ( 1d+2d+3+4+5)

6

Schedule DCG
1

Deemed Capital Gains on sale of depreciable assets

Plant and machinery
a Block entitled for depreciation @ 15 per cent
(Schedule DPM - 20i)
b Block entitled for depreciation @ 30 per cent
(Schedule DPM – 20ii)
c Block entitled for depreciation @ 40 per cent
(Schedule DPM - 20iii)
d Total ( 1a +1b + 1c)

1a
1b
1c
1d

2 Building (not including land)
a Block entitled for depreciation @ 5 per cent
(Schedule DOA- 17ii)
b Block entitled for depreciation @ 10 per cent
(Schedule DOA- 17iii)
c Block entitled for depreciation @ 40 per cent
(Schedule DOA- 17iv)
d Total ( 2a + 2b + 2c)

2a
2b
2c
2d

3 Furniture and ﬁttings ( Schedule DOA- 17v)

3

4 Intangible assets (Schedule DOA- 17vi)

4

5 Ships (Schedule DOA- 17vii)

5

6 Total ( 1d+2d+3+4+5)

6

Schedule ESR

Deduction under section 35 or 35CCC or 35CCD

Sl No

Expenditure of the nature
referred to in section
(1)

i

35(1)(i)

ii

35(1)(ii)

iii

35(1)(iia)

iv

35(1)(iii)

v

35(1)(iv)

vi

35(2AA)

vii

35(2AB)

viii

35CCC

ix

35CCD

x

Total

Amount, if any, debited to proﬁt
and loss account
(2)

Amount of deduction allowable
(3)

Amount of deduction in excess of the
amount debited to proﬁt and loss account
(4) = (3) - (2)
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Schedule CG

Capital Gains

A Short-term Capital Gains (STCG) (Sub-items 4 & 5 are not applicable for residents)
1 From sale of land or building or both
a

i

Full value of consideration received/receivable

ai

ii Value of property as per stamp valuation authority
iii
b

aii

Full value of consideration adopted as per section 50C for the purpose of
Capital Gains (ai or aii)

aiii

Deductions under section 48
Cost of acquisition without indexation

bi

ii Cost of Improvement without indexation

i

bii

iii Expenditure wholly and exclusively in connection with transfer

biii

iv Total (bi + bii + biii)

biv

c

Balance (aiii – biv)

1c

d

Deduction under section 54D/ 54G/54GA (Specify details in item D below)

1d

e

Short-term Capital Gains on Immovable property (1c - 1d)

2 From slump sale
a Full value of consideration
b Net worth of the under taking or division

A1e
2a

(5 of Form 3CEA)

2b

(6(e) of Form 3CEA)

c Short term capital gains from slump sale (2a-2b)

A2c

From sale of equity share or unit of equity oriented Mutual Fund (MF) or unit of a business trust on which STT is
3
paid under section 111A or 115AD(1)(ii) proviso (for FII)
a Full value of consideration
3a
b

Short-term Capital Gains

c
d
e

Deductions under section 48
i Cost of acquisition without indexation

bi

ii Cost of Improvement without indexation
iii Expenditure wholly and exclusively in connection with transfer

biii

iv Total (i + ii + iii)

biv

bii

Balance (3a – biv)

3c

Loss to be disallowed u/s 94(7) or 94(8)- for example if asset bought/acquired
within 3 months prior to record date and dividend/income/bonus units are
3d
received, then loss arising out of sale of such asset to be ignored (Enter positive
value only)
Short-term capital gain on equity share or equity oriented MF (STT paid) (3c +3d)

For NON-RESIDENT, not being an FII- from sale of shares or debentures of an Indian company (to be computed
4
with foreign exchange adjustment under ﬁrst proviso to section 48)
a STCG on transactions on which securities transaction tax (STT) is paid
b

A3e

A4a
A4b

STCG on transactions on which securities transaction tax (STT) is not paid

5 For NON-RESIDENTS- from sale of securities (other than those at A3 above) by an FII as per section 115AD
a
i In case securities sold include shares of a company other than quoted shares,
enter the following details
a Full value of consideration received/receivable in respect of unquoted
shares
b Fair market value of unquoted shares determined in the prescribed
manner
c Full value of consideration in respect of unquoted shares adopted as
ic
per section 50CA for the purpose of Capital Gains (higher of a or b)
ii Full value of consideration in respect of securities other than unquoted
shares
iii Total (ic + ii)
aiii
b Deductions under section 48
Cost of acquisition without indexation

bi

ii Cost of improvement without indexation

i

bii

iii Expenditure wholly and exclusively in connection with transfer

biii

iv Total (i + ii + iii)

biv
5c

c

Balance (5aiii – biv)

d

Loss to be disallowed u/s 94(7) or 94(8)- for example if security
bought/acquired within 3 months prior to record date and
dividend/income/bonus units are received, then loss arising out of sale of such
security to be ignored (Enter positive value only)

e

Short-term capital gain on securities (other than those at A3 above) by an FII (5c +5d)

5d
A5e

6 From sale of assets other than at A1 or A2 or A3 or A4 or A5 above
a

i

In case assets sold include shares of a company other than quoted shares, enter
the following details
a Full value of consideration received/receivable in respect of unquoted
shares
b Fair market value of unquoted shares determined in the prescribed
manner
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c Full value of consideration in respect of unquoted shares adopted as
per section 50CA for the purpose of Capital Gains (higher of a or b)
ii Full value of consideration in respect of assets other than unquoted shares
b

iii Total (ic + ii)
Deductions under section 48
i Cost of acquisition without indexation

aiii
bi

ii Cost of Improvement without indexation
iii Expenditure wholly and exclusively in connection with transfer
c

ic

bii
biii

iv Total (i + ii + iii)
Balance (6aiii – biv)

biv
6c

In case of asset (security/unit) loss to be disallowed u/s 94(7) or 94(8)- for
example if asset bought/acquired within 3 months prior to record date and
dividend/income/bonus units are received, then loss arising out of sale of such
asset to be ignored (Enter positive value only)

6d

e

Deemed short term capital gains on depreciable assets (6 of schedule- DCG)

6e

f

Deduction under section 54D/54G/54GA

6f

g

STCG on assets other than at A1 or A2 or A3 or A4 or A5 above (6c + 6d + 6e – 6f)

d

A6g

7 Amount deemed to be short-term capital gains
Whether any amount of unutilized capital gain on asset transferred during the previous years shown below was
a deposited in the Capital Gains Accounts Scheme within due date for that year?
o Yes o No o Not applicable. If yes, then provide the details below
Sl.

Previous year Section under which
in which asset deduction claimed in
transferred that year

i

2014-15

Amount not used for
new asset or remained
unutilized in Capital
gains account (X)

New asset acquired/constructed
Year in which asset Amount utilised out of
acquired/constructed Capital Gains account

54D/54G/54GA

b Amount deemed to be short-term capital gains u/s 54D/54G/54GA, other than at ‘a’
Total Amount deemed to be short-term capital gains u/s 54D/54G/54GA (aXi + b)

A7

8 Amount of STCG included in A1-A7 but not chargeable to tax or chargeable at special rates in India as per DTAA
Sl. Amount of
No. income
(1)

(2)

Item No. A1 to
A7 above in Country name Article of
& Code
DTAA
which
included
(3)

(4)

Rate as per
Treaty

(enter NIL, if not
chargeable)

(5)

Whether TRC
Section of
obtained
I.T. Act
(Y/N)

(6)

(7)

Rate as per Applicable rate
[lower of (6) or
I.T. Act
(9)]

(8)

(9)

(10)

I
II

a Total amount of STCG not chargeable to tax in India as per DTAA

A8a

b Total amount of STCG chargeable at special rates in India as per DTAA

A8b

9 Total Short-term Capital Gain (A1e+ A2c+ A3e+ A4a+ A4b+ A5e+ A6g+A7-A8a)

A9

B Long-term capital gain (LTCG) (Sub-items 5& 6 are not applicable for residents)
1 From sale of land or building or both
a

i

Full value of consideration received/receivable

ai

ii Value of property as per stamp valuation authority
iii

aii

Full value of consideration adopted as per section 50C for the purpose of
Capital Gains (ai or aii)

aiii

b Deductions under section 48
i

Long-term Capital Gains

Cost of acquisition with indexation

bi

ii Cost of Improvement with indexation

bii

iii Expenditure wholly and exclusively in connection with transfer

biii

iv Total (bi + bii + biii)

biv

c

Balance (aiii – biv)
Deduction under section 54D/54EC/54EE /54G/54GA (Specify details in item D
d
below)
e Long-term Capital Gains on Immovable property (1c - 1d)
2 From slump sale
a Full value of consideration
2a
b Net worth of the under taking or division

1c
1d
B1e
(5 of Form 3CEA)

2b

c Balance (2a – 2b)

2c

d Deduction u/s 54EC/54EE

2d

(6(e) of Form 3CEA)

e Long term capital gains from slump sale (2c-2d)

B2e

3 From sale of bonds or debenture (other than capital indexed bonds issued by Government)
a

Full value of consideration

3a

b Deductions under section 48
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i Cost of acquisition without indexation
ii Cost of improvement without indexation
iii Expenditure wholly and exclusively in connection with transfer
iv Total (bi + bii +biii)
c

Balance (3a – biv)

3c

d Deduction under sections 54EC /54EE (Specify details in item D below)
4

bi
bii
biii
biv
3d

e LTCG on bonds or debenture (3c – 3d)
B3e
From sale of listed securities (other than a unit) or zero coupon bonds where proviso under section 112(1) is
applicable
a Full value of consideration
4a
b Deductions under section 48
i Cost of acquisition without indexation
bi
ii Cost of improvement without indexation
bii
iii Expenditure wholly and exclusively in connection with transfer
biii
iv Total (bi + bii +biii)
biv
c

Balance (4a – biv)

4c

d

Deduction under sections 54EC /54EE (Specify details in item D below)

4d

e Long-term Capital Gains on assets at B4 above (4c – 4d)
B4e
For NON-RESIDENTS- from sale of shares or debenture of Indian company (to be computed with foreign
exchange adjustment under ﬁrst proviso to section 48)
a LTCG computed without indexation beneﬁt
5a
5b
b Deduction under sections 54EC /54EE (Specify details in item D below)
c LTCG on share or debenture (5a-5b)
B5c
For NON-RESIDENTS- from sale of, (i) unlisted securities as per sec. 112(1)(c), (ii) units referred in sec. 115AB,
6 (iii) bonds or GDR as referred in sec. 115AC, (iv) securities by FII as referred to in sec. 115AD
5

a

b

In case securities sold include shares of a company other than quoted shares,
enter the following details
a Full value of consideration received/receivable in respect of unquoted
shares
b Fair market value of unquoted shares determined in the prescribed
manner
c Full value of consideration in respect of unquoted shares adopted as
ic
per section 50CA for the purpose of Capital Gains (higher of a or b)
ii Full value of consideration in respect of securities other than unquoted
shares
iii Total (ic + ii)
aiii
Deductions under section 48
i

Cost of acquisition without indexation

bi

ii Cost of improvement without indexation

i

bii

iii Expenditure wholly and exclusively in connection with transfer

biii

iv Total (bi + bii +biii)

biv

c

Balance (6aiii – biv)

6c

d

Deduction under sections 54EC/54EE (Specify details in item D below)

6d

e

Long-term Capital Gains on assets at 6 above in case of NON-REESIDENT (6c – 6d)

B6e

7 From sale of assets where B1 to B6 above are not applicable
a

i

In case assets sold include shares of a company other than quoted shares, enter the
following details
a Full value of consideration received/receivable in respect of unquoted shares
b Fair market value of unquoted shares determined in the prescribed manner

c Full value of consideration in respect of unquoted shares adopted as per
section 50CA for the purpose of Capital Gains (higher of a or b)
ii Full value of consideration in respect of assets other than unquoted shares

ic

iii Total (ic + ii)

aiii

b Deductions under section 48
i
Cost of acquisition with indexation
ii

bi

Cost of improvement with indexation

bii

iii

Expenditure wholly and exclusively in connection with transfer

biii

iv

Total (bi + bii +biii)

biv

c Balance (7aiii – biv)
d Deduction under section 54D/54EC/54EE /54G/54GA (Specify details in item D below)
e Long-term Capital Gains on assets at B7 above (7c-7d)

7c
7d
B7e

8 Amount deemed to be long-term capital gains
Whether any amount of unutilized capital gain on asset transferred during the previous year shown below was
a deposited in the Capital Gains Accounts Scheme within due date for that year?
o Yes o No o Not applicable. If yes, then provide the details below
Sl. Previous year in Section under which

New asset acquired/constructed

Amount not used for
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i

Amount 9tilized
Year in which asset
out of Capital
acquired/constructed
Gains account

which asset
transferred

deduction claimed in
that year

2014-15

54/54D/54F/54G/54GA

new asset or remained
unutilized in Capital
gains account (X)

b Amount deemed to be long-term capital gains, other than at ‘a’
Total amount deemed to be long-term capital gains (aXi + b)
9

B8

Amount of LTCG included in items B1 to B8 but not chargeable to tax or chargeable at special rates in India as
per DTAA
Item No. B1 to B8 Country
Sl. Amount
above in which
name &
No. of income
included
Code

(1)

(2)

(3)

Article of
DTAA

(4)

(enter NIL, if not
chargeable)

Rate as per
Treaty

Whether TRC
obtained
(Y/N)

Section of
I.T. Act

(6)

(7)

(8)

(5)

Applicable
Rate as per
rate [lower of
I.T. Act
(6) or (9)]

(9)

(10)

I
II
a Total amount of LTCG not chargeable to tax in India as per DTAA

B9a

b Total amount of LTCG chargeable at special rates in India as per DTAA

B9b

Total long term capital gain [B1e +B2e+ B3e +B4e + B5c + B6e + B7e+ B8-B9a] (In case of loss take the ﬁgure to
10
9xi of schedule CFL)
C Income chargeable under the head “CAPITAL GAINS” (A9 + B10) (take B10 as nil, if loss)

B10
C

D Information about deduction claimed against Capital Gains
1

In case of deduction u/s 54B/54D/54EC/54EE /54G/54GA give following details
a

Deduction claimed u/s 54B
i Date of transfer of original asset

ai

ii Cost of new agricultural land

aii

iii Date of purchase of new agricultural land

aiii

iv Amount deposited in Capital Gains Accounts Scheme before due date

aiv

v Amount of deduction claimed

av

b

dd/mm/yyyy
dd/mm/yyyy

Deduction claimed u/s 54D
i Date of acquisition of original asset
Cost of purchase/ construction of new land or building for industrial
undertaking
iii Date of purchase of new land or building

biii

iv Amount deposited in Capital Gains Accounts Scheme before due date

biv

v Amount of deduction claimed

bv

ii

c

bi

dd/mm/yyyy

bii
dd/mm/yyyy

Deduction claimed u/s 54EC
i Date of transfer of original asset

ci

ii Amount invested in speciﬁed/notiﬁed bonds

cii

iii Date of investment
(not exceeding ﬁfty lakh rupees)
iv Amount of deduction claimed

ciii

d

dd/mm/yyyy
dd/mm/yyyy

civ
Deduction claimed u/s 54EE

i

Date of transfer of original asset
(
ii Amount invested in speciﬁed asset

dii

iii Date of investment

diii

iv Amount of deduction claimed

div

e

di

dd/mm/yyyy
dd/mm/yyyy

Deduction claimed u/s 54G
i Date of transfer of original asset from urban area

ei

ii Cost and expenses incurred for purchase or construction of new asset
Date of purchase/construction of new asset in an area other than
iii
urban area
iv Amount deposited in Capital Gains Accounts Scheme before due date

eii
eiii

v Amount of deduction claimed

ev

f

dd/mm/yyyy
dd/mm/yyyy

eiv

Deduction claimed u/s 54GA
i Date of transfer of original asset from urban area

ﬁ

ii Cost and expenses incurred for purchase or construction of new asset

ﬁi

iii Date of purchase/construction of new asset in SEZ

ﬁii

iv Amount deposited in Capital Gains Accounts Scheme before due date

ﬁv

v Amount of deduction claimed
g Total deduction claimed (1a + 1b + 1c + 1d + 1e + 1f)

dd/mm/yyyy
dd/mm/yyyy

fv
1g

E Set-off of current year capital losses with current year capital gains (excluding amounts included in A7 & B9 which is chargeable under DTAA)
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Sl. Type of Capital Gain

Gain of current
year (Fill this
column only if
computed ﬁgure is
positive)

Short term capital loss set off
15%

30%

applicable rate

10%

20%

2

3

4

5

6

(A3e+A4a)

A5e

1
Loss to be set off (Fill this
row if ﬁgure computed is
negative)

i
ii

15%

(A3e+A4a)

iii Short term
capital gain
iv

30%

A5e

v

Long term
capital gain

Long term capital loss set off

(A1e+A2c+A4b
(B4e+ + B6e)
+A6g +A7)

Current year’s capital
gains remaining after set
off
(7= 1-2-3-4-5-6)
7

(B1e+B2e+B3e+
B5c+ B7e+B8)

applicable (A1e+A2c+A4b+A6g
rate
+A7)
10%

(B4e+ + B6e)

(B1e+B2e+B3e+
B5c+ B7e+B8)
vii Total loss set off (ii + iii + iv + v + vi)
vi

20%

viii Loss remaining after set off (i – vii)
F Information about accrual/receipt of capital gain
Type of Capital gain / Date

Upto 15/6
(i)

16/6 to 15/9
(ii)

16/9 to 15/12
(iii)

16/12 to 15/3
(iv)

16/3 to 31/3
(v)

Short-term capital gains taxable at the rate of 15%
Enter value from item 5v of schedule BFLA, if any.
Short-term capital gains taxable at the rate of 30%
2
Enter value from item 5vi of schedule BFLA, if any.
1

3

Short-term capital gains taxable at applicable rates
Enter value from item 5vii of schedule BFLA, if any.

Long- term capital gains taxable at the rate of 10%
Enter value from item 5viii of schedule BFLA, if any.
Long- term capital gains taxable at the rate of 20%
5 Enter value from item 5ix of schedule BFLA, if any.
4

Schedule OS

Income from other sources

1 Income
a Dividends, Gross

1a

b Interest, Gross

1b

c Rental income from machinery, plants, buildings, etc., Gross
d Others, Gross (excluding income from owning race horses) Mention the nature

1c

i Income by way of winnings from lotteries, crossword puzzles etc.
ii a Cash credits u/s 68

OTHER SOURCES

b
c
d
e
f

Unexplained investments u/s 69
Unexplained money etc. u/s 69A
Undisclosed investments etc. u/s 69B
Unexplained expenditure etc. u/s 69C
Amount borrowed or repaid on hundi u/s 69D
Total (a + b + c + d + e + f)

1di

1dii

iii Income of the nature referred to in section 56(2)(x) which is chargeable to tax

a
b
c
d
e

Aggregate value of sum of money received without
consideration
In case immovable property is received without
consideration, stamp duty value of property
In case immovable property is received for inadequate
consideration, stamp duty value of property in excess of
such consideration
In case any other property is received without
consideration, fair market value of property
In case any other property is received for inadequate
consideration, fair market value of property in excess of
such consideration
Total (a+ b + c +d + e)

iv
v

1diii
1div
1dv

vi Total (1di + 1dii+ 1diii+ 1div+1dv)

1dvi

e Total (1a + 1b + 1c + 1dvi)
f

1e

Income included in ‘1e’ chargeable to tax at special rate (to be taken to schedule SI)
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Income by way of winnings from lotteries, crossword puzzles, races, games, gambling, betting etc (u/s
115BB)
ii Deemed Income chargeable to tax u/s 115BBE

1ﬁi

iii Income from patent chargeable u/s 115BBF

1ﬁii

iv Income from transfer of carbon credits u/s 115BBG

1ﬁv

v Any other income chargeable to tax at the rate speciﬁed under chapter XII/XII-A

1fv

i

1ﬁ

vi Income chargeable at special rates under DTAA
Sl. Amount of Nature of
No. income
income

(1)

(2)

Country
name &
Code

(3)

Rate as per Treaty Whether TRC
Applicable
Article of
Section of Rate as per
(enter NIL, if not
obtained
rate [lower of
DTAA
I.T. Act
I.T. Act
chargeable)
(Y/N)
(6) or (9)]

(4)

(5)

(6)

(7)

(8)

(9)

(10)

I
II
III Total amount of income chargeable at special rates under DTAA
vii Income included in ‘1e’ chargeable to tax at special rate (1ﬁ +1ﬁi + 1ﬁii +1ﬁv+1fv + 1fvi)

1fvi
1fvii

g Gross amount chargeable to tax at normal applicable rates (1e – 1fvii)

1g

h Deductions under section 57 (other than those relating to income under 1ﬁ, 1ﬁi , 1ﬁii, 1ﬁv, 1fv & 1fvi )
i

Expenses / Deductions

hi

ii Depreciation

hii

iii Total

hiii

Amounts not deductible u/s 58
j Proﬁts chargeable to tax u/s 59
i

k
2

1i
1j

Income from other sources (other than from owning race horses and amount chargeable to tax at special rate)
(1g – hiii + 1i + 1j) (If negative take the ﬁgure to 4i of schedule CYLA)

Income from other sources (other than from owning and maintaining race horses) (1fvii + 1k) (enter1k as nil, if
negative)

1k
2

3 Income from the activity of owning race horses
a Receipts

3a

b Deductions under section 57 in relation to (4)

3b

c Amounts not deductible u/s 58
d Proﬁts chargeable to tax u/s 59

3d

3c

e Balance (3a – 3b + 3c + 3d) (if negative take the ﬁgure to 10xi of Schedule CFL)

3e

4 Income under the head “Income from other sources” (2 + 3e) (take 3e as nil if negative)

Schedule CYLA

Details of Income after Set off of current year losses

Sl.No Head/ Source of Income

Income of current year House property loss
(Fill this column only if of the current year
set off
income is zero or
positive)

1

CURRENT YEAR LOSS ADJUSTMENT

i

Loss to be set off

ii

House property

(3b of Schedule HP)

iii

Business (excluding speculation
income and income from speciﬁed
business)

(A39 of Schedule BP)

iv

Speculation income

(3ii of item E of Sch. BP)

v

Speciﬁed business income u/s 35AD

(3iii of item E of Sch. BP)

Short-term capital gain taxable @
15%
Short-term capital gain taxable @
vii
30%
Short-term capital gain taxable at
viii
applicable rates
Long term capital gain taxable @
ix
10%
Long term capital gain taxable @
x
20%
Other sources (excluding proﬁt from
xi owning race horses and amount
chargeable to special rate of tax)
Proﬁt from owning and maintaining
xii
race horses
vi

4

Business Loss (other
than speculation or
speciﬁed business
loss) of the current
year set off

Other sources loss
(other than loss from
race horses and amount
chargeable to special
rate of tax) of the
current year set off

Current
year’s
Income
remaining
after set off
5=1-2-3-4

2

3

4

(3b of Schedule –HP)

(2v of item E of
Schedule BP)

(1k of Schedule-OS)

(7ii of item E of schedule
CG)
(7iii of item E of schedule
CG)
(7iv of item E of schedule
CG)
(7v of item E of schedule
CG)
(7vi of item E of schedule
CG)
(1k of schedule OS)
(3e of schedule OS)

xiii Total loss set off (ii+ iii+ iv+ v+ vi+ vii+ viii+ ix+ x+ xi+ xii)
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xiv Loss remaining after set-off (i - xiii)

Schedule BFLA

BROUGHT FORWARD LOSS ADJUSTMENT

Sl.
No.

Details of Income after Set off of Brought Forward Losses of earlier years
Head/ Source of Income

Income after set off, if
any, of current year’s
losses as per 5 of
Schedule CYLA)
1

i

House property

(5ii of schedule CYLA)

ii

Business (excluding speculation
income and income from speciﬁed
business)

(5iii of schedule CYLA)

iii Speculation Income

(5iv of schedule CYLA)

iv Speciﬁed Business Income

(5v of schedule CYLA)

v
vi
vii
viii
ix
x
xi

Short-term capital gain taxable @
15%
Short-term capital gain taxable @
30%
Short-term capital gain taxable at
applicable rates
Long-term capital gain taxable @
10%
Long term capital gain taxable @
20%
Other sources income (excluding
proﬁt from owning and maintaining
race horses and amount chargeable
to special rate of tax)
Proﬁt from owning and maintaining
race horses

Brought forward loss set Brought forward Brought forward Current year’s
off
depreciation set
allowance under
income
off
section 35(4) set off remaining after
set off
2
3
4
5
(B/f house property loss)
(B/f business loss, other
than speculation or
speciﬁed business loss)
(B/f normal business or
speculation loss)
(B/f normal business or
speciﬁed business loss)
(B/f short-term capital
loss)
(B/f short-term capital
loss)
(B/f short-term capital
loss)
(B/f short-term or longterm capital loss)
(B/f short-term or longterm capital loss)

(5vi of schedule CYLA)
(5vii of schedule CYLA)
(5viii of schedule CYLA)
(5ix of schedule CYLA)
(5x of schedule CYLA)
(5xi of schedule CYLA)
(5xii of schedule CYLA)

(B/f loss from horse races)

xii Total of brought forward loss set off
xiii Current year’s income remaining after set off Total (i5 + ii5 + iii5 + iv5+v5 + vi5 + vii5 + viii5 + ix5 + x5 + xi5)
Details of Losses to be carried forward to future years

Schedule CFL
Sl.
No.

Assessment Year

1
i

CARRY FORWARD OF LOSS

ii
iii
iv
v
vi
vii
viii

2

Loss from Loss from
Loss from
Date of House property
loss
business other speculative speciﬁed
Filing
business
business
than loss from
(DD/MM/
speculative
YYYY)
business and
speciﬁed
business
3

4

5

6

7

Short-term
capital loss

Long-term
Capital loss

Loss from
owning and
maintaining
race horses

8

9

10

2010-11
2011-12
2012-13
2013-14
2014-15
2015-16
2016-17
2017-18

ix

Total of earlier year
losses b/f

x

Adjustment of above
losses in Schedule BFLA

xi

2018-19 (Current year
losses)

xii

Total loss Carried
forward to future years

(2iv of
(2iii of
(2xi of schedule
schedule
schedule
BFLA)
BFLA)
BFLA)
(C49 of (2viii+3viii+4viii) ((5viii+6viii) (3e of schedule
(2xiv of schedule (3xiv of schedule
(B43 of
OS, if –ve)
of item E of
of item E of
CYLA)
CYLA)
schedule BP, schedule
schedule CG)
schedule CG)
BP, if –ve)
if –ve)
(2i of schedule
BFLA)

(2ii of schedule
BFLA)
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Schedule UD
Sl No

Unabsorbed depreciation and allowance under section 35(4)

Assessment Year

Depreciation

Allowance under section 35(4)

Amount of brought Amount of depreciation Balance carried Amount of brought Amount of allowance
Balance
Carried
forward unabsorbed set-off against the current forward to the forward unabsorbed set-off against the
depreciation
year income
next year
allowance
current year income forward to the
next year
(1)

(2)

(3)

(4)

(5)

(6)

(7)

(8)

Current Assessment
Year

i
ii
iii
iv

Total

Schedule ICDS

(3xii of BFLA)

(4xii of BFLA)

Effect of Income Computation Disclosure Standards on proﬁt

Sl. No.

ICDS

Amount (+) or (-)

(i)

(ii)

(iii)

I

Accounting Policies

II

Valuation of Inventories (other than the effect of change in method of valuation u/s 145A, if the same
is separately reported at col. 4d or 4e of Part A-OI)

III

Construction Contracts

IV

Revenue Recognition

V

Tangible Fixed Assets

VI

Changes in Foreign Exchange Rates

VII

Government Grants

VIII

Securities (other than the effect of change in method of valuation u/s 145A, if the same is separately
reported at col. 4d or 4e of Part A-OI)

IX

Borrowing Costs

X

Provisions, Contingent Liabilities and Contingent Assets

11a.

Total effect of ICDS adjustments on proﬁt (I+II+III+IV+V+VI+VII+VIII+IX+X) (if positive)

11b.

Total effect of ICDS adjustments on proﬁt (I+II+III+IV+V+VI+VII+VIII+IX+X) (if negative)

DEDUCTION U/S 10AA

Schedule 10AA
Deduction under section 10AA
Deductions in respect of units located in Special Economic Zone
Sl

Sl

Amount of deduction

a Undertaking No.1

a

(item 17 of Annexure A of Form
56F for Undertaking 1)

b Undertaking No.2

b

(item 17 of Annexure A of Form
56F for Undertaking 2)

c

c

Total deduction under section 10AA (a + b)

Schedule 80G
A

Assessment year in which unit begins to
manufacture/produce/provide services

Undertaking

Details of donations entitled for deduction under section 80G

Donations entitled for 100% deduction without qualifying
limit
Name and address of donee

PAN of Donee

Amount of donation

Eligible Amount of donation

PAN of Donee

Amount of donation

Eligible Amount of donation

DETAILS OF DONATIONS

i
ii
iii
iv Total
B

Donations entitled for 50% deduction without qualifying
limit
Name and address of donee
i
ii
iii
iv Total
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C Donations entitled for 100% deduction subject to
qualifying limit
Name and address of donee

PAN of Donee

Amount of donation

PAN of Donee

Amount of donation Eligible Amount of donation

Eligible Amount of donation

i
ii
iii
iv Total
D Donations entitled for 50% deduction subject to qualifying
limit
Name and address of donee
i
ii
iii
iv Total
E Total donations (Aiv + Biv + Civ + Div)
Schedule 80-IA

DEDUCTION U/S 80-IA

a

Deductions under section 80-IA

Deduction in respect of proﬁts of an enterprise referred
to in section 80-IA(4)(i) [Infrastructure facility]

Deduction in respect of proﬁts of an undertaking
b referred to in section 80-IA(4)(ii) [Telecommunication
services]
Deduction in respect of proﬁts of an undertaking
c referred to in section 80-IA(4)(iii) [Industrial park and
SEZs]
Deduction in respect of proﬁts of an undertaking
d
referred to in section 80-IA(4)(iv) [Power]
Deduction in respect of proﬁts of an undertaking
referred to in section 80-IA(4)(v) [Revival of power
e generating plant] and deduction in respect of proﬁts of an
undertaking referred to in section 80-IA(4)(vi) [Crosscountry natural gas distribution network]

a1 Undertaking no. 1 (item 30 of Form 10CCB of the undertaking)
a2 Undertaking no. 2 (item 30 of Form 10CCB of the undertaking)
b1 Undertaking no. 1 (item 30 of Form 10CCB of the undertaking)
b2 Undertaking no. 2 (item 30 of Form 10CCB of the undertaking)
c1 Undertaking no. 1 (item 30 of Form 10CCB of the undertaking)
c2 Undertaking no. 2 (item 30 of Form 10CCB of the undertaking)
d1 Undertaking no. 1 (item 30 of Form 10CCB of the undertaking)
d2 Undertaking no. 2 (item 30 of Form 10CCB of the undertaking)
e1 Undertaking no. 1 (item 30 of Form 10CCB of the undertaking)
e2 Undertaking no. 2 (item 30 of Form 10CCB of the undertaking)

f Total deductions under section 80-IA (a1 + a2 + b1 + b2 + c1 + c2+ d1 + d2+ e1 + e2)

Schedule 80-IB

f

Deductions under section 80-IB

Deduction in respect of industrial undertaking located in Jammu
a
& Kashmir [Section 80-IB(4)]

a1
a2

Undertaking no. 1 (30 of Form 10CCB of the undertaking)
Undertaking no. 2 (30 of Form 10CCB of the undertaking)

Deduction in respect of industrial undertaking located in
b industrially backward states speciﬁed in Eighth Schedule
[Section 80-IB(4)]

b1

Undertaking no. 1 (30 of Form 10CCB of the undertaking)

b2

Undertaking no. 2 (30 of Form 10CCB of the undertaking)

Deduction in respect of industrial undertaking located in
industrially backward districts [Section 80-IB(5)]

c1
c2

Undertaking no. 1 (30 of Form 10CCB of the undertaking)
Undertaking no. 2 (30 of Form 10CCB of the undertaking)
(10(v) of Form 10CCBA of the
Undertaking no. 1
undertaking)
(10(v) of Form 10CCBA of the
Undertaking no. 2
undertaking)
(10(v) of Form 10CCBB of the
Undertaking no. 1
undertaking)
(10(v) of Form 10CCBB of the
Undertaking no. 2
undertaking)
Undertaking no. 1 (30 of Form 10CCB of the undertaking)
Undertaking no. 2 (30 of Form 10CCB of the undertaking)
Undertaking no. 1 (30 of Form 10CCB of the undertaking)
Undertaking no. 2 (30 of Form 10CCB of the undertaking)
Undertaking no. 1 (30 of Form 10CCB of the undertaking)
Undertaking no. 2 (30 of Form 10CCB of the undertaking)
Undertaking no. 1 (30 of Form 10CCB of the undertaking)
Undertaking no. 2 (30 of Form 10CCB of the undertaking)

c

d Deduction in the case of multiplex theatre [Section 80-IB(7A)]

d1
d2
e1

e

Deduction in the case of convention centre [Section 80-IB(7B)]

f

Deduction in the case of company carrying on scientiﬁc research
[Section 80-IB(8A)]

g

Deduction in the case of undertaking which begins commercial
production or reﬁning of mineral oil [Section 80-IB(9)]

h

Deduction in the case of an undertaking developing and building
housing projects [Section 80-IB(10)]

i

Deduction in the case of an undertaking operating a cold chain
facility [Section 80-IB(11)]

f1
f2
g1
g2
h1
h2
i1
i2

j

Deduction in the case of an undertaking engaged in processing,
preservation and packaging of fruits, vegetables, meat, meat
products, poultry, marine or dairy products [Section 80-IB(11A)]

j1

Undertaking no. 1 (30 of Form 10CCB of the undertaking)

j2

Undertaking no. 2 (30 of Form 10CCB of the undertaking)

k1

Undertaking no. 1 (30 of Form 10CCB of the undertaking)

Deduction in the case of an undertaking engaged in integrated
k business of handling, storage and transportation of food grains
[Section 80-IB(11A)]
l

Deduction in the case of an undertaking engaged in operating
and maintaining a rural hospital [Section 80-IB(11B)]

e2

k2

Undertaking no. 2 (30 of Form 10CCB of the undertaking)

l1
l2

Undertaking no. 1
Undertaking no. 2

(11(v) of From 10CCBC)
(11(v) of From 10CCBC)
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Deduction in the case of an undertaking engaged in operating
m and maintaining a hospital in any area, other than excluded area
[Section 80-IB(11C)
n Total deduction under section 80-IB (Total of a1 to m2)
Schedule 80-IC or 80-IE

m1

Undertaking no. 1

(11(d) of From 10CCBD)

m2

Undertaking no. 2

(11(d) of From 10CCBD)
n

Deductions under section 80-IC or 80-IE

a Deduction in respect of undertaking located in Sikkim

b Deduction in respect of undertaking located in Himachal Pradesh

DEDUCTION U/S 80-IC

c Deduction in respect of undertaking located in Uttaranchal

a1

Undertaking no. 1

a2

Undertaking no. 2

b1

Undertaking no. 1

b2

Undertaking no. 2

c1

Undertaking no. 1

c1

Undertaking no. 2

(30 of Form 10CCB of the
undertaking)
(30 of Form 10CCB of the
undertaking)
(30 of Form 10CCB of the
undertaking)
(30 of Form 10CCB of the
undertaking)
(30 of Form 10CCB of the
undertaking)
(30 of Form 10CCB of the
undertaking)

d Deduction in respect of undertaking located in North-East
da Assam
db

Arunachal
Pradesh

dc Manipur
dd Mizoram

da1
da2
db1

Undertaking no. 1
Undertaking no. 2

(30 of Form 10CCB of the undertaking)
(30 of Form 10CCB of the undertaking)

Undertaking no. 1

(30 of Form 10CCB of the undertaking)

db2
dc1

Undertaking no. 2

(30 of Form 10CCB of the undertaking)

Undertaking no. 1
Undertaking no. 2
Undertaking no. 1
Undertaking no. 2
Undertaking no. 1
Undertaking no. 2
Undertaking no. 1
Undertaking no. 2
Undertaking no. 1
Undertaking no. 2

(30 of Form 10CCB of the undertaking)
(30 of Form 10CCB of the undertaking)
(30 of Form 10CCB of the undertaking)
(30 of Form 10CCB of the undertaking)
(30 of Form 10CCB of the undertaking)
(30 of Form 10CCB of the undertaking)
(30 of Form 10CCB of the undertaking)
(30 of Form 10CCB of the undertaking)
(30 of Form 10CCB of the undertaking)
(30 of Form 10CCB of the undertaking)

dc2
dd1

de Meghalaya

dd2
de1
de2

df Nagaland

df1
df2

dg Tripura

dg1
dg2

dh Total deduction for undertakings located in North-east (total of da1 to dg2)

dh

e Total deduction under section 80-IC or 80-IE (a + d + c + dh)

Schedule VI-A

e

Deductions under Chapter VI-A

1 Part B- Deduction in respect of certain payments
a 80G

b 80GGB

c 80GGA

d 80GGC

TOTAL DEDUCTIONS

Total Deduction under Part B (a + b + c +d)

1

2 Part C- Deduction in respect of certain incomes
e

80-IA

g

80-IAC

h 80-IB

i

80-IBA

j

80-IC/ 80-IE

k

80JJA

l

80JJAA

m

80LA

(f of Schedule 80-IA)

f

80-IAB
(n of Schedule 80-IB)
(e of Schedule 80-IC/ 80-IE)
(10 of Annexure to Form 10DA)

(9 of Annexure to Form 10CCF)

Total Deduction under Part C (total of e to m)

2
3

3 Total deductions under Chapter VI-A (1 + 2)

SPECIAL
RATE

Schedule SI

Income chargeable to tax at special rates [Please see instruction Number-7(ii) for section and rate of tax]

Sl
Section/Description
No
1 111A (STCG on shares/equity oriented MF on which STT paid)

þ
o

Special rate
(%)
15

Income
(i)
(5v of schedule BFLA)

2 115AD (STCG for FIIs on securities where STT not paid)

o

30

(5vi of schedule BFLA)

3 112 proviso (LTCG on listed securities/ units without indexation)

o

10

(part of 5viii of schedule BFLA)

Tax thereon
(ii)
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4 112(1)(c)(iii) (LTCG for non-resident on unlisted securities)

o

10

(part of 5viii of schedule BFLA)

5 115AB (LTCG for non-resident on units referred in section115AB)

o

10

(part of 5viii of schedule BFLA)

6 115AC (LTCG for non-resident on bonds/GDR)

o

10

(part of 5viii of schedule BFLA)

7 115AD (LTCG for FII on securities)

o

10

(part of 5viii of schedule BFLA)

8 112 (LTCG on others)

o

20

(5ix of schedule BFLA)

9 115B (Proﬁts and gains of life insurance business)

o

12.50

(part of 37ixa of schedule BP)
(part of 1ﬁi of schedule OS)

10

115AC (Income of a non
foreign currency)

-resident from bonds or GDR purchased in

o

10

11 115BB (Winnings from lotteries, puzzles, races, games etc.)

o

30

(1 ﬁof schedule OS)

12 115BBD (Dividend received from speciﬁed foreign company)

o

15

(part of 1fiv of schedule OS)

13 115BBE (Income under section 68, 69, 69A, 69B, 69C or 69D)

o

60

(1ﬁi of schedule OS)

14 115A(b) (Income of a foreign company from Royalty)
15 Chargeable under DTAA rate

o

25

(part of 1fiv of schedule OS)
(part of 1fvi of schedule OS +
A8b and B9b of schedule CG)

o

16 115BBF (Tax on income from patent)
a Income under head business or profession

o

10

(3d of schedule BP)

b Income under head other sources

o

10

(1ﬁii of schedule OS)

a Income under head business or profession

o

10

(3e of schedule BP)

b Income under head other sources

o
o

10

(1ﬁv of schedule OS)

17 115BBG (Tax on income from transfer of carbon credits)

18

Total

EXEMPT INCOME

Schedule EI

Details of Exempt Income (Income not to be included in Total Income)

1 Interest income

1

2 Dividend income

2

3 Long-term capital gains from transactions on which Securities Transaction Tax is paid

3

4

i

Gross Agricultural receipts (other than income to be excluded under rule 7A, 7B
or 8 of I.T. Rules)

i

ii Expenditure incurred on agriculture

ii

iii Unabsorbed agricultural loss of previous eight assessment years

iii

iv Net Agricultural income for the year (i – ii – iii) (enter nil if loss)

4

5 Others, including exempt income of minor child (please specify)

5

6 Total (1+2+3+4+5)

6

Schedule PTI
Sl.

PASS THROUGH INCOME

1.

2.

NOTE ►

MINIM
UM

Schedule MAT

Pass Through Income details from business trust or investment fund as per section 115UA, 115UB
Name of business trust/
PAN of the business
Sl.
Head of income
Amount of income
investment fund
trust/ investment fund
i
House property
ii
Capital Gains
a
Short term
b
Long term
iii
Other Sources
iv
Income claimed to be exempt
a u/s 10(23FBB)
b u/s …………..
c u/s …………
i
House property
ii
Capital Gains
a
Short term
b
Long term
iii
Other Sources
iv
Income claimed to be exempt
a u/s 10(23FBB)
b u/s …………..
c u/s …………
Please refer to the instructions for ﬁlling out this schedule.

TDS on such
amount, if any

Computation of Minimum Alternate Tax payable under section 115JB

Whether the Proﬁt and Loss Account is prepared in accordance with the provisions of Parts II of Schedule III to the Companies Act, 2013
1 (If yes, write ‘Y’, if no write ‘N’)
o
If 1 is no, whether proﬁt and loss account is prepared in accordance with the provisions of the Act governing such company (If yes, wr ite ‘Y’,
2 if no write ‘N’)
o
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Whether, for the Proﬁt and Loss Account referred to in item 1 above, the same accounting policies, accounting standards and same method
3 and rates for calculating depreciation have been followed as have been adopted for preparing accounts laid before the company at its annual
general body meeting? (If yes, write ‘Y’, if no write ‘N’)
4 Proﬁt after tax as shown in the Proﬁt and Loss Account (enter item 48 of Part A -P&L)
5 Additions (if debited in proﬁt and loss account)
Income-tax paid or payable or its provision including the
a
amount of deferred tax and the provision thereof
b Reserve (except reserve under section 33AC)
c

Provisions for unascertained liability

5b
5c
5d

e

5e

Dividend paid or proposed

Expenditure related to exempt income under sections 10, 11
or 12 [exempt income excludes income exempt under section
10(38)]
g Expenditure related to share in income of AOP/ BOI on
which no income-tax is payable as per section 86
h Expenditure in case of foreign company referred to in clause
(fb) of explanation 1 to section 115JB
i Notional loss on transfer of certain capital assets or units
referred to in clause (fc) of explanation 1 to section 115JB
j Expenditure relatable to income by way of royalty in respect
of patent chargeable to tax u/s 115BBF
k Depreciation attributable to revaluation of assets
Gain on transfer of units referred to in clause (k) of
explanation 1 to section 115JB
Others (including residual unadjusted items and provision for
m
diminution in the value of any asset)
l

5f
5g
5h
5i
5j
5k
5l
5m

n Total additions (5a+5b+5c+5d+5e+5f+5g+5h+5i+5j+5k+5l+5m)
6 Deductions
a Amount withdrawn from reserve or provisions if credited to
Proﬁt and Loss account
b Income exempt under sections 10, 11 or 12 [exempt income
excludes income exempt under section 10(38)]
c Amount withdrawn from revaluation reserve and credited
to proﬁt and loss account to the extent it does not exceed the
amount of depreciation attributable to revaluation of asset
d Share in income of AOP/ BOI on which no income-tax is
payable as per section 86 credited to Proﬁt and Loss
account
e Income in case of foreign company referred to in clause
(iid) of explanation 1 to section 115JB
f Notional gain on transfer of certain capital assets or units
referred to in clause (iie) of explanation 1 to section 115JB
g Loss on transfer of units referred to in clause (iif) of
explanation 1 to section 115JB
h Income by way of royalty referred to in clause (iig) of
explanation 1 to section 115JB
i Loss brought forward or unabsorbed depreciation
whichever is less
j Proﬁt of sick industrial company till net worth is equal to or
exceeds accumulated losses
k Others (including residual unadjusted items and the amount of
deferred tax credited to P&L A/c)
l Total deductions (6a+6b+6c+6d+6e+6f+6g+6h+6i+6j+6k)

4

5a

d Provisions for losses of subsidiary companies
f

o

5n

6a
6b
6c
6d
6e
6f
6g
6h
6i
6j
6k

7 Book proﬁt under section 115JB (4+ 5n – 6l)

6l
7

Whether the financial statements of the company are drawn up in compliance to the Indian Accounting
8 Standards (Ind-AS) speciﬁed in Annexure to the companies (Indian Accounting Standards) Rules, 2015 . If
yes, furnish the details below:-

o Yes

o No

A. Additions to book proﬁt under sub-sections (2A) to (2C) of section 115JB
Amounts credited to other comprehensive income in statement of proﬁt & loss under the head “items
that will not be reclassiﬁed to proﬁt & loss”
Amounts debited to the statement of proﬁt & loss on distribution of non-cash assets to shareholders in
b
a demerger
a

8a
8b

c One ﬁfth of the transition amount as referred to in section 115JB (2C) (if applicable)

8c

d Others (including residual adjustment)

8d

e Total additions (8a + 8b + 8c + 8d)

8e

B. Deductions from book proﬁt under sub-sections (2A) to (2C) of section 115JB
f

Amounts debited to other comprehensive income in statement of proﬁt & loss under the head “items
that will not be reclassiﬁed to proﬁt & loss”

8f
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g

Amounts credited to the statement of proﬁt & loss on distribution of non-cash assets to shareholders in
a demerger

8g

h One ﬁfth of the transition amount as referred to in section 115JB (2C) (if applicable)

8h

i Others (including residual adjustment)

8i

j Total deductions (8f + 8g + 8h + 8i)

8j

9 Deemed total income under section 115JB (7 + 8e – 8j)

9

10 Tax payable under section 115JB

10

Schedule MATC

Computation of tax credit under section 115JAA

1 Tax under section 115JB in assessment year 2018-19 (1d of Part-B-TTI)

1

2 Tax under other provisions of the Act in assessment year 2018-19 (2f of Part-B-TTI)

2

3 Amount of tax against which credit is available [enter (2 – 1) if 2 is greater than 1, otherwise enter 0]

3

MAT CREDIT

4 Utilisation of MAT credit Available [Sum of MAT credit utilised during the current year is subject to maximum of amount mentioned in 3 above and
cannot exceed the sum of MAT Credit Brought Forward ]
Balance MAT Credit
S.No
Assessment Year
MAT Credit Utilised
MAT Credit
Carried Forward
(A)
during the Current
Gross
Set-off in earlier years
Balance Brought
(D)= (B3) – (C)
Year
(B1)
(B2)
forward
(C)
(B3)=(B2)-(B1)
i 2008-09
ii

2009-10

iii

2010-11

iv

2011-12

v

2012-13

vi

2013-14

vii

2014-15

viii 2015-16
ix

2016-17

x

2017-18

xi

2018-19 (enter 1 -2, if
1>2 else enter 0)
Total

xii

5 Amount of tax credit under section 115JAA utilised during the year [enter 4(C)ix]

5

6 Amount of MAT liability available for credit in subsequent assessment years [enter 4(D)ix]

6

DIVIDEND DISTRIBUTION TAX

Schedule- DDT

Details of tax on distributed proﬁts of domestic companies and its payment

Sl

Description

Details of 1st dividend

Details of 2nd dividend

Details of 3rd dividend

(i)

(ii)

(iii)

(iv)

(v)

(DD/MM/YYYY)

(DD/MM/YYYY)

(DD/MM/YYYY)

1

Date of declaration or distribution or payment, whichever is
earliest, of dividend by domestic company

2

Rate of dividend, declared, distributed or paid

3

Amount of dividend declared, distributed or paid

4

Amount of reduction as per section 115-O(1A)
Additional income-tax @15% payable
a
Tax payable
under section 115-O on (3-4)
on dividend
b Surcharge on ‘a’
declared,

5

distributed or
paid

c

Education cess on (a+b)

d

Total tax payable (a+b+c)

6

Interest payable under section 115P

7

Additional income-tax and interest payable (5d + 6)

8

Tax and interest paid

9

Net payable/refundable (7-8)

10

Date(s) of deposit of dividend distribution tax

11
12

Name of Bank and Branch
BSR Code

13

Serial number of challan

14

Amount deposited

Date 1
(DD/MM/
YYYY)

Date 2
(DD/MM/
YYYY)

Date 1
(DD/MM/
YYYY)

Date 2
(DD/MM/
YYYY)

Date 1
(DD/MM/
YYYY)

Date 2
(DD/MM/
YYYY)
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Schedule- BBS

Details of tax on distributed income of a domestic company on buy back of shares, not listed on stock exchange
Details of 3rd buyDetails of 2nd buyDescription
Details of 1st buy-back
back
back
(ii)
(iii)
(iv)
(v)

Sl
(i)
1
2

TAX ON BUY BACK OF SHARES

3
4

5

Date of payments of any consideration to the shareholder on
buy back of share
Amount of consideration paid by the company on buy-back of
shares
Amount received by the company for issue of such shares

income

c

Education cess on (a+b)

d

Total tax payable (a+b+c)

Interest payable under section 115QB

7

Additional income-tax and interest payable (5d + 6)

8

Tax and interest paid

9

Net payable/refundable (7-8)
Date 1
(DD/MM/
YYYY)

Date(s) of deposit of tax on distribution income

11
12

Name of Bank and Branch
BSR Code

13

Serial number of challan

14

Amount deposited

Schedule FSI

(DD/MM/YYYY)

Date 2
(DD/MM/
YYYY)

Date 1
(DD/MM/
YYYY)

Date 2
(DD/MM/
YYYY)

Date 1
(DD/MM/
YYYY)

Date 2
(DD/MM/
YYYY)

Details of Income from outside India and tax relief

Sl. Country Taxpayer
Code
Identiﬁcation
Number

INCOME FROM OUTSIDE INDIA AND TAX RELIEF

(DD/MM/YYYY)

Distributed Income of the company (2 – 3)
Additional income-tax @20% payable
a
under section 115QA on 4
Tax payable
b Surcharge on ‘a’
on distributed

6

10

(DD/MM/YYYY)

Sl.

Head of income

(a)
1

Tax paid
Income from outside
outside India
India
(included in PART BTI)
(b)

i

House Property

ii

Business or
Profession

(c)

Tax payable on Tax relief available Relevant article of
DTAA if relief
in India
such income
claimed u/s 90 or
(e)= (c) or (d)
under normal
90A
whichever is lower
provisions in
India
(d)

(e)

(f)

iii Capital Gains
iv Other sources
Total
2

i

House Property

Business or
ii
Profession
iii Capital Gains
iv Other sources
Total
NOTE ►

Please refer to the instructions for ﬁlling out this schedule.

TAX RELIEF FOR TAX PAID OUTSIDE
INDIA

Schedule TR

Summary of tax relief claimed for taxes paid outside India

1 Details of Tax relief claimed
Country Code
Taxpayer Identiﬁcation
Total taxes paid outside India
Number
(total of (c) of Schedule FSI in respect
of each country)
(a)

(b)

(c)

Total tax relief available
(total of (e) of Schedule FSI in
respect of each country)

Section under which relief
claimed
(specify 90, 90A or 91)

(d)

(e)

Total
2 Total Tax relief available in respect of country where DTAA is applicable (section 90/90A) (Part of total of 1(d))

2

3 Total Tax relief available in respect of country where DTAA is not applicable (section 91) (Part of total of 1(d))

3

Whether any tax paid outside India, on which tax relief was allowed in India, has been refunded/credited by the
4
foreign tax authority during the year? If yes, provide the details below

4

Yes/No
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a Amount of tax refunded
NOTE ►

b Assessment year in which tax relief allowed in India

Please refer to the instructions for ﬁlling out this schedule.

Schedule FA

Details of Foreign Assets and Income from any source outside India

A

Details of Foreign Bank Accounts held (including any beneﬁcial interest) at any time during the previous year

Sl
No

Country
Name and
Code

(1)

(2)

Account
StatusName and Account
Number
Owner/
Address of holder
name Beneﬁcial owner/
the Bank
Beneﬁciary
(3)
(4)
(5)
(6)

Interest taxable and offered in this return
Account Peak Balance Interest
opening During the accrued in Amount
Schedule
Item number of
the account
Year (in
date
where offered
schedule
rupees)
(7)
(8)
(9)
(10)
(11)
(12)

(i)
(ii)
B Details of Financial Interest in any Entity held (including any beneﬁcial interest) at any time during the previous year
Nature of Income taxable and offered in this return
Income
Date
Total
Nature of
Sl
Country Nature of Name and
Income
accrued
since held Investment
InterestNo Name and entity Address of
Amount
Schedule
Item number of
the Entity Direct/ Beneﬁcial
code
(at cost) (in from such
where offered
schedule
Interest
owner/
rupees)
Beneﬁciary
(1)
(2)
(3)
(4)
(5)
(6)
(7)
(8)
(9)
(10)
(11)
(12)
(i)

DETAILS OF FOREIGN ASSETS

(ii)
C Details of Immovable Property held (including any beneﬁcial interest) at any time during the previous year
Date of
Total Investment
Income
Nature of
Income taxable and offered in this return
Sl
Country
Address of Ownershipacquisition
derived from Income
No Name and the Property
Direct/
(at cost) (in
Amount
Schedule
Item number of
the property
code
Beneﬁcial
rupees)
where offered
schedule
owner/
Beneﬁciary
(1)
(2)
(3)
(4)
(5)
(6)
(7)
(8)
(9)
(10)
(11)
(i)
(ii)
D Details of any other Capital Asset held (including any beneﬁcial interest) at any time during the previous year
Nature of
Income taxable and offered in this return
Date of
Total Investment
Income
OwnershipNature of
Country
Sl
acquisition
derived from Income
Direct/
Asset
No Name and
(at cost) (in
Amount
Schedule
Item number of
the
asset
Beneﬁcial
code
rupees)
where offered
schedule
owner/
Beneﬁciary
(1) (2)
(3)
(4)
(5)
(6)
(7)
(8)
(9)
(10)
(11)
(i)
(ii)
E Details of account(s) in which you have signing authority held (including any beneﬁcial interest) at any time during the previous year and which
has not been included in A to D above.
If (7) is yes, If (7) is yes, Income offered in this return
Whether
Address of Name of the Account Peak Balance/
Name of the
Sl
Income
income accrued
Investment
Number
account
the
Institution in
No
Amount
Schedule
Item number of
accrued in
is taxable in
during the year
holder
Institution
which the
where offered
schedule
your hands? the account
account is held
(in rupees)
(1)
(2)
(3)
(4)
(5)
(6)
(7)
(8)
(9)
(10)
(11)
(i)
(ii)
F Details of trusts, created under the laws of a country outside India, in which you are a trustee, beneﬁciary or settlor
If (8) is yes, If (8) is yes, Income offered in this return
Whether
Date
Sl
Country Name and Name and Name and Name and
Income
since income derived
No Name and address of address of address of address of
Amount
Schedule
Item number
Beneﬁciaries position is taxable in derived from
Settlor
trustees
the trust
code
where offered
of schedule
the trust
your hands?
held
(1)

(2)

(3)

(4)

(5)

(6)

(7)

(8)

(9)

(10)

(11)

(12)

(i)
(ii)
Details of any other income derived from any source outside India which is not included in,- (i) items A to F above and, (ii) income under the
head business or profession
If (6) is yes, Income offered in this return
Sl Country Name Name and address of the
Whether taxable
Income derived Nature of income
Amount
Schedule
Item number
No
and code
person from whom derived
in your hands?
where offered
of schedule
(1)
(2)
(3)
(4)
(5)
(6)
(7)
(8)
(9)
G

(i)
NOTE ►

Please refer to instructions for ﬁlling out this schedule
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DETAILS OF
GST

Schedule GST
Sl.
No.

(1)

Total amount of Expenditure
during the year
(aggregate of expenditure
reported at items 6, 8 to 35, 37 &
38 of Part-A-P&L / P&L – Ind
AS)
(2)

NOTE ►

Schedule FD
Foreign Currency
Transaction

Break-up of total expenditure with entities registered or not registered under the GST (Details in respect of expenditure on or
after 01st July, 2017 to be ﬁlled up by the assessee who is not liable to get accounts audited u/s 44AB)
Expenditure in respect of entities registered under GST
Relating to goods or
services exempt from
GST

Relating to entities
falling under
composition scheme

Relating to other
registered entities

(3)

(4)

(5)

(6)

(7)

Please refer to instructions for ﬁlling out this schedule.

Break-up of payments/receipts in Foreign currency (to be ﬁlled up by the assessee who is not liable to get accounts audited u/s
44AB)

S.
No.
i Payments made during the year on capital account
ii

Expenditure relating
to entities not
Total payment registered under GST
to registered
entities

Amount (in Rs.)

Payments made during the year on revenue account

iii Receipts during the year on capital account
iv Receipts during the year on revenue account

NOTE ►

Please refer to instructions for ﬁlling out this schedule.

InthischapterwehavediscussedonlysubmissionofITR-6.Forthepurposeoflogintherequiredweb
addressisasgivenbelow.
https://www.incometaxindiaefiling.gov.in/help/?lang=eng
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UNIT - 15
E-FILLING OF RETURN – ONLINE PAN APPLICATION
Online Application of for New PAN (Form 49A) à
Guidelines à
• An applicant will fill Form 49A online and submit the form.
• If there are any errors, rectify them and re-submit the form.
• A confirmation screen with all the data filled by the applicant will be displayed.
• The applicant may either edit or confirm the same.
• On confirmation, an acknowledgement will be displayed. The acknowledgement will contain a
unique 15-digit acknowledgement number.
• The applicant is requested to save and print this acknowledgement.
• ‘Individual’ applicants should affix two recent colour photographs with white background (size
3.5 cm x 2.5 cm) in the space provided in the acknowledgement. The photographs should not be
stapled or clipped to the acknowledgement. The clarity of image on PAN card will depend on the
quality and clarity of photograph affixed on the acknowledgement.
• Signature / Left Thumb Impression should only be within the box provided in the acknowledgement.
The signature should not be on the photograph affixed on right side of the form. In case of
applicants other than ‘Individuals’, the authorized signatory shall sign the acknowledgement and
affix the appropriate seal or stamp. The signature should not be on photograph. If there is any mark
on photograph such that it hinders the clear visibility of the face of the applicant, the application
will not be accepted.
• Signature / Left hand thumb impression should be provided across the photo affixed on the left
side of the form in such a manner that portion of signature/impression is on photo as well as on
acknowledgement.
• Thumb impression, if used, should be attested by a Magistrate or a Notary Public or a Gazetted
Officer under official seal and stamp.
• If communication Address is within India
 The fee for processing PAN application is 96.00 ( 85.00 + 12.36% service tax).
 Payment can be made either by
- Demand Draft
- Cheque
- Credit Card / Debit Card
- Net Banking
• If any of addresses i.e. office address or residential address is a foreign address, the payment can
be made only by way of Credit Card / Debit card and Demand Draft payable at Mumbai.
• If communication Address is outside India
 The fee for processing PAN application is 962.00 [(Application fee 85.00 + Dispatch Charges
771.00) + 12.36% service tax].
 Payment can be made only by way of Credit Card / Debit card and Demand Draft payable at
Mumbai.
 At present the facility for dispatch of PAN cards outside India is available for a select list of
countries. Applicants from other countries may contact NSDL at the contact details given in
point (v) below.
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This point is not applicable if applicant is providing the representative assessee details in the point
no.14 of application form.
• Demand draft and cheque should be drawn in favour of ‘NSDL - PAN’.
• Demand draft shall be payable at Mumbai and the acknowledgement number should be
mentioned on the reverse of the demand draft.
• Applicants making payment by cheque shall deposit a local cheque (drawn on any bank) with
any HDFC Bank branch across the country (except Dahej). The applicant shall mention NSDLPAN
on the deposit slip. List of HDFC Bank Branches.
• Credit card / Debit card / Net banking payment
Persons authorized to make Credit card / Debit card / Net banking payment are as below:
Category of Applicant

Payment by Credit Card / Debit Card / Net Banking can be
made by / for
Individual
Self, immediate family members (parents, spouse, children)
HUF
Karta of the HUF
Company
Any Director of the Company
Firm / Limited Liability Partnership
Any Partner of the Firm / Limited Liability Partnership
Association of Person(s) / Body of Authorized Signatory covered under section 140 of Income
Individuals/ Association of Person(s) Tax Act, 1961
Trust / Artificial Juridical Person / Local
Authority
Applicants making online payment using credit card / debit card will be charged an additional
charge of upto 2% (plus applicable taxes) of application fee by the bank providing gateway facility.
Additionally, the conversion/exchange rates may also be levied by the card issuing bank, as per
prevailing rates.
Applicants making payment through Net Banking facility will be charged an additional surcharge of
4.00 + service tax for payment gateway facility.
On successful credit card / debit card / net banking payment acknowledgement will be displayed.
Applicant shall save and print the acknowledgement and send to NSDL as mentioned in point (p) &
(q) below.
• The acknowledgement duly signed, affixed with photograph (in case of ‘Individuals’) alongwith
Demand Draft, if any, and proof of identity (name in the application should be same as in the
proof of identity) & proof of address (Individuals, HUFs, Body of Individuals, Association of Persons
& Artificial Juridical Person should provide proof of address of residence stated in the application)
as specified in the application form is to be sent to NSDL at ‘Income Tax PAN Services Unit, NSDL
e-Governance Infrastructure Limited, 5th floor, Mantri Sterling, Plot No. 341, Survey No. 997/8,
Model Colony, Near Deep Bungalow Chowk, Pune - 411016’
• Super scribe the envelope with ‘APPLICATION FOR PAN - Acknowledgement Number’ (e.g.
‘APPLICATION FOR PAN - 881010100000097’).
• Your acknowledgement, Demand Draft, if any, and proofs, should reach NSDL within 15 days from
the date of online application.
• Applications received with demand draft or cheque as mode of payment shall be processed only
on receipt of relevant proofs and realization of payment.
• For more information:
§ Call PAN/TDS Call Centre at 020 - 27218080; Fax: 020 – 27218081
§ e-mail us at: tininfo@nsdl.co.in mailto:tininfo@nsdl.co.in
§ ASMS NSDLPAN <space> Acknowledgement No. & send to 57575 to obtain application status.
§ Write to: INCOME TAX PAN SERVICES UNIT (Managed by NSDL e-Governance Infrastructure
Limited), 5th floor, Mantri Sterling, Plot No. 341, Survey No. 997/8, Model Colony, Near Deep
Bungalow Chowk, Pune – 411016.
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UNIT - 16
E-FILLING OF RETURN – CUSTOM DUTY AUTOMATION
Custom Duty à
Introduction à
Custom duty is on imports into India and export out of India. Section 12 of Custom Act, often called
charging section, provided that duties of Customs shall be levied at such rates as may be specified
under the Custom Tariff Act, 1975’, or any other law for the time being in force, on goods imported into,
or, exported from, India,
Procedure for getting IEC Codeà
Definition of IEC Codeà
IEC Code is unique 10 digit code issued by DGFT – Director General of Foreign Trade , Ministry of
Commerce, Government of India to Indian Companies.
Full form of IEC Codeà
Full From of IEC Code is “Importer Exporter Code ”. To import or export in India, IEC Code is mandatory.
No person or entity shall make any Import or Export without IEC Code Number.
IEC Code No Notificationà
Directorate General of Foreign Trade(DGFT) issued a Policy Circular No.15 (RE-2006)/2004-2009 Date:
27th July, 2006) for New System for issuance of Importer-Exporter Code Number.
Eligibility, Legal Provisions and Conditions for IEC Code Numberà
Eligibility condition and Legal Provisions are given for IEC Code Number Application in Foreign Trade
(Regulation) Rules, 1993 Ministry of Commerce, Notification No. GSR 791 (E), dated 30-12-1993.
Application for Grant of IEC Numberà
An application for grant of IEC number shall be made by the Registered/Head Office of the applicant
and apply to the nearest Regional Authority of Directorate General Foreign Trade, the Registered
office in case of company and Head office in case of others, falls in the ‘Aayaat Niryaat Form - ANF2A’
and shall be accompanied by documents prescribed therein. In case of STPI/ EHTP/ BTP units, the
Regional Offices of the DGFT having jurisdiction over the district in which the Registered/ Head Office
of the STPI unit is located shall issue or amend the IECs.
Only one IEC would be issued against a single PAN number. Any proprietor can have only one IEC
number and in case there are more than one IECs allotted to a proprietor, the same may be surrendered
to the Regional Office for cancellation.
IEC Code Online Application Formà
The application can be download Form in PDF or Word. This is called “Aayaat Niryaat Form - ANF2A”.
Along with IEC Code Number Application Form it is necessary to submit Appendix-18B Attested by
Applicant’s Banker in his letter head with two passport size photo).
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List Of Regional Authorities Of DGFT And The Corresponding Office of Reserve Bank Of India, Exchange
Control Department à
You can find the list of Foreign Exchange Control Department of the RBI as given in Appendix-18D.
Validity of IEC Code No à
An IEC number allotted to an applicant shall be valid for all its branches/divisions/units/factories as
indicated in the format of IEC given in Appendix- 18B.
Duplicate Copy of IEC Number à
Where an IEC Number is lost or misplaced, the issuing authority may consider requests for grant of a
duplicate copy of IEC number, if accompanied by an affidavit.
Surrender of IEC Number à
If an IEC holder does not wish to operate the allotted IEC number, he may surrender the same by
informing the issuing authority. On receipt of such intimation, the issuing authority shall immediately
cancel the same and electronically transmit it to DGFT for onward transmission to the Customs and
Regional Authorities.
Application Fee For IEC Code Numberà
Application Fee : ` 250.00
Mode of Payment : In Demand Draft/ Pay Order from any designated bank in favour of Zonal Joint
Director General of Foreign Trade or Payment through EFT ( Electronic Fund Transfer by Nominated
Bank by DGFT Like HDFC Bank, ICICI Bank, State Bank of India, UTI Bank, Punjab National Bank, Central
Bank etc) or Application fee can deposited by TR6 Challan with Duplicate Copy in any branch of
Central Bank of India and TR6 Challan need to be submit along with IEC Code Application.
Specified fee shall be paid for making an application under any provision of the Policy and Handbook
of Procedure Volume-I.. The scale of fee, mode of payment, procedure for refund of fee and the
categories of persons exempted from the payment of fee are contained in Appendix-21B.
Territorial Jurisdiction of Regional Authoritiesà
Every application, unless otherwise specified, shall be submitted to the Regional Authority of Directorate
General Foreign Trade, as per the territorial jurisdiction of the Regional authorities indicated in Policy
and Handbook of Procedure Volume-I.
Filing of Applicationà
Application can be filed online in DGFT website, details of online links are given below.
Every application for an Import/Export licence/ certificate/ Authorisation/ permission or any other
purpose should be complete in all respects as required under the relevant provisions of the Policy/
Procedures and shall be signed by the applicant as defined inparagraph 9.9 of the Policy. An
incomplete application is liable to be rejected giving specific reason for rejection. However in case
of manual applications, the applicant would furnish a soft copy of the application in MS word format.
Profile of Importer/ Exporterà
Each Importer/Exporter shall be required to file importer/ exporter profile once with the Regional
Authority in Part 1 of ‘Aayaat Niryaat Form - ANF2A’. Regional Authority shall enter the information
furnished in Part 1 of ‘Aayaat Niryaat Form ANF-2A’ in their database so as to dispense with the need
for asking the repetitive information. In case of any change in the information given in Part 1 of ‘Aayaat
Niryaat Form ANF-2A’, importer/exporter shall intimate the same to the Regional Authority.
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Self Addressed Stamped Envelopeà
The applicant shall furnish a self addressed envelope of 40 × 15 cm with postal stamp affixed on the
envelope as follows for all documents required to be sent by Speed Post:
• Within local area

` 25.00

• Up to 200 Kms.

` 25.00

• Between 200 to 1000 Kms

` 30.00

• Beyond 1000 Kms.

` 50.00

Guidelines for Application of IEC Code Number à
Mandatory Requirements to apply for IEC Code Number
• Covering letter
• Fill Part A, B & D of the application form.
• Application must be accompanied by documents as per details given below:
§ Bank Certificate from the bank on Bank letter head as per proforma (Part B) given in the
application.
Ø In case of Proprietorship firms, please furnish
ü Date of Birth of individual
ü Number of IECs held along with their details
Ø In case of Companies, please furnish
ü Extract of Board of Resolution.
ü MOA with Form 32 and ROC in case of change in Directors.
Ø In case of others
ü Notorised Partnership Deed showing date of formation.
ü No Objection Certificate from other partners/HUF.
§ Self certified copy of Permanent Account Number (PAN) issued by income Tax Authorities.
§ Two copies of passport size photographs of the applicant. The photograph pasted on the
banker’s certificate must be attested by the banker with Seal and Signature of the applicant.
• The application must be submitted in Duplicate.
• Each individual page of the application must be signed by the applicant.
• Self addressed envelope stamped with ` 25 (Local Address) & for others ` 30. These documents
may be kept secured in a file cover.
How to submit IEC Code application à
Application can be submitted in person/by Authorised Employee of the Company at the R & I counters
in the office Or It can be sent by post/courier.
Processing of IEC Code Application à
The application can be submitted at the counter in person at the office or it can be sent through
Post/Courier. An acknowledgement in form of a receipt having File Number is generated on receipt
of application. The file number is used for any correspondence/query regarding the IEC application
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submitted to the office. The application is then sent to IEC section where it is processed. If the
application is found complete in all aspects (as per requirements prescribed) an IEC is generated, or
else a deficiency letter stating the nature of deficiency is prepared and sent to the applicant. Replies
are awaited in cases where deficiency letter is issued and after due compliance by the applicant the
IEC is allotted.
Issue and Despatch of IEC Codeà
IEC allotment letter is sent through post at the registered office mentioned by the applicant in the
application. Similarly deficiency letters are sent to applicant by post.
File No for IEC applicationà
A new option to know the file number has been introduced for all exporter who are sending their
application through Post/Courier. The applicant has to input PAN number to get the file number.
Status of IEC Applicationà
The applicant can know the status of the IEC application using option “Status of IEC Application” on
the website of CLA.
IEC issued day wise
IEC’s issued daily can be viewed on the website using option “IEC issued day wise”
File No for IEC application
Applicant’s who have sent their application through post/courier can know their file number using
option “File No for IEC application”.
IEC Code Number Related linksà
DGFT Online IEC Code Number Application Form -ANF-2A
View Your IEC Status : http://dgft.delhi.nic.in:8100/dgft/iecprint
IEC Status at Custom(BIN) : http://164.100.9.176/iecstatus.html
http://www.dgft.gov.in/dgftcla
http://www.dgft.gov.in
http://www.icegate.gov.in
Bill of Entry à
Introduction à
All goods imported into India have to pass through the procedure of customs for proper examination,
appraisal, assessment and evaluation. This helps the custom authorities to charge the proper tax and
also check the goods against the illegal import. Also it is important to note that no import is allowed in
India if the importer doesn’t have the IEC number issued by the DFGT. There is no requirement of IEC
number if the goods are imported for the personal use.
Bill of Entryà
A Bill of Entry also known as Shipment Bill is a statement of the nature and value of goods to be imported
or exported, prepared by the shipper and presented to a customhouse. The importer clearing the goods
for domestic consumption has to file bill of entry in four copies; original and duplicate are meant for
customs, third copy for the importer and the fourth copy is meant for the bank for making remittances.
If the goods are cleared through the EDI system, no formal Bill of Entry is filed as it is generated in the
computer system, but the importer is required to file a cargo declaration having prescribed particulars
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required for processing of the entry for customs clearance. In the non-EDI system along with the bill of
entry filed by the importer or his representative the following documents are also generally required:• Signed invoice
• Packing list
• Bill of Lading or Delivery Order/Airway Bill
• GATT declaration form duly filled in
• Importers/ CHA’s declaration
• License wherever necessary
• Letter of Credit/Bank Draft/wherever necessary
• Insurance document
• Import license
• Industrial License, if required
• Test report in case of chemicals
• Adhoc exemption order
• DEEC Book/DEPB in original
• Catalogue, Technical write up, Literature in case of machineries, spares or chemicals as may be
applicable
• Separately split up value of spares, components machineries
• Certificate of Origin, if preferential rate of duty is claimed
• No Commission declaration
Amendment of Bill of Entryà
Whenever mistakes are noticed after submission of documents, amendments to the bill of entry is
carried out with the approval of Deputy/Assistant Commissioner.
Green Channel facilityà
Some major importers have been given the green channel clearance facility. It means clearance
of goods is done without routine examination of the goods. They have to make a declaration in the
declaration form at the time of filing of bill of entry. The appraisement is done as per normal procedure
except that there would be no physical examination of the goods.
Payment of Dutyà
Import duty may be paid in the designated banks or through TR-6 challans. Different Custom Houses
have authorised different banks for payment of duty and is necessary to check the name of the bank
and the branch before depositing the duty.
Prior Entry for Shipping Bill or Bill of Entryà
For faster clearance of the goods, provision has been made in section 46 of the Act, to allow filing of bill
of entry prior to arrival of goods. This bill of entry is valid if vessel/aircraft carrying the goods arrive within
30 days from the date of presentation of bill of entry.
Specialized Schemesà
Import of goods under specialized scheme such as DEEC and EOU etc is required to execute bonds
with the custom authorities. In case failure of bond, importer is required to pay the duty livable on those
goods. The amount of bond would be equal to the amount of duty livable on the imported goods.
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The bank guarantee is also required along with the bond. However, the amount of bank guarantee
depends upon the status of the importer like Super Star Trading House/Trading House etc.
Bill of Entry for Bond/Warehousingà
A separate form of bill of entry is used for clearance of goods for warehousing. Assessment of this bill of
entry is done in the same manner as the normal bill of entry and then the duty payable is determined.
Electronic Submission under EDI systemà
Customs work at many ports has been computerized. In that case, the Bill of Entry has to be filled
electronically, i.e. through Customs EDI system through computerization of work. Procedure for the
same has been prescribed vides Bill of Entry (Electronic Declaration) Regulations, 1995.
The board procedures to be followed for export are as follows:
• Submit Shipping Bill for export to customs authorities.
• Submit invoice, packing lists, contracts, export license (if applicable) and other related documents.
• Submit necessary declaration for export. Submit GR/SDF/SOFTEX from as required under FEMA
Excise ARE-1 form
• Nothing of Shipping Bill by customs officer
• Assessment i.e. valuation and classification of goods. Checking of Advance License. If applicable
• Custom check weather export is restricted/prohibited
• Examination of goods by customs officer
• Pay export duty, if applicable
• Stuffing of container, if not already done
• ‘Let export’ Order by customs officer
• Obtain ARE-1 form duty signed by customs officer. Obtain Bill of Lading from shipping company.
Submit proof of export to excise authorizes.
Complete formalities relating to claim of duty drawback.
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UNIT - 17
E-FILLING OF RETURN – ESIC
Applicability à
Under Section 2(12) The Act is applicable to the factories employing 10 or more persons irrespective of
whether power is used in the process of manufacturing or not.
• Under Section 1(5) of the Act, the Scheme has been extended to shops, hotels, restaurants, cinemas
including preview theatre, road motor transport undertakings and newspaper establishment
employing 20 or more persons.
• Further, u/s 1(5) of the Act, the Scheme has been extended to Private Medical and Educational
Institutions employing 20 or more persons in certain States .
• The State Govt. has been requested to issue notification under Section 1(5) on the lines of Section
2(12) keeping the threshold limit for coverage as 10 employees instead of 20.
• The existing wage-limit for coverage under the Act, is Rs.15,000/- per month (with effect from
01.05.2010).
AREAS COVEREDà
The ESI Scheme is being implemented area-wise by stages. The Scheme has already been
implemented in different areas in the following States/Union Territories
STATESà
All the States except Nagaland, Manipur, Tripura, Sikkim, Arunachal Pradesh and Mizoram.
UNION TERRITORIESà
Delhi, Chandigarh and Pondicherry
Contributionà
This is a contribution of both Employer and Employee
Contribution - of wages:1.75%

4.75%

Employee

Employer

6.50%
(Total)
Wagesà
It includes:- Basic pay , DA, HRA, City compensatory allowance ,overtime wages payment for day of
rest , production incentives, bonus.
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Excludesà
Any traveling allowance or the value of any travelling concession paid by employer, contribution paid
by employer to any pension Provident Fund under ESI Act, Benefits paid under ESI scheme, encashment
of leave.
• Date of payment ( if delay interest paid @ 12% )
• In Form-6 with copies of challan
• Form-01- Application for registration.
• Form-1- Declaration by persons in employment engaged after appointed day.
• Form-10- Employees registration form.
• Form-3 Return of declaration form – This is a covering letter for the declaration forms to be submitted
in duplicate to the appropriate office.
• Form-6- Return of contribution – Submit this form qudruplicate to the regional office along with 6
challan of deposit with in 30 days of the end of every contribution period.
• Form -86- Certificate of employment issued to insuredt person by employer
• Registers / Files to be maintained by the employer.
• Form-7- Every employer shall maintain a register in form -7 in respect of every employee of this
factory- preserve it for a period of 5 years from the date of the last entry therein.
• Form-15- Appropriate particulars of any accident causing personal injury to an insured person
may entered - preserve if for a period of 5 years from the date of last entry thereon.
Applicability à
ESI applies on all factories other than seasonal facilities.
Factories

(Using power)
10 or more person

(Non power manufacturing units)
20 or more person.

ESI Act Shall continue to be governed by the act notwithstanding than no of persons employed fall
below the limit subrecoverly.
Provisions enclosed as follows:
• Shops
• Hotels – Resturents
• Rood motor transport undertaking
Registration à
Steps 1:
Application in Form-01à within 15 daysà Regional officeà After satisfaction allot code no àEmployee
Step-2:
After step-1 employer shall determine- (a) Employee coverable (b) Declaration shall be filled by
employee.
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Registration – 1Aà
Every employer shall maintain a register in form-7 in respect every employee engaged by him.
Penal Provisionsà
• For employees’ contribution : Imprisonment for minimum 2 yrs. to maximum 5 yrs. and/or fine of
` 25,000/- .
• For employer’s contribution : Imprisonment for minimum 6 months to maximum 3 yrs. and/or fine of
`10,000/- .
RECORDS TO BE KEPT READY FOR ESI INSPECTIONà
• Attendance Register/Muster Roll.
• Salary/Wage Register/Payroll.
• EC (Employee’s & Employer’s Contribution) Statement.
• Employees’ Register U/R 32 (Form 7).
• Accident Register U/R 66.
• Return of Contribution (RC-Form 6).
• Return of Declaration Forms (RDF - Form 3).
• Receipted Copies of Challans.
• Books of Account viz Cash/Bank, Expense Register, Sales/Purchase Register, Petty Cash Book,
Ledger, Supporting Bills asnd Vouchers, a/w Delivery Challans (if any).
SCREEN FOR LOGIN AND REGISTRATION à
• Employer will log in to ESIC official Web Site:- www.esic.in
• Enter username and password and click “ Login” button. It will redirect to Employer Landing Page.
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STEPS TO DO BEFORE SUBMITTING MONTHLY CONTRIBUTION AND CHALLAN GENERATIONà
• Ensure all existing IP’s having Insurance No. are registered for and mapped to the
• employer , if not listed and then Click “Insert IP Details” in Employer Landing page.
• Ensure those employees(New Joinings ) entering insurable employment for the first time, for filling
Declaration Form , click “ Register New IP” in Employer Landing Page for generating Insurance
No./TIC. Fill all the required fields in Employees Registration Screens in Employment Registration
Screens.
• In case of Inter Region Migration of an IP from one region to another. Click “Register New IP” .
There will be an option in the screen “Is IP already registered”, then select option “Yes” and fill all
required fields and Submit.
• Mandatory fields are marked in RED asterisk (*) and must be filled.
• If all Employees inserted/registered then Click “File Monthly Contributions” LINK in the Employer
Landing Page shown in next SCREEN.
EMPLOYER LANDING PAGE à

• Click ‘File Monthly Contribution link ‘to navigate to subsequent Monthly Contribution page,
Monthly Contribution
Details home page and Payment Details homepage for entering and uploading the due
contribution.
• Click on ‘Generate Challan link’ redirects to Monthly Contribution page
• Click on ‘Modify Challan link’ redirects to Monthly Contribution > View History page.
MONTHLY CONTRIBUTION PROCESSING à
In order to process the payable contribution, provide the basic information like Contribution Period,
type of contribution.
We have two option for filing the Contribution :• Through the upload excel file, for big Employers or in alternative
• Online entry of contribution of all employees.
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MONTHLY CONTRIBUTION PROCESSING à
In order to process the payable contribution, provide the basic information like Contribution Period,
type of contribution.
We have two option for filing the Contribution :• Through the upload excel file, for big Employers or in alternative
• Online entry of contribution of all employees.

MONTHLY CONTRIBUTION PROCESSING à
Click on Browse. Browse this sheet from Desktop and click on Upload.
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MONTHLY CONTRIBUTION PROCESSING à
Select Month, year and type of contribution whether Monthly Contribution or Supplementary
contribution and click on “Submit” for entering online Days and Wages details of employees.

EMPLOYER > Monthly Contribution page à
Save : To save the entries in the screen.
Reset : To clear the entries in the screen.
Cancel : To cancel the entries and revert to the landing page.
Close : To redirect to Employer landing page
Submit : For submission or uploading the data.
MONTHLY CONTRIBUTION PAYMENT DETAILS à
On selection of month and year of contribution from dropdown, following screen will be opened to fill
particulars employment and payment in Form 5 maintained online.
• Furnish no of days worked, wages of the employees.
• In case of left Employee, enter no of days and wages as ‘ 0 ‘ , Select Reason from dropdown and
enter date of last working day.
• Click ‘Submit’
• The total of Employer/Employee Contribution will be calculated by the system on the basis of
input.

•

EMPLOYER > Monthly Contribution > Monthly Contribution Details
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MONTHLY CONTRIBUTION PAYMENT DETAILS à
Click ‘Preview’ to see the details of the due Contribution payable for confirmation before generation
of challan.

EMPLOYER > Monthly Contribution > Monthly Contribution Details
MONTHLY CONTRIBUTION PAYMENT CONFIRMATION à
A small window will appear showing Employees contribution + Employer contribution = Total Contribution,
Total wages and “SUBMIT”

• EMPLOYERR >Monthly Contribution > Monthly Contribution Details>Payment History
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MONTHLY CONTRIBUTION VIEW à
On Clicking “View “, it will redirect to Payment page.

• EMPLOYER > ONLINE Monthly Contribution > PAYMENT
SELECTION OF CONTRIBUTION MONTH FOR PAYMENTà
• Enter the amount to be paid in “TOTAL AMOUNT TO BE PAID” box ’.
• This amount should be less or equal to amount due mentioned. This means Employer can make
part payment.
• Employer should select payment mode ‘Online’ or ‘Offline’ (by default Offline).
• On Clicking ‘Submit’, Employer will be connected to Payment Gateway for payment using Credit/
Debit card and internet Banking (facility yet to be extended)

• EMPLOYERR > Monthly Contribution > Monthly Contribution Details > Payment > Payment Details
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PAYMENT MODE SELECTION (CASH) à
• Select payment mode i.e. cash or cheque /Demand Draft from the drop down list.
• For Cash as a PAYMENT MODE, fill the amount to be paid and then SUBMIT. In this case State Bank
of India will be populated automatically for depositing it in that Bank.

• EMPLOYERR > Monthly Contribution > Monthly Contribution Details > Payment > Challan Form
PAYMENT MODE SELECTION (CHEQUE / DEMAND DRAFT) à
• In case of Cheque/Demand Draft as PAYMENT MODE, fill the cheque/Demand Draft details as
Cheque/DD No, Cheque/DD Date, drawn Bank name, Branch name.
• Click SUBMIT
• EMPLOYERR >Monthly Contribution>Monthly Contribution Details>Payment>Challan Form
CHALLAN CREATION à
After submitting the request, it will take 2-3 seconds to process and please wait till then.

• EMPLOYERR >Monthly Contribution>Monthly Contribution Details>Payment>Challan Form
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CHALLAN PRINTING à
To print the challan, click ‘Print’ Option.

CHALLAN PRINTING à
Click on “Option”. It will direct to a pop-up window.

CHALLAN PRINTING à
Select “Allow pop-ups for www.esic.in” and click ‘Print’ Button.
CHALLAN PRINTING à
You have successfully generated the challan.

17.10 I The Institute of Cost Accountants of India-100 Hours Compulsory Computer Training Program

CHALLAN PRINTING à
Click on ‘Export’ and select the file type as “PDF”.
Again click on Print then it will be converted into PDF File in Landscape mode.

CHALLAN PRINTINGà
Select ‘All ’ and click ‘ok’ to print the report.
CHALLAN PRINTINGà
• The challan print is in twin (Bank Copy/Depositors Copy) for presenting it along with cash/cheque
for payment before any branch of State Bank of India .
• Depositors Copy of the challan is payment instrument/receipt for further reference.
• Henceforth system generated challan will only be accepted by our Bankers.
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FLOW CHART OF ACTIVITIES FOR FILING OF MONTHLY CONTRIBUTION AND CHALLAN CREATIONà
PREACTIVITYà
• Inserting of existing covered employees having Insurance no. EMLOYERS->INSERT IP DETAILS
• Insertion of not already covered employees drawing wages less than `15000 EMLOYERS-> REGISTER
NEW IPs
FILING OF MONTHLY CONTRIBUTIONà
• CLICK ‘Filing of Monthly Contribution Link’ . EMPLOYERS->FILING OF MONTHLY CONTRIBUTION
• Select M/Y and Type of Contribution from dropdown. Entry of contribution details either online or
upload. Enter no of days worked and wages paid. Enter no of days and wages as ‘0’ and reason
of leaving of employees from dropdown in ONLINE register of employees in Form 5 u/r 32(1) and
32(1A). Click ‘SUBMIT’.
• Click ‘preview’ button to confirm correctness of total due contribution.
• Click ‘Create Challan’ for updating the monthly payable contribution by the employer in the
system.
• Select ‘View’ to show the page listing Contribution History of all paid/payable dues of the Employer.
• Select ‘Type of Contribution’ and M/Y of Contribution and ‘Submit’.
• Select Mode of Payment.
• Click ‘Print’ to print the challan. Click ‘Option’. Select ‘Allow Pop for ‘www.esic.in’. Click on Export
and Select the file type as ‘PDF’(applicable to Internet Explorer) Again click ‘Print’. Select ‘ALL’
and Click ‘OK’.
Types of forms required to be submitted time to time à
Employees State Insurance Act, 1948 & Employees State Insurance Regulations, 1950
Sl.
No

Type &
Nature of
Document

Description of Form

Relevant
Clause
Regulation 11
& 12

Schedule of
Submission/Maintenance

1

Form I

Declaration Form

To be filled in by the employee with his
signature or thumb impression and submit
it to the employer

2

Form I-A

Family Declaration Regulation
Form
15-A

To be filled in by the employee and
submitted back to the employer, who shall
forward the same to the appropriate office
within 10 days from the date of submission
by the employee

3

Form I-B

Changes in family Regulation
Declaration form
15-B

To be submitted by the insured person to the
employer within 15 days of such changes
occurring and the employer in turn would
forward the same to the appropriate office
within 10 days of receipt.

4

Form 3

Returns
of Regulation 14
declaration form

To be sent by the employer to the
appropriate office within 10 days of receipt
of the filled up forms
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Sl.
No

Type &
Nature of
Document

Description of Form

Relevant
Clause
Regulation 17

Schedule of
Submission/Maintenance

5

Form 4

Identity Card

To be issued by the appropriate office in
respect of all insured employees, and send
the same to the employer, who shall issue
the same to the concerned employee
after obtaining the signature in the card

6

Form 4-A

Family
Card

7

Form 6

ESIC–Return
Contribution

of Regulation 26

To be sent by the employer in quadruplicate
along with receipt copies of challans to
the appropriate office within 42 days of
termination of related contribution period;
within 21 days of permanent closure of
factory; within 7 days of the date of receipt
of requisition from the appropriate office

8

Form 7

Register
Employees

of Regulation 32

To be maintained by the employer in
respect of every employee of his factory
or establishment

9

Form 8

First Certificate

Regulation 57 This medical certificate is to be issued
& 89-B
by the insurance medical officer the first
examination in respect of a spell of sickness
or a spell of temporary disablement

10

Form 9

Final Certificate

Regulation 58 To be issued by the insurance medical
& 89-B
officer, when he feels that not later than 3
days of the date of examination(other than
a first certificate) the insured employee
would be fit to resume duties

11

Form 10

Intermediate
Certificate

Regulation 59 To be submitted by the insured person
& 89-B
within 7 days (commencing from the date
of first certificate) in cases wherein the final
certificate is not issued within 7 days of
issue of first certificate

12

Form 11

Special
Intermediate
Certificate

Regulation 61 To be furnished by the insured person in
& 89-B
cases wherein the insurance medical
officer feels that temporary disablement
has continued for not less than 28 days
and such disablement is likely to continue
for a longer period

13

Form 12

Sickness or
Temporary
Disablement
Benefit

Regulation 63

Identity R e g u l a t i o n To be arranged by the appropriate office
95-A
and necessary family particulars added in
Form 4

To be submitted by the insured person
desirous of claiming sickness or temporary
disablement benefit to the appropriate
local office by post or otherwise alongwith
appropriate medical certificate
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Sl.
No

Type &
Nature of
Document

Description of Form

Relevant
Clause

Schedule of
Submission/Maintenance

14

Form 12-A

Maternity Benefit
for Sickness

R e g u l a t i o n To be submitted by every insured women
89-B
claiming maternity benefit in case
of sickness arising out of pregnancy,
confinement, permanent birth of child or
miscarriage to local appropriate office by
post or otherwise

15

Form 13

Sickness or
Temporary
Disablement
Benefit or
Maternity Benefit
for sickness

Regulation 63 To be submitted by the insured person
& 89-B
or insured women desirous of claiming
sickness or temporary disablement benefit
to the appropriate local office by post or
otherwise alongwith appropriate medical
certificates

16

Form 13-A

Maternity Benefit
for sickness

R e g u l a t i o n To be submitted by every insured women
89-B
claiming maternity benefit in case
of sickness arising out of pregnancy,
confinement, premature birth of child or
miscarriage to local appropriate office by
post or otherwise

17

Form 14

Sickness or
Temporary
Disablement
Benefit or
Maternity Benefit
for sickness

Regulation 63

18

Form 14-A

Maternity Benefit Regulation
for sickness
89-B

To be submitted by every insured women
claiming maternity benefit in case
of sickness arising out of pregnancy,
confinement, premature birth of child or
miscarriage to the local appropriate office
by post or otherwise

19

Form 15

Accident Book

Regulation 66

To be maintained by the employer in which
appropriate particulars of any accident
causing personal injury to an insured
person may be entered and preserved
every suck book for a period of five years.

20

Form 16

Accident
Report Regulation 68
from Employer

To be furnished by the employer to the
nearest local office and to the nearest
insurance medical officer immediately if
the injury is serious

21

Form 17

Dependent’s
Benefit – Death
Certificate

Regulations 79 To be issued free of charge by the
& 95-C
Insurance Medical attending the disabled
person at the time of his death

22

Form 18

Dependent
benefit- Claim
Form

Regulation 80

To be submitted by the insured person
or insured women desirous of claiming
sickness or temporary disablement benefit
to the appropriate medical certificate

To be submitted by the dependent or
dependents concerned or by the legal
representative of the insured member
with all supporting documents to the
appropriate local office by post or
otherwise
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Sl.
No

Type &
Nature of
Document

Description of Form

Relevant
Clause

Schedule of
Submission/Maintenance

23

Form 18-A

Dependent’s
Regulation
Benefit- Claim
83-A
Form for periodical
Payments

To be submitted by the dependent whose
claim for dependent’s benefit is admitted,
to the local appropriate office except in
the case of first and final payments

24

Form 19

Maternity Benefit
–Notice of
Pregnancy

Regulation -87

To be submitted by an insured women
before
confinement
to
the
local
appropriate office

25

Form 20

Maternity Benefit
– Certificate of
Pregnancy

Regulation 87

To be submitted by an insured women
before
confinement
to
the
local
appropriate office

26

Form 21

Maternity BenefitCertificate
of Expected
Confinement

Regulation 88

To be submitted by every insured women
claiming
maternity
benefit
before
confinement not earlier than 15 days
before the expected date of confinement

27

Form 22

Maternity BenefitClaim Form

Regulation 88 To be submitted by every insured women
& 89
to the local appropriate office stating
therein the date on which she ceases to
work for remuneration and if the insured
woman is claiming maternity benefit for
miscarriage the claim form ought to be
submitted within 30 days of the date of
miscarriage

28

Form 23

Maternity Benefit
– Certificate of
Confinement or
Miscarriage

Regulation 88 To be submitted by every insured women
& 89
within 30 days on which her confinement
takes place to the local appropriate office

29

Form 24

Maternity BenefitNotice of Work

Regulation 91

30

Regulation
Form 24-A & Maternity Benefit
24-B
after the death of 89-A
an insured woman
leaving behind the
child / Maternity
Benefit- Death
Certificate

To be submitted by the nominee or legal
representative of the insured woman to
the local appropriate office, a claim for
maternity benefit within 30 days of the
death of the insured women, together with
a death certificate in 24-B

31

Form 25

Claim for
Permanent
Disablement
Benefit

Regulation
76-A

To be submitted by an insured person
declared as permanently disabled by a
Medical Board to the local appropriate
office by post or otherwise

32

Form 25-A

Funeral Expenses
Claim Form

Regulation
95-E

To be submitted by the claimant entitled,
to the local appropriate office and in case
of a minor, by his guardian and the form
ought to be submitted with all supporting
documents

To be submitted by every insured women
who has claimed maternity benefit, if she
does work for remuneration on any day
during the period for which maternity
benefit would be payable to her
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Sl.
No

Type &
Nature of
Document

Description of Form

Relevant
Clause

Schedule of
Submission/Maintenance

33

Form 26

Certificate for
permanent
disablement
benefit

Regulation 107 To be submitted by every person whose
claim for permanent disablement has
been admitted at six monthly intervals, a
certificate attested by such authority as
may be specified by the director general

34

Form 27

Declaration &
Certificate for
Dependent’s
Benefit

Regulation
107-A

To be submitted by every person whose
claim for dependent’s benefit has been
admitted at six monthly intervals, duly
attested by such authority as may be
specified by the director general

35

Form 28

Abstention
Verification

Regulation
52-A

To be furnished by every employer to
the appropriate office, such particulars
& information in respect of abstention
of an insured person from work for which
sickness benefit or disablement benefit
for temporary disablement have been
claimed or paid

36

Form 28-A

Abstention
Verification

Regulation
52-A

To be furnished by every employer to
the appropriate office, such particulars
& information in respect of abstention
of an insured person from work for which
maternity benefit has been claimed or
paid
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UNIT - 18
E-FILLING OF RETURN – PROVIDENT FUND
CENTRAL GOVERNMENT CONTRIBUTION à
In exercise of powers conferred under Section 6A of the Employees’ Provident Funds & Miscellaneous
Provisions Act, 1952, the Central Government formulated the Employees’ Pension Scheme, 1995. The
benefits under the Scheme are paid out of the Employees’ Pension Fund into which the employer and
the Central Government contribute @ 8.33% and 1.16% of the wages respectively subject to a wage
ceiling of ` 15,000/This act is applicable to employees drawing pay not more than ` 15,000 pm. But at the time of
registration the same employee pay should not exceed ` 5,000. This act deals with:
• The Employees’ Provident Fund Schemes, 1952,
• The Employees’ Pension Scheme, 1995, and
• The Employees’ Deposit linked Insurance Scheme, 1976
APPLICABILITYà
• To every establishment which is a factory engaged in any industry specified in Schedule 1 and in
which 20 or more persons are employed, and
• To any other establishment employing 20 or more persons or class of such establishments which
the CG by notification on the official gazette specifies in this behalf.
NON-APPLICABILITYà
• Establishment registered under the Co-operative Societies Act, 1912 or under any other law for the
time being in state relating to cooperative societies, employing less than 50 person without the
aid/help of power,
• Establishment belonging to CG or SG whose employees are entitled to the benefit of these
provident and pension funds in accordance with any scheme or rule framed by Central or State
Government governing such benefits,
• Establishment belonging to Provincial or State Act whose employees are entitled to the benefit of
these provident and pension funds in accordance with any act governing such benefits,
Note: If once such establishment falls within this act, then the act will apply to such establishment even
if the number of employee falls below 20.
The Employees Provident Fund Schemes, 1952à
This act has been passed by Central Government. This fund is administered by Central Board which is
administered by Board of Trustees.
Whether Voluntary Coverage under this scheme is allowedà
• The establishment is allowed the coverage under the provisions of the Act on voluntary basis with
the consent of majority of the employees.
Employee entitled and required to join Provident Fundà
• Every employee employed in or in connection with the work of a factory or establishment shall
entitle and required to become a member of the Fund from the date of joining the factory or
establishment.
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The term employee includes the following persons also à
• Who is employee for wages in any kind of work manual or otherwise, in or in connection with the
work of an establishment and who gets wages directly or indirectly from the employer and
• Includes any person employed by or through a contractor in or in connection with the work of the
establishment
Thus the term “employee” includes à
• Employed by or through the contractor in or in connection with the work of the establishment
• Engaged as an apprentice, not being an apprentice under the Apprentices Act, 1961
Basic salary à
• Equal or Less than ` 15000/pm COMPULSORY contribution in PF
• More than ` 15001/pm OPTIONAL to become member of the PF
Where wages or salary or pay consists of à
• Basic Salary or Wages
• Dearness Allowances
• Cash value of food concessions
• Retaining allowances
• Leave encashment
Contributionà
For Employees’à
Contribution

Minimum

Maximum

Towards PF

12% of the pay

100% of the Pay

Contribution

Minimum

Maximum

Towards PF

12% of the pay

12% of the Pay

For Employer’s à

Further the employer’s contribution should be divided as follows à
• Pension Fund (EPS)- 8.33% of Pensionable Salary
• Pensionable Salary: Pay or `15000/- whichever is less
• Provident Fund – 3.67% (12%-8.33%)
The rate of contribution is 10% in the case of following establishments à
• Any covered establishment with less then 20 employees, for establishments cover prior to 22.9.97.
• Any sick industrial company as defined in clause (O) of Sub-Section (1) of Section 3 of the Sick
Industrial Companies (Special Provisions) Act, 1985 and which has been declared as such by the
Board for Industrial and Financial Reconstruction,
• Any establishment which has at the end of any financial year accumulated losses equal to or
exceeding its entire net worth
• Any establishment engaged in manufacturing of (a) jute (b) Breed (d) coir and (e) Guar gum
Industries/ Factories.
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Note: The contribution under the Employees’ Provident Fund Scheme by the employee and employer
will be as under with effect from 22.9.1997.
Due Date à
• Employer is required to pay, amount received from employee, on or before 15th of the following
month (plus Grace period of 5 days), i.e. contribution of Oct before 15th November.
• By separate Bank drafts or cheques on account of contributions and administrative charge.
What if amount of PF paid after due date à
Penalty will charge at the time of PF Inspection. At the time of inspection the record, E.O (Enforcement
Officer) ask you about to make the record of PF Challan contribution under different account LIKE A/C1,10,2,21 AND 22. and date of deposit challan and Clearance date by Bank........and if challan clear
after the Due date then interest will charge by E.O under PF 7A AND 14 B (INTREST AND DAMAGES)
DAMAGES à
• For 0 — 2 months delay - @ 5 % p.a.
• For 2 — 4 months delay - @10 % p.a.
• For 4 — 6 months delay - @ 15 % p.a.
• For delay above 6 months - @ 25 % p.a. (subject to a maximum of 100%)
INTEREST à
• 12 % per anuunm
EXAMPLE à
• PF challan last date is 15 of every month and if it is not cleared till 15th of the same u will get 5 days
grace period
If it cleared on 20th à à No penalty and interest
If it clear on 21th à à 6 days penalty and interest
Accounting Year under PF act à
• Accounting year is from March to February.
Procedure of Application à
• PF form is to be filled up along with incorporation documents, MOA, AOA, PAN, Address Proof; etc
as before 30 days from the date such act becomes applicable on the establishment.
Procedure for PF registration à
The following forms are to be filed for registering the establishment:
• A Detailed Application for termed as ― Performa for coverage
• Form 5 A with Annexure I
Information required for filling up forms à
• Name of The Company
• Postal Address, Telephone No and Email Address
• Details of Director/ Managing Director/ Partners – Address, Ph. No, email ID
• Details of Authorized Signatory (in case whose is signing in the place of Director)
• Nature and Date of Commencement of Business
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• Date of Joining of Employees, Father Name, DOB
• Salary, PF Statement and Bank Account Details of the Company
Documents required for filling up the Forms à
• Incorporation Certificate of Company in case of private limited company and Certificate of
Registration of Firm in case of Partnership Firm.
• MOA & AOA in case of Private Limited Company and Partnership Deed in case of Partnership Firm.
• Rental Agreement/ Lease Agreement of Company
• Company/ Firm PAN Card
• Address Proof of Director/Partners – Lease / Rental Agreement
• ID Proof of Director/ Partners – Pan Card / Election Card/ Passport/ Driving License
• List of Directors/ Partners
• Registration copies with other Departments like. VAT, PT, Labour dept.
• First Invoice raised from the company/ Firm
• True copy of Board resolution empowering company representatives as Authorised signatories
Once
Note: Documents are filed the PF Authorities carry out a physical inspection of the premises and verify
all original documents. On satisfaction, the business is granted with a PF allotment letter.
The Employees’ Pension Scheme, 1995 à
• The purpose of the scheme is to provide for:
• Superannuation pension
• Retiring Pension.
• Permanent Total disablement Pension
 Superannuation Pension: Member who has rendered eligible service of 20 years and retires on
attaining the age of 58 years.
 Retirement Pension: member who has rendered eligible service of 20 years and retires or
otherwise ceases to be in employment before attaining the age of 58 years.
 Short service Pension: Member has to render eligible service of 10 years and more but less than
20 years.
Government has introduced this scheme under section 6A, to CLAIM this à
• Have attained 58 years of age, or
•

Retirement, or

•

Permanent total disablement, or

•

Children pension, or

•

Orphan pension

Eligibility to enjoy pension scheme à
Employee has to complete membership of the Fund for 10 Years i.e. continuous service.
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Meaning of continuous service of ten years à
Example, an employee who has worked with:X company 3 years, resigned
Y Company 2 years, resigned
Establishment for 5 years
But during these 10 years of service he has not withdrawn but transferred his Employee pension fund,
and then we say continuous service of ten years.
The Government accounts in which the PF dues are required to be deposited à
The PF dues are required to be deposited as follows:
• 12% of the Pay, Employees Provident Fund Contribution – A/c No. – 1
• Voluntary Provident Fund Contribution – A/c No. – 1
• 3.67% of the employer contribution, Employer Provident Fund, – A/c No. – 1
• 8.33% of the Pensionable Salary (EPS)-A/c No. – 10
• 1.10% of the Pay, PF Admin. Charges-Minimum ` 5/-pm, A/c No. – 2
• 0.50% of Pensionable Salary for EDLI contribution-A/c No. – 21
• 0.01% of Pensionable Salary for EDLI administrative charges – Minimum ` 2/-pm., A/c No.–22

Filing of Return and Create Challan Online à
Background à
• PF Organization in India has taken the much awaited step of going online for return filing and
related activities.
• W.e.f. 1st April’2012 (March paid in April) EPF return can be filed online
• Similarly, Challan can be generated online and also paid online
• This online service has been named as ECR, Electronic Challan Cum Return
• This is mandatory for each employer (covered under PF)
• Employer needs to get itself registered to avail this facility
• For employee, there is already an online facility to track their claim status and check their EPF
Balance
Benefits to Employer à
• No paper return to be prepared and submitted to EPFO
• No need to submit other return viz Form 5, 10, 12A, 3A and 6A
• Employers will get the confirmation of payment through SMS instantly
• This contribution will be credited to the member’s account on monthly basis
• Employers can view the annual accounts slip for accounting year 2011-2012 online
• For earlier years employers can request for the for the annual slips through this portal
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Filing ECR à
Preconditions à
 The Employer has registered his/her establishment on the Employer e-Sewa Portal. (Click on http://
esewa.epfoservices.in/)
 The employer has downloaded the ECR file format and prepared the ECR text file.
ELECTRONIC CHALLAN CUM RETURN (ECR) FILE FORMAT (FOR EMPLOYERS) à
The Electronic Challan cum Return (ECR) will be an electronic return in plain text format and will consist
of DETAILED lines (one line for each member). The separator between fields should be #~# ( hash tilda
hash).
Sl.
No

Column Name

1

Member ID

2

Column
Width
Number (7)

Whether
mandatory

Remarks

Yes

Only account number ( maximum 7 digits)
Value should be > 0
Two lines with same member id will not be
accepted in a single ECR text file

Member Name Character (85)

Yes

No special characters other than ‘.’ are allowed

3

EPF Wages

Number (10)

no

Numbers only, no special character and not in
decimals

4

EPS Wages

Number (10)

No

Numbers only, no special character and not in
decimals
Wages on which Pension contribution is due.
In case of the member over 58 years age, the
wages should be ‘0’ even in case there are PF
wages. Also in case of employer contributing
over the wage ceiling, the pension wages should
be maximum `15000 if Pension contribution
is restricted to ` 541.

5

EPF
Contribution
(EE Share) due

Number (10)

No

Numbers only, no special character and not in
decimals, should be equal to or more than EPF
Contribution (EE Share) being remitted. Employee
share deducted and due for remittance

6

EPF
Contribution
(EE Share)
being remitted

Number (10)

No

Numbers only, no special character, not in
decimals:
Employee share being remitted through this ECR

7

EPS
Contribution
due

Number (10)

No

Numbers only, no special character and not in
decimals, should be equal to or more than EPS
Contribution being remitted

8

EPS
Contribution
being remitted

Number (10)

No

Numbers only, no special character, not in
decimals

9

Diff EPF
and EPS
Contribution
(ER Share) due

Number (10)

No

Numbers only, no special character and not
in decimals, should be equal to or more than
Diff EPF and EPS Contribution (ER Share) being
remitted
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Sl.
No

Column Name

Column
Width

10

Diff EPF
and EPS
Contribution
(ER Share)
being remitted

Number (10)

No

Numbers only, no special character, not in
decimals,

11

NCP Days

Number (10)

No

Numbers only, no special character, not in
decimals.
Number of days in the month for which wages
are not due.

12

Refund of
Advances

Number (10)

No

Numbers only, no special character and not in
decimals

13

Arrear EPF
Wages

Number (10)

No

Numbers only, no special character and not in
decimals

14

Arrear EPF EE
Share

Number (10)

No

Numbers only, no special character and not in
decimals

15

Arrear EPF ER
Share

Number (10)

No

Numbers only, no special character and not in
decimals

16

Arrear EPS

Number (10)

No

Numbers only, no special character and not in
decimals

17

Father’s/
Husband’s
Name

Character (85)

No

No special characters are allowed. Please
provide only if the member has joined in the
wage month. (for new member only)

18

Relationship
with the
Member

Character (1)

No

Relationship of the member with column 17
above. Value should be F(for father) or S (for
Husband). Please provide only if the member
has joined in the wage month. (for new member
only)

19

Date of Birth

Date(10)

No

Valid date in dd/mm/yyyy format. Please
provide only if the member has joined in the
wage month. (for new member only)

20

Gender

Character (1)

No

M(Male) , F(Female) or T (Transgender).
Please provide only if the member has joined in
the wage month. (for new member only)

21

Date of Joining Date (10)
EPF

No

Valid date in dd/mm/yyyy format, not later than
the month of ECR. Please provide only if the
member has joined in the wage month. (for new
member only)

22

Date of Joining Date (10)
EPS

No

Valid date in dd/mm/yyyy format, not later than
the month of ECR. Please provide only if the
member has joined in the wage month. (for new
member only)

23

Date of
from EPF

No

Valid date in dd/mm/yyyy format, cannot be
prior to date of joining. Please provide only if the
member has left in the wage month. (for exiting
member only)

Exit Date (10)

Whether
mandatory

Remarks
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24

Date of
from EPS

Exit Date (10)

No

Valid date in dd/mm/yyyy format, cannot be
prior to date of joining. Please provide only if the
member has left in the wage month. (for exiting
member only)

25

Reason
leaving

for Character (1)

No

C (Cessation), S (Superannuation) , R (Retirement), D (Death in Service), or P (Permanent
Disablement).
Please provide only if the member has left in
the wage month. (for exiting member only).
Mandatory, if “Date of Exit from EPF” is not blank.

Sample ECR text file with three members for the month of March 2012 paid in April 2012 for establishment
id DLCPM0001234000 is as follows for reference:
12#~#RANJAN#~#7000#~#6500#~#840#~#840#~#541#~#541#~#299#~#299#~#0#~#0#~#10000#
~#1500#~#1000#~#500#~##~##~##~##~##~##~#20/03/2012#~#20/03/2012#~#S
13#~#BIRENDRA#~#6000#~#6000#~#720#~#720#~#500#~#500#~#220#~#220#~#8#~#0#~#0#~
#0#~#0#~#0#~##~##~##~##~##~##~##~##~#
16#~#SHEELA#~#5000#~#5000#~#600#~#600#~#417#~#417#~#183#~#183#~#4#~#0#~#0#~#0#
~#0#~#0#~#VINEET#~#F#~#05/03/1990#~#F#~#05/03/2012#~#05/03/2012#~##~##~#
How to Prepare ECR Text fileà
• Step 1: Use any Spreadsheet (OpenOffice, Excel, Lotus, etc.) for creating the member details as
per the prescribed format and save the file in CSV (Comma Delimited) format.
• Step 2: Open the CSV file in any Text Editor (Notepad, Editplus, etc.) and replace all “,” with “#~#”.
Save the file as a TXT file by using “Save as” option of the Text Editor.
Process à
Step 1: Login to the Employer e-Sewa Portal.
Click here for Login.
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After login you will find the following screenà

Step 2: Upload ECRà
Click on ECR at the top Menu Bar. You will find the various options. Click ECR UPLOAD.
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The following screen will open à

Select the text file you have to upload from the location where you have saved it. Check the Wage
Month and year for which you are going to upload the ECR. Select the correct Wage Month/Year and
click SUBMIT button.
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If your text file has been prepared correctly, the Summary sheet as follows will appear.

Enter the additional details regarding EDLI and EPF/EDLI Administrative and Inspection charges. Check
the Contribution rate also. By default it is 12%. If applicable for your establishment, you can change it
to 10%. Click SUBMIT ECR button.
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An alert will appear to confirm the Contribution rate. Click OK and again click SUBMIT ECR button.

Step 3: Approve ECR à
A digitally signed PDF file with date and time of upload will appear on the screen.
Note: In case the number of members in the ECR file is more than 200, please wait till you get an SMS
alert to view/download the digitally signed PDF file.
Click on the PDF file icon to download the file and verify the data with the data of the ECR text file
uploaded by you.

Note: The PDF file that is displayed is digitally signed by EPFO for security purpose and no signature is
required.
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This step is also available at the following link (ECR PENDING FOR APPROVAL)

The digitally signed PDF will look like the following screens.

After you have satisfied yourself with the correctness of the data, click APPROVE button. An alert will
come on Approval. Click OK.
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Step 4: Download and Print Challan à
On approval of the ECR file, a Temporary Return Reference Number (TRRN) for the uploaded ECR file
will be generated and the next screen that will appear will display the Challan and Acknowledgement
slip for uploaded file.

Click Challan Receipt File for downloading and printing the Challan.
This step is also available at the following link (REQUEST ECR REJECTION)
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The challan will look as follows: After Printing, manually fill in the details under “For establishment use
only”.

The ECR Acknowledge slip will be as follows:

The challan generated on approval of ECR will lapse after 15 days if remittance is not made.
Till this stage the employer can request for rejection of the approved ECR. However if remittance is
made against the ECR, it cannot be rejected.
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Step 5: Make Remittance: (Off line activity) à
There are two options
• If the employer is a CINB (Corporate Internet Banking) customer of SBI, then he/she can make
online payment through the onlinesbi portal of SBI. Click here for SBI Portal. ##
• Otherwise the remittance can be made through Demand draft/local cheque in any designated
branch of SBI. For SBI designated branch list, click SBI BRANCHES FOR EPF REMITTANCE
• Once the cheque against the challan is realized, you will get SMS alert. With this the ECR filing
process for the month will be complete.
Note: The online payment option will be available after a few days. Please make remittance through
Demand Draft/local cheque till the facility starts.
Some Useful Forms for Compliance à
• Form-19: To claim final settlement of Provident Fund by a member.
• Form-20: To claim Provident Fund by nominee/legal heir on death of the member.
• Form-10-D: To claim pension. (In duplicate: If within state, In triplicate: If outside state.)
• Form-10-C: To claim withdrawal benefit/scheme certificate under Employees’ Pension Scheme
‘95.
• Form-5IF: To claim assurance benefit under Employees’ Deposit Linked Insurance ‘76 by nominee/
legal heir of a member.
• Form-31: To claim temporary withdrawal/advance under Employees’ PF scheme
• Form-13: To effect transfer of Provident Fund/Pension from one A/C to another.
• Form-9(Revised): The details of employees enrolled as members of Employees’ Provident FundS’52,
Employees’ Deposit Linked Insurance’76 & Employees’ Pension Scheme’95 on coverage of the
establishment- This is to be submitted immediately after coverage, within 15 days of coverage.
• Form-12A:The details of the contributions recovered from the members & paid along with details
of employers’ contribution & administrative charges- This is to be submitted monthly by 25th of
following month.
• Form-5: The details of the employees enrolled newly to the Provident Fund- To be submitted along
with Form- 12A every month within 15 days of the following month.
• Form-10: The details of the employees leaving service during the month- To be submitted along
with form-12A.
• Form-2(Revised): Nomination form- To be submitted along with form-5/9.
• Form-3A: The details of wages & contributions in respect of each member, to be prepared financial
year wise- To be submitted to the Provident Fund office by 30th of April every year.
• Form-6A: Yearly consolidated statement of contributions- To be forwarded yearly along with form3A. It should be ensured that all the form-3A are entered in form-6A, irrespective of whether the
form-3A was forwarded for the broken period and the total dues as per the form-12A for the whole
year agrees with the total of form-6A within 30th April.
• Form-5A: Return of ownership of the establishment- To be forwarded immediately after coverage
& whenever there is a change in the ownership, it has to be intimated within 15 days of change.
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UNIT - 19
EXTENSIBLE BUSINESS REPORTING LANGUAGE
XBRL (EXtensible Business Reporting Language)
XBRL stands for eXtensible Business Reporting Language. It is one of a family of “XML” languages which
is becoming a standard means of communicating information between businesses and on the internet.
XBRL provides major benefits in the preparation, analysis and communication of business information
and is fast becoming an accepted reporting language globally. It offers major benefits to all those who
have to create, transmit, use or analyse such information.
Let us take a closer look at the meaning of the term:
(a) Extensible: means the user can extend the application of a particular business data beyond its
original intended purpose and the major advantage is that the extended use can bedetermined
even by the users and not just the ones who merely prepare the business data. This is achieved by
adding tags which are both human and machine readable – describing what the data is.
The property of extensibility is very handy in situations when list of items reported for various elements
of the financial statements are not the same across firms, industries, and countries. For example,
many of item constituting non-current assets in Oil and Gas Industry (items like rigs, exploratory oil
and gas wells) may not be applicable to companies in general. In a situation of this kind, XBRL
may prepare a taxonomy called a ‘Global Common Document’ (GCD) for items common to all
the firms, industries, and countries, and, any country specific, industry specific and firm-specific
variations (extensions / limitations) can, then, be written as independent taxonomies that can be
imported and incorporated with the GCD.
(b) Business: means relevant to the type of business transaction. XBRL focus is on describing
the financial statements for both public and private companies.
(c) Reporting: the intention behind promoting use of XBRL is to have all companies report their
financial statements in a consolidated manner using the specified formats.
(d) Language: XBRL is based on XML, which prescribes the manner in which the data can be
“marked-up” or “tagged” to make it more meaningful to human readers as well as to
computers-based system.
Potential XBRL applications:
(a) XBRL for Financial Statements - financial statements of all sorts used to exchange financial
information
(b) XBRL for Taxes -specification for tax returns which are filed and information exchanged for items
which end up on tax returns
(c) XBRL for Regulatory Filings – specifications for the large number of filings required by government
and regulatory bodies
(d) XBRL for Accounting and Business Reports - management and accounting reporting such as all
the reports that are created by your accounting system rendered in XML to make re-using them
possible
(e) XBRL for Authoritative Literature - a standard way for describing accounting related authoritative
literature published by the AICPA, FASB, ASB, and others to make using these resources easier, “drill
downs” into literature from financials possible
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There is a dramatic improvement in processing of Financial Statements as XBRL documents can be
prepared efficiently, extracted reliably, published more easily, analyzed quickly, retrieved by investors
simply, and enables smarter investments.
XBRL solves two significant issues. The first issue is that preparing a financial statement for printing, for
a Web site, and for filing today means that a company could typically enter information three times.
With XBRL, information will be entered once and the same information will be “rendered” as a printed
financial statement, an HTML document for a Web site, an EDGAR (Electronic Data Gathering, Analysis,
Retrieval) filing file, a raw XML file, or a specialized reporting format such as periodic banking and other
regulatory reports.
The second issue is that earlier, extracting specified detailed information from a financial statement,
even an electronic financial statement like a regulatory filing, was a manual process. For example, a
company cannot tell a computer program to “Get the prepaid expenses for 2008” from an electronic
financial statement. If a financial statement is prepared using XBRL, computer programs can easily
extract every piece of information in that statement
Benefit of having cost related data in XBRL format:
Government and Regulators require cost data of different sectors for policy making. The availability
of cost data [without compromising on the confidentiality in XBRL format enables informed decision
making and for sectoral studies. With full adoption of XBRL, companies would be able to integrate its
financial and cost data across its operational areas and exercise better control on its activities.
Costing Taxonomy:
Costing Taxonomy is a dictionary of all cost elements required in the cost audit report and compliance
report. The costing taxonomy contains the properties and interrelationships of all these cost elements
for the purposes of capturing the required reporting data in XBRL format.
8. Where can I find the Costing Taxonomy and related Business Rules?
The Costing Taxonomy and related Business Rules including sample instance documents can be
downloaded from the website of MCA (http://mca.gov.in). The specific links are as follows:
Costing Taxonomy http://www.mca.gov.in/Ministry/pdf/Costing_Taxonomy_2012-11-22_v1.0.zip
Business Rules –
http://www.mca.gov.in/Ministry/pdf/Revised_Business_Rules_Updated_XBRL_Costing_29.11.2012.zip
9. What are the contents of the excel sheets provided with the Costing Taxonomy?
The excel sheets are for reference and easy understanding of various components of taxonomy in a
human readable form. The excel workbook contains the following worksheets:a. Elements: This worksheet contains all the concepts that form the costing taxonomy. The concepts
are defined as elements/tags along with their characteristics such as data type, balance type,
Nillable etc. e.g. cost of sales of product or activity group is an element defined as:
Characteristic

Property

Meaning

Element Name Cost of Sales of Product or Activity Name of the Element / Tag
Group
Preferred
Label

Cost of Sales of Product or Activity Label that would appear in the rendered
Group
report

Label Role

Standard label

It is a standard label
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Abstract

False

Abstract is False implies element can be
used to tag data. Abstract set to True
indicates that the element is only used
in a hierarchy to group related elements
together and cannot be used to tag data
in an instance document.

Data Type

Monetary Item Type

It is monetary data type

Balance Type

Debit

The balance is debit balance

Period

Duration

The concept is reported for the period
(financial year)

Substitution
Group

Item

This tells whether the element is item,
tuple, hypercube or dimension.

Nillable

True

Nillable set to true means the element
can take empty values. If set to False it
would means that the element in the
instance should have non empty value.

b. Labels: This worksheet contains the 491 nos. of labels to be used as preferred labels in the final
presentation (rendering) of the report in human readable format. A screenshot of the labels is given
below:

c. References: This worksheet contains the relationships between elements and the references of the
elements defined by authoritative literature. The reference parts used are listed below:
Reference part

Use

Name

CAS

Publisher

Institute of Cost Accountants of India

Section

Title of sections of standard or interpretation

Paragraph

Paragraph (number) in the standard

Subparagraph

Subparagraph (number) of a paragraph
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d. Extended Link Cost Audit Report: This worksheet contains the Extended Link Role definitions
contained in the Cost Audit Report. Extended Link Roles represents a set of relationships between
concepts and are the logical grouping of elements. The extended links are then used in
link bases to build the relationships. The list of extended link roles in the Cost Audit Report are:

e. Presentation Cost Audit Report: This worksheet defines the structure of the Cost Audit Report for
displaying the data along with preferred label attribute and the specific order in which they appear.
This enables the taxonomy users to view the representation of elements in the human readable
format. The illustration below shows the presentation of Product or Activity Group Details (Para 3 of
the Annexure to Cost Audit Report):

f.

Calculation Cost Audit Report: This worksheet contains the Additive relationships between numeric
items expressed as parent-child hierarchies in the Cost Audit Report. Each calculation child has a
weight attribute (+1 or -1) based upon the natural balance of the parent and child items. Illustration
below represents the calculation view of the Value addition and distribution of earnings of the
Annexure to Cost Audit Report (Para 8):
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g. Definition Cost Audit Report: It is used to express the dimensional relationship between elements of
the Costing Taxonomy for the Cost Audit Report. An illustration of the definition linkbase for the Cost
Audit Report showing elements of the Product or Activity Group Details is given below:

h. Extended Link Compliance Report: This worksheet contain the Extended Link Role definitions
contained in the Compliance Report. Extended Link Roles represents a set of relationships between
concepts and are the logical grouping of elements. The extended links are then used in link bases
to build the relationships. The list of extended link roles in the Compliance Report are:

i.

Presentation Compliance: This worksheet defines the structure of the Compliance Report for
displaying the data along with preferred label attribute and the specific order in which they
appear. This enables the taxonomy users to view the representation of elements in the human
readable format. The illustration below shows the presentation of Quantitative Information (Para 2
of the Annexure to Compliance Report):
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j.

Calculation Compliance Report: This worksheet contains the Additive relationships between
numeric items expressed as parent-child hierarchies in the Compliance Report. Each calculation
child has a weight attribute (+1 or -1) based upon the natural balance of the parent and child items.
Illustration below represents the calculation view of the Quantitative Information and Reconciliation
Statement of the Annexure to Compliance report:

k. Definition Compliance Report: It is used to express the dimensional relationship between elements
of the Costing Taxonomy for the Cost Audit Report. An illustration of the definition linkbase for the
Compliance Report showing elements of the Quantitative Information (Para 2) is given below:

http://www.mca.gov.in/XBRL/cost_audit_faq.html
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Notes

Notes

